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Determining the IP address of the VPOP3 computer

To determine the IP address of the VPOP3 computer, go to Start -> Run on the VPOP3 computer and
enter 'cmd' and press OK


Now, in the command prompt window which appears, type 'ipconfig' and press 


The screen should show some information. One of the lines will begin with 'IP Address'. The IP
address at the end of the line is the IP address of the VPOP3 computer.


 


Keywords: ipconfig determine discover ip address ipaddress tcp


Tips for searching the Knowledgebase

When searching the knowledgebase try to search for several words if possible. This is most likely to
give the best results. 


It can often be useful to search for error numbers, eg 10061, or the text of an error message. If the
error number doesn't find any relevant results, try searching for the associated error text. For
instance, if you get an error message "550 relaying denied", try searching for "550", but if that
doesn't help, try searching for "relaying denied" instead.


The exception for error messages are ones from Microsoft Outlook or Outlook Express that look
similar to 0x8000cc0e. These are Microsoft specific error messages and don't mean anything
outside Outlook or Outlook Express. If you get an error like this, and there is no other error
information, try searching on Google for it, or Microsoft's knowledgebase.


Please note:



    many problems that people have are related to Internet service provider problems. Our
knowledgebase cannot possibly list all possible Internet service provider errors, it does list a few, but
if you get an error message from VPOP3 saying that it received an error from your ISP it is unlikely
that searching for the error that VPOP3 received from your ISP on our knowledgebase will be useful -
instead contact your ISP and ask them what the error means if it is not clear, as it is their servers
which are generating the error! 

    currently, you cannot search the knowledgebase for phrases using a "" search. Search terms are
always just treated as a collection of words. 

    Searching for entries from the VPOP3.LOG file is likely to be fruitless. Instead, try searching for
details of the symptoms you're seeing. 
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If you don't get a suitable answer to your question, you can contact our technical support team by
emailing support@pscs.co.uk, or posting a message on our forums at discuss.pscs.co.uk. These
forums are monitored by our technical support engineers.

VPOP3 & VPOP3 Enterprise

"550 Recipient not local - access denied" error

If you get the error below when sending a message:

550 ... Recipient not local - access denied

This means that the sender has been set up not to be allowed to send outgoing Internet Email. Go to
the 'Users' list, select the sending user and press 'Edit', then check that the 'Allow Sending Of
Internet Mail' option is enabled for that user.

"550 Relaying not allowed" error when sending mail through VPOP3

The usual reason for this error is that the Access Restrictions setting on the Services -> SMTP
page is set to refuse relaying from the client\'s IP address.


This can happen if you have changed your network's IP address since it was originally installed. You
need to check the Access Restrictions allow access from computers on your local network. 


Usually pressing the Default for your LAN button will set the access restrictions to appropriate
settings, but check they are correct before submitting them, as VPOP3 cannot automatically
determine the settings if you have a more complex network setup 


Also see:



    SMTP Relay Protection in VPOP3 

    Allowing remote users to relay mail through VPOP3 




 




Note that this article refers to the settings in VPOP3 V2.0.0 and later. For earlier versions, the
equivalent settings are accessible from the Local Servers page in the settings by pressing
Configure on the SMTP Server line. There is no Default for your LAN button on these earlier
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versions of VPOP3, so you will need to enter the network details manually. (See here for more details)

"Import Mappings" Feature in VPOP3 2.x

VPOP3 versions 2.0 to 2.1.3 did not have a facility to Import Mappings or Export Mappings. This
feature was re-added in VPOP3 2.1.4 beta, and is available in that version and later.


Note that you do not need to use an Import/Export Mapping facility to either backup the VPOP3
settings, upgrade VPOP3, or move VPOP3 to a new computer. In those cases, simply backup or copy
the MAILBOX.MAP file to the new computer. VPOP3 will automatically upgrade that file if necessary.


The only reason for using the Import/Export Mappings facility is if you want to manage your VPOP3
Mappings from a 3rd party program such as Microsoft Excel or a database.


(This is the same for all other Import/Export facilities in VPOP3 - they are not needed for
upgrade/backup or transfer to a new PC - use the underlying data files for this actions instead)


 

"Internet Explorer Cannot Download...." error when downloading
attachments from WebMail using SSL

If you have configured VPOP3's WebMail to use SSL (either using VPOP3 Enterprise or the third party
STUNNEL program) you may receive the error 




Internet Explorer cannot download..... from 


Internet Explorer was not able to open this Internet site. The requested site is either unavailable or
cannot be found. Please try again later.



If you use a different web browser such as Opera or Mozilla Firefox this problem does not occur. The
problem also does not occur if you don't use WebMail over SSL.

This is an issue with Internet Explorer and is described on Microsoft's knowledgebase here:
http://support.microsoft.com/?kbid=323308. Obtaining the hotfixes (if necessary) from Microsoft and
applying the registry changes described in this article should resolve the problem.

(During our testing of this issue we found that Windows XP SP2 already has the hotfix component,
but the registry changes were still needed)

"Low memory - POP3 download aborted" error in status window

VPOP3 2.3.1 and later will check the amount of free memory before it will start downloading
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messages, or will accept messages from a message sender. By default versions 2.3.1 to 2.4.0b will
check for 200MB of free virtual memory. If this amount of memory is not available, then VPOP3 will
continue working, but will not download or accept any new messages. This is because VPOP3 can
use up to 2-3 times the size of an incoming message in memory whilst processing the message
through the spam filter, integrated virus scanner, attachment filtering etc, and if Windows runs out
of virtual memory, really bad things can happen (usually involving every program on the PC
crashing, locking up etc)


Virtual memory is physical RAM in the computer PLUS the swap file, so if you have 256MB of
physical RAM in a PC, and a 512MB swap file you will usually not see this error, as there is 768MB
virtual memory on the PC. (Most people recommend that a swap file is set to at least 2-4 times the
amount of physical RAM in the PC)


We will be reducing the amount of free virtual memory that is checked for by VPOP3 in 2.4.0c and
later to be 60MB, and in 2.4.2 and later you can set the amount of memory that is checked for
yourself on the Utilties -> Misc Settings page.


In earlier versions of VPOP3, you can change the amount of free memory that VPOP3 checks for
using the following procedure:



    Stop VPOP3

    Run RegEdit, find HKEY_LOCAL_MACHINE\Software\PaulSmith\VPOP3\Secret

    Set POP3ClientRequiredMemory to the desired check level in MB

    find HKEY_LOCAL_MACHINE\Software\PaulSmith\VPOP3\SMTPServer

    Set RequiredMemory to the desired check level in MB

    Restart VPOP3




Note that setting the check level too small risks the computer running out of memory totally, with
adverse effects, so we don't recommend that you set it less than 60MB, and if you regularly send
very large messages, set it to at least 3 times the size of the largest message you send.


 

"SMTP - xx: Killing Incomplete File" in ERRORS.LOG file

You may see a line in the VPOP3 'ERRORS.LOG' file saying something like:

SMTP - 22: Killing Incomplete File

This error means that a user was sending a message to VPOP3 over the network, and the user told 
their email client to stop sending the message (perhaps it was a large message).

When VPOP3 realises that the email client is not going to send any more of the message, it will 
delete the part of the message that it has already received, and write the above error to the 
ERRORS.LOG file
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This is not usually a problem, unless users are reporting errors in their email client software.

"VPOP3 Encountered a bad LAN forwarding data file" error messages

If you get an email message looking like this 

VPOP3 Encountered a bad LAN forwarding data file:

D:\Program Files\VPOP3\OutQueue\WXb0f088.DAT [Code:2]

Please contact your distributor for help





This is caused by a bug in VPOP3 triggered when: 



    Mail is being sent to VPOP3 from Exchange Server or another email program which supports DSN
(Delivery Status Notifications), and 

    Mail is being sent out from VPOP3 using 'SMTP Direct' 




This problem is fixed in VPOP3 1.4.2 or later, but for earlier versions there is a simple workaround: 



    Go to the Local Servers tab 

    Press the Configure button on the SMTP Server line 

    Check the Disable DSN Support box 




This should solve the problem.

'POPROXY' crashes

POPROXY is a component of Norton Antivirus 2000 which is used for scanning email messages.

If you get an error message about <B>POPROXY</B> crashing this is because Norton Antivirus is
complaining about a conflict between VPOP3 and POPROXY. Both these programs install a service on
TCP/IP port 110 (the POP3 server port). If POPROXY finds that this port is already in use (by VPOP3),
it will crash!

The solutions are:

Remove the email scanning part of Norton Antivirus 2000
Change the TCP/IP port which VPOP3 uses for its POP3 service (on the <B>Local Servers</B> tab). If
you do this you will have to change all the users' email clients to point to the new port number.

Also see here and search Symantec's website for information on POPROXY.
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-ERR Password supplied for "xx" is incorrect

If you receive a 'POP3 Client Error' something like:
-ERR Password supplied for "xx" is incorrect
this means that the password on the 'In Mail' tab in VPOP3 for the indicated user is entered
incorrectly.

Check with the ISP that you have the username and password correct, and ensure that you have
entered the 
username and password using the correct case letters.

-ERR POP Timeout Errors

We have had reports of VPOP3 reporting POP3 Client Errors saying '-ERR POP Timeout'. 
The 'POP Timeout' errors are coming from the ISP and are simply being reported back to the VPOP3
administrator.

In the cases we have investigated this appears to be an ISP problem. What is happening is that
the ISP's POP3 server has a very short idle timeout, typically 60 seconds or so, and it is
NOT taking into account the time spent in the data being returned from the POP3 server to VPOP3.

For instance, let's say that there are several messages in an ISP mailbox, and that the 
first message is 2MB long, and the connection speed
is 48000 bits/second.

At 10:00 VPOP3 sends a <B>RETR 1</B> command to retrieve the first message.

The ISP sends the message back to VPOP3. Because of the size of the message, and the connection
speed, the message takes about 5½ minutes to download.

At 10:05 the message download completes, so VPOP3 sends a <B>RETR 2</B> command to
retrieve the
second message.

The ISP's POP3 server then says, 'there was more than 60 seconds between the <B>RETR 1</B>
command and the
<B>RETR 2</B> command, so the user took too long to send the second command, so I will send a 
"-ERR POP Timeout" response and throw the user off.

Obviously, in this case VPOP3 has done nothing wrong, as it has sent the second command as soon
as
it possibly could, but the ISP has ignored the time spent for the message download in its idle timeout
calculations. There is nothing that VPOP3 can do about this, and you need to contact the ISP to get
the problem fixed.

Other symptoms
As well as happening on the download of large messages, this problem can also happen when VPOP3
sends certain status commands, such as <B>LIST</B> (to obtain a list of messages and their sizes)
or <B>UIDL</B> (to obtain a list of message identifiers). It may also happen in rare cases at login
when the ISP POP3 server takes a long time to index the mailbox, so the time between VPOP3
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logging
on and sending the first data retrieval command may be longer than the idle timeout.

As well as being indicated by a '-ERR POP Timeout' error, in some cases, the ISP may just silently
close the connection, causing VPOP3 to report a 10503 error.

Further information
The POP3 standard (RFC 1939) says:

   A POP3 server MAY have an inactivity autologout timer.  Such a timer
   MUST be of at least 10 minutes' duration.  The receipt of any command
   from the client during that interval should suffice to reset the
   autologout timer.

so if an ISP has an inactivity timer of 60 seconds or so, they are actually breaking the POP3
standard.

Note that even if an ISP has a 10 minute inactivity timer, they should still take into account
the time taken for a command's results to be downloaded to the client PC over a slow connection.

-ERR Unable to copy mail spool file, quota exceeded (69)

If you receive a POP3 Client Error from VPOP3 saying something like:

The received error was: "-ERR Unable to copy mail spool file, quota exceeded (69)"
The last command sent by VPOP3 was: "PASS *******"

This error is coming from your ISP - VPOP3 is merely passing the message on to you.

The error probably means that your ISP have set a limit on the amount of disk space your account 
can use and your mailbox has reached this limit. Unfortunately the ISP's POP3 mail server needs
some
extra working space which is now not available. (This has the undesirable side-effect that you cannot
now even access your mailbox in order to delete messages...)

You need to contact your ISP to ask them to sort out the problem (either they will need to delete 
messages manually, or they will need to increase your disk space quota)

-ERR Unable to process From lines (envelopes), change recognition modes

If you receive an error email message from VPOP3 like:
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VPOP3 has encountered an error whilst retrieving messages from your ISP POP3 server (svr1 (1))

The received error was: "-ERR Unable to process From lines (envelopes), change recognition modes."

The last command sent by VPOP3 was: "PASS *******

This means that when VPOP3 logged onto the ISP's POP3 server, the ISP's mail server returned an
error 'Unable to process From lines...'.

Usually this means that the ISP's server is either configured incorrectly, or your ISP mailbox has
become corrupted somehow. You should contact your ISP and tell them about this error message -
they should be able to either correct their server configuration, repair your mailbox, or remove a
problem message from your mailbox if necessary.

<B>This is <I>NOT</I> a problem with VPOP3</B>

-ERR Unknown User

"-ERR Unknown User" is a POP3 error. There are two places you can receive it:



    If you receive it as part of a 'POP3 Client Error' email message from VPOP3, then it means that
VPOP3 was unable to log on to your ISP's mail server because the ISP POP3 server reported an error
"Unknown User". In this case, check the In Mail settings in VPOP3 as the error means that you have
specified the wrong 'User ID' (check with your ISP if you are not sure) 

    If you receive it as an error message in your email client (usually in a popup window) then it
means that the email client is trying to connect to VPOP3 using a user name which VPOP3 does not
recognise. Check that you have configured the email client correctly with the username and
password of a User in the VPOP3 User tab. 


10053 and 10503 errors with Norton Antivirus 2004

10053 and 10503 errors can happen with certain versions of Norton Antivirus 2004.


An update released in December 2004 caused Norton Antivirus to drop POP3 connections that
passed through it intermittently.


A bugfix was released by Symantec - see here for more information.


Forcing LiveUpdate to download all the latest updates seems to fix the problem for most people with
this particular problem.


 

8 of 223Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



10055 errors with VPOP3 when using a SEG AR-601 ADSL Router

Problems have been reported when using an 
AR-601 ADSL router
 from SEG Communications which can lead to VPOP3 reporting 10055 errors, especially when using 
'SMTP Direct' for sending email.

There is a firmware upgrade which can be obtained from 
SEG Communications which appears to 
resolve this issue. Unfortunately, at this time the upgrade isn't publically available from their
website, but they will supply it if requested.

10060 error downloading from Demon Internet, through a firewall/router

If you download POP3 email from Demon Internet through a firewall or router, you may get 10060
errors if the firewall/router is attempting monitor the POP3 connection to perform it's 'firewall' tasks.


This happens if you have told VPOP3 to Use Demon POP3 Extensions (on the InMail -> Configure
Routing Options window).


To resolve the problem, turn off this option and see if it fixes the problem.


The problem can happen because Demon Internet have invented their own POP3 command which
VPOP3 recognises, but which most firewalls do not recognise. When VPOP3 uses this command,
some firewalls discard the responses that Demon Internet returns, causing VPOP3 to continue
waiting for the responses until it times out.


If you turn off the option to make VPOP3 use this extra command, then the firewall will be happy.


This extra command is the *ENV command which lets VPOP3 retrieve the original SMTP envelope of
the incoming message. This command is documented here.

10060 Timeout error downloading mail from ISP when ISP uses the QPOP
2.53 mail server

A bug in the QPOP mail server V2.53 (a common POP3 mail server used by ISPs) means that in 
certain circumstances, when VPOP3 sends a 'TOP' command to the ISP POP3 server, it receives an 
invalid response which means that VPOP3 is not able to detect that the response has completed, so 
VPOP3 continues to wait until it times out.

Unfortunately there is no workaround available - you need to contact your ISP and request that
they get an update to their mail server software.
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The only possible workaround is for your ISP to delete the offending message from your mailbox
on their server, but, obviously, this may not be acceptable because this message might be
important!
More Information

The problem happens if the first line of the message body is longer than 1024 characters long. 
What <I>should</I> happen is that the ISP's POP3 server should give VPOP3 the message header,
and 
then the first line of the message body followed by a '.' on a line of its own. In fact, due to a 
buffer overrun problem on the QPOP server, the first line of the message body is truncated to 
1024 characters, and the '.' is appended to the end of this line, rather than being on a line
of its own.

The ISP should really update their server from QPOP 2.53 for lots of other reasons. There are
many known exploits with that server, and it suffers from several buffer overflow problems.

550 5.7.1 Unable to relay for....

When trying to send emails from your email client software you get an error in your email client
\"550 5.7.1 Unable to relay for .....\'


This error is happening because you have installed the Microsoft IIS SMTP Service, and your email
client is talking to that service rather than to VPOP3.


To resolve this, you need to close down the Microsoft SMTP service and restart VPOP3.



Go to Start -> Control Panel -> Administrative Tools -> Services in Windows. 

Find the Simple Mail Transfer Protocol service (sometimes called the Microsoft Simple Mail Transfer
Protocol or Microsoft SMTP Service etc)

Double-click on this service to get the settings

Press the \'Stop\' button to stop the service

Set the Startup Type to Disabled.

Find the VPOP3 Email Server service

Right-click it and choose Restart


 

Accepting Incoming SMTP through a router

If your ISP is providing you with an SMTP mail feed (incoming SMTP) and you have VPOP3 connecting
to the ISP through a router then you will probably need to modify the router configuration to allow
this.

Most routers' default configuration will only allow <I>outbound</I> connections (ie connections
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from the local network out to the Internet). If you need to accept incoming SMTP mail, then you need
to tell the router to allow <I>inbound</I> connections on port 25 for the IP address of the mail
server.

Your ISP should be able to tell you what IP address they have assigned as the address of your mail
server, and you should make sure that this is the address you use.

Because there are so many different sorts of router available and many different ways of configuring
them we cannot give the details of how this should be done. You should contact the suppliers of the
router who should be able to do this.

Note that most routers will <B>not allow</B> this behaviour (incoming SMTP) if you are using an
'address pooling NAT (Network Address Translation)' setup. They probably will allow you to have
incoming SMTP if you are not using NAT or have static NAT translations set up.

Examples for CISCO IOS 12 software
Without NAT
If the ISP have specified that your mail server should be on IP address 123.123.123.123, you would
need to have something like:

interface BRI0
  ip access-group 110 in
!
access-list 110 permit tcp any host 123.123.123.123 eq smtp

in your configuration

With NAT
If the ISP have specified that your mail server should be on IP address 123.123.123.123, and you
have assigned this an internal address of 192.168.1.1 you would need to have something like:

interface BRI0
  ip access-group 110 in
!
ip nat inside source static 192.168.1.1 123.123.123.123

access-list 110 permit tcp any host 123.123.123.123 eq smtp

in your configuration

Accessing multiple POP3 accounts with VPOP3

You can set up VPOP3 to access multiple Internet email accounts quite simply.
VPOP3 1.3.4 and earlier
Set up the details of the first email account on the <I>In Mail</I> tab.

On the <I>In Mail</I> tab, choose <B></B> from the drop-down <B>Svr:</B> list box. Then enter
the details of the second email account.

Then choose <B></B> again to enter the third email account details, and so on.
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In the <I>Home User</I> version of VPOP3 you can enter up to 5 different email accounts, on all
other versions there is no limit.
VPOP3 1.3.5 and later
Set up the details of the first email account on the <I>In Mail</I> tab.

On the <I>In Mail</I> tab, press the <B>Add In Mail Setting</B> button. Then enter the details of
the second email account, and so on.

Adding a disclaimer to the footer of outgoing messages

In VPOP3 2.2 and later


If you want to add a fixed disclaimer to the bottom of every outgoing message, you can do so in
VPOP3 by going to the Users -> Global Signature menu item.


In there you can specify a global signature in plain text and HTML for your messages. There are two
signatures you can set - the one for unauthenticated senders, and one for authenticated senders.
The one for authenticated senders can contain address book data in it to personalise the signature a
bit. The settings page contains details on how to do this.

Notes



    The signature is not added to internal messages, 

    If you only specify a plain text signature, or an HTML signature, VPOP3 will convert it to the other
form if necessary. If you specify both types of signature, VPOP3 will use the appropriate one for your
messages.

    The HTML signature has to be entered as HTML (without ,  tags etc), there is currently no rich-text
editor for signatures.

    The signature cannot contain embedded images, but it can contain links to external images -
however note that many email clients may not display images, especially external ones for security
reasons.

    The 'Previews' section of the global signature page will currently only update after you have
submitted changes to a signature.



In VPOP3 1.x


If you want to add a fixed disclaimer to the bottom of every outgoing message, you can do so in
VPOP3 by going to the Users tab and pressing the Advanced button. Then press the Edit Global
Sig/Headers button. In there you can put a plain text disclaimer or signature to be added to the
bottom of every outgoing message. 

Notes



    The signature is not added to internal messages, 

    The signature must be plain text NOT HTML or any other advanced format. This is because a lot of
mail readers cannot handle HTML messages, so the lowest common denominator is plain text. 

    If you send an HTML message, VPOP3 will automatically convert the plain text signature to HTML
before appending it to your outgoing message 




Also see: Having different VPOP3 signatures depending on the email address of the sender
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After uninstalling Epanoopy, you get a "DBISAM Engine Error"

If you uninstall Epanoopy whilst VPOP3 is still running, you may get a DBISAM Engine Error being
reported. This is because the VPOP3 Plugin part of Epanoopy could not be uninstalled, so VPOP3 is
still calling that, but the Epanoopy VPOP3 Plugin cannot contact the main Epanoopy database
system.


To prevent this problem you should either:



    Stop VPOP3 before uninstalling Epanoopy, or

    Go to Utilities -> VPOP3 Plugins in VPOP3 and press Unload All Plugins before uninstalling
Epanoopy. Then, if you have any other VPOP3 plugins, press Refresh Plugin List to re-load the other
plugins




If you have already uninstalled Epanoopy and are having the problem, then:



    Stop VPOP3

    In the VPOP3 folder on the hard disk will be a subfolder called Plugins, in that folder will be a file
spamplugin.dll, delete that file

    Restart VPOP3




 

Allowing remote access into VPOP3 mailboxes

Sometimes people want to be able to access their office VPOP3 mail server from a remote site.

With a permanent Internet connection


If you have a permanent connection to the Internet (eg leased line, xDSL etc) it is usually quite easy.
Simply set your router up to allow incoming access to the VPOP3 computer on the relevant ports (eg
110 for POP3, 143 for IMAP4, 25 for SMTP, 5108 for WebMail). The remote user then dials to the
Internet and connects to your VPOP3 server's Internet IP address. 


By default VPOP3 2.0.0 and later will refuse access to email for anyone connecting from outside the
local network, so this will need to be opened up. The easiest way to do this is to go to Services ->
POP3 (or Services ->IMAP4 or Services -> WebMail, as appropriate), and find the Access Restrictions
section.


In VPOP3 2.4.0 and later, click on the Add New Restriction text, choose Type: Any, then in the
Allowed Users box, either leave it blank to allow any user to access the VPOP3 service from the
Internet, or enter a list of VPOP3 usernames, separated by spaces, to just allow those users to
access VPOP3 from the Internet
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In earlier versions of VPOP3, add the line "0.0.0.0 0.0.0.0" to the Access Restrictions settings. (This
will allow access to anyone with a valid username and password from any IP address - if you want to
restrict it to certain users only, see this article).


Note do NOT simply allow access to anyone to your VPOP3 SMTP service, this will lead to you making
VPOP3 into an open relay. See "Allowing remote users to relay mail through VPOP3" for details on
changing the VPOP3 SMTP service restrictions.


By default VPOP3 1.5.0 and earlier will allow access to email for anyone connecting from outside the
local network, so this may need to be closed down. 

Without a permanent Internet connection


If you do not have a permanent connection to the Internet, then the user will need to dial directly
into the VPOP3 computer or another computer on the network. This only works reliably if the dial-
inserver is running Windows NT or Windows 2000. 

Dial-in server using Windows NT (Workstation or Server)


You need to install the Remote Access Server network service and configure this to allow
incoming TCP/IP connections. 


If the Remote Access Server is running on the VPOP3 computer itself, then you only need to allow
inward access to the VPOP3 computer itself, otherwise you will need to allow inward access to the
whole network. 

Dial-in server using Windows 2000 (Professional, Server, Advanced Server) or Windows XP


You need to install the dial-in server portion of Windows 2000. Do this by going to Settings -
Network and Dial-up connections - Make New Connection. Then choose \'Accept Incoming
Connections\' and set it up appropriately. 


If the Remote Access Server is running on the VPOP3 computer itself, then you only need to allow
inward access to the VPOP3 computer itself, otherwise you need to allow access to the whole
network. You set this on the Networking tab in the Internet Protocol Properties.

Allowing remote users to relay mail through VPOP3

If you are allowing remote access into VPOP3 to collect mail (see this article) then it is probable that
you might also want those remote users to be able to send their outgoing mail through VPOP3 as
well.


This is more complex than allowing users to collect mail, because, by default, SMTP connections are
not authenticated. This means that when someone tries to send a message through VPOP3, VPOP3
doesn\'t know who that user is. This can cause a problem if unauthorised users try to send mail
through VPOP3, as you will want to block those users, whilst still allowing legitimate users to send
mail.
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The default VPOP3 settings will tell VPOP3 which computer IP addresses are allowed to send
outgoing messages, so VPOP3 checks the IP address of the computer which is connected to it to
work out whether that user can send outgoing messages. However, if you want to allow remote
users to send mail, you may not know the IP addresses of the remote users' PCs.


In this case, you need to change the VPOP3 configuration to make it use the 'Authentication'
extension to the SMTP protocol so that your remote users can log on before sending mail. This works
fine as long as the remote users are using email client software which supports SMTP authentication.
(Most modern email clients do, but some older ones don't).


To do this, go to the Services -> SMTP page in the VPOP3 settings.


Click on Require SMTP Authentication and Do not require SMTP authentication for internal/incoming
mail


Make sure the SMTP Anti-Relay Protection method is set to Check Client IP Address.


You now need to modify the entries in the Access Restrictions box. If you currently have there
something like:




NOGLOBAL


192.168.1.0 255.255.255.0 noauth


0.0.0.0 0.0.0.0



This tells VPOP3 that users on the 192.168.1.0 subnet can send mail without needing to
authenticate, and users on the rest of the Internet (0.0.0.0 0.0.0.0) can send mail as long as they
authenticate first. The NOGLOBAL tells VPOP3 not to let the global access restrictions (set on the
Services page) override the SMTP service specific settings.

The 'Do not require SMTP authentication for internal/incoming mail' option tells VPOP3 to still allow
incoming SMTP messages if you use that facility.

You can optionally add VPOP3 account names to the 0.0.0.0 0.0.0.0 line if you want to restrict the
users who can send mail from the Internet, eg


Archiver error "error accessing main store directory"

If the VPOP3 archive facility is reporting "Possible error accessing main store directory" and the
archive store directory is a drive on another network computer, then there are a few possible
difficulties that you have to be aware of.



    If VPOP3 is running as a service, then it does not have access to mapped drives, all drives have to
be referred to as UNC paths, eg \\Server\share\path

    If VPOP3 is running as a service, then it could be running in a different user account from the
account of the currently logged in user. In this case, you need to make sure that the account in
which VPOP3 is running has the appropriate permissions to the shared network drive. This usually
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requires you to go to Admin Tools -> Services in Windows, edit the properties of the VPOP3 service,
and make it log in as a different user, then give that user permissions on the shared network drive.


Are there memory leaks in VPOP3

It is very unlikely that there are memory leaks in VPOP3 itself. VPOP3 has been tested using memory
validators and tools such as BoundsChecker. 


VPOP3 can seem to use up memory, especially in a LAN system, because there are a couple of bugs
in Windows 95 components which can cause memory leaks when opening and closing Sockets many
times. On a LAN VPOP3 server, it may be receiving many connections every hour meaning that it has
to open and close many Sockets. It is unlikely that you've got other software on your system which
would lead to the same effects. 


The bugs that we know of in Windows 95 components are: 



    There is an acknowledged bug in the original KERNEL32.DLL distributed with Windows 95, and not
fixed in Service Pack 1. A free fix is available from Microsoft 

    There also seems to be a bug in early versions of WSOCK32.DLL. Microsoft haven't officially
published a fix for this, however early versions of WSOCK32.DLL seem to cause large memory leaks,
and later versions (definitely those in OSR2 and probably those in MSIE 3.01) don't cause the leaks
(this was a cause of great confusion and consternation for a couple of weeks until we found the
cause of the problem). 


avast! for VPOP3 error code meanings

This article lists some error codes which avast! for VPOP3 will report:





42040 - virus database compressed incorrectly

42041 - virus database corrupt

42051 - unknown version of archive file

42052 - archive file corrupted

42053 - unknown compression of archive file

42054 - decompression of archive file failed

42056 - archive file is encrypted

42057 - archive file - contained file is too big

42058 - not enough temporary file space

42120 - ARJ file corrupted

42121 - EXEC file corrupted

42125 - ZIP file corrupted

42126 - RAR file corrupted

42127 - CAB file corrupted

42128 - TAR file corrupted

42129 - GZ file corrupted


Backing up VPOP3 Settings
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Please see the article in our Wiki at



http://kbase.pscs.co.uk/index.php?article=315

Block a specific IP address from sending mail to VPOP3 using SMTP

You can block a specific IP address or range of IP addresses from sending mail to VPOP3 using SMTP
by using SMTP Rules.


In the VPOP3 settings, go to Services -> SMTP and press Edit SMTP Rules. In the SMTP Rules, add a
couple of lines like:



1*Block mail from 123.123.123.123


IPAddress:123.123.123.123




If you want to block all 123.123.123.x addresses, use:



1*Block mail from 123.123.123.*


IPAddress:123.123.123.*



And so on.

If you want to block from two or more different IP addresses, use something like this:



1+*Block mail from 123.123.123.123 or 234.234.234.234


IPAddress:123.123.123.123


IPAddress:234.234.234.234



 

BT Internet adds an incorrectly formatted From line to the start of POP3
messages

BT Internet's mail servers are configured to add a line like

From support@pscs.co.uk Fri Jan 26 15:12:09 2001 

    to the start of every message you download from their POP3 mail servers.

    

This line does not comply with the RFC 822 standard defining how Internet messages should be
formatted (see below). 

    

A lot of email clients are forgiving and will not let this line confuse them, however when the message
has passed through other mail servers such as VPOP3, other header lines (eg a Received: trace
header line) may be added to the message header which may cause the badly formatted line from
the ISP to be treated as the first line of the message body. 
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In VPOP3 1.4.3 beta and earlier there is no workaround for this problem, but in 1.4.4 beta and later
we have added an option to make VPOP3 strip out this invalid line (In Mail -> Routing ->
Advanced -> Ignore leading "From" line added by some ISPs) 

    

Notes: 

    

        This problem may also occur in other ISP's POP3 servers, but these have not been
confirmed yet 

        We have attempted to contact BT Internet to try to resolve the issue on their servers, but they
have not responded to us, and feedback that mutual customers have had from them suggests that
they believe they are conforming to the standards but are unable to explain how. 

    

    RFC 2822

    RFC 2822 is called STANDARD FOR THE FORMAT OF ARPA INTERNET TEXT MESSAGES and
defines the basic format of Internet email messages (and Usenet messages etc).

    

The sections relevant to this topic are shown below. The full text of RFC 2822 can be viewed here. 

    2.  LEXICAL ANALYSIS OF MESSAGES

    2.1.  GENERAL DESCRIPTION

       A message consists of header fields (collectively called "the header


       of the message") followed, optionally, by a body.  The header is a


       sequence of lines of characters with special syntax as defined in


       this standard. The body is simply a sequence of characters that


       follows the header and is separated from the header by an empty line


       (i.e., a line with nothing preceding the CRLF).

      2.2.  HEADER FIELDS

       Header fields are lines composed of a field name, followed by a colon


       (":"), followed by a field body, and terminated by CRLF.  A field


       name MUST be composed of printable US-ASCII characters (i.e.,


       characters that have values between 33 and 126, inclusive), except


       colon.  A field body may be composed of any US-ASCII characters,


       except for CR and LF.  However, a field body may contain CRLF when


       used in header "folding" and  "unfolding" as described in section


       2.2.3.  All field bodies MUST conform to the syntax described in


       sections 3 and 4 of this standard.

    

Basically this means that any message header line should consist of the field name followed directly
by a colon and then the field text, so the line 


    From support@pscs.co.uk Fri Jan 26 15:12:09 2001 
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    is not valid. 

Can FAXmaker share a modem with VPOP3 and other software?

GFI Fax & Voice do not recommend that you have FAXmaker sharing a modem with any other
software.

VPOP3 cannot share a modem in your situation then you should obtain a 
second modem for FAXmaker.

You can use the same telephone line for both modems by using a 'Privacy Adapter' which you should
be able
to obtain from computer suppliers or electronics stores.

Can I change the order of VPOP3 'In Mail' methods?

There is no way to change the order of VPOP3 In Mail methods,  VPOP3 will process the In Mail
methods in numeric order when it does a mail poll.





However, there is no real reason to change the order. If VPOP3 does a poll every 10 minutes, then it
will process each In Mail method every 10 minutes, regardless of which order they are in. If the poll
takes longer than 10 minutes, it won't stop and restart the poll at the beginning, but continue to the
end, so each In Mail methods will still be processed as frequently as any others using the same
Connection method. Therefore, changing the order of the In Mail methods would be purely cosmetic.





If you want certain In Mail methods to be processed more frequently than others you can create two
(or more, depending on how many different frequencies you want) 'Connection' methods, assign the
In Mail methods to one or the other Connection method depending on whether you want the In Mail
method to be processed more frequently. Then on the External Mail -> Schedule setting page you
can create two connection schedules, one for each Connection method, with the appropriate
connection frequency.





For instance, you could create a Connection method called 'Frequent' which has a schedule defined
for every 10 minutes, and another Connection method called 'Less Frequent' which has a schedule
defined for every 30 minutes. Then, you set some In Mail methods to use the 'Frequent' connection,
and other In Mail methods to use the 'Less Frequent' method.








Keywords: priority
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Can VPOP3 be used with AOL (America Online)

VPOP3 can be used with any ISP which supports POP3 or SMTP email accounts. Unfortunately, at the
moment, AOL do <I>not</I> support this type of email account, so the only software you can use to
access your AOL email is the software you get from AOL.

Can VPOP3 get mail from a Hotmail account

VPOP3 can be used with any ISP which supports POP3 or SMTP email accounts. Unfortunately, at 
the moment, Hotmail do <I>not</I> support this type of email account, they only allow access
through a web browser.

Hotmail currently are beta testing a POP3 service (this has been in beta-test for quite a while), 
and this is only accessible using Outlook Express 5 or later. When this service comes out of 
beta test, there may be documentation available from Microsoft on how to access the Hotmail POP3 
service from other software, in which case we will endeavour to support this facility in VPOP3.

Changing email password at your ISP

If you are changing your email account password at your ISP you have to be a bit careful. In general
do NOT follow the instructions your ISP give you blindly. They will usually tell you to change it in your
settings at the ISP, then change it in Outlook/Outlook Express as well. Do NOT do that.


What they really mean is that you have to change the password in your settings at the ISP, then
change it in the software which downloads the mail from your ISP. If you are using VPOP3, then that
usually means change it at the ISP and in VPOP3 - NOT in Outlook as Outlook will not be
communicating with your ISP's mail servers at all.


So, once you have changed the password at your ISP, go to the External Mail -> In Mail settings in
VPOP3, click on the appropriate In Mail method(s) and change the account password in there. That is
ALL you need to do.


You only need to change the password in Outlook if Outlook is talking directly to the ISP (not VPOP3)
or you change the user's password in the VPOP3 Users -> Accounts settings as well - that is not
necessary for changing the password at your ISP!

Changing the From address of an autoresponder

By default, a VPOP3 autoresponder will set the 'From' address of the autoresponse message to be @,
where  is the user's account name defined in VPOP3, and  is the default domain defined in the Local
Mail section of VPOP3.
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If you need VPOP3 to use a different 'From' address, then you can specify this by adding the text




into the autoresponse text. This must be on a line of its own.


(There are other, similar, control sequences you can use to customise autoresponse messages,
please see the documentation for more information).

Changing VPOP3 Startup Options

When you install VPOP3 you can decide whether VPOP3 should run as a Service (either a Windows
NT Service or a Windows 95/98 Service), run from the Startup group, or not start automatically at all.

If you later change your mind, the <I>easiest</I> way to change the settings is actually to reinstall
VPOP3 (do <B>not</B> uninstall it first!). This will not change any other settings, and you will not
lose any users, messages or your licence details.

If you want to change the option manually, see below:

Windows NT/2000 Service
To add it as an NT service
Choose 'Install VPOP3 Service' from the VPOP3 item on the Start menu. (This option is only available
if you chose to install the NT service when you installed VPOP3 - if you didn't then you MUST reinstall
VPOP3 and choose to install this option).
To remove the VPOP3 NT service
Choose 'Remove VPOP3 Service' from the VPOP3 item on the Start menu

Windows 95/98 Service
To add it as a Windows 95/98 Service
Using Regedit, find
<B>HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\RunServices</B>

Add a new value to this key where the name is <B>VPOP3</B> and the value is the location of the
VPOP3.EXE file (eg <B>c:\program files\vpop3\vpop3.exe</B>)
To remove it as a Windows 95/98 Service
Using Regedit, find
<B>HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\RunServices</B>

Remove the value called <B>VPOP3</B>

Choosing a VPOP3 licence size to use with LAN Forwarding to another mail
server

To use VPOP3 with another mail server such as Microsoft Exchange Server, Lotus Domino Server or
any other SMTP capable email server you need to use the 'LAN Forwarding' feature in VPOP3.
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If you are using VPOP3 as a spam filter before the other mail server, then the most effective way is
to have a user in VPOP3 for each user on the other mail server, so that each user's spam gets put
into a quarantine for that user. In this case, you need a VPOP3 licence size at least as large as the
number of users on the other mail server.





If you are not using VPOP3 as a spam filter, or you are using it as a spamfilter but not using the
VPOP3 quarantine facility, then you need to use the general LAN forwarding licence rules:





With LAN Forwarding VPOP3 counts the number of email addresses that it forwards to on the other
mail server. It has no way of knowing which are USERS on the other mail server, so it has to assume
that each distinct email address is a user on that mail server. So, first you need to work out how
many email addresses you wish on the other mail server. Note that this may not be the same as the
number of users, as groups on the other mail server count as an email address.





Then, with VPOP3 Standard, you need a matching licence size, with a cap of 25 users. A 25 user
licence of VPOP3 allows unlimited LAN forwarding. 





With VPOP3 Enterprise, the cap is 10 users, so a 10 user licence gives you unlimited LAN forwarding
as well. (Note that VPOP3 Enterprise is more expensive than VPOP3 Standard, but gives you a lot of
Exchange-like features, such as shared message folders, access from anywhere and so on, but
working with almost any email client, not limited to Microsoft Outlook. If you are using Microsoft
Exchange, these may not be that useful, but it may be a suitable, cheaper, alternative to Exchange if
that is why you are considering using Exchange).





This may be clearer with some examples:


Using VPOP3 Spamfilter and quarantine:



    

        

             Number of Users


            

             VPOP3 Licence size


            

        

        

             7

             10

        

        

             42

             50
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             157

             250

        

        

             678

             Unlimited

        

    



Otherwise:



    

        

             Number of Email Addresses


            

             VPOP3 Standard Licence size


            

            VPOP3 Enterprise Licence size 


            

        

        

             3

             5

             10

        

        

             8

             10

             10

        

        

             17

             25

             10

        

        

             53

             25

             10

        

    


Command line options for the VPOP3 Status Monitor

The VPOP3 Status Monitor program (VPOP3Status.EXE) supports several command-line options
which advanced users may find useful. To use these, modify the Windows shortcut which launches
VPOP3Status.EXE to add these options at the end of the command line.



    /debug  - this makes the status monitor run in debug mode. In this mode, it writes diagnostic
information to a file called C:\VPOP3STATUS.LOG

    /s: - this makes the status monitor start up connecting to the configuration called 'servername' (in
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the VPOP3 Status Monitor configuration you can specify multiple configurations)

    /o - this makes the status monitor start up with the status window open. If this is not specified,
then it starts with the status window closed, and only the task tray icon showing

    /q - this makes the status monitor not report any connection errors it gets at startup

    /r - this makes the status monitor read its settings from the registry
(HKEY_CURRENT_USER\Software\PSCS\VPOP3Status) rather than from the VPOP3.INI file. This allows
the same shortcut to be used by several users to start VPOP3 using user-specific settings rather than
global settings




Keywords: registry vpop3status

Configuring SpamPal to work with VPOP3

The SpamPal user manual has a very good section on configuring VPOP3 and SpamPal to work
together. There is no need to repeat it here.


View the SpamPal & VPOP3 setup guide

Configuring VPOP3, SPAMPAL, Norton Antivirus and Outlook

(NB. This article has been submitted by a user - it has not been verified by Paul Smith Computer
Services) 





Configuring VPOP3, SPAMPAL, Norton Antivirus and Outlook

Making it all work together
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All trade marks and copyrights are acknowledged. My personal vote of thanks is offered to Paul
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Smith Computing Services for VPOP3; James Farmer for SpamPal; Symantec Corporation for Norton
Antivirus. I would like to thank the technical support team at PSCS and especially David James and
Paul Smith for their help, comments and patience whilst I got this all working. 

1          Introduction 


This document is an unofficial guide to getting VPOP3 working with both Norton Antivirus and
SpamPal. The aim of this is to: 


a)      Provide a POP3 distribution on one of your PC's for local mail; 


b)      Ensure all mail is checked by Norton and any virus is quarantined


c)      Remove any mail that is identified as SPAM. 


Spampal is the work of James Farmer and is obtainable free from http://www.spampal.org/. 


VPOP3 is the work of Paul Smith Computer Services and is a licensed product available from
http://www.pscs.co.uk/ 


Norton Antivirus (NAV) is the work of Symantec and is a licensed product available from
http://www.symantec.com/ 


My personal thanks to all three and their employees from this very satisfied user. I used to get over
80 spam messages per day, now I see less than 3 per day, and we have never had a virus come in
via email. 

2          Versions Used


This work was done on the following configuration, but other configurations may very well work.
Unfortunately, I am unable to test them for you! 


Operating System:                    Windows 2000 Server


VPOP3                                    V1.5.4 


Norton Antivirus:                      NAV 2001 (V7.07.23D)


SpamPal:                                  V1.50


Outlook:                                   Office 2000 Version


Why use NAV 2001? Well, NAV 2002 and 2003 don't support Windows Server. They refuse to install
on a server, so NAV 2001 Server is used. 
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3          Installation  


Follow all installation procedure for your products. Download all products and install in the following
order: 


1)      NAV - ensure you have virus protection enabled before you do anything else. Run Live
Update repeatedly until NAV informs you that you have no further updates outstanding. This may
require you to reboot several times. Make sure you set up the scheduler within NAV to look for virus
definition (that's LiveUpdate) at least three times per week. Norton normally publish updates on a
Wednesday, but they have been known to put emergency definitions out from time to time. 


2)      Outlook. This example uses Outlook, because we will configure some rules in Outlook later
on, but of course, you can use any email program you like. The principals don't change and the
majority of this document doesn't mention Outlook at all. 


3)      VPOP3 - It's a good idea to configure this to work with your ISP first off. You wont
immediately have anti virus protection, so please take care what you down load. However, it is wise
to verify that you do have connection to your ISP, that you have the users set up correctly, and that
this part works as expected. 


4)      SpamPal - this will complain about the POP port 110 being in use. You may safely ignore
this warning for now. We will configure SpamPal in the next stage. 

4          Configuring the programs 


At this stage you should have VPOP3 downloading and sending mail to and from your ISP. It's a good
idea to check you can send and receive. Perhaps your ISP has a webmail interface you can use to
send yourself mail, or you have a friend you can send a test message to. Make sure that Outlook (or
an email program of your choice) can send and receive mail via VPOP3. This is just to ensure that
you have all the connectivity sorted out. It eliminates this from problems later on. 


The aim is to now configure all three programs (VPOP3, NAV, SpamPal) so that VPOP3 reads
messages from SpamPal, which in turn validates them via NAV. To do this, we need to change a few
port addresses, as all three think they are reading POP mail on port 110. 



4.1      Configure NAV 


First enable external email virus filtering. This is done by opening Norton Antivirus and selecting
Options. Then navigate to the Email Protection section of the Internet block. 


<img height="426" alt="" src="http://kbase.pscs.co.uk/admin/images/navspampal01.jpg"
width="542" border="0" v:shapes="\"_x0000_i1025\""/>


Change the Action to read ?Quarantine the attachment?. Because this will work in the background,
you do not want ?Ask me what to do?. 


Next, open up Advanced. Make sure that ?Enable Manual configuration? is check. 


<img height="426" alt="" src="http://kbase.pscs.co.uk/admin/images/navspampal02.jpg"
width="542" border="0" v:shapes="\"_x0000_i1026\""/>
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Press OK until you come out of Options, and then close Norton Antivirus. 


Now change the POP3 port for NAV. These instructions are exactly the same as those listed in the
PSCS Knowledge Base. This requires the use of the Registry Editor. This is a potentially dangerous
exercise, and should be done only by competent users. To start RegEdit, use the Start Button, then
select ?Run?? and enter RegEdit as the command. The Registry Editor will open. 


Navigate to: 


         HKEY_LOCAL_MACHINE 


                  SOFTWARE


                           Symantec


                                    Norton Antivirus


                                             eMail Protection


Select the key called ?Default Port?. It will be a Hex number 0x0000006E (Decimal 110). Double click
the key to open it and change the value to 456 (Hex) or 1110 (Decimal). 


Press IK to save the change, and exit RegEdit. Ensure that you are changing the right key. Do not
change the value of ?Defaults? in the Ports folder under the eMail Protection key. 


This change will require you to reboot the computer to make it active. 

4.2      Configure SpamPal


SpamPal will have already warned you when it was installed that it could not gain control of the
default POP port. This is OK, and we will no set it to have a specific port. 


Open the SpamPal Options utility by clicking on the SpamPal icon on the task bar <img height="20"
alt="" src="\"http://kbase.pscs.co.uk/admin/images/navspampal04.jpg\"" width="17" border="0"
v:shapes="\"_x0000_i1027\""/> and select ?Options?. Navigate to the Connection node. 


<img height="407" alt="" src="http://kbase.pscs.co.uk/admin/images/navspampal06.jpg"
width="554" border="0" v:shapes="\"_x0000_i1028\""/>


Select the POP3 port and press Properties: 


<img height="430" alt="" src="http://kbase.pscs.co.uk/admin/images/navspampal08.jpg"
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width="522" border="0" v:shapes="\"_x0000_i1029\""/>


Set the local port number to be 1101. It may have already defaulted this. Press OK to close this
dialog, and OK again to close the Options dialog. 


Please ensure that you have set the NAV and SpamPal ports to be: 


            NAV                1110


            SpamPal           1101 


Strictly speaking, they can be other values. But these work just fine. They must be different and
unused. 



4.3      Configure VPOP3 


Open up the VPOP3 Settings window and select the InMail tab. This is where the complex part
happens. At this stage, the settings will be: 


            Address:           Your ISP?s POP3 server address 


            Username:        Your login name to the ISP


            Password:        Your password for the login name


            Port:                 110 


We will change all but the password. In the example below, I have hidden things like my username
and password. Make a note of these ? we will need them and if anything goes wrong, its good to be
able to change it back! You can see that I have an account called Eclipse which is where I have my
domain and mail registered. 


First, change the PORT to 1110. This is the port we specified for NAV. VPOP3 will ask NAV for the
mail. 


The address we will change to ?pop3.norton.antivirus?, this being the default name for the NAV
interface. It maps to IP address 127.0.0.1, which is the local IP address of your server. 


<img height="393" alt="" src="http://kbase.pscs.co.uk/admin/images/navspampal09.jpg"
width="567" border="0" v:shapes="\"_x0000_i1030\""/>


Finally, we change the User ID. This is the complex part. It?s worth doing this in Notepad (or some
other editor) and copying it in, because the field on the VPOP3 dialog box is a little small to see what

28 of 223Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



is going on. 


This will become: 


            USERNAME@ADDRESS/localhost:1101


where  

USERNAME            is what was in this box originally, the user name you use to connect to your
ISP.


ADDRESS                is the original contents of the address field; that is the address of the
POP3 mail server at your ISP.  


localhost                    is just like the earlier address we entered for the NAV address. In
fact, ?localhost? and ?pop3.norton.antivirus? are synonymous, they both point to the IP address
127.0.0.1, which is your local machine. 


1101                                                  is the port name we assigned for
SpamPal. 


Do not worry if this string is long, or if it contains multiple ?@? symbols. This is OK, and will be
handled correctly. A typical string might read:


            mypostmaster@mydomain.co.uk@mail.myisp.co.uk/localhost:1101


where: 

USERNAME            = mypostmaster@mydomain.co.uk


ADDRESS                = mail@myisp.co.uk  


I know it?s surprising, but in fact all three programs seem to cooperate very well in this
configuration! 


<img height="930" alt="" src="http://kbase.pscs.co.uk/admin/images/navspampal11.gif"
width="511" border="0" v:shapes="\"_x0000_i1031\""/>

5          Tagging SPAM in SpamPal 


Having got this far, you will now want to tell SpamPal how to recognise SPAM and what to do with it.
There are many documents on the web that tell you exactly what the various SpamPal configuration
settings do, and this document will not attempt to replace these. What this will do is tell you some of
the ways in which you can get SpamPal to tag mail as spam, and VPOP3 / Outlook to do something
about it! 


I use a combination of SpamPal settings: 
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Whitelists:                        I enter the IP address of all newsletters and e-magazines
that I want to receive in the white list. This prevents later processing by SpamPal flagging things like
the W2K news letters as spam. My entries include things like: 


do_not_reply@w2knews.com


symantec_bulletins@symantec.com

Public Blacklists:              You should choose which of the DNS Block Lists you wish to use.
Some are a lot more aggressive that others, which leads to some mail that is valid being tagged as
SPAM. Which you use are entirely up to you. 







Countries:                        Again, if you don?t want to receive mail from certain
countries that are less than diligent about preventing SPAM, then flag those you wish to exclude. 

You need to tell SpamPal how to tag mail that it identifies as SPAM. These tags are what VPOP3 will
use to identify the spam and deal with it. My selected configuration is as follows: 

<img height="277" src="http://kbase.pscs.co.uk/admin/images/navspampal12.jpg" width="398"
border="0" v:shapes="\"_x0000_i1032\"" alt=""/>

Experienced SpamPal users might notice that I changed the subject line for Spam tagging. That was
so it could fit in with my VPOP3 download rules. More on this later. 

6          VPOP3 Download Rules


In order to reject message that are marked as spam in VPOP3, you must enable the download rules.
This is done by first checking the  checkbox ?Use Download Rules?:


<img height="384" src="http://kbase.pscs.co.uk/admin/images/navspampal09.jpg" width="553"
border="0" v:shapes="\"_x0000_i1033\"" alt=""/> 


Then, edit the DL Rules file. Exactly what you put in this file is up to you. There are two basic
choices: 


1)      Do you want to redirect any Spam messages to a special mailbox? You might do this until
you are certain that the messages you are getting do not include any false positives (valid mail
being tagged as spam). 








2)      Do you simply wish to delete the message and have done with it. 


VPOP3 allows you to do either, by adding the following codes: 


1)      Redirecting Spam Mail


These codes redirect all Spam to a user call SPAMBOX, and delete them from the mail server. I do
this because I use a webmail program to access my mail when I am away from my home or office.
Deleting spam mail reduces the list I have to process over a web front end. I can always get the
original message when I return to base, because it will be in the SPAMBOX user. 
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+>SPAMBOX?spampal Headers


X-SpamPal: SPAM


+>SPAMBOX?Subject 


Subject: 


2)      Deleting Spam Mail 


These codes silently delete all Spam:


+@spampal Headers


X-SpamPal: SPAM


+@spampal Subject 


Subject: 


In both cases, note that I first look for the header, X-SpamPal and then check the subject line. This is
really belt-and-braces stuff, as the second rule will very rarely fire.



7          Using RegExFilter 

There is also a supplied content filter called RegExFilter that is available with SpamPal. This is loaded
as a SpamPal add-in.

RegExFilter uses a set of rules that scan the incoming message. If a certain text, or pattern, fires a
rule in RegExFilter, it will increment a Spam score by an amount. If this score exceeds a certain
value that extra headers are added to the message. These extra headers are of the form X-RegEx:
There can be many, as each rule that is triggered will add some text. This helps you track and tune
the rules to your requirements. This tuning process is beyond the scope of this document. More
details can be found at http://www.slabihoud.de/spampal

One typical spam message might have the following added: 

X-RegEx: [235.4] BASE64_ENC_TEXT_B Message text disguised using base-64 encoding

X-RegEx: [21.8] HTML_FONT_BIG FONT Size +2 and up or 3 and up              

X-RegEx: [0.0] WEIRD_PORT Uses non-standard port number for HTTP           


Creating fax cover pages for the VPOP3 FaxServer

This information only applies to the fax server software in VPOP3 2.0.3 beta and later


The VPOP3 FaxServer uses .VCP files to define cover pages. Currently these can only be created

31 of 223Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



manually, which is a relatively simple task if you have a graphics program which can create TIFF files
(most can) and a text editor (eg Notepad).


First of all, create a monochrome TIFF file containing the cover page details (logos, text etc). This
should be a suitable size to cover a whole page. A suitable size would be 2376 x 1728 pixels.


Then, using your graphics program note down the bounding coordinates for the locations where you
want the VPOP3 FaxServer to put information such as the sender's name, subject, comments etc.


 


Create a new file in Notepad, and, using the following example as a template, define where the field
locations are

file cover1.tiff


font arial 14 BI


recipientname 658 418 1474 458


recipientcompany 658 468 1474 508


recipientfax 658 558 1474 608


sendername 658 640 1474 690


sendercompany 658 700 1474 750


senderphone 658 770 1474 820


senderfax 658 820 1474 880


date 658 920 1474 970


pages 658 1020 1474 1070


subject 244 1078 1474 1128


comment 224 1138 1474 2052


date 658 980 1474 1030

pages 658 1080 1474 1130

comment 224 1138 1474 2052 arial 12





    The line 'file' defines the TIFF background (this is optional) 

    The line 'font' defines the default font - this can be overridden on each line (eg in the comment
line in the above example) 

    On the other lines, the coordinates are left top right bottom in pixel coordinates from the top left
of the page 

    The font definitions are font name, font size (in points), and then some optional modifiers:

    

        B - Bold 

        I - Italic 

        U - Underlined 
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        S - StrikeThrough 

        C - Centered 

        E - Truncate text that is too long and end it with '...' 

        R - Right justified 

        L - Limit to a single line 

    

    



On the cover page definition box in the VPOP3 FaxServer settings, you can optionally enter two VCP
files separated by a ; (semicolon). The second will be used if the fax comments overflow past the
cover page comments box. If a second VCP file is not specified, then the VPOP3 FaxServer will
automatically use the BLANK.VCP file.

Daily Summary is not reporting all Sent messages

For VPOP3 to log outbound messages it needs to be able to work out that the message is FROM: a
user whose mail is handled by the local VPOP3. To do this it has to examine the FROM: address in
the message header.

If the message is FROM: fred@domain.com, VPOP3 will look to see if fred@domain.com is a local
user or not.

This means that first of all, VPOP3 will check that 'domain.com' is listed in the 'Local Domains' box
on the 'Local Mail' tab, and secondly, that 'fred' is listed in the VPOP3 user list.

Defining Access Restrictions in VPOP3

You can restrict access to VPOP3\'s internal servers by going to the Services page in the VPOP3
settings and clicking on the links for the various servers(Local Servers tab and pressing the
<B>Configure</B> buttons on the various server lines in VPOP3 1.5.0 and earlier) and editing the
values in the <B>Access Restrictions</B> box.

Format of Access Restrictions values



Any line beginning with \'#\' is ignored.

Each line defines a range of IP addresses which can are either allowed or prohibited.

If a line begins with a \'!\' then the following range of addresses will be prohibited, otherwise they
are allowed.

Each line contains either a single IP address or a range of IP addresses defined using:
<B>Network address</B> <B>Subnet Mask</B>


For instance, a line:    !192.168.17.0		255.255.255.0means that all addresses from 192.168.17.0 to
192.168.17.255 are prohibited



The access restrictions list is processed until either a matching address is found, or the end of the
list is reached. 

Unless otherwise defined, all IP addresses are allowed. To prohibit any addresses which aren\'t
otherwise mentioned, set the last line of the file to: !0.0.0.0 0.0.0.0


With the Web Mail server, POP3 server, and SMTP server, you can also put a list of usernames after
the subnet mask part of the line. For instance, the line  192.168.1.0	255.255.255.0	fred bob
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sarahmeans that only Fred, Bob and Sarah can access VPOP3 from the address range 192.168.1.0 to
192.168.1.255


With the SMTP server, putting NOAUTH after the subnet mask part of the line tells VPOP3 that from
the listed addresses, no authentication is needed. So, for instance  192.168.1.0	255.255.255.0
noauth  0.0.0.0	0.0.0.0means that computers in the range 192.168.1.0 to 192.168.1.255 can send
messages without needing to authenticate first, but addresses outside that range can still send
messages, but only if they use whatever authentication methods have been specified on the SMTP
Server Configuration window.

Delete Temporary Files button doesn't work

On the VPOP3 <B>Diagnostics</B> tab there is an option to <B>Keep Temporary Files</B>. This
option 
tells VPOP3 to rename files to D*.DAT instead of deleting them - this option is intended for
diagnostics purposes.

If you turn this option on, obviously the VPOP3 hard disk will fill up with old files which
are usually not needed. By pressing the <B>Delete Temporary Files</B> button on the VPOP3 
<B>Diagnostics</B> tab, you should be able to tell VPOP3 to delete all these old files. VPOP3
1.4.5 Beta also has an option to automatically delete these files that are over a certain age.

In some cases this button and automatic option do not work. This is usually because a file 
<B>VPOP3INST.DAT</B> is missing from the VPOP3 directory on the hard disk, or subdirectories.

The VPOP3INST.DAT file tells VPOP3 (and the VPOP3 uninstaller) that a certain directory was
created by VPOP3, so it can automatically process/delete files within that directory. When you
press the <B>Delete Temporary Files</B> button VPOP3 checks for this file so it will not delete
files in subdirectories of the VPOP3 directory that you have created manually.
Solution
Ensure that there is a VPOP3INST.DAT file in the VPOP3 directory, and all VPOP3 subdirectories. 
If possible copy an existing VPOP3INST.DAT file into these locations, otherwise create an empty
file with this filename and save it in these locations. (The contents of the file do not matter,
VPOP3 just checks for the existence or otherwise of the file).

Deleting incoming POP3 messages to unknown users

Some people want VPOP3 to discard incoming POP3 messages which are to unrecognised users,
rather than the normal options of sending them to a specified user, or generating a bounce
message.


We do not recommend this, because, although this method does discard a lot of spam, it also
discards legitimate messages which were mistakenly misaddressed, and the sender won't receive an
error message to say their message wasn't received - their message will just vanish without trace.


However, if you still want to do this, go to the Mappings page in the VPOP3 settings, and add a new
mapping, with the email address set to ~@your.domain.com, and the target mailbox set to No-one.
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The ~@ style of address means 'unrecognised address at', and 'No-one' is a built-in list with no
members, so redirecting messages to that address makes them disappear.


(NB - we won't be held responsible if you do this and subsequently lose important emails which the
sender addressed incorrectly, or for any subsequent loss, such as lost sales, or legal action).


 


Keywords: delete discard unrecognised unknown invalid

Demon POP3 Extensions

VPOP3 has a facility to use the POP3 Extensions (<B>*ENV</B>) defined by Demon Internet. This
can 
be enabled by going to the VPOP3 <B>In Mail</B> tab, pressing <B>Routing</B> and enabling
the <B>Demon POP3 Extensions</B> option.

This option should normally be used if you are downloading mail from a Demon Internet account,
EXCEPT in the following case:

If you have a registered domain with a company OTHER THAN Demon Internet, and that company
are forwarding all your mail onto a specific email address on your Demon account 
(eg '<I>info@company.demon.co.uk</I>'), then the *ENV command will tell VPOP3 that all your mail
is addressed to the user <I>info</I>, regardless of who the original message was sent to. This is
because the *ENV command only knows the recipient of the message when Demon received it, not
when
the message was originally sent.

If the registered domain is with Demon Internet, then they usually handle it so that the 
recipient is kept, so the *ENV command works correctly. Some other ISPs also will be able to set
up their email forwarding so that mail sent to @domain.com can be forwarded
to @company.demon.co.uk, and will keep the original recipient name so that the *ENV 
command can be used successfully.

Details for SMS messaging to TELSTRA in Australia

To send messages using VPOP3_SMS to a TELSTRA mobile phone you should use the <B>TAP</B>
service with the server phone number of 018 018767 (+61 18 019767 from outside Australia)

The VPOP3 Plugins help has further details of how to use this information

(Information kindly submitted by Rod Webster)
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Discarding incoming mail to unrecognised users

Sometimes people want VPOP3 to discard all incoming mail for unrecognised users, rather than
bouncing it back to the sender, or sending it to another user.


This is not something we recommend, as it will mean that any legitimately mis-addressed email will
be discarded with neither you nor the sender knowing what has happened to it, so the sender may
think that you are ignoring them, rather than that you never got the message.


However, if you do want to do this, then go to the Mappings page in the VPOP3 settings, add a new
mapping with the Address set to ~@ and the Target Mailbox set to No-one.


The ~@domain address will act on any unrecognised email address at the specified domain, and the
target of No-one will make that mail be discarded.

Does VPOP3 have a 'Global Address Book'?

VPOP3 contains an LDAP (<B>L</B>ightweight <B>D</B>irectory <B>A</B>ccess
<B>P</B>rotocol)
server. This allows you to share email addresses and contact information around your network 
as long as the email client you are using supports LDAP.

Most <B>modern</B> email clients support LDAP in one form or another, for instance, Outlook 97 
does NOT support LDAP, but Outlook 98/2000/Express do.

A lot of email clients call the LDAP service a <B>Directory Service</B> so look for that in the 
email client documentation.

Note that the 'Directory Service' usually acts different from a normal email client specific 
address book in that you have to search for addresses, you cannot simply list all the addresses.
This is just down to the way that the LDAP system is designed (it is intended to work with databases
that can contain millions of addresses that can be accessed over slow network connections). Email 
client address books are normally meant to work with local databases of hundreds of addresses
over very fast connections.

Does VPOP3 have \'Out of Office Agents\'?

VPOP3 has autoresponders which can act as 'Out of office agents' or do a lot more.


Users can set the autoresponder on their account by logging into their WebMail pages, and going to
'Mailbox Settings'
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Administrators can set the autoresponder on any account by going to Users -> Accounts in the
VPOP3 settings, selecting the appropriate user, and going to the 'Autoresponder' tab.


For an 'Out of Office' reply, we recommend having the Keep Incoming message in mailbox after
responding and Only respond once to each sender options checked. (You may want to have VPOP3
Automatically clear log of responded to senders every day so that each sender will get a response
once per day). For more advanced uses of autoresponders you may want different options here.


Note that the Only respond once to each sender option is highly recommended, otherwise you can
end up with two autoresponders sending messages to each other non-stop, and you will return from
your break to find millions of autoresponder messages filling up your mailbox.


For more information on autoresponders, see the Autoresponder section in the VPOP3 help


 


Keywords: autoresponder out of office reply agent automatic responder

Does VPOP3 support ADSL/DSL connections

VPOP3 and VPOP3 Enterprise both support ADSL and DSL connections.

ADSL and DSL connections are usually made through either a "network"
 card plugged into the PC, or an external box which is plugged into a network hub (or connected to
a standalone PC using a "swapover" cable).

To use these ADSL/DSL connections from VPOP3, simply tell VPOP3 to 'Connect Using LAN' on the 
<B>Connections</B> tab and set up the Windows networking settings to use the ADSL/DSL
connection as
instructed by your service provider.

Does VPOP3 support Cable Modem connections

VPOP3 and VPOP3 Enterprise both support Cable Modem connections.

Cable Modem connections are usually made through either a "network"
 card plugged into the PC, or an external box which is plugged into a network hub (or connected to
a standalone PC using a "swapover" cable).

To use these Cable Modem connections from VPOP3, simply tell VPOP3 to 'Connect Using LAN' on
the 
<B>Connections</B> tab and set up the Windows networking settings to use the Cable Modem
connection as
instructed by your service provider.
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Does VPOP3 support Multilink PPP connections

"Multilink PPP" is a facility of Windows NT and Windows 2000 which allows it to use several
dial-up connections together to get a faster link to the Internet than normal (the ISP must support
this facility as well). Note that multilink connections typically cost more than normal connections
as you have more than one telephone call in operation at once.

VPOP3 1.4.0 and later support Multilink PPP connections when running under Windows NT or
Windows
2000.
Multilink PPP in VPOP3 1.4.0x
In these versions of VPOP3 the Multilink capability is there, but it is not made public because
it was still unverified when VPOP3 1.4.0 was released (it has since been confirmed to work properly).

To enable the option follow the following steps:

  Close VPOP3
  Using RegEdit, find <B>HKEY_LOCAL_MACHINE\SOFTWARE\PaulSmith\VPOP3\Secret</B>
  Set the DWORD value <B>DoMultilinkRAS</B> to a 1 (one)
  Restart VPOP3

This will enable the multilink feature for all dial-up connections from VPOP3. (To enable it on
selected connections you will need to upgrade to VPOP3 1.4.1 beta or later)

Multilink PPP in VPOP3 1.4.1 beta and later
Go to the <B>Connection</B> tab. In the <B>RAS Details</B> section is a checkbox called 
<B>Use Multilink RAS</B>. This box is enabled when running in Windows NT or Windows 2000. Just
check
that checkbox to use a Multilink connection. You can set this option differently for different 
connection methods.

Does VPOP3 support SPF (Sender Policy Framework)

SPF lets a program receiving a message using SMTP determine whether or not the computer which
sent the message to the receiving program was authorised to send a message from that sender. It is
used to help prevent email sender address forging. In itself it is not an 'anti-spam' system, as
spammers can send messages which pass SPF checks by using their own email address to send the
spam messages, however, it does give you a degree of confidence that the sender of the message
has not been forged.


VPOP3 does not currently support SPF natively (as of VPOP3 2.2.7), but VPOP3 2.1.0 and later
supports the Lua Scripting language, and we have an example script which performs SPF checking
on our website forums, here


 

Does VPOP3 support SSL connections?
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VPOP3 Enterprise 2.2.0 and later support server-side SSL support to the WebMail/WebAdmin, POP3,
SMTP and IMAP4 services.


Earlier versions of VPOP3, and all versions of VPOP3 Standard do not support SSL (Secure Sockets
Layer) connections.


Also, see here for details on setting up a third party tool to 'convert' VPOP3 connections into SSL
ones.


Keywords: ssl

Does VPOP3 support UUCP

UUCP is an old protocol which was used for transferring mail from an ISP to a mail gateway(UUCP
means 'Unix - Unix CoPy').

Because UUCP is largely obsolete and has been replaced by POP3 and SMTP protocols for
transferring mail, VPOP3 does not support UUCP, and we currently have no plans to make it support
UUCP.

Most ISPs which support UUCP also support the more widely acceptable POP3 and/or SMTP protocols
as well, so it is worth asking your ISP if you can transfer the account to the newer protocol.

Does VPOP3 work on Windows ME

VPOP3 works on Windows Millennium Edition (Windows ME) with no problems.

Does VPOP3 work on WIndows XP

Yes, VPOP3 works with Windows XP.

The Windows XP "Upgrade Advisor" may warn about VPOP3, but that is because
the Upgrade Advisor merely has a list of programs which it knows about which work on
Windows XP, and anything which is not on that list will generate a warning. It is by no
means an exhaustive list.

Does VPOP3 work with Sophos PureMessage

VPOP3 will not work directly with Sophos PureMessage.


PureMessage will only work directly with the Microsoft SMTP server, or with Microsoft Exchange
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Server.


If you want to use PureMessage with VPOP3, you need to set up an installation of Microsoft SMTP
Server (preferably on a different computer). Then, you need to set your incoming SMTP mail feed to
deliver your incoming mail to this Microsoft SMTP Server, and configure the Microsoft SMTP Server to
forward all your messages on to the VPOP3 server.


(Note that PureMessage only works with an incoming SMTP mail feed - it will not work if you collect
your mail from an ISP's POP3 mail account)


The details of configuring PureMessage with the Microsoft SMTP Server is not something we are able
to help with, you should contact Sophos technical support for help with this. There is no special
configuration needed for VPOP3, in this instance it is just an SMTP server that the Microsoft SMTP
server needs to be configured to deliver the mail to.


Note that VPOP3 2.2 and later come with their own spam filter software, and VPOP3 also works well
with SpamPal. All these methods work with incoming SMTP or POP3, and are much simpler to
configure. Also, if you have an incoming SMTP mail feed you may wish to investigate the Red Condor
spam filtering service which has almost zero maintenance and also works well with VPOP3.


For virus scanning of incoming messages, you can use Sophos 'SAV Interface', avast! for VPOP3 or
MailScan for VPOP3 - see the pricelist for pricing details.


Keywords: PureMessage Pure Message

Downgrading from VPOP3 Enterprise to VPOP3 Standard

To downgrade from VPOP3 Enterprise to VPOP3 Standard (for instance, after evaluating VPOP3
Enterprise) simply install VPOP3 Standard over the top of your VPOP3 Enterprise installation


Do NOT uninstall VPOP3 Enterprise first


All your settings, users, messages etc will be retained in the downgrade


Once you have installed VPOP3 Standard you will need to go to the Info page in the settings to enter
the VPOP3 Standard licence key

Download Rules don't work

There are several reasons why VPOP3's Download Rules may not work:

 Download Rules only act on messages downloaded by VPOP3 using the POP3 protocol. (For incoming
SMTP messages, look at <I>SMTP Rules</I> instead)
 In versions of VPOP3 earlier than 1.4.1, you <B>MUST</B> enable the 
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<B>Leave messages on server</B> option to enable download rules
 When you save the DLRULES.DAT file make sure that it is really called <B>DLRULES.DAT</B>. 
Notepad will often add a <B>.TXT</B> onto the end of the filename, so you may be saving it 
as <B>DLRULES.DAT.TXT</B>. The fact that Windows Explorer hides extensions like .TXT by default 
makes this hard to see sometimes.

Duplicate Messages

If you get duplicate messages when VPOP3 downloads mail from the ISP there are several common
reasons for this

Multiple POP3 mailboxes on the ISP

If your ISP gives you one POP3 mailbox for each VPOP3 user, then you have to tell VPOP3 which user
each mailbox is associated with. If you don't do this, then when a message is sent to two VPOP3
users, each user will receive two copies of that message.


To link each ISP mailbox with a VPOP3 user, go to the VPOP3 External Mail -> In Mail page. Then, for
each In Mail setting you have, in the 'Extended Email Routing Options' section, choose Send all
messages to a specified user/list: .... and select the VPOP3 user who this POP3 mailbox is for. 

Download Errors

If VPOP3 gets disconnected when downloading mail from the ISP and you do NOT have Leave
Messages on Server for X days enabled on the In Mail tab in VPOP3, thenthe next time VPOP3
connects it will download all the messages again.


This is because, although VPOP3 has asked the ISP to delete the message from the ISP POP3 mailbox
the POP3 standard says that if a connection error occurs, the ISP must automatically undelete all
messages which were deleted during that session. 


The solution is to tell VPOP3 to Leave Messages On Server for at least one day. 

Multiple Identical In Mail Settings

Check that you do not have multiple identical In Mail settings defined in VPOP3. If you do,then
Remove all but one of them.

Other causes

If none of these common causes matches your problem, then you need to send a copy of a set of
duplicated messages (eg if you receive two copies of a message, send both copies) to
support@pscs.co.uk with any other information you have (eg which messages are duplicated etc).
We must see the FULL message headers, not just the abbreviated headers which many email clients
show by default.

Dynamic IP Address

VPOP3 needs to run on a computer with a static (fixed) IP address on the local network. 
This does <I>not</I> mean that it will not work with ISPs that dynamically assign IP addresses!

A computer which has both a LAN adapter AND a dial-up adapter will have two IP addresses:
one for the LAN adapter, and one for the dial-up adapter.

The dial-up adapter will have a dynamically assigned IP address, and the LAN adapter will
have a static IP address assigned by you.
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See the VPOP3 help section entitled <B>Preparing your TCP/IP LAN</B> for details on how to
assign IP addresses to the computers on your network.

EICAR.COM test virus

When testing virus scanning with VPOP3 or the VPOP3 Plugins Pack, a useful thing to have is the
EICAR.COM test virus.

EICAR.COM is not a real virus , however most virus scanners are programmed to be able to 
detect it and act as if it was a real virus. This allows you to test virus checking systems without
needing to use a real (and dangerous) virus.

To make EICAR.COM, make a text file called EICAR.COM and put the following 68 characters at the
start of the file

<B>X5O!P%@AP[4\PZX54(P^)7CC)7}$EICAR-STANDARD-ANTIVIRUS-TEST-FILE!$H+H*</B>

Note that the third character is an upper case letter 'Oh' and not a 'zero'.

When you run this program from a DOS prompt, 
it should display "EICAR-STANDARD-ANTIVIRUS-TEST-FILE!"

<B>Note that if you are running a virus checking when you make this file, the virus scanner may
prevent you saving the file, or may delete it immediately after saving, so you should turn off the
virus scanner first!</B>

If you want confirmation about the EICAR test virus (in case you think it is a real virus), look
here or check with the web site of your
own virus scanner software.

Email Client Software dials the Internet before collecting mail from VPOP3

This is a limitation of Windows 95/98. These operating systems cannot tell the difference between a
local TCP/IP connection and
an Internet TCP/IP connection, so as soon as any software (eg your email software) tries to make a
TCP/IP connection to a
local server (eg VPOP3) it will cause Windows to try to dial the Internet.

You should disable autodialing, by going to <B>Control Panel</B> -> <B>Internet</B> ->
<B>Connection</B> and
choose <B>Connect to the Internet using a LAN</B>.
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This has a side-effect of stopping Windows dialing the ISP when you start your web browser.
Unfortunately you have to decide
which is more annoying: having the unwanted dialing or having to dial manually before using your
web browser.

(One way of making it less annoying to dial manually is to create a shortcut for the Dial-Up
Networking entry on the Windows
desktop so that you can just click that to dial the Internet).

Error 10038

There are two main situations where we have seen VPOP3 or the VPOP3 Status Monitor report error
10038.


If the error is coming from the VPOP3 Status Monitor when you try to connect it to the VPOP3 server,
the problem is probably that the VPOP3 IP address configured in the status monitor is incorrect.


Right-click the VPOP3 Status Monitor icon in the task tray, and choose 'Configure Status Monitor...'.
Then, check the value of the 'VPOP3 Server Address' in the settings to make sure it is correct. The
VPOP3 installer will usually set it correctly, but then if the IP address changes (e.g. because you
change your Internet router) then it will need reconfiguring manually.


The other main reason for error 10038 is if you have some Internet security software which is
blocking VPOP3's access to the Internet, or the VPOP3 Status Monitor's access to VPOP3. If you have
any Internet security software, please ensure that it is configured to allow VPOP3 to access the
Internet (on ports 25 and 110) and to allow the VPOP3 Status Monitor to access the VPOP3 computer
(on port 5109).


 

Error 10053 or 10061 with McAfee VirusScan 8

Error 10053 can be caused by McAfee VirusScan Enterprise 8 when sending outgoing email from
VPOP3.


By default McAfee VirusScan 8 blocks all outgoing messages sent by any program that it does not
recognise. This is intended to stop email worms from sending out messages, but it also stops VPOP3
from sending messages.


To solve this problem you need to tell McAfee that VPOP3 is a \'trusted\' program for sending emails.
To do this:



    Right-click the McAfee \'shield\' in the task tray 
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    Choose VirusScan Console 

    Then, double-click on Access Protection


    <img alt="" src="http://kbase.pscs.co.uk/admin/images/mcafee8e_1.gif"/> 

    Go to the Port Blocking tab


    <img alt="" src="http://kbase.pscs.co.uk/admin/images/mcafee8e_2.gif"/> 

    In the Ports to Block section, select Prevent mass mailing worms from sending email and press
Edit 

    In the Excluded Processes box, add VPOP3.EXE


    <img alt="" src="http://kbase.pscs.co.uk/admin/images/mcafee8e_3.gif"/> 
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Error 10503 with BT Internet connections

We have received a lot of reports of VPOP3 reporting error 10503 with users of BT Internet's
POP3 mail servers.

Our tests have confirmed that this <B>is</B> a problem with BT Internet's mail servers, which
appears to be related to server load (it generally happens more during the day than during the
night). 
We have run tests against about 15 different ISPs using software written specifically for this 
purpose and have found that 10503 errors only happen on BT Internet out of the tested ISPs 
(most of the other ISPs get occasional timeout errors etc as would be expected). We have also seen 
the problem occur with other commercially available email software trying to collect mail 
from BT Internet.

We have tried to contact BT Internet to alert them to this problem but unfortunately they have 
not responded to us.

The problem does seem to be intermittent, so mail will be collected eventually, but you may
need to retry once or twice before a successful mail collection can be achieved.

Error message - "Failure opening message file POPIN.TMP"

The POPIN.TMP file is where VPOP3 stores a message as it is downloading it from a remote POP3
mail server before it puts the message into a local user's mailbox.

We know of two reasons why you would get the above error message:

 If the VPOP3 hard disk is full, VPOP3 will not be able to write the file to the disk. This is usually
prevented by the disk space checking in VPOP3 but it is possible to disable that checking, so this
problem may occur in that situation.
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 If you have an on-access virus scanner on the VPOP3 computer, the scanner may detect a virus in
the POPIN.TMP file if a virus is included in a downloaded mail message (this <B>usually</B> only
happens with VBScript viruses/worms included in messages themselves, not with viruses in
attachments). The virus scanner may then either prevent VPOP3 from opening the file, or
rename/move/delete the file according to its configuration. VPOP3 will then (understandably) report
that it had a problem opening the file. The way around this is, if possible, exclude the POPIN.TMP file
from the on-access virus scanner so that the scanner will leave the message file as it is.

Error printing downloadable Manual

When you try to print the VPOP3 manual you get lots of errors about fonts etc.


This usually happens if you try to print the manual using Adobe Acrobat Reader V3.0 


You should download Acrobat Reader V4 or later to solve the problem. You can download this from
www.adobe.com

ERROR: Failed to Initialise SAVI [0xa004020d]

In the October 2002 release of Sophos Antivirus (3.62) there is a bug which affects some people 
using the VPOP3/Sophos integration.

When VPOP3 tries to load SAVI, it will get an error back ('0xa004020d') which is recorded in
the VPOP3 'ERRORS.LOG' file.

This appears to be a known problem in SAVI (and should be fixed in subsequent releases). The 
intermediate solution is to use the <B>XRS</B> release of Sophos, included on the CD in the 
<B>\XRS</B> folder.

This problem is actually mentioned on a note that comes with the Sophos 3.62 CD update, but it 
may not be realised that it applies to VPOP3 users using Sophos.

ERROR: Failed to load SAVI [0x80040154]

If you get a message in the VPOP3.LOG or ERRORS.LOG file saying:

ERROR: Failed to load SAVI [0x80040154]

this simply means that you do not have SAVI (Sophos Antivirus Interface) installed. In 
most cases this is not a problem, as you will not have that software, but if you think that SAVI
should be installed, then this indicates a problem with the SAVI installation. (We recommend that you
uninstall Sophos Antivirus and re-install it)
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Example spam filter script to redirect messages

The VPOP3 spam filter scripting language (in VPOP3 2.2.0 or later) can be used for many tasks as
well as spam filtering. 

As an example, you may want all incoming messages to be redirected to a user 'sales' if they
contain your product name 'widget'. To do this, you could add the following lines to the
spamfilter_userchecks.txt file in the VPOP3 directory.

IfMatch AnyText "/widget/i"

Redirect "sales"

EndIf


The '/widget/i' is a "regular expression" to match the text 'widget' using a case-insensitive test. More
complex regular expressions can be used if desired.


If you want to redirect to a specific user's specific IMAP4/Webmail folder, use something like


 Redirect "sales myfolder"


with a space between the username and the folder name


If you want to redirect to a specific IMAP4/Webmail folder in the original recipients' mailbox, use
something like


 Redirect " myfolder"


with a space before the folder name


 

External Users

If you are wanting to know how to allow external users access to VPOP3, or how to handle email for
external users on your domain, try searching for Remote Users instead.

Failure To Route Messages

This article presents a potential solution if you are using mailscan and receive the following 
error and have experienced a problem (such as a crash).

<B>VPOP3 encountered a critical error trying to run the external router.
The message has NOT been routed, but the control file/message has been renamed to
AQ21a0a6.DAT in the HOUSEKEEPER directory.
This usually only happens if the disk is full or the ROUTING.DAT file cannot be created.
Contact your dealer if you need more help</B>
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An alternative solution may be to remove the entries for mailinit.exe from your 
External Router and Outmail Processor under the Define VPOP3 Extensions button on the Misc tab in 
VPOP.  Then rename all AQ files in the Housekeeper directory to RQ files and connect to your ISP. 
This should solve the problem and you should see the mails being processed correctly but you may 
need to re-start VPOP3 or re-boot the machine it is running on.

Note that while the External Router and Outmail Processor are disabled you will not have e-mail 
virus protection.  Do not forget to replace the commands in the External Router and Outmail
Processor boxes when the problem is resolved.

File permission problems with VPOP3 FaxServer

If you are running the VPOP3 Fax Printer driver on a PC with tightened permissions, there are some
changes you may need to make.





The VPOP3 Fax Printer writes temporary files to the C:\Documents And Settings\All Users\Application
Data\PSCS\FaxPrintDriver folder and subfolders. 


The VPOP3 Fax Printer "port" is set to C:\Program Files\VPOP3FaxPrinter\output





So, all users need permission read/write/delete/modify the above files/folders. (If you have moved
the file locations from their defaults, then the above locations will have moved as well)





To do this, in Windows Explorer, find the C:\Documents And Settings\All Users\Application Data\PSCS
folder. Right-click on the FaxPrintDriver folder and choose Properties. Go to the Security tab, press
Advanced and check the 'Replace permission entries on all child objects with entries shown here
that apply to child objects' box. Then add the relevant people with 'Full Control' to this folder.





Then, find the C:\Program Files\VPOP3FaxPrinter\output file, right-click it and choose Properties. On
the Security tab, give 'Full Control' permission for the relevant people.






Forwarding messages to an external email address

There are two possible methods to forward messages to an external address:
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	Use this method if it is for a person who might want to receive their email whilst in the office
	and/or get the mail sent to an external address.

	
		Create a VPOP3 mailbox for the user as normal
		In 'Add/Edit User' type the external email address into the 'Assistant' box or the 'Forward To' box.
	
	Use this method if it is for a person who will never want to receive their email whilst in the office.

	(for this example, we'll assume you want mail sent to <I>fred@yourcompany.com</I> sent to
	<I>fred@aol.com</I>)
	
		Create a 'Distribution List' called <B>fred</B>
		Add a 'Remote Member' to this list called <B>fred@aol.com</B>
		Ensure that 'Allow Remote Access to List' is enabled in the list definition
	
	

Goldmine locks up during download from VPOP3

A user has reported that when downloading messages from VPOP3 into Goldmine V4, it sometimes
locks up.

This apparently has been fixed in the latest version of Goldmine (build 9922 or later)

Having different VPOP3 signatures depending on the email address of the
sender

In VPOP3 2.4 and later, you can use a piece of simple scripting to have VPOP3 generate different
signatures based on the sender's email address. 


Whenever a local user sends a message, VPOP3 tries to load a file 'signature.lua' in the VPOP3
directory. This file should contain a short program in the Lua programming language.


VPOP3 calls a function in the signature.lua file called 'GetSignature' which should have the following
prototype:



GetSignature(, , )



(where '' is either "HTML" or "PLAIN") 

This function should return a string which tells VPOP3 which signature to use (if there isn't a return
value, VPOP3 will use the signature configured in VPOP3).

A simple example would be:



function GetSignature(Type, AuthSender, Sender)
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 if string.find(Sender, "@domain1%.com$") then





  if Type == "PLAIN" then


   return "This is the signature for domain1"


  else


   return "

This is the HTML signature for domain1"


  end





 elseif string.find(Sender, "@domain2%.com$") then





  if Type == "PLAIN" then


   return "This is the signature for domain2"


  else


   return "

This is the HTML signature for domain2"


  end


 end


end



If you need, we can produce a script for you, but there would be a cost for this - contact
support@pscs.co.uk with a specification for a quote. (The price is usually £50 + VAT for a simple
case with 2 or 3 signatures which are fixed depending on the sender. If you want signatures which
vary (eg contain the date/time) or more different signatures, or reading signatures from a file, then
we would need to know the exact specification to be able to give you a quote.

Hints for using VPOP3\'s antivirus update with the WinRoute firewall/proxy

(These notes are from information received from A. Burtenshaw of National Windscreens - we don\'t
have direct experience of WinRoute ourselves)


There are two main issues of using the WinRoute proxy server with the avast! or Sophos antivirus
updating facility in VPOP3.


1) Login page
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VPOP3 needs to be able to connect to an external web server through the WinRoute firewall without
having to log on to WinRoute. This means that a firewall rule needs to be in place to allow the VPOP3
computer to bypass the login page for accessing remote web servers.


2) HTTP Errors


By default if WinRoute can\'t connect to the remote web server and times out, it will return a page
telling the user about the error. It returns this page with a status code \"200\", which means
\"success\". VPOP3 then tries to read this page as if it was the requested page, which it isn\'t.


In the WinRoute configuration there is a setting to make WinRoute correctly return an HTTP error
code to VPOP3


Edit the WinRoute.CFG file using notepad, and find the section called ProxyHTTP. In that section is a
value called ErrorCodesEnabled. The default value for this setting is 0 which means that error pages
will have the code 200 (success). If you change this setting to have the value 1, then it will return
the code 504 (Gateway Timeout) instead. This will make VPOP3 ignore the contents of the returned
page and report an error instead.


 

How can I delete all messages from a user's mailbox

In VPOP3 2.1.0 and later there's a 'Purge Mailbox' icon <img height="16" alt=""
src="/Image/purgeie.png" width="16"/> next to the message count for each user on the Users ->
Accounts page in the VPOP3 settings. Clicking on this icon will make VPOP3 delete all the messages
in that mailbox's inbox. (Note this may take a while if there are lots of messages there)


In earlier versions, you need to find the user's mailbox directory on the hard disk. This is a
subdirectory of the VPOP3 installation directory with the same name as the appropriate user. If you
look in that directory, there will be lots of I*.DAT files. Each of these files is a message, so if you
delete all these files, you will delete all the messages from the mailbox. (Note that this may take a
while if there are lots of messages there - if you know how to delete files from a command prompt
(eg CMD.EXE) that may be quicker). After doing this, the message counts in VPOP3 will be incorrect
until you restart VPOP3 - it won't cause any functionality problems, but the administration pages will
display the wrong data until it is restarted.


 


 Keywords: empty mailbox inbox purge

How do I install the VPOP3 Status Monitor on other computers
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The VPOP3 Status Monitor program can be installed on other computers on your network to allow
other network users access to it. To do this copy the VPOP3STATUS_SETUP.EXE program from the
VPOP3 installation folder to the other computers, and run it (or run it across the network).This simply
installs the VPOP3 Status Monitor program which should then be configured with the IP address of
the VPOP3 computer, and the login details for the VPOP3 user who will be using the status monitor.


You can also access the VPOP3 Status Monitor installation program from the WebMail Settings page
of the VPOP3 WebMail service.


Note that different users can be given different permissions for the VPOP3 Status Monitor, so you
could let some users use it to trigger connections, other users might just be able to use it for seeing
when the last connection and next connection times are, or other users might be able to use it for
the VPOP3 Instant Messaging facility.

How to 'share' domains between Exchange and VPOP3

If you want to have a VPOP3 server and Exchange Server using the same email domain, then you
need to ensure that Exchange does not think it is 'authoritative' for the domain in question.


See http://support.microsoft.com/Default.aspx?kbid=321721 for details of how to do this in
Exchange.


In VPOP3 you would usually use LAN Forwarding to forward the messages for the relevant users to
Exchange. See this article for more details.

How to block someone sending email to you

You can use VPOP3's 'Download Rules' or 'SMTP Rules' to prevent specific people from sending
messages to you.


The examples below block messages based on the sender's email address. You can also use
Download Rules or SMTP Rules to do other actions (eg redirect) messages based on other header
field contents (but not the message text or attachments as these rules can only see the message
header which does not contain those details). See the VPOP3 help file for more details.

If you receive your incoming mail from an ISP's POP3 mailbox


If you receive incoming mail using POP3, then you can use Download Rules to filter them. (See the
VPOP3 help for more details)


Go to the External Mail -> In Mail page, and press Edit Download Rules (you may need to go into one
of the In Mail settings to see this button if you are using an older version of VPOP3).
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Add some lines like the following to the download rules:




~ignore messages from xx@yy.com


From: xx@yy.com





    The ~ tells VPOP3 to ignore these messages and not download them. There are several other
actions you could use instead - see the VPOP3 help file for more details. 

    The ignore messages from xx@yy.com text is purely for your reference 

    The From: xx@yy.com is the condition which will cause this rule to be actioned - in this case if the
From: header field contains xx@yy.com. Note that this is a substring match, so if someone sends a
message to you with an address aaxx@yy.com, it will also be blocked. 




In the relevant In Mail settings, make sure that the Use Download Rules option is ticked.

If you receive your incoming mail from an incoming SMTP mail feed


If you receive incoming mail using SMTP, then you use SMTP Rules to filter them. (See the VPOP3
help for more details). Note that SMTP rules also apply to locally sent outgoing mail.


Go to the Services -> SMTP page in the VPOP3 settings. Press the Edit SMTP Rules button and add
some lines like the following:




1*Reject messages from xx@yy.com


MailFrom: xx@yy.com





    The 1 tells VPOP3 to process this rule at the very first stage of the SMTP transaction, when the
sender's address is specified 

    The * tells VPOP3 to reject the message at the SMTP level. The sending mail server will generate
a bounce message back to the sender. There are several other actions you could use instead - see
the VPOP3 help file for more details. 

    The Reject messages from xx@yy.com text is purely for your reference 

    The MailFrom: xx@yy.com is the condition which will cause this rule to be actioned - in this case if
the MailFrom: part of the SMTP Envelope matches xx@yy.com. Note that this is an exact match. You
can use wildcards if you want, eg MailFrom: *@yy.com to match any yy.com email addresses. 




 

How to configure VPOP3 when some people on your domain are not
handled by VPOP3

In some situations you will have a situation where most of your users are handled by VPOP3, but

52 of 223Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



several users will collect their mail directly from a separate POP3 account on your ISP, even though
they may have an email address on the same domain as other users.


For instance, if your domain is domain.com, you may have VPOP3 users fred, kate and jim who are
all defined as users in VPOP3, but you may also have another user sarah who gets her mail directly
from a separate POP3 account on the ISP.


If you don't tell VPOP3 about the sarah user, then, if a local user tries to send mail to
sarah@domain.com, VPOP3 will immediately bounce back the message saying that sarah is an
unrecognised user name. Also, if an external user sends a message to fred@domain.com and CC's it
to sarah@domain.com, then the VPOP3 administrator will get an error message about an incoming
message for sarah@domain.com since that address is not recognised.


To get around this problem, VPOP3 has the concept of Remote Users. If you create a Mapping in
VPOP3 of sarah -> *REMOTE, then VPOP3 knows that sarah@domain.com exists, but is managed
somewhere else. This solves both problems mentioned above. VPOP3 sends locally sent messages to
*REMOTE mappings out to the ISP, and ignores incoming messages to *REMOTE mappings.


This is described in more detail in the VPOP3 help file here.


 


Keywords: user does not exist locally

How to copy sent messages to IMAP4 'Sent Items' folder in Outlook

It is possible to set up Outlook 2000/2002 to put copies of sent messages into the IMAP4
'Sent Items' folder, but, unfortunately, it is not obvious.

Tools -> Rules Wizard
Click on New
Select the Move Messages I send to someone template
Press Next
Uncheck Sent to people or distribution list
Press Next
If Outlook asks you to confirm that this will happen to all sent messages, 
press Yes
Check Move a copy to the specified folder
Click on the Specified link in the bottom half of the window
Select the IMAP4 Sent Items folder
Press Next
Press Next
Press Finish

How to delete messages from the VPOP3 OutQueue
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To delete messages from the VPOP3 'OutQueue':



    log into the VPOP3 settings

    go to Users -> Accounts

    click on the OutQueue entry in the accounts list. This will show you a list of all the messages
waiting to be sent by VPOP3

    Select the messages you want to delete, and either Hold or Delete them. Holding a message will
leave it in the OutQueue, but VPOP3 will not try to send it. Deleting a message will remove it from
the OutQueue permanently.




Note that you cannot delete items from the VPOP3 OutQueue whilst VPOP3 is in the process of
sending them, so you should stop VPOP3 from sending first.


 


Keywords: Outque Outqueue Outgoing Messages Outbox

How to import/export a Windows Registry Branch

Exporting

To Export a registry branch:



    Go to the Start menu, choose Run 

    Type in \"REGEDIT\", and press OK 

    In the left hand side of the RegEdit window, find the branch you want to export (eg
HKEY_LOCAL_MACHINE\\SOFTWARE\\PaulSmith\\VPOP3) and select this 

    In the RegEdit menu, choose Registry then Export Registry File 

    Check that the Export Range is set to Selected Branch and enter the filename that you want
the registry branch exported to 



This will create a .REG file. You can then copy this file to a new computer, or back it up or whatever.


You can also export the registry from a batch file or command prompt, using a command such as:


regedit /e vpop3.reg "HKEY_LOCAL_MACHINE\\Software\\PaulSmith\\VPOP3"


to save the registry branch to a file called VPOP3.REG


NB - on 64 bit Windows, the VPOP3 settings are stored at
HKEY_LOCAL_MACHINE\Software\WOW6432Node\PaulSmith\VPOP3 instead of the location specified
above.

Importing

To Import a registry branch:


There are two ways to do this: 



    If you double-click the .REG file from Windows Explorer it will often automatically import the file.
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However this is often seen as dangerous behaviour as you can inadvertently import registry settings,
so some utility programs will disable this facility. 

    Use Regedit again:

    

        Go to the Start menu, choose Run 

        Type in \"REGEDIT\", and press OK 

        In the RegEdit menu, choose Registry then Import Registry File 

        Choose the correct .REG file and press Open 

    

    



NOTE: Editing the registry can lead to problems with your computer, so make sure you
know what you are doing first, and backup the registry before making any changes.

How to install the VPOP3 FaxServer

To install the VPOP3 FaxServer:



    Download the VPOP3 FaxServer from http://www.pscs.co.uk/downloads/vpop3fax.php 

    Install it onto the same computer as VPOP3 is installed. 

    Go to the Utilities -> FaxServer page in the VPOP3 settings, and enter your VPOP3 FaxServer
licence key. 

    Restart VPOP3 to allow it to detect and load the FaxServer components 

    Go back to the Utilities -> FaxServer page in the VPOP3 settings to configure the FaxServer
according to the instructions in the VPOP3 help file 




Go through the FaxServer General, Incoming Fax Routing,  Banner & Cover Page, Sender
Information, and Devices pages setting the necessary options in there.


You will also need to install the VPOP3 Fax Printer Driver onto the computers from which you will
wish to send faxes. In the VPOP3 FaxServer installation directory will be a file called
VPOP3FAXPRINTER.EXE this is the fax printer installation program. Run that program on all your
users' PCs.


Once the printer driver has been installed on the PCs, you will see a new printer on those PCs called
VPOP3 Fax Printer 2. If you print to that printer, a popup window will appear asking where you want
to send the fax. The first time you print a document to the VPOP3 fax printer, you will be asked to
configure the driver with the following information:






    

        

              VPOP3 Server Address 

             the IP address or DNS name of the VPOP3 server 

        

        

             VPOP3 User Name         

             the user's username in VPOP3 
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             VPOP3 Password

              the user's password in VPOP3 

        

        

             Your Email Address

             the user's email address (for delivery acknowledgements or failure reports) 

        

        

              Fax Email Address

             the email address of the VPOP3 fax server (this is usually FAX@domain) 

        

        

             Real Name

             the user's real name. 

        

        

             Company Name

             the user's company name (optional) 

        

        

             Your Phone Number

             the user's phone number (optional) 

        

        

             Your Fax Number

             the user's fax number (optional)

        

    






This information is also in the FAXREADME.TXT file in the VPOP3 FaxServer installation directory.

How to make the VPOP3 Status Monitor icon show the 'In Queues' status
of the whole server

Starting from VPOP3 2.1, the VPOP3 Status Monitor icon will, by default, 'bulge' only if there is mail
waiting for the user who is logged into the status monitor. In previous versions of VPOP3 it would
'bulge' if there was mail waiting for ANY user.


This facility was added so that people could use the status monitor to show if they have got new
mail


To change it back to the old method:


 



    Right-click on the status monitor and choose 'Disconnect from VPOP3 Server' 

    Right-click on the status monitor and choose 'Configure Status Monitor' 

    Check the checkbox called 'Use Global Message Count instead of personal' 
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    Press 'OK'

     

        

    

How to obtain 'full headers' for a message

When obtaining technical support for VPOP3, you will often be asked for the 'full headers' of a
message which is causing a problem. 


The full headers of an email message are usually quite long. They are usually at least 10 lines long,
but can often be 20 or 30 lines long, and they include some useful diagnostic information for helping
to find the cause of many email problems. Unfortunately, some email clients make it quite hard to
obtain the full header information, so the instructions for some common email clients are given
below.

Outlook Express 6


In Outlook Express 6, right-click the message in question, choose Properties, click on the Details tab.
The Internet Headers for this message box contains the full message headers. Copy and paste the
details from there into the email you are sending to us.

Outlook 2003


In Outlook 2003, right-click the message in question, choose Options. At the bottom of the Options
window is a section called Internet Headers. Copy and paste the details from there into the email
you are sending to us.


Some earlier versions of Outlook (eg Outlook 2002/XP) use the same method. Very early versions of
Outlook (eg 97/98) may not let the headers be viewed at all.

Eudora


In Eudora, view the message outside the preview pane (If you are using the preview pane, double-
click on the message to view it in a window of its own). Then click on the message toolbar button
with the text \'Blah Blah Blah\' in it. This will show the full message headers which you can copy and
paste into the email you are sending to us

Opera


In Opera, view the message. At the right-hand side of the message viewer there is a link Display all
headers, pressing this will make Opera show the message in a window of its own, with the full
header information. Copy and paste the header information into the email you are sending to us.

Mozilla Thunderbird


In Mozilla Thunderbird, select the message, then, in the Thunderbird menu go to View -> Message
Source. This will show the entire message source. The start of this (up to the first blank line) is the
full message header. Copy and paste the header information into the email you are sending to us.


Note do not use the View -> Headers -> All menu item. This does show the full header information,
but the order is not the same as the original header information, so it is not as useful.
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How to redirect messages with a certain subject to a different user

If you download messages from an ISP POP3 mailbox, and you want VPOP3 to redirect messages
containing a certain subject to a different user's mailbox, you can use VPOP3's Download Rules
feature.


For instance, you want any messages where your ISP has added [SPAM] to the subject to be routed
to a mailbox called 'spambox' instead of the original user


Go to External Mail -> In Mail in the VPOP3 settings, and press Edit Download Rules.


Add the following two lines:



>spamboxspambox

How to reinstall VPOP3

To reinstall VPOP3 simply:



    Stop VPOP3 running, and close the VPOP3 status monitor

    Re-install VPOP3 into the same location where it was previously installed

    Restart VPOP3




 

How to send a fax by email using the VPOP3 FaxServer

VPOP3 2.1.0 and later together with the VPOP3 FaxServer software allows you to send specially
crafted emails to VPOP3 to have them sent as faxes.


To do this, send an email to fax@ . The email subject will be the subject of the fax used on the fax
cover page. The email should be in plain text (not HTML). It can also include .TIF, .BMP or .TXT
attachments. The plain text content of the email gets put into the 'comments' section of the cover
page, or onto overflow pages. Then, any TIF, BMP or TXT attachments are added at the end of the
fax.


You specify who the fax is to by using special sequences in the text of the email (these get stripped
out before the fax is sent). These special sequences need to be on lines of their own.


Use:
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~~~


to specify recipients (you can use as many of these lines as you wish. The 'real name', and
'company' parts are optional.


You can optionally add lines to specify more details about the fax sender:


~~RealName~


~~FaxNumber~


~~PhoneNumber~


~~Company~


In VPOP3 2.2.0 and later you can also use


~~cover~


 Keywords: fax by email fax to email gateway

How to upgrade the VPOP3 Licence size

To increase the number of users that your VPOP3 licence allows you need to buy an upgrade
licence to the next higher licence size. You will receive a new licence code which you should enter
into the software to
activate the upgrade.

You can <B>NOT</B> add two licences together. For instance if you have a 10 user licence, you 
cannot buy a 5 user licence and add the two licences to make a 15 user licence. You must buy a 
10 to 25 user licence upgrade to give you 25 users.

You can buy the common upgrades (10 to 25, 25 to 50 etc) from our website online
order system. If you do this you will be issued with a temporary 5 day licence for the new size
whilst we validate that you are eligible for the upgrade, you will then be sent a permanent licence
code for the new size.

If you want to buy a non-standard upgrade (eg 10 to 50 users) then you can do so by contacting
our sales department directly (telephone +44 1484 855801, look 
here or email 
sales@pscs.co.uk for details on other ways to pay). The upgrade
price is the difference in price between the two licence sizes, plus a 10 UK pounds administration 
charge (plus VAT at 17.5% if applicable). 

You will not need to reinstall the VPOP3 software or make any configuration changes other 
than to enter a new licence code and add any new users you want to add (and any settings 
associated with these new users).
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How to upgrade the VPOP3 Version

All registered VPOP3 owners are eligible to upgrade their copy of VPOP3 to a later minor release
version free of charge. Major release versions are chargeable. So, for instance, users of VPOP3 1.4
can upgrade to 1.5 free of charge, but there may be a cost to upgrade to 2.0. Users of 2.0 will be
able to upgrade to 2.1 free of charge. (Note that major version upgrades are free for people who've
recently purchased the previous version - the Upgrade VPOP3 page on our main website will give
you details of the upgrade prices for your particular licence).


To upgrade the software version simply download the latest version from our website at
http://www.pscs.co.uk/downloads/vpop3.php and install the new version into the same location as
your existing installation. 


If you want us to do the upgrade for you we can do this for a small fee (as long as we can get remote
access to your server, which usually just requires an internet connection from the server). To order
this go to http://www.pscs.co.uk/buynow/buy.php?item=REMUPG


Do NOT uninstall your existing installation first or you will lose all your settings, users and
messages! 


You should make sure that VPOP3 is not running at the time when you run the installation for the
upgrade or the VPOP3.EXE file will not be upgraded properly. 


Note - the free upgrade does NOT cover upgrades from Standard VPOP3 to VPOP3
Enterprise, or an increase in the number of users that your licence covers. These
upgrades are chargeable.

How to use ETRN to retrieve messages from your ISP using SMTP

ETRN is a command which is sent to your ISP's SMTP mail server to tell it to start sending your mail 
to you.

To use this option, on the <B>In Mail</B> tab in VPOP3 select <I>SMTP Incoming</I>. Then turn
on the <I>Use ETRN</I> option and in the box where it says <I>for domain:</I> put the data that
your
ISP have told you to send with the ETRN command. Often this is your ISP username or your email
domain,
but it could be either of those or something else. If you enter the wrong data your ISP won't send
you your mail!

Most ISPs want you to send the ETRN command to their main SMTP mail servers as, in which case
you can leave
the <I>Send ETRN to host</I> box empty and VPOP3 will use the server specified on the <B>Out
Mail</B>
tab, but if you need to you can specify a different SMTP server to send the ETRN command to in this
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box.

You should then also put a value in the <I>Wait for up to X seconds</I> box. For dial-up
connections 
this may need to be up to a few minutes in length - your ISP should be able to tell you how quickly
they
will start sending the mail to you. For permanent connections or ISDN routed connections it 
usually just needs to be a few seconds.

Common Problems

 The ETRN command sends data to the ISP. This can be in various forms, such as your username,
your email domain
or even a special code assigned by your ISP. You should check with your ISP what data you have to
send
with the ETRN command. If you don't send any data the chances are it won't work!
 Most ISPs will only allow you to send ETRN to them if you are dialed into their dial-in servers or
use oe of their leased-line, cable or ADSL connections
 If you have a router between your ISP and VPOP3 (eg because you use a dial-up router, or a 
leased line or ADSL connection), then you MUST ensure that the router allows incoming SMTP
connections
to the VPOP3 computer on port 25. See also here

How to use VPOP3's Bandwidth Limiting Feature

VPOP3 2.x versions have an undocumented facility for limiting the bandwidth used for various types
of connections.


These are currently only accessible by manually editing the Windows Registry. To change the
settings:



    Stop VPOP3 Running 

    Go to Start -> Run in Windows and type Regedit and press OK 

    In the left hand pane, find HKEY_LOCAL_MACHINE\Software\PaulSmith\VPOP3 

    In the right hand pane, find the appropriate bandwidth limiting entry (see below), and change it as
required 

    Restart VPOP3 




There are four bandwidth limiting entries:



    POP3ClientBandwidth - this sets the bandwidth limit when VPOP3 downloads messages from your
ISP 

    POP3ServerBandwidth - this sets the bandwidth limit when your email client downloads messages
from VPOP3 

    SMTPClientBandwidth - this sets the bandwidth limit when VPOP3 sends messages to your ISP 

    SMTPServerBandwidth - this sets the bandwidth limit when your email client sends messages to
VPOP3 
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If these settings are set to '0' (zero) then there is no limit, and VPOP3 will send/receive data as fast
as possible


If you change these settings to a different value, then that sets the bandwidth limit to the specified
number of bytes per second. (Note that this is an average, so if you set it to 1000, VPOP3 will send,
on average, no more than 1000 bytes per second. It might send 1000 bytes in one big chunk, then
nothing else for the rest of the second, rather than sending 1 byte every millisecond)


The bandwidth limit sets the limit per connection, not the total limit. So, if you limit the 'POP3 Server'
bandwidth to 1000 bytes per second, but have 50 POP3 clients connecting to VPOP3, the total limit
will be 50,000 bytes per second, not 1000 bytes per second (with a limit per client of 20 bytes per
second)


See Also: Using VPOP3 on 64 bit Windows


 

I can send faxes from my LAN, but if I send messages to FAXmaker across
the Internet, they fail

VPOP3 has built in protection to prevent Internet users from sending faxes by sending a message to
<I>faxnumber@your.domain.com</I>.
By default, it will only allow these messages to be routed to the FAX mailbox if they are sent
internally.

To allow external access to this facility, you need to change a VPOP3 setting:

	In VPOP3 1.3.0c and earlier you need to edit the registry slightly:
	
		Stop VPOP3
		Open the registry editor 'regedit.exe'
		Select the key <B>HKEY_LOCAL_MACHINE\SOFTWARE\PaulSmith\VPOP3\Secret\</B>
		Change the DWORD entry <B>AllowRemoteFaxAccess</B> from <B>0</B>(zero) to
<B>1</B>(one)
		Close the registry editor
		Restart VPOP3
	
	In VPOP3 1.3.3 beta and later, go to the <B>Diagnostics</B> -> <B>Tuning</B> window
	and turn on the <B>Allow External Access To Fax Mailbox</B> option

I'm getting lots of bounce messages from messages I didn't send.

If you are receiving lots of bounce messages from other mail servers, which seem to be in response
to messages which you didn't send, the chances are that a spammer or virus somewhere is sending
out messages using your email domain and/or email address as a fake sender's email address.
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This phenomenon is known as 'Backscatter' - see the Wikipedia article on Backscatter for some more
detail on this and happens when another mail server accepts the message, and then, later, decides
it should have rejected it as it came in, and therefore sends out a delivery failure report message.


Unfortunately, it is very hard to stop the bounce messages coming back to you. The VPOP3 spam
filter will not be very effective at stopping them, because the message may either have no spam
characteristics at all, or may contain a copy of the original spam message, but 'mangled' by having
the delivery failure report message added to it. If it was configured to stop bounce messages, then it
would almost certainly stop legitimate bounce messages as well.


Two things you can do to reduce the effect of spam backscatter are:



    Do not use catch-all accounts in VPOP3. Have VPOP3 reject any mail addressed to addresses it
doesn't recognise. Usually spammers will just pick random addresses at your domain, so most of the
backscatter will be addressed to unrecognised addresses. See this knowledgebase article for details
on having VPOP3 delete incoming POP3 mail to unrecognised users.

    Set up an SPF record for your domain. This requires contacting the DNS hosting company for your
domain (or using their online control panel if they have one) to add data to your domain's DNS
configuration. SPF tells mail servers whether mail is coming from an authorised mail server for that
domain. If the receiving mail server checks the SPF data, it will know that it is a forged email
address, so it won't send a bounce message back. See www.openspf.org for details on SPF,
including a 'wizard' to create the SPF configuration string for your domain.




 

I've changed the IP address of my server, and now it doesn't work

The first thing is that, unless you have a very good reason to do so, it's best not to change the IP
address of any server which is referred to by IP address on your network. A common reason for
people changing the IP address is that their ISP has sent them a new router which has a default
configuration in a different network range from the one they previously used. It will typically take 10-
20 seconds to change the configuration in the router to use the old network range, or an hour or two
to change the server's configuration and configuration of all the clients to use the new IP address.


If you really must change the IP address of the VPOP3 server (eg because you are joining two
networks via a router, and they previously used the same network range) then the things you need
to do are:



    Change the server's IP address in the Windows settings if it has a static IP address

    In the VPOP3 settings, on Services -> General, make sure that the 'IP Address to bind to' is either
set to '' or the new IP address

    In the VPOP3 settings, on Services -> (each service), check the 'Access Restrictions' apply to the
new network. On a simple network, pressing 'Default for your LAN' will work, otherwise you need to
specify which IP addresses can and can't access it. Don't be tempted to allow anywhere to access
the server, unless you are protecting it from abuse some other way (e.g. by a firewall). Remember to
press 'Submit' on each page after making changes.

    In any client software (email clients, web browsers, VPOP3 status monitors etc) change the
configuration to point to the new IP address of the server.
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I've lost the administrator password for the VPOP3 settings

The administrator password is the same password as used for collecting email by a user who is set
up as an administrator in VPOP3. It is not a separate password, so if the administrator can remember
his or her email password that is the same as the administrator password. 


The details are case sensitive, so ensure that you are entering capital and lower case letters as
appropriate. 


Also, please note that the default username and password are "postmaster" and "admin"
respectively. Many of the files we are asked to decrypt still have these settings which ARE described
in the context help for the login window. This is one of the reasons why we are considering charging
for decrypting this file. 

VPOP3 2.1.0 and later


In VPOP3 2.1.0, VPOP3 creates a file called VPOP3PASS.AUTH in the VPOP3 folder when licence
details are entered. This file is linked to your particular VPOP3 installation.


This file lets you change the administrator password by going to Start -> Programs -> VPOP3 ->
VPOP3 Service Settings. If you go there, at the login window, there is a button Forgotten Login
Details. If you press this, VPOP3 will search for the VPOP3PASS.AUTH file in the VPOP3 folder. If it
can't find it, it will ask you to insert the floppy disk containing the file into drive A or copy the
VPOP3PASS.AUTH file to the VPOP3 installation directory.


Once VPOP3 has validated the VPOP3PASS.AUTH, it will let you reset the administrator password. 


For security reasons we recommend that you move the VPOP3PASS.AUTH file from the VPOP3
installation directory to a floppy drive or similar, and store in a safe & secure place so that the
password can be recovered at a later date if necessary.


Note this password reset mechanism requires access to the VPOP3 server itself (or remote desktop
access). It cannot be used over the Web-based administration facility, for security reasons.

All versions of VPOP3


If you have tried the above two options and are still unable to log on to the VPOP3 settings, then our
technical support department will probably be able to decrypt the user database file for you. 


Note that this is a (currently) free service offered for our customers. Because of the amazing amount
of people who seem to forget critical passwords with ease there may be delays in processing these
requests - we often get 20 or more 'forgotten' password requests a week, each of which has to be
processed manually and may take up to 30 minutes to handle (this 30 minutes is not the time that
the results will be returned within!). Lots of other systems won't allow passwords to be recovered at
all (eg Windows), requiring a reinstall if passwords are lost. 
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Also, note that in a future version of VPOP3 the passwords may be stored using a one-way
encryption algorithm for increased security - at which point we will not be able to recover passwords,
so you should REMEMBER THE PASSWORD!! If you can't remember it, write it down and lock it
somewhere safe. 


To have our technical support department recover your forgotten details, you need to email the file
USER.LST from the VPOP3 directory to support@pscs.co.uk along with your VPOP3 licence details. 


Our technical support department will then be able to send the administrator password back by
email to the email address which was used when originally purchasing the VPOP3 software (this is
for security reasons). If you need it emailed to a different address, then we need a signed fax from a
director (or someone of similar status) of your company to say that we can email the details to a
different address. If you need the details faxed to you then there WILL be a charge of £5.00 to do
this. Please contact our sales department on 01484 855801 (within the UK) or +44 1484 855801
(from outside the UK) 


There is NO "back door" into the VPOP3 settings. 

In the User Account list in WebAdmin pages, VPOP3 shows a mailbox as
having zero messages, but a non-zero mailbox size

This is probably working as designed.


The message count is the number of messages in the 'Inbox' folder of the mailbox. The 'Mailbox
Size' gives the total size of all messages in the mailbox - that is, the size of messages in the 'Inbox'
folder and all other WebMail/IMAP4 mail folders.


If you log into the account using WebMail, then you will be able to see the other folders, so you can
check whether there are messages in those folders.

Incorrect \'non-existant user\' for a list

If you get error messages about incoming messages stating that a message arrived for a \'non-
existant user\', but the email address actually does exist, as a distribution or mailing list in VPOP3,
check that you have the \'Allow Internet Access to List\' option checked for the list.




If you do not have that option checked, VPOP3 will treat the list as if it does not exist when
processing incoming emails.

ISP adds Delivered-To or X-Envelope-To type headers to incoming
messages
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The POP3 protocol was not originally designed so that a single POP3 mailbox could be shared
by multiple users. This means that when VPOP3 downloads messages which have been BCC'd or
sent to a mailing list, sometimes it cannot work out who the message is for because the
recipient's email address is not in the message header.

Some ISPs work around this by adding a custom line to the message header. This is commonly
something like:

       Delivered-To:
       X-Envelope-To:
       X-SMTP-To:
       X-RCPT:
       X-RCPT-to:

If your ISP adds a line like this you can tell VPOP3 to look for that line and to use
the recipient information in there if it exists (if the custom line doesn't exist, VPOP3 will
use the standard To: and Cc: lines)

To do this, go to the <B>In Mail</B> tab in VPOP3 and press the <B>Routing</B> button. In
the <B>Special Header Fields</B> box put the custom header line name that you want VPOP3 to 
look for (you can list several if you want)
Examples

If your ISP adds a line like: <I>X-Envelope-To: user@domain.com</I> you would just add
<B>X-Envelope-To:</B> to the Special Header Fields box.

If your ISP adds a line like: <I>Delivered-To: account-user@domain.com</I> you would add
<B>Delivered-To: account-*</B> to the Special Header Fields box. (The <B>*</B> goes where 
VPOP3 should look for the recipient's email address)

Known bugs in VPOP3 1.4.1 beta

  When adding a new user using the Web Admin function, VPOP3 will crash
  VPOP3 Installer isn't properly closing down a running copy of VPOP3
  Redirect SMTP Rules only work in the <B>DATA</B> phase of processing
  'Use Download Rules' option always gets enabled at startup if 'Leave Messages on server' is
enabled
  + signs get stripped out of messages sent using Web Mail
  Problem when processing incoming multiline subjects
  The 'save attachment in subdirectory by received date' option makes incorrect subdirectory names
  Mailing list Digest creation sometimes crashes (if there are lots of blank subjects)
  Blank lines in global signatures get stripped out
  'Quick Connect' doesn't always work if there are outgoing mail threshold schedule entries
  LDAP authentication doesn't work with Eudora/Netscape (it does with Outlook/Outlook Express)
  Outlook 2000 LDAP search using ODBC (VPOP3 Enterprise) doesn't work properly
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LDAP attributes that VPOP3 uses

What LDAP attributes does VPOP3 use for its own addressbook.


The attributes below are those that VPOP3 uses itself. As of VPOP3 2.1.1, VPOP3\'s LDAP server will
store other attributes as well, but will not use them itself.



cn - display name

mail - email address

givenname - first name

initials - middle initials

sn - surname/family name

homepostaladdress - home postal address

homephone - home telephone number

otherfacsimiletelephonenumber - a fax number (usually home fax)

mobile - mobile phone number

title - job title

department - work department

physicaldeliveryofficename - office name

co - company name

postaladdress - business address

l - business city

st - business state/region

postalcode - business postcode

c - business country

telephonenumber - business telephone number

officefax - business fax number

pager - pager number

url - website URL

LDAP Queries crash VPOP3 1.4.4 and 1.4.5 beta

<B>This only applies to VPOP3 1.4.4 and 1.4.5 beta. Previous versions did not have the problem, 
and it will be fixed in 1.4.6 beta</B>

VPOP3 1.4.4/5 beta now supports 'personal address books' using LDAP as well as a global one. 
This means that if you actually log in using LDAP (so VPOP3 knows who you are), then VPOP3 will 
give you the merged results of your personal address book and the global address book. 
Unfortunately, if you DON'T log in, then VPOP3 tries to give you the 
personal address book for a non-existant user, and then crashes. It should give you just the 
global address book, but it doesn't.

The workarounds are:

 Use 1.4.3
 Always 'log in' to the LDAP server before using it (most LDAP clients support logging in)
 Don't use LDAP until 1.4.6 beta is released (expected in May 2001)
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Limitations of the VPOP3 Home User Licence

The VPOP3 Home User licence allows you to have up to 5 users for a lower price than the 
standard 5 user licence, but there are some restrictions in functionality. These are described below:

 There is no Mailing List Server (you can still have distribution lists)
 There can only be one Connection method (instead of 10)
 There can only be 5 In Mail methods for ISP email accounts (instead of unlimited)
 There is no LAN forwarding to other mail servers
 There are no external/programmed autoresponders
 There is no facility for defining VPOP3 Extensions such as 'External Routers' or 
'OutMail Processors'
 There is no facility to add the VPOP3 FAXServer option (only in 1.4.4 and later)
 There is no VPOP3 file transfer server (there is still a VPOP3 file transfer client)

The main limitations which can cause problems for people are the lack of VPOP3 Extensions as
these are often used for tasks like virus scanning by using the VPOP3 Plugin Pack or batch files.

Virus scanning can still be performed with the VPOP3 Home User licence using either 
Sophos Antivirus or a virus scanner
with built in POP3 email virus scanning facilities such as 
Norton Antivirus 2000 or 2001.

Lost messages when sending mail using Outlook

When you use Outlook to send a message that includes an attachment, the message may 
be received without the attached item. If you view the message in the Sent Items folder in Outlook, 
the attachment is not visible. 

This is a known problem in Outlook - see
Microsoft knowledgebase article Q235870

Lost messages with Mailscan

It appears that if you have <B>Encrypt Local Data Files</B> enabled in the VPOP3 <B>Admin</B>
tab,
and are using Mailscan for VPOP3 to scan for viruses, then there is the possibility that some
messages will be lost.

The workaround for current versions of Mailscan is to ensure that the 
<B>Encrypt Local Data Files</B> option in VPOP3 is disabled.

We expect this problem to be fixed in a future version of Mailscan.
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Mailboxes do not show after moving VPOP3

If you have moved a VPOP3 installation to a different computer or location, and the previous
mailboxes do not appear in the new installation, this usually means you have not moved the
installation correctly.


The recommended method for moving VPOP3 to a new PC is described here. One of the key steps
which is often left out is that VPOP3 must be reinstalled onto the new PC, in the correct location. 


If you move VPOP3 to the D:\VPOP3 location, when you come to reinstall VPOP3, it will, by default,
try to install to C:\VPOP3, instead of D:\VPOP3. If you let it install to C:\VPOP3, you will then find that
you will run the program on the C: drive instead of the D: drive. If this has happened, simply reinstall
VPOP3 again, but, this time, check the installation directory is correct for the location that you have
moved VPOP3 to.


 


 

Making VPOP3 make sounds

VPOP3 can make sounds on the server when certain events occur. These are

Administrator Logon
Connection Made
Connection Ended
New Mail Arrived (this indicates that mail has been downloaded from a POP3 account on the Internet
into someone's mailbox)
Program End
Program Startup

To set the sounds, go to the Control Panel in Windows and choose the <B>Sounds</B> or 
<B>Sounds and Multimedia</B> icon. In the <B>Sound Events</B> list you should see a list of
applications and associated sounds. Find the VPOP3 application and set the sounds to those you 
wish.

NB - In Windows, sounds are set for a particular user, so if you log in as one user and set the 
sounds and then log in as a different user to run VPOP3, the sounds will not apply to VPOP3.

If VPOP3 is running as a Windows NT service, then it will actually run in a user account called
<B>LocalSystem</B> which you cannot set the sounds for easily. 
This article tells you 
how to set sounds which apply to the <B>LocalSystem</B> user account in Windows NT/2000.

Making VPOP3 re-download POP3 messages from the ISP
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If you have the VPOP3 In Mail setting Leave Mail On Server enabled, then VPOP3 will leave your
messages on the ISP POP3 server for the specified number of days after downloading it.


If, during this time, you want to make VPOP3 download those messages again, then you can do so
by following the procedure below. 


Note that you cannot selectively download messages again using VPOP3 (there are other utilities
available on the Internet to do this) - you have to re-download all the left messages again. 

Procedure



    Determine the numeric ID of the In Mail setting you want to re-download the mail for bylooking at
the configuration list on the In Mail tab. 

    If the ID is 1 (one), then delete the file SRVRUIDL.DAT in the main VPOP3 directory on the server
hard disk using Windows Explorer. 

    If the ID is greater than 1, then delete the file SRVUIDLx.DAT in the main VPOP3directory on
the server hard disk using Windows Explorer. 'x' is the ID less 1, so if the In Mail ID is '3', you should
delete SRVUIDL2.DAT



Notes:



    You can do this procedure whilst VPOP3 is running, and you do not need to restart VPOP3, but
youshould NOT do it whilst VPOP3 is connected to the Internet, so if VPOP3 connects very often, it
may be safer to close VPOP3 down whilst you carry out the procedure below. 

    The SRVRUIDL.DAT or SRVUIDLx.DAT file will be automatically created by VPOP3 the next time it
connects to the Internet 

    The main VPOP3 directory is usually C:\PROGRAM FILES\VPOP3 or C:\VPOP3, but you mayhave
installed it elsewhere on your hard disk. If you can't find it go to the Misc tab in the VPOP3 settings
and look at the Base Directory setting.



Advanced


If you just wish to download a few messages again, you can avoid disruption to most of your users
by using the following technique.



    Make a copy of the current SRVRUIDL.DAT or SRVUIDLx.DAT file to a safe place 

    Modify your 'In Mail' configuration to send all messages to a specific mailbox (either your mailbox,
or a dummy mailbox you set up for this occasion). Make a note of your previous settings! 

    Delete your SRVRUIDL.DAT or SRVUIDLx.DAT file as above 

    Make VPOP3 connect. All the old mail will be downloaded to the mailbox specified in (2) 

    Restore your 'In Mail' configuration to the previous settings. 

    Restore the SRVRUIDL.DAT or SRVUIDLx.DAT file from the location you saved it to in (1) 

    Go through the mailbox specified in (2), forwarding or moving the desired messages to the
desired mailbox(es).




 


Keywords: - redownload re-download download again

Making VPOP3 rebuild user database files
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VPOP3 2.1.0 and later store summary information about messages in database files. Occasionally
these can become damaged, and may need rebuilding. 


To make VPOP3 rebuild the user database files, use the following procedure:



    Stop the VPOP3 program

    Find the VPOP3 installation directory on the hard disk (usually C:\VPOP3 or C:\Program
Files\VPOP3)

    In that directory there will be database files called user_.db. Delete, rename or move the database
for the user(s) who are encountering problems

    Delete the dbcheck.txt file in the VPOP3 installation directory

    Restart VPOP3. It might take a long time to restart now as it has to check & rebuild any databases
which it needs




Note that doing this will not lose or damage any messages, but it will lose any WebMail 'read' flags
(or read/deleted/replied/etc flags if using IMAP4) for the relevant user(s).

Making VPOP3 reprocess downloaded messages by downloading from
itself

Sometimes you may wish to make VPOP3 reprocess downloaded messages, as if it had just
downloaded them from your ISP. There is a quite easy way to do this, but it isn't always obvious.


You need to temporarily create another mailbox in VPOP3, which you then make VPOP3 download
from - so it is downloading mail from itself - this isn't a problem to VPOP3, and it treats the mail that
it downloads as if it was coming from your ISP.


So, for instance:



    Go to Users -> Accounts and make a new User in VPOP3 called DummyISP

    Copy the messages you want to reprocess into that user's mailbox

    Go to External Mail -> In Mail and create a new POP3 InMail method with the following settings

    

        POP3 server - IP address of VPOP3 computer

        POP3 Username - DummyISP (or whatever you called the user you made in step (1) above

        POP3 Password - the password you set in step (1) above

        Accepted Domains and routing method - as required - usually the same as your main In Mail
Method

    

    Now, make VPOP3 connect, and it will download mail from the DummyISP account as well as from
your ISP. The mail downloaded from DummyISP will be processed as if it was coming from your ISP.




 

Making VPOP3 run FINGER when connecting to trigger incoming SMTP
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Some ISPs require you to send a <B>Finger</B> command to their server to trigger incoming
SMTP mail to start. This functionality is not built into VPOP3 (as the more common <B>ETRN</B>
command requirement is), but it is not hard to do.

First of all, you need to get hold of a <B>FINGER.EXE</B> program. Windows NT, 2000 and XP have
a version of FINGER.EXE included (in c:\winnt\system32), but Windows 95, 98 and ME don't have a
version
included as standard. There are several suitable Finger programs available on the Internet, one such
website is at 
http://www.kiraly.com/software/utilities/whois/

Once you have a copy of FINGER.EXE available on the VPOP3 computer, go into the VPOP3 settings,
go to the <B>Misc</B> settings tab, and press <B>Define VPOP3 Extensions</B>. In the 
<B>Post Connect Command</B> box type something like:
c:\winnt\system32\finger.exe username_password@server.isp.com

(this should all be on one line)

The first part of this command is the location of the FINGER.EXE program to run, the second part
is the command to send to the Finger command - this should be told to you by your ISP.
Further Information

The "Post Connect Command" is run by VPOP3 just after connecting to the Internet, so you
can use this facility to run other programs at this time as well.

Manually installing PostgreSQL for VPOP3 3.x

VPOP3 version 3.x and later require a PostgreSQL installation to be able to work. For most users, the
installer will automatically install PostgreSQL on the same PC as VPOP3 and configure it
appropriately, but this article explains how to manually install and configure PostgreSQL for
advanced users who may want install it differently (eg on a different PC or drive) or if you are having
problems using the normal installer.





VPOP3 version 3.x requires PostgreSQL 8.3, so use the latest 8.3.x version (8.3.7 at the time of
writing)


To get this, go to http://www.postgresql.org/download/windows and click on the 'Download
pgInstaller' link to take you to http://www.postgresql.org/ftp/binary/. Then, click on the latest 8.3.x
version, then 'win32', then click on the plain 'zip' file, eg 'postgresql-8.3.7-1.zip'. This will download
the PostgreSQL installer to your PC.





Once that has downloaded, double-click on the downloaded file to open the ZIP archive, and extract
all files to a temporary folder.
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Open the temporary folder that you have extracted the ZIPped files to, and double-click on 'SETUP'
to start the PostgreSQL installation. 


First it will install the Microsoft Visual C++ 2005 redistributable files, then the PostgreSQL
installation itself will start. 




    Select the language to use during installation. For this article, we will choose 'English'. Press 'Start'


    

    Stop all unnecessary Windows programs, as recommended, then press 'Next'

    Read the Installation Notes if you wish, then press 'Next'

    On the installation options page:

    

        you can leave the component options at their defaults. You need to have the 'Database Server',
'Data Directory', 'Application Stack Builder' and 'psql' options. To follow this article, you should also
have 'pgAdmin III' selected.

        change the 'Current location' by pressing the 'Browse' button. For the default VPOP3 install
method, set this to the 'pgsql' subdirectory of the VPOP3 installation directory - eg 'C:\VPOP3\pgsql'

    

    On the 'Service Configuration' page:

    

        check the 'Install as a service' box. 


        

        In the 'Service name' box type 'PostgreSQL-VPOP3'

        In the 'Account name' box type 'postgres'

        In the 'Account domain' box either choose your Windows domain or the name of this computer
(if this computer is an AD controller, you must use the Windows domain name)

        In the 'Account password' and 'Verify password' boxes, either enter a password, or leave them
blank for the installer to generate a (strong) password for you

        press Next

    

    User issues. Many problems occur here, because of problems with the Windows user that
PostgreSQL must run as


    

    

        If the 'postgres' user does not exist, the installer will ask if you want it to create the user for
you. Choose 'Yes'. It will then tell you the randomly generated password and tells you to write it
down. This can be tricky because it is a very strong password... If you select the dialog box and
press Ctrl-C, it will copy the text to the Windows clipboard, where you can paste it into a document
and save or print it for future reference (saving it to disk will be easier so you can cut/paste the
password back if necessary!)

        If the 'postgres' user does exist and you don't know the password, the simplest thing to do is to
either delete the 'postgres' user or use a different 'Account name' (eg 'postgres2') so that the
installer will create the new user. To delete the 'postgres' user you can either use the Active
Directory tools or the 'Local Users' tools, or run 'net user postgres /delete' from a command prompt.


        

    

    On the 'Initialize database cluster' page:

    

        Check the 'Initialize database cluster' box

        Leave all the other options as defaults if this is on the same computer as VPOP3. If it is on a
different computer, you will need to check the 'Accept connections on all addresses' box
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        Enter a password in the 'Password' and 'Password (again)' boxes. Remember this password! For
the sake of this article we'll use 'pgsqlpass', but you can use whatever you want

        Press Next

    

    On the 'Enable procedural languages' page, ensure that only 'PL/pgsql' is checked, press Next

    On the 'Enable contrib modules' page, press Next

    On the 'Ready to install' page, press Next

    PostgreSQL will now install.

    After installation, clear the 'Launch Stack Builder at exit' box and press Finish



Now, you need to create a user and database for VPOP3 to use.




    go to Start -> Programs -> PostgreSQL 8.3 -> pgAdmin III

    right-click the 'PostgreSQL Database Server 8.3 (Local) in the left pane, and choose 'Connect'

    in the 'Connect to Server' box enter the password you defined in step 7 above (eg 'pgsqlpass')
and press OK

    expand the tree in the left pane

    Right-click on Login Roles and choose 'New Login Role'

    

        In the 'Role name' box enter 'vpop3'

        In the 'Password' and 'Password (again)' boxes enter 'vpop3pass'

        Press OK

    

    Right-click on 'Databases' and choose 'New Database'

    

        In the 'Name' box enter 'vpop3'

        In the 'Owner' box choose 'vpop3'

        In the 'Encoding' box choose 'SQL_ASCII

        Press OK

    

    Close down pgAdmin III because everything is now configured correctly




Message Delivery Reports

When VPOP3 generates a bounce message or delivery failure message, it uses the Internet Standard
'Message Delivery Notification' format to contain the delivery status information.


Although the delivery status report is not in an attachment, some email clients (most notably
Microsoft Outlook & Outlook Express) will store the delivery report in an attachment. This delivery
report is probably the most useful part of the bounce message for determining what went wrong
with the message delivery. if your email client saves it as an attachment, you should open the
attachment up in a text editor, such as Notepad and view it from there. The delivery status report
will look something like:




Reporting-MTA: dns; vpop3.company.com


Remote-MTA: dns; mail.isp.com
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Final-Recipient: rfc822; recipient@target.com


Original-Recipient: rfc822; recipient@target.com


Action: failed





Status: 5.0.0 (Message failed due to content restriction)



This report means that vpop3.company.com was trying to send a message to mail.isp.com for
recipient@target.com, but the mail server at mail.isp.com reported an error Message failed to to
content restriction. If you are unsure what it means, you should contact the administrators for
mail.isp.com as it is that mail server which generated the error, VPOP3 (the 'Reporting-MTA') is just
reporting the error to you.

Keywords: Bounce Message Delivery Status Report

 

Messages being flagged as spam incorrectly due to URIBL

By default, the VPOP3 Spamfilter used to use the real-time blacklist provided by URIBL.COM in part
of its spam filter decision-making.





However, in Q3-4 of 2008, URIBL started reporting everything as spam for heavy users of their
service unless they paid for a data-feed.





Unfortunately, this means that if VPOP3 is using your ISP's DNS servers to query URIBL's database,
then the chances are that lots of other people are also using the same DNS servers, so URIBL will
flag you as a heavy user, and will make VPOP3 generate lots of false positives.





The only solution to this is to turn off the use of URIBL.COM in the VPOP3 Spamfilter settings, unless
you purchase a data-feed from URIBL.COM.





If you have a spamfilter update subscription, then since the beginning of December 2008, URIBL use
is automatically turned off by default, so you shouldn't need to do anything.





If you don't have a subscription, then you can turn it off by going to Utilities -> Spam Filter Settings -
> General, and in the 'Rule Weighting' section, set the values for 'uribl-black', 'uribl-grey' and 'uribl-
red' to '0' (zero)








If you have a spamfilter subscription and want to turn on URIBL use again, go to Utilities -> Spam
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Filter Settings -> General, and in the 'Script Configuration' section, set 'UseURIBL' to '1'. You may
also want to check the values in the 'Rule Weighting' section for 'uribl-black' (default is '1'), 'uribl-
grey' (default is '0.25') and 'uribl-red' (default is '0.1')



Messages from JUNO

VPOP3 can have problems routing messages received from JUNO (a free email provider in the USA).

The problem is that JUNO's mail servers create a slightly misformed 'Received:' message header line
which confuses VPOP3. The line looks something like:

Received: from cookie.juno.com by cookie.juno.com for 

VPOP3 sees this, sees that the '182YSq....' does not have an '@' sign, so it presumes that is a local
address and tries to send the message to a user with that name (which probably does not exist).

This problem will be fixed in a future version of VPOP3. In the meantime, you can reduce the
problem by going to the VPOP3 In Mail -> Routing window, and tell VPOP3 to read 'Received: Fields'
<B>Forwards</B> rather than <B>Reversed</B>

Messages transferred slowly over network

If you find that email messages are being transferred very slowly over the local network, then the
usual reason for this is that you have excessive logging enabled.

On the VPOP3 <B>Diagnostics</B> tab check that the <B>Log SMTP Server Connections</B> and 
<B>Log POP3 Server Connections</B> options are turned <I>OFF</I>. (If these options are
enabled,
then VPOP3 will copy everything that is transmitted over the network to a log file which will
seriously slow things down).

It has also been reported by a user that using ZoneAlarm on the Windows 95/98/ME PC running
VPOP3
can substantially slow down email transfers from VPOP3 to the user's PC over the network. 
(This doesn't seem to affect Windows NT/2000/XP installations). At the moment we don't have 
any further information about this issue, but it's possibly related to ZoneAlarm's email filtering
capabilities.
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Monitoring of Outbound Messages isn't working

For VPOP3 to monitor outbound messages it needs to be able to work out that the message is
<B>FROM:</B> a user whose
mail should be monitored. To do this it has to examine the <B>FROM:</B> address in the message
header.

If the message is <B>FROM: fred@domain.com</B>, VPOP3 will look to see if
<B>fred@domain.com</B> is a local user
or not.

	If you have told VPOP3 to "Monitor <I>ALL</I> Outbound Messages", VPOP3 will check the
	<B>Local Domains</B> setting on the <B>Local Mail</B> tab to see if it contains the
"domain.com" entry
	If you have told VPOP3 to "Monitor <I>ALL</I> Outbound Messages", VPOP3 will check the
	<B>Local Domains</B> as above, and it will also look for a VPOP3 user called <B>Fred</B>,
which must have 
	the <B>Monitor Messages</B> option enabled.

<B>Note:</B> if you use some form of SMTP authentication (either <I>POP3 before SMTP</I>
authentication
or full SMTP authentication), then VPOP3 will use the login name to decide whether it should monitor
the
message, instead of using the FROM: address. (n.b. some email clients do not support SMTP
authentication)

More information on VPOP3's SMTP Direct sending

A common source of confusion is when people configure VPOP3 to use SMTP Direct to send 
outgoing messages. Often, people expect it to behave in the same way that Via SMTP Relay 
works, but it does not.

With Via SMTP Relay, VPOP3 sends the messages to another SMTP server (usually your ISP's),
and all responsibility for delivering those messages passes to that SMTP server. If the ISP 
encounters any errors whilst trying to send messages, it will handle the retrying of those messages,
and this will be totally invisible to you.

With SMTP Direct, all responsibility for delivery the messages remains with VPOP3. This 
means that if VPOP3 encounters an error whilst trying to send the message to the recipient's mail
server, VPOP3 will decide whether it needs to retry or not, and will automatically perform the 
retries. This is all normal behaviour, and is similar to the way your ISP works, except, now you
can see the retrying occurring.
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A common question we are asked is, 'why aren't these messages going out of the VPOP3 outqueue?'
The normal reason is that VPOP3 is trying to send them, but is getting back an error of some
sort, which indicates that the message should be retried at a later stage.

With SMTP, there are two types of error codes that the recipient's SMTP server can pass back to
VPOP3. Temporary errors begin with the digit '4', and permanent errors begin with the digit '5'.
There are other errors that can occur before VPOP3 reaches the recipient's SMTP server - eg network
errors, DNS errors etc. VPOP3 treats all network errors as temporary errors, and some DNS errors
(eg 'server failure' or timeouts) as temporary errors and some DNS errors (eg host does not exist)
as permanent errors.

If VPOP3 has to retry messages it will usually send back a warning message to the sender after 
4 hours of trying, and will continue trying until 3 days have passed from the original message being
sent, and will the remove the message from the outqueue, and send back a failure message to the
message sender. This is the same sort of behaviour that most ISP's SMTP relay servers exhibit.

Another source of confusion is how VPOP3 implements the retrying algorithm. If VPOP3 tries to
send a message using SMTP Direct and fails, it renames the message file in the OutQueue folder
on the disk to be 'PX.DAT'. Then 10 minutes (the default setting) later, it renames these
back to 'Q.DAT' files so they can be retried at the next connection attempt. This is 
normal behaviour for VPOP3, and is nothing to worry about.

Moving VPOP3 to a new PC

See this Wiki article for instructions on moving VPOP3.

Mozilla Thunderbird is slow when retrieving large attachments using
IMAP4

By default Mozilla Thunderbird downloads large attachments from an IMAP4 server in small chunks -
this can make it quite slow when downloading big messages


To override this behaviour:



    In Thunderbird, go to Tools -> Options -> Advanced -> General tab, click on 'Config Editor' 

    In the 'Filter' box type 'chunks' 

    Set "mail.imap.fetch_by_chunks" and "mail.server.default.fetch_by_chunks" both to 'false' 




 Also, see http://kb.mozillazine.org/Entire_message_fetched_when_opening_a_IMAP_message
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Multiple VPOP3 icons in the taskbar

If you reinstall VPOP3 it is possible that you may end up with two VPOP3 Status Monitor icons in the
task tray. This doesn't mean that two copies of VPOP3 are running, just that two copies of the VPOP3
Status Monitor are running.


When you install VPOP3 it asks you whether you want the Status Monitor to run for all users, or only
for the currently logged in user. Depending on the option you choose, VPOP3 will start the VPOP3
Status Monitor either from the current user's Startup group, or from the "All Users" Startup group.  If
you install VPOP3 twice and choose different options on the two installations, you can end up with
the VPOP3 Status Monitor being started from both Startup groups.


To only have one VPOP3 Status Monitor running, you need to remove it from one of the Startup
groups, by going to Start -> Programs in Windows. Depending on your version of Windows there
may be two separate Startup groups, or both might be merged. You need to remove the VPOP3
Status program from the appropriate Startup group.


 


 


Keywords: postbox post box icon status monitor multiple two

Nesting Level too Deep

When VPOP3 processes a message the VPOP3 administrator gets an error message like:




From: Mailer_Daemon@domain.com


To: postmaster@domain.com 


Subject: VPOP3 Error





Error expanding recipient "username"


Nesting Level too deep (51)


Check the configuration for loops




This error happens if VPOP3 is trying to work out which users to send mail to 'username' to, but the
configuration has loops. This could be, for instance, a distribution list containing itself, or a user with
itself as the assistant, or two or more users/lists configured in a loop - eg user A forwards to user B
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which forwards to user C which forwards back to user A


You need to examine the configuration for the username specified in the error message and 'follow'
any forwards or assistants through to see if you can identify the loop, and then change the
configuration to eliminate the loop.

Netscape Messaging 4.6 crashes when I search VPOP3's LDAP server

This appears to be a bug in Netscape 4.6. If you decrease the maximum number of results to
retrieve from 100 to 99 it
seems to work correctly. This problem doesn't happen with other LDAP clients such as Outlook
Express, Eudora, Calypso etc.

Notes about Sophos Autoupdate

We currently recommend that people use the Sophos Enterprise Manager to update Sophos' virus
definitions, instead of using VPOP3 to update them.


The article below is for historical purposes, and in case people can't use Enterprise Manager for
some reason.


(Note that when VPOP3 1.5.0 was written, Sophos Enterprise Manager did not exist, so you either
had to update it manually, or use a third party program such as VPOP3 to do it)







VPOP3 1.5.0 and later will automatically download new IDE files from the Sophos website as they
are released. VPOP3 currently checks and downloads these files every time it connects to the
Internet to collect mail. 


In a networked setup, the IDE files that VPOP3 downloads will be applied to ALL computers installed
from the same CID, not just the VPOP3 computer. 


The VPOP3 administrator will receive an email every time that VPOP3 downloads any updates,
deletes any obsolete IDE files, or has an error downloading updates. 


The most common causes for problems are: 



    If Sophos change an IDE file contents without changing the file name, VPOP3 cannot tell that the
file has changed (without downloading all the files on every connection) so it will not download the
new version. We plan to work around this problem in the future by allowing you to tell VPOP3 to re-
download ALL the IDE files once every day (or other configured period) 

    If VPOP3 has to connect to the Internet through a proxy server, check that VPOP3 knows about
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the proxy server settings if it is running as an NT service as it cannot automatically determine the
settings in this case (it may be safer to manually configure the proxy settings in VPOP3 in any case) 

    VPOP3 will download the IDE files to your Sophos CID (Central Installation Directory). If the CID is
not on the same computer as VPOP3, you have to tell VPOP3 the username and password for an
account which is allowed to WRITE to the CID. Note that this is usually not the SweepUpdate
account, as that usually only has READ access to the CID. 

    If Sophos is installed on the VPOP3 computer in Standalone mode, then VPOP3 will not be able to
download and apply the updates automatically. This is because when Sophos Antivirus is installed in
this mode, it can not check a CID for updates (because a CID does not exist). To get around this
problem you should first of all create a network installation of Sophos on the VPOP3 computer from
the Sophos CD (this creates a CID), then install Sophos onto the VPOP3 computer from this CID. This
will mean that Sophos is actually on the hard disk twice (once for the CID, and once actually
running). In this case, VPOP3 will be able to update the CID, and the Sophos installation will be
updated. You do not actually need a network to be able to do this, you just need to pretend you
have one. 



Note that due to the way Sophos Antivirus updates work, when VPOP3 downloads new IDE files, they
will probably not be applied immediately. Sophos Antivirus checks for updates periodically (the
default is every 60 minutes), so there may be up to an hour's delay before the update are applied.

Only allow certain IP addresses to connect to the VPOP3 SMTP Service

If you have a third party company which filters your SMTP email before forwarding it on to the VPOP3
SMTP service you may wish to block other IP addresses from sending mail to VPOP3's SMTP service.
To do this, you need to use SMTP Rules.





Go to Services -> SMTP, and press the Edit SMTP Rules button. On the SMTP Rules editor which
appears, press the green plus icon on the first line to add a new rule at the top of the SMTP rules.





Then, create a 'Reject' rule where 'All Conditions' match, and add conditions where the IP address
does NOT match any of the allowed addresses. Remember to add your local network, or local users
will not be able to send mail.





An example is below, where you want the 192.168.0.xxx network to be able send mail (your local
network) and 111.222.111.222 to be able to send mail (the external SMTP filter IP address)


If you need to allow multiple IP addresses to send incoming mail, add multiple conditions like the last
one, with the relevant IP addresses in. You can use ? and * wildcards in the IP address.





<img height="361" width="750" src="/Image/smtpfilter.png" alt=""/>


Keywords: SMTP IP address incoming filter allow deny block restrict

Outgoing mail doesn't get sent by VPOP3

Symptoms:
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Outgoing mail goes into VPOP3's OutQueue, but does not get sent out, and you have VPOP3 
configured to send outgoing mail using an SMTP Relay server.

If you are receiving error messages about 'SMTP Client Problems', then search on the 
knowledgebase for the error in that message

If incoming mail is working fine, and you are not receiving any error messages about
the outgoing mail, then the chances are that the outgoing mail configuration is incorrect. Check:

The 'SMTP Relay Servers' box has at least one SMTP server listed in it
The 'Domain Filtering' box is empty (unless you know for certain that it should have something
in it - 99% of the time it should be blank)

If incoming mail is not working either, then check that you have a schedule configured correctly, 
and watch the VPOP3 status monitor activity log at the scheduled time to see what happens. You
may 
need to contact out technical support team for further help

Outlook doesn't respond to Mailer_Daemon when responding to Download
Rule query messages

When VPOP3 processes a Download Rule whose action is 'Query' it sends a message to the intended 
recipient asking if they want to download the full message.

The most commonly seen instance of this is when a message is bigger than the download size limit
set on the <B>In Mail</B> tab in VPOP3 (This is called the <B>Default Size Rule</B>).

Usually if you press <B>Reply</B> in your email client, the response will go back to the 
<B>Mailer_Daemon</B> user in VPOP3 which will process the request to download the full message.

However, if you are using Microsoft Outlook and have told it to use <B>Wordmail</B> as the mail
editor, it appears that the response does NOT go back to the <B>Mailer_Daemon</B>.

The solution is not to use Microsoft Word as the email editor.

Outlook XP fails when sending email

If Outlook XP hangs when you send mail, it is probably due to the problems described on Microsoft's
knowledgebase here A hotfix is available from Microsoft, but you currently need to contact them to
obtain this fix - see the above link for details.
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Outlook XP hangs whilst downloading mail

Several people have reported problems with Outlook XP hanging when downloading mail
from VPOP3, especially when running on Windows XP.

This problem seems to affect some people, but not others, running an apparently
identical setup.

We believe this problem is now fixed in VPOP3 1.5.0f and 1.5.7 beta.

The problem was apparently due to VPOP3 responding 'too quickly' to a command from Outlook,
when it wasn't ready to accept the response, so it just threw the response away.

The fix we implemented is to slow down the response from VPOP3 to, hopefully, give Outlook
chance to catch up with reality

The information below is kept here for historical reasons. The
Performance tab change would obviously change the timing in borderline cases, thus allowing it 
to work, the SP1 installation may also have changed timing in some cases. In all cases we
recommend
that people encountering this problem upgrade to the versions mentioned above (or later versions).

Two of our users have suggested solutions that they have found to this problem, and details
are given below:

Solution 1
There is an Office XP Service Pack which may fix the problem. Sometimes the Outlook 
Email account also to be removed and recreated

The problem manifests itself with very slow send/recieve response or Outlook 
prompting again for passwords and giving the error message 0x8004210B.

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q304008

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q315049

Thanks to Steve Gibson for this information

Solution 2

A user has told us that they found that the problem was due to the 'performance
preference tab' being set to 'background tasks'. If that option is switched off, the
user reports that the problem was solved.
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Thanks to Paul Lakey for this information

Note that this information has not been verified by PSCS.

Outlook/Windows Messaging refuses to collect mail for some people

This problem normally occurs because a mail message is in an incorrect format and
Outlook and Windows Messaging are very sensitive about this and will just refuse to download the
message.
Other mail software will probably retrieve the messages with no problems.

The solution is to remove the message from the user's in-queue from within VPOP3 - by viewing the
user's message queue, and delete the offending message.

If possible, make a copy of the messages by copying the user's mailbox directory
(....\VPOP3\\) to a temporary location. Then, if deleting the message works, it could help
us to send the message files to us (after checking there's nothing confidential in them). This will
help us to check that there isn't anything which VPOP3 could do to help Outlook/Windows Messaging
to understand Internet mail properly.

Outlook/Windows Messaging reports "No transport provider is available"

If Outlook or Windows Messaging reports <B>No transport provider is available</B> when trying to
connect to VPOP3, it can mean several things. 
(This must be a contender for "the world's most meaningless error message").

Ideally, the first thing to try would be to try to connect to VPOP3 using a different email program (eg
Outlook Express, Netscape Messenger, Eudora), which will give a more meaningful error message.
Also, look in the <B>ERRORS.LOG</B> file in the VPOP3 directory to see if this gives an error
message corresponding to the time you tried to connect using Outlook.

It may be that Outlook/Windows Messaging is contacting VPOP3 and VPOP3 is giving an error
message - in that case, you should find the error message in the ERRORS.LOG file, and you should
look for more information on that error message.
It may be that Outlook/Windows Messaging is trying to contact VPOP3 but is unable to do so. This
could be a TCP/IP addressing problem or a network problem.
It may be that Outlook/Windows Messaging is not even trying to contact VPOP3 but is deciding there
is a problem before it gets that far. Outlook/Windows Messaging use MAPI 'Transport Providers' (this
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is what the error message means) to talk to 
mail servers, such as POP3/SMTP servers (like VPOP3), MS Mail or Exchange servers, or even other
types of mail server. The 'No transport is available' error means that Outlook has gone through all
the registered 'Transport Providers' and none of 
them has said that it can send mail to the email address you have specified. 

A common reason that this can happen is if you have both the 'Internet Mail' and 'MS Mail' or
'Exchange Server' transport providers enabled
(see the 'Tools' -> 'Services' option in Outlook. MS Mail and Exchange Server are both capable of
handling Internet Mail addresses as well as the 'Internet Mail' service,
but the 'MS Mail server' or Exchange Server may not be set up to allow Internet mail (eg if you are
using the 'Workgroup Postoffice' which comes free with Windows). In this case,
if the 'MS Mail' <I>service</I> has a higher priority than the 'Internet Mail' service, Outlook will
never
ask the 'Internet Mail' service if it can send the message, it will just ask the 'MS Mail' service which
will
initially say that it does support Internet email addresses, but later on say that it can't because the
MS Mail server doesn't support it.

To get around this problem, set the order of the 'Services' so that the 'Internet Mail' service comes
first, before either the 
'MS Mail' or 'Exchange Server' services.

POP3 Client - Unable to make temporary file

If you get an entry in the VPOP3 ERRORS.LOG file saying "Pop3 Client - Unable to make temporary
file", this means that VPOP3 won't be able to download messages because it can't create the file it
uses to store the message temporarily whilst it is being downloaded.


VPOP3 temporarily stores messages which it is downloading from an ISP POP3 account in a file called
POPIN.TMP in the main VPOP3 folder. It needs to delete this file, and recreate it for each incoming
message. Usually there should be no problems with this. However, some other software may
interfere and prevent this happening. Usually this other software is virus scanning software. This
may see that the file has changed, and open it up to scan it, preventing VPOP3 from deleting the file
when it needs to. 


Other software which may also cause this problem is any 'real-time' directory synchronisation
software which, again, may see that the file has changed, so may open it up in order to replicate it
to another directory/computer.


Most antivirus packages do not exhibit this problem, but a few do. If the problem is being caused by
antivirus software, it is probably a good idea to contact the technical support team for the antivirus
software to report the problem to them and see if they have any solution.


Alternatively, a workaround is to exclude the POPIN.TMP file (or, preferably, the entire VPOP3 folder)
from the 'real-time' protection section of the virus scanner (periodic scans are still recommended).
This will stop the virus scanner from opening the temporary file in between VPOP3 closing it at the
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end of one message being downloaded and wanting to re-create it ready for the next message.


 

POP3 Client Error - VPOP3 Received error "-ERR Invalid userid/password"

If you get an error message from VPOP3 saying something such as:

From: Mailer_Daemon@yourdomain.com
To: postmaster@yourdomain.com
Subject: VPOP3 - POP3 Client problem
Date: Fri, 30 Nov 2001 00:00:18 -0000

VPOP3 has encountered an error whilst retrieving messages from your ISP
POP3 server (YourISP (0))
The error received from the ISP was: "-ERR Invalid userid/password"
The last command sent by VPOP3 was: "PASS *******
"

This problem is usually an ISP problem which VPOP3 is just forwarding on to you.
Check with your ISP for more information.

This error means that VPOP3 was trying to log onto your ISP's POP3 mail server to collect 
your email, and it used the username and password specified on the <B>In Mail</B> tab in VPOP3,
however your ISP rejected the login because it was incorrect (that is what the 
'Invalid userid/password' text means). 

Resolution steps

 First of all check the server name and login details on the VPOP3 'In Mail' tab are correct.
 Check with the ISP that the details are actually as you think they are.
 On the VPOP3 <B>Diagnostics</B> tab, turn on <B>Log POP3 Client Connections</B>. Now try to 
connect to the ISP. After you get the error, look in the <B>POP3CLT.LOG</B> file on the VPOP3
server. This will show VPOP3 sending the username and password to the ISP so you can check that
they are being sent correctly. If necessary send this log file to your ISP for help.

POP3/WebMail client can't see messages, but WebAdmin can

With this issue, POP3 and WebMail email clients cannot see any messages in their mailboxes, even
though VPOP3 reports that messages are in a mailbox. If the administrator goes into the Web
Administration pages, they will be able to see the messages there correctly.


This problem usually happens due to one of two causes



    The user database files have become damaged 

    VPOP3 cannot create temporary database files for some reason 



The user database files have become damaged
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The user database files are stored in the main VPOP3 directory with filenames like user_.db. You can
make VPOP3 rebuild these database files as described here: Making VPOP3 rebuild user database
files.


Note that rebuilding a user database file will not cause any messages to be lost, but will lose any
WebMail 'read' flags on messages (or deleted/read/replied/etc flags if you use IMAP4)

VPOP3 cannot create temporary database files


This problem usually happens if there is no suitable 'temporary' directory defined. To check this, go
to Start -> Control Panel -> System -> Advanced -> Environment Variables.


If VPOP3 is running as a Service under the 'Local System' account, check the 'System Variables'
section, if it's running as an application, or as a service under a user's account, you need to check
the 'User Variables' section, making sure that you are logged in as the appropriate user.


Find the TEMP and TMP variables, and check that they point to a directory which exists, and that
VPOP3 has permission to read/write to that directory.


 

Pound signs (or other non-US characters) being shown as question marks
when sending messages from Outlook

If you send messages from Outlook which include pound signs (£) or accented characters,
eg é, ü etc, then those characters will be shown in the outgoing message as 
question marks (?)

This problem means that Outlook has been told to send messages in 7 bit plain text mode, rather
than to use a system such as <B>quoted-printable</B> or <B>base64</B> encoding to convert
non-US characters into a form which only contains US characters.

For instance, in 'Quoted-printable' encoding, the £ character is converted to '=A3' by the
sending email client software. The receiving email client software will convert it back to a £
character for displaying.

Solution
You need to tell Outlook to use an encoding mechanism to convert non-US characters into US
characters
for transmission.
Outlook 2000

Outlook 97
You need to tell Outlook to use the 'ISO 8859-1' character set (Western Europe) rather than the
'US ASCII' character set. Outlook will then automatically use quoted-printable encoding on any
European characters which are not in the US ASCII character set.

To do this:
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 in Outlook go to <B>Tools</B> -> <B>Options</B>.
 Go to the <B>Internet E-mail</B> tab.
 Check that the <B>E-mail sending format</B> option is set to <B>MIME</B>, and in the 
  <B>Character Set</B> box, choose <B>ISO-8859-1</B>
 Press OK

Problem sending or receiving message - with the error "PROHIBITED
FILENAME" or "PROHIBITED ATTACHMENT"

When you send or receive a message, the sender or VPOP3 administrator gets an error reporting
that the message could not be sent or received because of a 'PROHIBITED FILENAME' or
'PROHIBITED ATTACHMENT'.


This happens if an attachment sent with the message matches a blocked filename specified in
Utilities -> Attachment Processing -> Filtering.


Go to that page in the VPOP3 settings, and look at the "Attachment filenames to filter' section. This
tells you which attachments VPOP3 will block. DOS wildcards * and ? can be used in these rules. *
means any number of any character. ? means one of any character.


The most common rule to incorrectly block an attachment is *.???.??? . This rule is intended to block
attachments such as readme.txt.exe, document.txt.xls or picture.jpg.vbs - where some email
clients won't display the last file extension, so the user thinks they are going to open a text or
picture file, when in fact they will run a program or script or other executable file.


If you want to remove any filter rule, simply delete the appropriate line from the filter box and press
Submit. Alternatively, have the attachment renamed and resent.


 

Problem using VPOP3 FaxServer Printer on Terminal Services

Below are some steps to take if you are having problems using the VPOP3 FaxServer Printer on a
Terminal Server.



    Make sure that the FAXPRINTHLP.EXE program is running in your terminal services session.
Usually this is put into the Windows 'Startup' group for 'All Users', so it should run, but it's worth
checking

    Make sure that the c:\Documents and Settings\All Users\Application Data\PSCS\FaxPrintDriver
directory and all subdirectories are read & writable by all users.
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The fax printer works on Terminal Services, by the printer driver writing the fax file to a subdirectory
under the above directory, and then the FAXPRINTHLP.EXE program reads it from there and sends it
as a fax. On Terminal Services, printer drivers themselves are not allowed to display anything on
screen, so it has to be done this way.


 

Problem with *REMOTE mappings in VPOP3 1.5.0

A problem has been found with *REMOTE mappings in VPOP3 1.5.0 which will apply in some cases
where an <B>Assistant</B> or <B>Forward To</B> setting points to a *REMOTE mapping.

The problem occurs if a Mapping is first of all used to direct a message to a mailbox,
and then that mailbox has an Assistant or Forward To setting pointing to a *REMOTE mapping,
Example
If you have a mailbox <I>Fred</I> with an assistant <I>FB@domain.com</I> and a mapping of

Fred.Bloggs -> Fred

and

FB -> *REMOTE

You will get an error of 'unrecognised user FB' if you send a message to Fred.Bloggs, but it 
will work correctly if you send a message directly to Fred (not going through the first mapping)

Resolution
This problem should be fixed in a future version of VPOP3, but in the meanwhile, if you can 
re-configure the system so that it will not need the first Mapping, then it should solve the problem.

Further Information
In VPOP3 1.4.0 and earlier, you simply could not have an Assistant or Forward-To address pointing 
to a *REMOTE mapping, as mappings were not processed at this stage of recipient discovery.

This bug was introduced with the changes between 1.4.0 and 1.5.0 to allow *REMOTE mappings
to be used at this stage. It was not discovered because it is only reproducible
in a scenario which was not tested for in-house, and the beta-test users did not discover the problem 
because they were not using that scenario either.

Problems accessing the VPOP3 Web Administration or Web Mail pages

If you have problems accessing the VPOP3 Web Administration or Web Mail pages, usually the cause
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will be some Internet Security or Firewall software on the VPOP3 computer.


If possible, try temporarily disabling or uninstalling this to see if that makes any difference. 


You can also try accessing the Web Administration/Web Mail pages from a different computer on the
network to see if that helps. See this article for details on doing that.


If you are having problems accessing the Web Administration/Web Mail pages from the VPOP3
computer itself, it can be worth trying to access the VPOP3 Web Administration/Web Mail pages
using the 'real' IP address of the VPOP3 computer instead of the '127.0.0.1' loopback IP address. To
do this:



    Right-click on the VPOP3 Monitor icon, and choose Disconnect From Server

    Right-click on the VPOP3 Monitor icon again, and choose Configure Monitor...,

    In the VPOP3 Status Monitor configuration window, change the Server Address to the network IP
address instead of 127.0.0.1, and press OK. 

    Then, (if necessary) right click the VPOP3 Monitor icon again and choose Connect to Server

    Then, try right-clicking the VPOP3 Monitor icon and choose VPOP3 Settings to see if that will work
better.




See Also:



    Problems administering VPOP3 2 with ZoneAlarm Installed

    VPOP3 Web Administration on Windows 2003


Problems accessing VPOP3 Web Administration pages when using
ZoneAlarm

The latest versions of ZoneAlarm modify web pages as are checked by ZoneAlarm to add various
'privacy' features. These changes alter the structure of the web pages that VPOP3 sends to the web
browser, and may cause problems viewing the pages in some cases.


If you view the web page source, you may see, near the top, something like this:








This is one of the changes that ZoneAlarm makes to web pages; there are sometimes other changes
as well. ZoneAlarm tries to insert these changes in sensible places, but it doesn't always get it right,
and sometimes the changes 'damage' the page.

If you are encountering problems due to this, try changing the privacy settings in ZoneAlarm. Go to
Privacy -> Main -> Cookie Control -> Custom -> Cookies -> 3rd Party Cookies -> Disable Web bugs.
Try turning that option off and see if it helps. The other tabs make changes as well, so it may be
worth experimenting with those settings as well.

 

We have also had one report of, what seems to have been, ZoneAlarm adding 'random' numbers
'randomly' throughout the web pages that VPOP3 was sending out. In that instance upgrading
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ZoneAlarm to the latest version fixed the problem.

See Also: Problems administering VPOP3 2 with ZoneAlarm Installed

Problems administering VPOP3 2 with ZoneAlarm installed

If you try to administer VPOP3 V2 from a computer with ZoneAlarm installed, you may encounter
problems. This is because VPOP3's WebAdmin facility uses cookies and HTTP headers which
ZoneAlarm may block.

VPOP3 is running on the computer you're trying to access it from


If VPOP3 is running on your computer, ZoneAlarm seems to have an issue where cookies and privacy
headers are always blocked from a web server on the '127.0.0.1' IP address. At the time of writing, it
doesn't seem possible to tell ZoneAlarm to allow cookies and privacy headers through from servers
on this address. You can add 127.0.0.1 to the 'Site List' in ZoneAlarm, but it ignores those settings. 


The solution is to use the network IP address of VPOP3 instead of the 127.0.0.1 loopback address. To
find the network IP address run 'IPCONFIG' from a command prompt (on Windows NT/2000/XP/2003)
or 'WINIPCFG' from Start -> Run (on Windows 95/98/ME). The network IP address is the same
address that you use to access the VPOP3 server from other computers on the network. 


You need to change the VPOP3 Monitor program to use the network IP address. To do this, right-click
on the VPOP3 Monitor icon, and choose Disconnect From Server, then Configure Monitor...,
then change the Server Address to the network IP address instead of 127.0.0.1, and press OK.
Then, right click the VPOP3 Monitor icon again and choose 'Connect to Server' 


Once you use the network IP address, you can tell ZoneAlarm to allow through the necessary
information, as described below. 

ZoneAlarm Privacy Settings



    Open up ZoneAlarm, go to the Privacy page, choose the Site List tab. 

    Find the site with the IP address of the VPOP3 computer (or Add a new site) and select it 

    Press Options 

    On the Cookies tab, uncheck ALL the options 

    On the Mobile Code tab, uncheck ALL the options 

    Press OK 




 


See Also: Problems accessing VPOP3 Web Administration pages when using ZoneAlarm


Keywords: Web Administration

Problems forwarding incoming emails to an external address

If you are having problems having VPOP3 forward incoming messages to an external address, but
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sending messages directly to that address works OK, and forwarding internal messages to that
address works OK, then the problem may be the SMTP return address which VPOP3 is using.


By default, VPOP3 will use the original return address of the message, so if a message is sent to you
from joe@company.com, VPOP3 will forward the message out, using that address as the return
address. Your ISP may be rejecting or discarding the message because it doesn't think that
joe@company.com should be sending mail through your account.


In this case, go to External Mail -> Out Mail -> (your Out Mail method) in the VPOP3 settings and go
to the SMTP Return Address Modifiers section. In there, choose the option Set Non-local return
addresses to: and enter an address such as postmaster@yourdomain.com in the box. This makes
VPOP3 use the specified return address instead of the original one.


This won't change the way that replies are sent to the forwarded messages, but it will mean that if
the forwarded messages bounce, the bounces will go to the specified address instead of the original
sender.


Note that the return address you specify MUST NOT be forwarded to another email address, or you
could end up with a message loop!


 


This article applies to any method of forwarding messages, such as the 'Forward To' setting for a
user, the 'Assistant Setting', using distribution lists etc.

Problems installing VPOP3 for Windows Home Server

If you are having problems installing VPOP3 for Windows Home Server, make sure you download it
using a web browser on a normal PC, and store the downloaded file on the Windows Home Server
disk.





If you download VPOP3 using Internet Explorer on the Windows Home Server PC itself, you may find
that Windows won't let you run the installer because VPOP3 was not from a 'trusted' site. You can
work around this by uninstalling the Internet Explorer 'Enhanced Security Configuration' first, but it is
simpler just to download it using a web browser on another PC.





(See http://support.microsoft.com/kb/815141 for details on the Internet Explorer Enhanced Security
Configuration which is a standard part of Windows 2003 server).

Problems sending mail through BT Internet

When sending mail through a BT Internet SMTP mail server you get the following error from BT\'s
servers:550 Recipient not authorised [recipient rejected due to no authorised destination
groups]
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This, rather cryptic, error message from BT Internet's SMTP servers means that the Sender's email
address is not recognised by their servers. This usually happens if the sender is in an email domain
which is not registered through BT Internet (ie is registered with a different ISP/hosting company). 


There are several solutions to this problem: 



    You can register your domain name with BT - using http://www.btconnect.com/maildomain/.
This can take some time to take effect, but may be the best option. 

    Transfer the hosting of your domain to BT Internet 

    Instead of using BT Internet's SMTP relay servers, ask your other hosting company if they have
SMTP relay servers you can use 

    Use a third party SMTP relay service provider, such as AuthSMTP.COM

    You can make VPOP3 pretend to be sending mail from a BT Internet domain 

    Change Internet provider




Since option (5) is the only one which can be achieved using VPOP3 alone, we will describe this
further.



    Go to the VPOP3 Settings 

    Go to the External Mail page, then the Out Mail page and edit the appropriate Out Mail settings 

    In the SMTP Return Address Modifiers section, change the option to Always set to the address,
and in the address box type your BT Internet email address (eg 'myaccount@btinternet.com') 

    Press Submit 




This will make VPOP3 change the SMTP envelope to indicate the BT Internet email address as the
sender, without modifying the actual message headers. This means that normal replies to your
messages should go back to the original recipient as desired.


This method does have some, potentially undesirable, side-effects: 



    Any bounce messages, for example due to incorrectly addressed messages being sent out,will
come back to the BT Internet email address, not to the original sender. This means that you MUST
download all mail to the BT Internet email address and handle it accordingly 

    Some mail systems may, incorrectly, send replies back to the BT Internet email address instead of
the email address specified in the message headers. Mail systems that do this don't conform to the
Internet email standards, but it may still happen. 

    The BT Internet email address may appear in the email message headers received by the
recipient in a trace header field. 


Problems sending mail to spam@<local domain> to train spam filter

You can 'train' the VPOP3 spam filter by sending mail to spam@ in VPOP3. However, sometimes
people receive an error message back if they do this. Below are several things to check in this
situation:



    On Utilities -> Spam Filter Settings -> General, make sure that Enable Spam/Content filter for
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SMTP Messages is enabled

    On Local Mail -> General, make sure that the Local Domains setting contains the correct local
domain(s)

    On Services -> SMTP, check the Access Restrictions contain the correct settings for your local
network. VPOP3 won't let you send mail to spam@local.domain if your IP address isn't allowed by the
access restrictions

    On Services -> SMTP, check that the SMTP Anti-Relay Protection method is set to Check Client IP
Address




 

Problems sending mail using Pegasus Mail

There can be problems sending mail to the Internet using Pegasus Mail. This is because it often sets
the SMTP Envelope Return Address to something like fred@[192.168.1.1] instead of
fred@mydomain.com. A lot of ISPs will reject messages with return addresses like this.

Solutions

Within VPOP3

VPOP3 versions earlier than 1.4.0 used to automatically correct this bug, but in 1.4.0 and later this is
now an option which defaults to 'off' (because it can cause problems for other email clients). In 1.4.0
and later, you can re-enable this option by going to the Diagnostics -> Tuning window and turning
on the Use From: header address in SMTP envelope option.


This option makes VPOP3 copy the address from the From: message header (which Pegasus sets
correctly) and put it into the SMTP Envelope Return Address 

Within Pegasus Mail

(These instructions are for Pegasus Mail 3.12)


Go to File -> Network Configuration, choose the Sending (SMTP) tab and turn on the Use the
e-mail address I supplied for the SMTP envelope option. 


(In current downloads of Pegasus Mail this option seems to be enabled by default, but it was not
enabled by default in earlier versions)

Problems sending mail via BT Openworld ADSL accounts

(This may apply to other BT Openworld accounts, but we cannot confirm that)




BT\'s Literature for the BT Openworld account may incorrectly specify that the outgoing mail
<B>SMTP Server</B> is <B>mail.btconnect.com</B>.




In fact, it should be <B>mail.btclick.com</B>. Changing the \'Out Mail\' server in VPOP3 to this
should help to resolve any related issues.
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Note that these server addresses do not apply to all BT customers. BT have many different sets of
mail servers, so you should use the correct ones for your account. The ones we know of are
mail.btconnect.com, mail.btclick.com, mail.btopenworld.com, but there may be others. If in doubt
you should contact BT\'s technical support team.

Problems sending messages

When VPOP3 tries to send mail it has to identify itself to the receiving mail server. Many ISP's expect
the sending mail server to identify itself using a real internet domain name (rather than the PC name
that VPOP3 may use)


If you have this problem you may receive error messages when sending that look something like
this:


HELO/EHLO was syntactically invalid 


Helo command rejected: need fully-qualified hostname


Syntactically invalid HELO argument(s) 


550 Administrative Prohibition


To fix this problem, you just need to tell VPOP3 to identify itself using a real domain name. (By
default VPOP3 2.0.0 and earlier asks Windows what the computer name is, and uses that as the host
name specified in the HELO or EHLO command)


To resolve this you need to override the default host name that VPOP3 chooses...

VPOP3 2.0.0 and later



    Go to the VPOP3 Settings 

    Go to the Utilities page 

    Go to the Misc Settings sub-page 

    Set the VPOP3 Host Name value to your internet domain name (eg 'mail.yourdomain.com')



VPOP3 1.5.0 and earlier



    Go to the VPOP3 Settings 

    Go to the Diagnostics tab 

    Press the Tuning Options button 

    Set the VPOP3 Host Name value to your internet domain name (eg 'mail.yourdomain.com')


Problems using VPOP3's WebMail with the Opera web browser

There are problems accessing VPOP3's WebMail using the popular Opera web browser. 
This problem affects users of VPOP3 1.4.3 and earlier.

The problem is fixed in later versions of VPOP3.
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Problems with incoming SMTP mail using VPOP3 with ISA

If you use Microsoft ISA between the Internet and VPOP3 and have incoming SMTP mail, you may
encounter problems with connections from ISA to VPOP3 failing. This is due to a peculiarity in the
way ISA works.


Because we have no experience of ISA here we cannot help you directly, but this article on
isaserver.org takes you through the steps for diagnosing and fixing this problem by changing the
'SMTP Server Publishing Rule' in your ISA configuration.


If you follow the steps in that article, make sure you go to Services -> SMTP in the VPOP3 settings,
set 'SMTP Anti-Relay Protection' to 'Check Client IP Address' and DENY access from the ISA server's
internal IP address. This will still allow incoming SMTP mail through the ISA server, but if you don't do
this, then you are making ISA + VPOP3 into an open-relay combination which will allow anyone on
the Internet to use your mail server for sending outgoing mail.


 

Thanks to Brandon Schultz for the link to the article on isaserver.org

Problems with POP3 client not disconnecting when using MailScan

Some people have reported problems when using MailScan with VPOP3. The problem usually
manifests itself as VPOP3 failing to make scheduled POP3 connections after a certain amount of
time.


The problem occurs when VPOP3 calls the closesocket Windows API function from the VPOP3 POP3
client thread, but that function never returns. In a normal Windows setup this function will always
return after at most a few seconds, but when MailScan is installed, MailScan installs itself as a
Layered Service Provider in the Windows TCP/IP networking stack, and this seems to interfere
sometimes with the operation of this API function when called from a POP3 client.


This issue has been reported to MailScan's technical support, which can be contacted on
support@mwti.net

Problems with VPOP3 with McAfee SpamKiller

If you have VPOP3 running on the same computer as McAfee SpamKiller (which is also included in
McAfee Security Centre) you may encounter problems such as:



    Users being unable to log on to VPOP3 to collect mail

    VPOP3 reporting a 10048 error at startup
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These problems occur because McAfee SpamKiller acts as a POP3 proxy which installs itself on port
110 on the computer it is installed on so that incoming mail can be processed by it before being
passed onto your email client. This means that VPOP3 can't use that port for its own POP3 service,
and also, any email clients will actually be trying to collect mail from McAfee SpamKiller, rather than
from VPOP3, so will get login errors.


Unfortunately, it doesn't seem that the McAfee SpamKiller can be stopped through the McAfee
Security Centre settings, and it will still use port 110 if you try to do this, blocking VPOP3.


You can stop McAfee SpamKiller by going to Start -> Control Panel -> Administrative Tools ->
Services. Then find the "McAfee Spamkiller Server" service, stop that service, and change the
Startup Type to "Disabled". Now, restart VPOP3.


 

RAS Connections not displayed in Windows 2000

If you have defined a dial-up connection in Windows 2000, but it does not appear in the Windows 
'Connection' tab, then this is due to the way Windows NT/2000 services work.

When VPOP3 runs as a Windows NT/2000 service, it runs in an account called 'LocalSystem'. This
account can have different settings from a normal user's account. So you may be able to see the
dial-up connection when you look in the Network settings in Windows 2000 because that dial-up
connection is associated with your account, but VPOP3 can't see the dial-up connection because
it is not associated with the LocalSystem account.

Usually manually created dial-up networking connections are defined for 'All Users', but you 
may have defined a connection to be associated only with the current user. For VPOP3 to be able 
to see the dial-up connection when running as an NT/2000 service it needs to be defined for 
'All Users'.
Solutions

If you define the connection manually again, ensuring that you choose 'Make available 
to all users' if that option is available, the connection should become visible to VPOP3. If
the connection is created using an automated ISP configuration CD then it may be made visible to
only the currently logged in user.

Alternatively, you can manually copy the RAS Phonebook from the currently logged in user to the 
'All Users' settings - you may need to be logged into Windows 2000 as an administrator to do this,
and you should only do this operation if you are technically competent.

 Open the <B>C:\Documents And Settings\\Application Data\Microsoft\Network\Connections\Pbk</B>
folder on your hard disk
 Open the <B>rasphone.pbk</B> file in Notepad
  Open the <B>C:\Documents And Settings\All Users\Application
Data\Microsoft\Network\Connections\Pbk</B>
folder.
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 Open the <B>rasphone.pbk</B> file in that directory in another copy of Notepad
 Copy the settings from the first <B>rasphone.pbk</B> file to the second <B>rasphone.pbk</B>
file
 Save the second <B>rasphone.pbk</B> file

RAS Error 623 - Cannot find Phonebook entry

If you get an error 623 - Cannot find Phonebook Entry when VPOP3 tries to dial out there are two
possible reasons:



    The Dial-up Connection entry specified on the VPOP3 External Mail ->Connections page (or
Connections Tab prior to 2.0.0) is set to an invalid entry and needs correcting (this can often happen
if VPOP3 is moved to a new PC, or if you change ISP) 

    VPOP3 is running as an NT/2000/XP/2003 service but you configured it when it was running as a
normal application. Services use the 'system phonebook', but applications can use either the current
user's phonebook or the system phonebook. So, if VPOP3 was configured when it was running as an
application, it may have an entry from the user's own phonebook rather than a system phonebook
entry. 




This article explains how to make users' entries available in the system phonebook.


 


Keywords: error623

RAS Error 629 - port disconnected by the remote machine

RAS error 629 means that VPOP3 was trying to connect to the Internet, but,
as it was connecting, the connection was dropped by the remote end (usually the ISP).

In most cases this means that the dial-up login details were incorrect (on the <B>Connection</B>
tab.

Check the details are entered correctly in VPOP3, and check with your ISP that you are using
the correct details.

If you think you are using the correct details, try using the Dial-up Networking connection 
manually (from the 'My Computer' icon) and enter the username and password there to see if that
works.
If you are still having problems with this, contact the ISP for help as the problem is probably
in your Dial-up Networking connection settings.

RAS Error 638 - Timed Out
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Error 638 is a dial-up connection (RAS) error meaning that when VPOP3 tried to dial up the ISP, it 
failed to establish a connection with the ISP's server within the specified time limit.

This can happen for several reasons:

  The modems/dial-up server simply take a long time to finish setting up the connection. 
In this case, on the 'Connection' tab in VPOP3, increase the 'Timeout' value - 2 or 3 minutes is 
usually the maximum you would ever need if this is the problem.
  There is an ISP problem which means that their dial-up server is never going to finish setting
up the connection. Usually (but not always) this is an intermittent problem as it may just be a 
faulty server which you will only dial into occasionally as their servers are used on a round-robin
basis. You need to contact the ISP as they may need more information to isolate the problem and 
fix it.
  The dial-up connection on your PC is incorrectly configured so it's not compatible with the
ISP's required settings. Usually this is a persistent problem, and you need to talk to the ISP to
go through the dial-up connection settings.

RAS not available since installing Windows 2000 SP4, Windows XP SP2 or
Windows 2003

After installing Windows 2000 SP4, Windows XP SP2 or Windows 2003 on the VPOP3 computer,
VPOP3 cannot use RAS (Dial-up Networking) to connect any more.


This happens because the method that VPOP3 1.5.0f and earlier use to detect the availability of RAS
on a computer do not work in these latest versions of Windows. The problem has been fixed in
VPOP3 1.5.0g and later (all VPOP3 V2.x versions do not have this problem).


You can download the latest version of VPOP3 Standard 1.5.0 here, or VPOP3 Enterprise 1.5.0 here.
This is a free upgrade for all registered users of VPOP3

RNAAPP.EXE hangs

One user has reported that "RNAAPP" hangs.

After further investigation the user found that the problem was caused by the 'Auto-Protect' feature
of 
Norton Antivirus 2000. Excluding RNAAPP.EXE from the files which Norton Antivirus 2000 scanned
solved
the problem.

More Info: <B>RNAAPP</B> is a Windows component which controls Dial-up Networking.

Running VPOP3 on Linux using VMWare
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VPOP3 will run on Linux if you use the VMWare for Linux
emulator software.

To work under VMWare, VPOP3 has to slightly change its behaviour to keep VMWare happy. To 
do this, it needs to know whether it is working with VMWare or not. To do this, it will try
to run a program called <B>CheckVM.EXE</B> which should come with VMWare. This needs to be
located in the same directory as <B>VPOP3.EXE</B>

Running VPOP3 on Windows 2000 or Windows 2003 Server

When you run VPOP3 on Windows 2000 or Windows 2003 Server you may receive an error saying

LDAP server not started - couldn't bind socket port 389 (10048)

    

This error happens because VPOP3 contains an LDAP (Lightweight Directory Access Protocol) server
for its global address book functionality, and the Windows 2000/2003 'Active Directory Service' also
uses LDAP as its mechanism. These two services are conflicting. 

    

The solution is to either remove the VPOP3 LDAP service or move it to a different port number. 

    VPOP3 2.0.0 and later

    

        To remove the VPOP3 LDAP service, go to the Services page in the VPOP3 settings, and
remove the tick in the Enable checkbox on the LDAP Server line. NB - This will stop the VPOP3
Global Address book from working. 

        To move the VPOP3 LDAP service to a different port, go to the Services page in the VPOP3
settings, and in the Port column on the LDAP Server line, change the number to something like
1389 (it should be greater than 1000 and mustn't conflict with any other TCP/IP service, we
generally find that adding 1000 to the standard port number is the easiest to remember). 

    

    VPOP3 1.5.0 and earlier

    

        To remove the VPOP3 LDAP service, go to the Local Servers tab in VPOP3, and remove the
tick in the Enable checkbox on the LDAP Server line. NB - This will stop the VPOP3 Global Address
book from working. 

        To move the VPOP3 LDAP service to a different port, go to the Local Servers tab in VPOP3,
and in the Port column on the LDAP Server line, change the number to something like 1389 (it
should be greater than 1000 and mustn't conflict with any other TCP/IP service, we generally find
that adding 1000 to the standard port number is the easiest to remember). 

    

    After any of these changes you will have to restart the VPOP3 software.

    

If you move the VPOP3 LDAP service, you will have to tell all your email clients that are using the
VPOP3 Global Address Book to use the new port number. This is done in the email client settings,
and depends on the particular email client you are using. In general look for something called
Directory Service or LDAP Service.

    SMTP Server conflict

    

You may also get a similar 10048 error referring to the VPOP3 SMTP server, or you may get unusual
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errors when sending messages to the VPOP3 SMTP service. In this case, it may be due to the
Microsoft 'Simple Mail Transfer Protocol' service running. 

    

Usually the best thing to do in this situation is to disable to Microsoft service - go to Control Panel ->
Administrative Tools -> Services, and stop and disable the 'Simple Mail Transfer Protocol' service (or
the 'Microsoft Simple Mail Transfer Protocol' service), then restart VPOP3.

Running VPOP3 on Windows Vista

VPOP3 2.5 and later


When VPOP3 2.5.0 is released, that will work without any problems on Windows Vista.


The only difference from running it on other versions of Windows is that the Start -> Programs ->
VPOP3 -> VPOP3 Emergency Server Settings option will cause the VPOP3 service to be shut down
before starting - this is due to a new security feature in Windows Vista.

VPOP3 2.0-2.4


These will work in normal operation without any problems on Windows Vista. 


The only problem is that you should not go to Start -> Programs -> VPOP3 -> VPOP3 Emergency
Server Settings whilst VPOP3 is running as a service. If you do try this, it may appear to work (or it
may show some warnings, and then appear to work), but it will not be working correctly. You need to
stop the VPOP3 service first before entering the Emergency Server Settings

VPOP3 1.5 and earlier


These versions of VPOP3 will not run on Windows Vista if you want to run VPOP3 as a service.
Windows Vista does not allow services to directly show windows to the user, and VPOP3 1.5 and
earlier rely on this feature of earlier versions of Windows.


You can run VPOP3 1.5.0m as an application without problems on Windows Vista, but if you want to
run VPOP3 as a service you need to upgrade to a 2.x version of VPOP3 which has a different method
of accessing the settings, which works correctly on Windows Vista.

Sender Domain Must Resolve

If you receive an 'SMTP Client Error' something like:
451 (user@domain.com) Sender Domain Must Resolve
this means that the ISP's mail server cannot find the domain.com part of the email address.

Often this means that the <B>FROM</B> address of the message is invalid, or that the <B>Default
Domain</B>
(or <B>Domain To Add To Unqualified Addresses</B>) on the <B>Local Mail</B> tab in VPOP3 is
incorrect. This 
setting should always be a valid Internet email domain.
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Occasionally this can happen if you have just registered a new domain (or moved the domain to a
new ISP) as
the DNS entries for the domain can take a while to propagate to all DNS servers, so the mail server
may be
talking to a DNS server which doesn't recognise the name yet - in this case waiting a few hours may
cause the
problem to rectify itself automatically.

If you know that the FROM addresses you are using are correct, try contacting the ISP to get them to
check
their settings - it is not unknown for their servers to be set up incorrectly. 

Sending mail from different domains/users through different ISP SMTP
relay servers

A few ISPs restrict which email addresses can send mail through their mail servers, even for
legitimate users. In this case you may have several different ISP SMTP relay servers which you want
VPOP3 to send mail through, with different mail going through different servers. This is a relatively
unusual situation, as most ISPs will allow legitimate users to send any mail through their servers at
all.


If your ISP does have this restriction, then you need to create multiple Connection/Out Mail methods
in VPOP3, and use Domain Filtering to tell VPOP3 which messages to send through which Out Mail
method.


To create extra Connection/Out Mail methods in VPOP3:



    Log into the VPOP3 settings

    Go to External Mail -> Connection

    Press the New button

    On the first page - enter the details relevant for your Internet connection, make sure that Use with
Main Schedule is checked

    On the second and third pages - enter details as appropriate (usually you leave them all blank or
at their defaults)

    On the fourth page, choose 'SMTP Relay'

    On the fifth page enter the ISP's SMTP relay server address (and authentication details if
necessary)




Do the above for each ISP's mail server you need to use. Note that VPOP3 has a limit of 10
Connection/Out Mail methods


Now, in the VPOP3 settings, go to External Mail -> Out Mail and choose each Out Mail method in
turn. For each Out Mail method, in the Domain Filtering box, enter something like:




From: *@domain1.com
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This tells VPOP3 that this Out Mail method can be used for sending mail from
anyone@domain1.com, but not for mail from anyone else.


Enter the appropriate domain filter settings for each Out Mail method, so that VPOP3 knows which
mail can be sent through each Out Mail method.


Now, when VPOP3 connects, it will send the appropriate mail through each ISP SMTP relay server in
turn.


 

Setting up a user to access mail using IMAP4

The IMAP4 protocol is supported in VPOP3 Enterprise as an alternative to the POP3 protocol (VPOP3
Standard only supports POP3 & WebMail for collecting mail)


Any user can collect mail from their mailbox using IMAP4, simply by using an IMAP4 compatible
email client, and telling that client to use IMAP4 instead of POP3. The exact mechanism to do this
varies depending on the email client you are using, but it is usually straightforward.


For instance, in Outlook Express, whilst adding a new email account, there is a box which lets you
say 'My incoming mail server is an IMAP4 server':


<img height="414" src="/Image/oeimap4.png" width="503" alt=""/>


In Opera, when you are creating a new account, you can choose between IMAP4 or POP3:


<img height="417" src="/Image/operaimap4.png" width="461" alt=""/>


It is usually similarly easy in other IMAP4 compatible email clients to specify that you wish to use
IMAP4 to collect mail.

Setting up FAXmaker to work with VPOP3

	Create a <B>mailbox</B> in VPOP3 called <B>FAX</B>
	Tell FAXmaker that the 'Mail Server' is the IP address of VPOP3, and tell FAXmaker to
		look in the <B>FAX</B> mailbox for messages

In VPOP3 V1.2.0

	Run <B>RegEdit</B>
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	Find <B>HKEY_LOCAL_MACHINE\SOFTWARE\PaulSmith\VPOP3</B>
	Add a <B>String</B> registry value called <B>FaxServer</B> and set it to <B>FAX</B>

In VPOP3 V1.2.5 or later

	Go to the <B>Diagnostics</B> page
	Press the <B>Tuning</B> button
	In the 'Fax Server Mailbox' list choose <B>FAX</B>

	

	If you want to use the faxnumber@your.domain.com addressing method to send faxes from your
email
	client software you will need to do the following:
	
		Stop FAXmaker
		Open the registry editor 'regedit.exe'.
		Select the key <B>HKEY_LOCAL_MACHINE\SOFTWARE\GFI FAX & VOICE\INTRANET\</B>
		Add a 'DWORD' entry named <B>aliasatserver</B> and set it to <B>1</B> (one)
		Close the registry editor
		Restart FAXmaker
	

Setting up multiple users to share a single IMAP4 email account

(The following applies to VPOP3 Enterprise only)


There are two ways to set up multiple users to share a single IMAP4 email account.

Log onto the account directly


The simplest way is to simply have both users log onto the same account, as if it were their account.



The article Setting up a user to access mail using IMAP4 explains how to set up users' email clients
to collect mail using IMAP4. The IMAP4 protocol lets several users access the same account at once
(unlike POP3 which limits it to one user at once).


Most IMAP4 email clients allow the user to log on to several IMAP4 accounts at once (and usually
POP3 accounts at the same time). The IMAP4 mail folder tree is usually shown separately in the
email client so you can tell which messages are in which folders in which IMAP4 account.


Using this method, all the users who access the account have full access to the account, as VPOP3
cannot see any difference between the people accessing the account, since they are all logging on
using the same login details

Use IMAP4 folder sharing
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This method gives more control, as you can specify which mail folders are shared with which other
users, and what the other users can do (eg can they read messages, but not delete them), and the
other users log on as themselves, so they don't need to know the login details for other users. The
shared folders are visible to the sharing user within a special part of their mail folder tree.


To do this, you need to set access controls on the folders you wish to share. A few email clients
support IMAP4 Access Control Lists (ACL) directly, but the most popular ones do not, so you need to
manage the access controls from within VPOP3's WebMail facility. 


Log into the account you wish to share in VPOP3's WebMail, then click on 'Manage Folders' at the left
of the WebMail page. This will give you a list of the folders, with options for the folders, click on Set
Folder Sharing. 


<img height="396" src="/Image/foldershare.png" width="768" border="1" alt=""/>


Then, on the Set Folder Sharing page, you can add users or groups who can share the folder by
choosing them from the drop down list (1) and pressing Add User/Group. Then, you can specify
which actions that user/group can perform on the folder by selecting the appropriate checkboxes
(2).


You can do this for as many users as you wish.


Then, in the email client for the users who are sharing the other user's folder, they will see a new
tree in their folder list, starting with #users/, and containing this user's shared folders.


 

Should we use SMTP Direct or SMTP Relay for sending mail

VPOP3 has two options for sending mail, "SMTP Direct" or "SMTP Relay". Sometimes people are
confused by which version to use.





In general, most people should use "SMTP Relay" method. This requires you to tell VPOP3 the name
of your ISP's SMTP server, and VPOP3 will send outgoing mail to there, and the ISP's server will send
it on to its destination. This is usually by far the most reliable method.





In some cases, you cannot use SMTP Relay for some reason. This is usually because you have a
leased line or leased "dedicated"/cohosted server and there is no SMTP relay service available to
you. In this case, use "SMTP Direct" and VPOP3 will send the message directly to the recipient's mail
server.





Some people see that "SMTP Direct" will send messages directly to the recipient's mail server rather
than going through their ISP, and think that "SMTP Direct" is better because of this. In an ideal world,

105 of 223Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



that would be the case. However, many recipient ISPs will block mail coming directly from a
computer unless it meets certain requirements. These ISPs will often not tell you what the
requirements are, so it can be difficult to make "SMTP Direct" work reliably with all recipients,
because the recipients will block your mail.





Also, some ISPs will block you from sending mail directly without going through their servers. These
restrictions are there because lots of PCs have 'spambots' on them to send out spam directly from
home users' PCs without the owners knowledge, so restricting them can cut down on spam.





Some common things that recipient ISPs check for are:


- reverse DNS entry on your mail server's IP address


- the public IP address of VPOP3 must not be associated with a dial-up, cable or xDSL connection





The first of these can always be fixed as long as you have a static IP address on the Internet, but the
second is harder to fix. Some ISPs publish their dial-up/xDSL IP address ranges, and some don't, but,
in general, if you have this sort of connection, you are likely to encounter with problems. People with
leased lines or cohosted servers will not have this problem, and so they will be OK using "SMTP
Direct"





If your ISP's relay server is unreliable or has too many restrictions on it, you should consider
changing ISP - if enough people change, they will fix their servers. Alternatively, you can pay extra
for a third party relay server. "authsmtp.com" have such a service, and we do as well. Contact us for
more details if you wish to use this.








In summary, if your ISP gives you an 'SMTP server address', use that with the "SMTP Relay" setting
in VPOP3, otherwise consider using "SMTP Direct".

SMTP Authentication

Some ISP's require password authentication before allowing access to their SMTP servers.  This
means that you won't be able to send mail via their servers, until you have authentication properly.
There are 2 kinds of SMTP Authentication...

Plain text Authentication    
Encrypted Authentication

 

The first of these <I><B>is supported</B></I> by VPOP3. If your ISP requires this, you can go to
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the Out Mail page in VPOP3, where you will see an "Authentication" button. From here you can enter
your SMTP user ID and password for authentication.
 

The second of these (encrypted authentication) <I><B>is not currently supported</B></I> by
VPOP3 in current versions. An example of a ISP using encrypted SMTP Authentication are the
Microsoft MSN servers. (we hope to support the new MSN authentication method in future when
Microsoft document the methods required)
 

If you are getting problems using SMTP Authentication in VPOP3, please make sure that you are
using the latest version of VPOP3. Versions of VPOP3 before v1.4.6 used the original SMTP
authentication draft standard. Current versions of VPOP3 use the newer version of the proposed
authentication standard (they will also work with servers which still use the original standard).
 

SMTP Direct sending fails to Yahoo, AOL, and other email addresses

If you configure VPOP3 to send using SMTP Direct, it may fail to send messages to certain ISPs, eg
Yahoo, AOL, and others.

This happens because those ISPs use databases of 'dynamic IP addresses' which other ISPs have
registered, and refuse to accept mail coming directly from those IP addresses.

This is done as an anti-spam protection method, because, in theory, the only people who should be 
sending mail directly to AOL/Yahoo/etcs mail servers should be other ISPs, or organisations with 
their own permanently connected mail servers (who must, by definition have fixed IP addresses)

Unfortunately, the only solution is to use the SMTP relay servers provided by your ISP, or you
may be able to ask your ISP for a static IP address, or an address which is not listed on the
dynamic IP address databases used by these other ISPs

SMTP Direct sending hangs in some cases

There is a known problem in VPOP3 1.4.0 and 1.4.1 beta which can cause VPOP3 to stop sending 
outgoing mail through an 'SMTP Direct' Out Mail method in certain circumstances.

This problem will be fixed in 1.4.2 beta and later, but there is a workaround in current versions
as below:
Workaround in VPOP3 1.4.0 and 1.4.1 beta

Close VPOP3
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Using REGEDIT find <I>HKEY_LOCAL_MACHINE\Software\PaulSmith\VPOP3\Secret</I>
Set <I>UseESMTP</I> to <B>0</B> (zero)
Restart VPOP3

Description of problem
The problem only occurs if two conditions are met:

The recipient's email server doesn't support ESMTP (Enhanced SMTP), or the recommended way of
VPOP3 determining that it doesn't support it, so VPOP3 has to disconnect and try again
The recipient's primary email server is not working, so VPOP3 has to try to use the secondary 
email server

In these situations VPOP3 gets stuck in a loop retrying the recipient's primary email server.

SMTP Error "500 5.3.3 Unrecognised command"

If you get an error '500 5.3.3 Unrecognised command' when trying to send messages through
VPOP3's WebMail, this usually means that you have another SMTP mail server running on the VPOP3
computer.


VPOP3's WebMail uses some private commands when sending messages. These commands are
recognised by VPOP3's SMTP server, but not by other SMTP servers.


Often the reason for the problem is that you are running the Microsoft SMTP server on the same
computer as VPOP3, so VPOP3's SMTP service is not able to start up correctly. This means that the
VPOP3 WebMail component will actually try to send the outgoing message through Microsoft's SMTP
server, with this error resulting.


In Windows, go to Control Panel -> Administrative Tools -> Services, and stop & disable the
'Microsoft SMTP Service' (also sometimes called 'Simple Mail Transfer Service' or 'Microsoft Simple
Mail Transfer' or other similar names). Then, restart VPOP3 and the problem should go away.


 


Keywords: SMFV Error2a


 

SMTP Error "552 Message too large - contact your
administrator"

If you get an error 552 Message too large - contact your administrator as soon as you try to
send a message to VPOP3, then it means that the size limit in VPOP3 is set smaller than the size of
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the message you are trying to send. 


There are two places this size limit can be set: 



    On the Services -> SMTP page, check the Maximum Message Size. The default limit is about
20MB 

    On the Edit User -> Permissions page for the person sending the message, check the Max
Internet Outgoing Size (a value of 0 (zero) means there is no limit here) 



Other Information

If you get the error message emailed to you when VPOP3 tries to send a message to the ISP's email
server, then it may be that the ISP has set a size limit itself (often ISPs will set a size limit of 5MB). In
this case you can either try to get the ISP to increase their limit for you, or send a smaller message.


To send a smaller message: 



    if you are sending several attachments, try sending them one at a time instead of all attached to
one message 

    try using WinZip to compress the attachments before sending them 




Also note that the size of an attachment in an email is typically 33% larger than the file size of the
attachment on the disk. This is because binary attachments have to be encoded using a system
called BASE64 into printable characters before they can be put into an email.

In VPOP3 1.5.0 and earlier


In VPOP3 1.5.0 and earlier the settings are the same, but they are in slightly different locations.



    On the Local Services tab, click 'Configure' on the 'SMTP' line 

    The individual maximum message size for each user is set on the main 'Edit User' window 


SMTP Error '553'

As of the time of writing, VPOP3 never generates an SMTP error 553. If you are getting an error
message from VPOP3 about an error 553, it is because your ISP is reporting the error to VPOP3 and
VPOP3 is just passing the message back to you.


The message text following the 553 error (or in the Message Delivery Report in the bounce
message) may give more information about the meaning of the error, or you may need to contact
your ISP for more details.


All the SMTP Standard (RFC 2821) says about error 553 is:




553 Requested action not taken: mailbox name not allowed (e.g., mailbox syntax incorrect)
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Keywords: Error553

SMTP Error 421

SMTP error 421 is an SMTP error meaning that the SMTP service is not currently available, but the
client should try again later.


VPOP3 currently can issue 4 different 421 error codes:



    421 VPOP3 SMTP Server too busy - try later - this happens if the maximum number of concurrent
SMTP connections (specified on the VPOP3 Services -> SMTP page) is exceeded. This limit only
applies to incoming SMTP connections (not connections from local users). Note that increasing this
limit too high can cause VPOP3 to be overloaded (especially if it is doing any content filtering, such
as spam filtering), so it should be increased gradually, while checking that the CPU load does not
become excessive.


    

    421 4.3.2 VPOP3 SMTP Server access disabled - content scanner problem - this happens if an
integrated virus scanner has reported a fatal error and cannot scan email attachments. VPOP3 will
refuse to accept any further messages until this is fixed. Restarting VPOP3 will usually reset the virus
scanner

    421 4.3.2 VPOP3 SMTP Server access not allowed - see your administrator - this happens if VPOP3
has encountered a problem at startup, and the administrator needs to fix it. Usually if the
administrator logs into the VPOP3 Web Administration settings, VPOP3 will give them more details of
the problem.

    421 4.3.2 VPOP3 SMTP Server refusing connection - this happens if the HELO string passed by the
client matches the Refuse Connections From setting in the Services -> SMTP settings page.




Any other 421 errors you see probably originate from the ISP's SMTP server, so you should contact
the ISP. 


 

SMTP Error 428

As of the time of writing, VPOP3 never generates an SMTP error 428. If you are getting an error
message from VPOP3 about an error 428, it is because your ISP is reporting the error to VPOP3 and
VPOP3 is just passing the message back to you.


The message text following the 428 error (or in the Message Delivery Report in the bounce
message) may give more information about the meaning of the error, or you may need to contact
your ISP for more details.


The SMTP Standard (RFC 2821) doesn't have any suggested meanings for error 428, so all we can
tell is that it should be a transient error (the 4xx meaning) relating to 'the transmission channel' 
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(the x2x meaning)


For further information you should contact the ISP.


 


Keywords: error428 

SMTP Error 554

As of the time of writing, VPOP3 never generates an SMTP error 554. If you are getting an error
message from VPOP3 about an error 554, it is because your ISP is reporting the error to VPOP3 and
VPOP3 is just passing the message back to you.


The message text following the 554 error (or in the Message Delivery Report in the bounce
message) may give more information about the meaning of the error, or you may need to contact
your ISP for more details.


All the SMTP Standard (RFC 2821) says about error 554 is:




554 Transaction failed (Or, in the case of a connection-opening


    response, "No SMTP service here")



 

Keywords: Error554

SMTP Relay Protection in VPOP3

SMTP Relay Protection should be used on ALL SMTP mail servers (such as VPOP3) which have a
permanent connection to the Internet. You may also want to use it on servers which are only
connected occasionally via a dial-up connection.


SMTP Relay Protection is needed because junk emailer's (SPAMMERS) often do network scans
looking for unprotected mail servers and then use those to send their junk email out to other people
on the Internet - so they are using your mail server without your permission. 


There are several ways of protecting VPOP3 against this type of abuse. In general the best way is to
make VPOP3 check the IP address of the computer which is connecting to it against a list of allowed
addresses. If the connecting computer is an allowed one, VPOP3 will let it send local or outgoing
mail, otherwise it will just allow it to send mail to local users (this is needed for incoming SMTP
connections). 

To protect VPOP3 2.0.0 and later

On the Services page, click on SMTP Server From the SMTP Anti-Relay Protection list choose
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Check Client IP Address. Then, in the 'Access Restrictions' box, enter the TCP/IP addresses you
want to be able to send outgoing mail. For instance, to allow computers in the TCP/IP subnet
192.168.1.0 with subnet mask 255.255.255.0, add a line

192.168.1.0 255.255.255.0 

    Note: If you have a proxy server between the Internet and VPOP3, this should be EXCLUDED from
the access restrictions range allowed by VPOP3, eg if the proxy server is 192.168.1.100, add a line

    !192.168.1.100 255.255.255.255 

        If you don't do this, any incoming connections through the proxy server will be allowed,
regardless of where the user's computer is - this is because all these connections will appear to be
coming from the proxy server's IP address.

        To protect VPOP3 1.3.3 to 1.5.0

        On the Local Servers tab, press Configure on the 'SMTP Server' line. Then, follow the
instructions above as for VPOP3 2.0.0 and later.

        To test the relay protection

        Go here to test the VPOP3 relay protection settings. This site is run by abuse.net who run the
'Network Abuse Clearinghouse'

Socket Error 10047 - Addresses in the specified family cannot be used
with this socket

This error only normally occurs during VPOP3 startup.


There are two main possible reasons for this error: 



    TCP/IP networking is not configured correctly on the PC which VPOP3 is running on. Check the
TCP/IP configuration.


    You may need to remove and reinstall TCP/IP networking. 

    On the Services page in the VPOP3 settings, you have an invalid address in the IP Address to
bind to: entries. (In VPOP3 1.5.0 and earlier, this is the 'Allow Connections On:' setting on the Local
Servers page)




 


Keywords: 10047

Socket Error 10048 - Specified Address Already in Use

This error only normally occurs during VPOP3 startup. It occurs if some other software is providing
an SMTP or POP3 mail service on the same computer as VPOP3 is running on. This could be a proxy
like WinGate or WinProxy, or another mail server program (eg Exchange Server).


To prevent this problem you should either remove the conflicting service from the other software or
change the 'Port' which either that other software or VPOP3 uses for that mail service (see the
Services page in VPOP3 (or Local Servers in VPOP3 1.x) to change the Port allocations in VPOP3) 


There are two ways to find out which program is using the appropriate port number. Each provides
different evidence so if the results of one method are unclear try the other.
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Firstly, open a Command Prompt prompt. This is generally available from Start; Programs;
Accessories on NT/2000/XP/2003 systems or, alternatively just Start; Programs on Win9x/ME. At the
prompt type in the following:

TELNET  

    e.g.

    TELNET 192.168.1.1 110

        

The response you get back should indicate the name of the program currently using the port.

        

The alternative is to use a free tool called TCPView from SysInternals.com which lists all the ports
currently in use for both TCP and UDP along with which programs are using them.

        

Keywords: 10048

Socket Error 10049 - The specified address is not available from the local
computer

This error normally means that you have entered an invalid address on the IP Address to Bind To
entries on the Services page in the VPOP3 settings. (Or the Allow Connections On: entries in the
Local Servers page in VPOP3 1.x).


The addresses entered here should be either  or the IP address of a LAN adapter the PC running
VPOP3.


Alternatively, this can be caused by timing issues related to a DNS lookup. On the Diagnostics tab
in VPOP3, press the TCP/IP Tuning Options button and tick Use Synchronous DNS


 


Keywords: 10049

Socket Error 10051 - Network is Unreachable

Socket Error 10051 means that the destination network is unreachable.


This error means that your router has returned a 'host unreachable' ICMP packet when the
connection was attempted.


Usually this means that either:



    Your Internet connection is down, so the router knows that there is no way to send data to the
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target computer 

    The router is misconfigured, so that it doesn't believe it can communicate with the target
computer 

    A router or firewall is blocking the VPOP3 computer from connecting to the target computer 

    Windows is misconfigured to communicate with the wrong router (only if you have two or more
routers) 




This error will not occur if Windows is not configured to talk to a router at all, that would give a
10065 error instead


 


Keywords: error10051


 

Socket Error 10053 - An established connection was aborted by the
software in your host machine.

Error 10053 means that an established connection has been dropped.


There are three descriptions of this error message we know about, but the descriptions are given by
Windows, so they may vary depending on your version of Windows:



    An established connection was aborted by the software in your host machine. 

    The TCP/IP Connection was aborted by Windows. This was possibly due to a data transmission
timeout or protocol error. 

    The virtual circuit was terminated due to a time-out or other failure. The application should close
the socket as it is no longer usable.




In the first of these, the \'software in your host machine\' that is referred to is actually \'Winsock\' -
the TCP/IP component of Windows, not VPOP3. The \'protocol error\' referred to in the second text is
the TCP protocol, not POP3 or SMTP, etc protocol.


10053 errors are actually quite rare usually, but there are a couple of cases we know of which can
cause them:


- if the 10053 error is being reported by your email client or by VPOP3 when downloading and/or
sending email, it could be a problem with your antivirus software. Both McAfee VirusScan 8 and
Norton Antivirus 2004 have been found to give these errors sometimes, but other virus scanners or
versions may also cause these errors. See below for more information.


- if the 10053 error is reported in the VPOP3 Status Monitor program, then this usually means that
the VPOP3 server has stopped for some reason. It may be that it was stopped by someone else, or it
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may have failed with an application error.


- some early releases of version 2 of vPOP3 use the recycle bin quite extensively. Windows is
sometimes unable to deal with these requests and this can result in 10053 errors. To eliminate this
as a possible cause of 10053 errors, ensure you are running at least version 2.5.0b of vPOP3.

More information



    10053 errors with McAfee VirusScan 8 

    10053 errors with Norton Antivirus 2004
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Socket Error 10054 - The virtual circuit was reset by the remote end

Error 10054 means that the connection between VPOP3 and a remote computer (eg the ISP or
another computer on your LAN) was disconnected by something outside of VPOP3.


This could mean that the remote computer itself decided to drop the connection abruptly, or that the
dial-up connection failed unexpectedly (or that the user dropped the dial-up connection manually) 


A common cause of error 10054 can happen if you are using a proxy server (eg VSOCKS or
WinProxy) on the same computer as VPOP3, but VPOP3 is not connecting to the Internet through the
proxy server. The proxy server will not know if VPOP3 is still using a dial-up connection that the
proxy server started, so it may decide to hang up the connection whilst VPOP3 is in the middle of
downloading or sending messages. The way to fix this problem is to make VPOP3 connect to the
Internet by using the proxy server rather than connecting directly. 


See also Problems downloading/Uploading messages with attachments 


Keywords: 10054

Socket Error 10055 - No buffer space is available

Error 10055 means that Windows has run out of TCP/IP socket buffers because too many
connections are open at once.

Things to check if this happens are:

 Is there any other TCP/IP software running on the same PC as VPOP3 - eg a proxy server
 If you are using 'MX Sending' (on the Out Mail tab in VPOP3), then we recommend that you use
the latest version of VPOP3 (1.4.0c or later)
 If VPOP3 is running on Windows 95, make sure you have the kernel updates which fixed a resource
problem which could cause this error
 If you have a lot of client computers connecting to VPOP3 either make them connect less frequently,
or make sure you are running VPOP3 on Windows NT or 2000 as that has less of a limit on the
number of
available buffers.
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We now also believe that the W32/QAZ trojan horse program may be responsible for causing 10055
errors.

We have seen the W32/QAZ trojan horse on several computers which were exhibiting this problem. 
Also 10055 errors which weren't related to the above problems have been infrequently reported 
and only since the last half of 2000 - the W32/QAZ trojan horse was first noticed in August 2000.

The W32/QAZ trojan horse replaces NOTEPAD.EXE with its own version, and will try to send emails
to a remote user. If this email attempt fails it appears that the socket buffers are not cleaned up
correctly afterwards, causing the 10055 errors later.

Most current email scanners should be able to find the W32/QAZ trojan horse. The trojan can also 
be detected by using REGEDIT to look in the registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run

for a string value of:

startIE   "notepad qazwsx.hsq"

For more information on the W32/QAZ trojan you can look at virus scanner developers' websites, eg

 Symantec
 McAfee
 Sophos

Socket Error 10060 - Operation Timed Out

This error is quite self explanatory. It means that Windows reported that a connection attempt or
idle connection timed out.


If this error occurs during a connection attempt (eg in a VPOP3 - SMTP Client connection problem
error message), then it means that Windows couldn't connect to the ISP mail server within a fixed
time (the timeout limit is fixed within Windows itself). This problem can either mean that your ISP is
having a problem, that you are connecting through a slow proxy (in this case, try increasing the
Utilities -> Misc Settings -> Network Tweaks, "Connect Attempt Count" or "Connect Retry Time"
settings - these are at Diagnostics -> Tuning in VPOP3 1.x), or that your Dial-up connection is faulty.



If this error occurs whilst a connection is in progress (eg in a VPOP3 - POP3 Client Problem error
message), then it means that the connection was idle for a set time - this set time can be changed
on the Utilities -> Misc Settings -> Network Tweaks page in the VPOP3 settings (or the Diagnostics -
> TCP/IP Tuning window in VPOP3 1.x)
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See also Problems downloading/Uploading messages with attachments 
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Socket Error 10061 - The attempt to connect was forcefully rejected

Error 10061 means that the computer which VPOP3 was trying to connect to (probably at your ISP)
refused the connection from the computer running VPOP3.


There are several possibilities that can cause error 10061: 



    The mail server you are trying to connect to is not running a mail service on the appropriate port.
For instance, if you try to connect to an SMTP server on the POP3 port of 110. 

    The mail server you are trying to connect to is having problems - eg the mail server software is
not running 

    A hardware firewall or router is blocking access to the specified port 

    A software firewall or 'Internet security software', or virus scanning software is blocking access to
the specified port




Keywords: 10061

Socket Error 10502 - Bad SOCKS Result

This means that VPOP3 is connecting to a SOCKS proxy server (possibly our VSOCKS Light, or
possibly 
another proxy server supporting SOCKS) to collect and/or send email, and that SOCKS proxy server
has
had a problem connecting to the ISP's POP3 and/or SMTP mail server.

Unfortunately the SOCKS 4 standard (www.socks.nec.com)
doesn't provide any mechanism for the SOCKS proxy server to tell VPOP3 (or any other SOCKS client)
what the reason for the error was, all it can say is 'connect failed'.

The proxy server may have some logging facility which will allow you to find out the original
cause of the problem - if it reports a 10xxx error, you can check in this knowledgebase, or on
Microsoft's knowledgebase for the reasons for the most common 10xxx error codes.

Socket Error 10503 - No More Data

Error 10503 means that the connection between VPOP3 and a remote computer (normally your ISP)
was dropped at an unexpected time. This is different from the error 10054 in that this is a controlled
line drop.
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One way this can happen is if the ISP's POP3 server uses an obsolete standard which allows it to
drop the connection if a POP3 'LIST' command is performed on an empty mailbox. The current
standard requires that the connection is not dropped until the client (VPOP3 in this case) performs a
QUIT command. 






    

        

            We have established that some ISP POP3 servers using the QPOP 2.53 server software (a
popular Unix/Linux POP3 mail server used by many ISPs), or custom mail server software based on
that software, are closing the connection immediately after a connection from a client computer
without reporting any POP3 error message, causing VPOP3 to generate a 10503 error.

            

This appears to be a load problem on the ISP server, and only happens when the ISP\'s mail server is
very busy. If this happens then subsequent connections may work OK, so it is usually not a critical
problem as mailis still delivered OK (eventually). This problem it is not exclusively happening to
people who use VPOP3 to download from QPOP servers, it also happens with people using other
download software. It may just be more noticeable with VPOP3 because it usually connects many
times a day, and reports the errors in an email message.

            

        

    






See also Problems downloading/Uploading messages with attachments 
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Socket Error 11001 - Host not found (authoritative answer)

This means that the ISP POP3 or SMTP server which you have told VPOP3 to connect to does not
currently exist. This might be that you have mistyped the server address, or that your ISP is having
temporary problems, or that you are using an internal DNS server or proxy which is either slow or
not configured correctly.


The first thing to do is to go to the VPOP3 settings, then External Mail -> In Mail (if the error is a
'POP3 Client Error') or Out Mail (if the error is an 'SMTP Client Error'), and check the server addresses
are correct - contact your ISP if you are not sure.


Also, try PINGing the server addresses from a DOS prompt on the VPOP3 computer - this will show if
Windows on that PC is able to resolve the server names to numeric IP addresses correctly.


If VPOP3 is connecting through a router or proxy server, then the DNS server settings on the VPOP3
computer (in Control Panel -> Network -> TCP/IP) could be set incorrectly as well.
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Also see: VPOP3 reports errors such as "POP3 Client not started - Error 11001"

Socket Error 11002 - Host not found (Non-Authoritative answer)

This means that VPOP3 is not getting a response from a DNS server when it is trying to look up the
name of the
ISP's mail server(s). Usually this means that Windows either does not know the address of a valid
DNS server, or that 
your ISP's DNS servers are not working properly.

If you are connecting to the Internet via a router or proxy server, check that this is either allowing
DNS queries
through or is proxying them properly.

See also:

VPOP3 is running as an NT service and reports errors '11002' when trying to connect
VPOP3 is running behind a proxy server or router and reports errors '11002' when trying to connect

Socket Error 11004 - Valid DNS Name - No data record of requested type

Socket Error 11004 means that the DNS server which VPOP3 is talking to does not have a record of
the appropriate type for the computer name which it was looking up.


DNS supports many different types of data record - 



    'A' records contain the IP address for a particular host name    

    'MX' records contain the mail server for a particular host name/domain name    

    'NS' records contain the DNS servers which hold authoritative information for a particular host
name    

    etc 



An error 11004 can happen if, for instance, VPOP3 does a DNS lookup for a POP3 server at
'myisp.com',  but the DNS server only holds an NS record or an MX record, but not an A record. This
can happen if the DNS server is currently incorrectly configured (check with your ISP, or whoever is
running the DNS server you are using) or because you should be using a different computer name 
(eg 'pop3.myisp.com') which would have an A record defined.


In some cases it can also happen because you are using the incorrect DNS server addresses (eg
using the DNS servers of one ISP when you are dialing into a second ISP.


Another cause is if your ISP has set your mail server address to be, for instance
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mail.yourcompany.com and you have your own internal DNS server (for instance on Windows 2003
server) which hosts the zone yourcompany.com. In that case, VPOP3 will be looking up the
mail.yourcompany.com name on your internal DNS server instead of your ISP's DNS server, so you
will need to manually tell your internal DNS server the correct IP address for the mail hostname.



Some PCs cannot access VPOP3 when VPOP3 is connected to the Internet

This error happens when you have multiple TCP/IP subnets on your network. The computers which
are on different subnets from the VPOP3 computer will not be able to see VPOP3 whilst VPOP3 is
connected to the Internet (through a dial-up connection). Whenever VPOP3 is offline, it will work
correctly.

This error is actually a TCP/IP routing problem rather than a VPOP3 problem. To confirm this, try
using the <B>PING</B> command to contact the VPOP3 computer from a computer experiencing
this problem. The <B>PING</B> will work when the VPOP3 computer is not connected to the
Internet, but not  work when it is.

The fix for this is to correctly set up the TCP/IP routing table on the VPOP3 computer. Simply setting
the TCP/IP <B>Default Gateway</B> setting is not sufficient, because when the computer connects
to the Internet, the ISP will set another <B>Default Gateway</B> which will temporarily override
the one set in the control panel.

The easiest way to explain how to set the routing table is by use of an example. Assume that the
VPOP3 computer is on the TCP/IP subnet 192.168.1.xxx and the other subnet is 192.168.2.xxx. The
router connecting these two subnets has addresses 192.168.1.254 and 192.168.2.254.

On the VPOP3 computer you should go to a DOS prompt and run:
ROUTE ADD 192.168.2.0 MASK 255.255.255.0 192.168.1.254
If VPOP3 is running on a Windows 95/98 computer, you should put this in a batch file and run it from
the <I>Startup</I> group. If VPOP3 is running on Windows NT/2000, you should add a <B>-P</B>
after the ROUTE and before the ADD, to make the setting permanent.

Sophos Virus Scanning button greyed out

If the 'Scan Attachments Using Sophos' option is disabled on the VPOP3 -> Misc -> Attachment 
Processing window, then this means that VPOP3 can't load or initialise SAVI (Sophos AntiVirus 
Interface).

This may mean that SAVI is not installed (eg if you don't have a Sophos AntiVirus licence) or
there could be an error. 

The VPOP3.LOG file contains an entry at startup if there is a problem 
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loading or initialising SAVI. This entry looks like 

  ERROR: Failed to Initialise SAVI [], or
  ERROR: Failed to Load SAVI []

A common Initialisation error code is "0x2004021e". This means that your virus 
definitions are out of date and need to be updated from your monthly Sophos CDs.

Spam Filter Black & White Lists

The VPOP3 SpamFilter (version 2.2.0 and later) has a Whitelist and Blacklist facility which you can
get to in the VPOP3 settings by going to Utilities -> SpamFilter Settings -> White List/Black List.
These lists let you specify the email addresses of message senders who will be automatically
allowed through (Whitelist) or blocked (Blacklist).


By default, VPOP3 will automatically add any recipients of outgoing messages to the Whitelist, but it
will never add any addresses to the Blacklist automatically.


You can specify entries in the lists using three different methods:



    Specify an address explicitly - eg fred@domain.com 

    Specify a set of similar addresses using DOS style wildcards (* and ?) - eg *@domain.com or
fred??@domain.* etc 

    Specify a Perl Compatible Regular expression surrounded by / characters (you can use perl style
expression modifiers (eg 'i' for case insensitivity) after the terminating /) - eg
/fred(dy)?@domain\.com$/i 




Spell Checking with VPOP3 2.2.2 and later WebMail

VPOP3 2.2.2 Beta and later have an integrated spell checker. 


This is activated by pressing the Spell Check Message button whilst composing a message in
WebMail. A new page will appear with the message text in it, with any misspellings highlighted.
Clicking on the misspellings will let you choose from possible correct spellings, or edit the text
manually. Press Finished Spell Checking when you are done, and you will go back to the message
editor with the corrected text.

Configuring the Spell Checker


The Spell Checker can be configured on the Services -> WebMail settings page in the VPOP3
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settings, in the Web Mail Settings section.


You can enable/disable the spell checker there.


You can also specify the dictionaries to use. Currently only English dictionaries are provided, but
other languages may be available in the future, possibly at a small extra charge. You can specify as
many dictionaries as you want, separated by commas. Below are the recommended settings for the
three different English dictionaries provided. (The more dictionaries that VPOP3 uses, the slower the
spell checking will be, and it may give confusing suggestions for misspelled words if you tell it to use
dictionaries in several languages)



    British English - use sscebr.tlx,sscebr2.clx 

    American English - use ssceam.tlx,ssceam2.clx 

    Canadian English - use ssceca.tlx,ssceca2.clx 




The .CLX files are compressed, so cannot be edited, but the .TLX files are plain text, so you can add
extra words if necessary to those.

Spell Checking with VPOP3 WebMail?

VPOP3 WebMail in versions 2.2.1 and earlier does not include any kind of spell checking. However
there is a free tool that you can download from www.iespell.com that can do this for you.


After installing this software, when you 'right-click' on the mouse, there is a new option to "check
spelling". This appears to work quite well, and is easy to use.


IESpell is an Internet Explorer extension, so, besides VPOP3 WebMail, it should work with other web
applications. Currently it can only check spelling in English.


IESpell is free for personal use but should be licenced for commercial use.


Note that PSCS has only carried out basic testing to identify if this product works with VPOP3
WebMail.  We make no recommendation as to it\'s suitability or reliability.


 


See Also: Spell Checking with VPOP3 2.2.2 and later WebMail

Starting VPOP3 FaxServer in 'Debug' mode

(This article only applies to VPOP3 FaxServer 0.3 and earlier)
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To start the VPOP3 Fax Server in debug mode, do the following: 



    Stop VPOP3 

    Stop the fax server - in the task bar tray near where the VPOP3 icon was is a small icon looking
like this: 

. Click on this and select Close 

    Open up a DOS prompt and run FM3032 /d. This will open up a window called FaxMan-3.0 which
is the Fax Server debug window. (you may need to wait a bit after step (2) before doing this) 

    Restart VPOP3 



To log the debug output to file, you can press the Logfile... button on the debug window. You won't
see the debug output on screen at the same time in this case.

Suppressing Error messages from VPOP3

Sometimes you may have a persistent error situation where you are expecting VPOP3 to encounter
errors repeatedly, and you don't want it to tell you every time it encounters the error.  If you are
certain you don't want VPOP3 to tell you every time it encounters the problem there is an
undocumented method in version 2.x, described below, which can reduce the number of most types
of error message.





Note that this may mean that VPOP3 is in an error state for a long time without telling you, as you
have told it not to tell you about the error state.





In the VPOP3 directory is a file called 'ERRORS.DAT'. Whenever VPOP3 encounters a new error which
can be suppressed it will add this to the ERRORS.DAT file.


You can open the ERRORS.DAT file in a text editor such as Notepad (do NOT use a word processor
such as Word!)


Each line in the ERRORS.DAT file defines an error message, and has 5 parts separated by ~
characters





A~B~C~D~E





(A) is the internal In Mail ID which this error message applies to (this is 1 less than the displayed In
Mail number)


(B) is the time before the first time this error will be reported (in seconds)


(C) is the time before the second time this error will be reported (in seconds)
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(D) is the time before subsequent times this error will be reported (in seconds)


(E) is the type of error message, eg a TCP/IP error code, or a POP3 error message





You can change the values of (B), (C) and (D) as appropriate


for instance, the line:





1~600~3600~86400~10060





means that if VPOP3 encounters a 10060 (timeout) error on the second In Mail method (id 1) it will
wait 10 minutes (600 seconds) before reporting the error the first time, a further hour (3600
seconds) before reporting the error the second time and a day between subsequent reports of the
error. 





If the In Mail method ever succeeds, the counter will be reset, so if you have





1~3600~3600~86400~10060





so that the first error will only be reported after an hour, and the connection only works every 50
minutes, you will never receive an indication that there was a problem (other than mail being
'mysteriously' delayed)





You have to restart VPOP3 after making any changes to the ERRORS.DAT file.








We are planning on making a way of setting this through the standard VPOP3 settings in future
versions of VPOP3.

Test article - please ignore

HILIGHT_REPLACE_PLACEHOLDER_0 is a funny word



Hmm, what about directory and Directory and DIRECTORY and this has a span happy

The email client requests a password every time it connects and it doesn't
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seem to work

If your email client (eg Outlook, Outlook Express, Eudora etc) asks you for your email password
every time it connects to VPOP3, but when you enter it, it doesn't work and you are asked for 
your password again, there are several possible reasons:

You have mis-remembered the password.. Reset the password in the Users tab in VPOP3
Your email client is actually talking to a different program, rather than VPOP3. Often this will
be another POP3 mailserver or a proxy server with POP3 support (eg WinProxy). In this case, that
other program won't know the usernames and/or passwords defined in VPOP3, so it will refuse to let
you log in. To find out if this is the case, on the user's computer, open a DOS prompt and type in

"<B>TELNET</B>  <B>110</B>"

eg. "<B>TELNET 192.168.1.1 110</B>".

If you are talking to VPOP3 it will say <B>+OK VPOP3 Server Ready </B>. If you 
are talking to a different program it will say something else, and it may give you a clue as to what
that program is.
Starting in VPOP3 1.5.0, VPOP3 will temporarily lock out an account if it has had incorrect
passwords entered several times in a row (the default setting is that it will lock the account for
30 minutes if 3 incorrect passwords are entered). If you go to the Users tab in VPOP3, the user will
have a padlock icon next to them if this is the case. You can right-click on the user and choose 
<B>Unlock User</B> to release this security lock.
There may be another problem with the mailbox in VPOP3. If this is the case, VPOP3 will be 
reporting the problem back to the email client, but some email clients choose not to show this
information. In this case you will have to turn on <B>Log POP3 Server Connections</B> on the
VPOP3 
<B>Diagnostics</B> tab, try to connect from the email client and look in the POP3SVR.LOG file in
the
VPOP3 directory to see what error is being returned by VPOP3.

The ISP needs POP3 before SMTP authentication

Some ISPs (especially in Germany) require you to log on to collect your POP3 mail before they will
allow you to send any mail through their SMTP relay servers.


VPOP3 actually connects to the POP3 server and SMTP server at the same time, so usually it will
nothave successfully logged onto the ISP\'s POP3 server before it tries to start sending mail.


You can tell VPOP3 to wait until it has finished retrieving mail before starting to send outgoing mail. 

In VPOP3 1.3.0cGo to the Diagnostics -> Tuning window in VPOP3 and turn ON <B>Sequential POP3 -
> SMTP Connection</B>


Also, go to the Misc tab and turn OFF <B>If outgoing mail arrives whilst online, send
immediately</B>

In VPOP3 1.3.5 - v1.5Go to the Diagnostics -> Tuning window in VPOP3 and turn ON <B>POP3 then
SMTP Connection</B>


Also, go to the Schedule -> Advanced window and turn OFF <B>If outgoing mail arrives whilst
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online, send immediately</B>

In VPOP3 2.0 and later


Go to the Utilities page -> Misc. Settings/General  in VPOP3 and turn ON \"POP3 then SMTP
Connection\" and save changes.


Also, go to the External Mail page, Connection Schedule and turn OFF \"If outgoing mail arrives
whilst online, send immediately\"

The VPOP3 Spamfilter whitelist does not appear to work

The VPOP3 spam filter checks incoming messages against a whitelist. If the message sender
matches an entry on the whitelist, the spam filter gives that message a heavy weighting towards not
being spam.


If the whitelist doesn't appear to work, there are several things to check.


First of all, in the message header, there should be a line starting with 'X-VPOP3-Spam'.  This tells
you the results of the spam filter processing, and which spam filter rules matched.


If this line does not exist, then the message is not being processed by the VPOP3 spam filter. Check
that the VPOP3 spam filter is enabled on Utilities -> Spam Filter Settings, and that incoming mail is
arriving through VPOP3


If the X-VPOP3-Spam line contains an entry called 'Whitelist', then check the number in parentheses
after the word 'Whitelist'. This should be a big negative number - usually '-10000'. 




If it is not a big negative number like that, check the Whitelist rule 'weight' on Utilities -> Spam Filter
Settings. The default weight is '-100'


If it is a big negative number, then check that there are no other rules which are counteracting the
whitelist result - eg a blacklist match will often cancel out the whitelist match. If this is the case, then
adjust the rule weightings as appropriate on the Utilities -> Spam Filter Settings page.



If the X-VPOP3-Spam line does not contain an entry called 'Whitelist', then:



Check that the whitelist has the correct entry. VPOP3 checks the 'From:', 'Reply-To:' and 'Return-
Path:' headers against the whitelist, not any headers such as 'X-Originator' etc

By default VPOP3 will not check any 'local' addresses on incoming messages against the whitelist.
This is because often the whitelist will contain local email addresses because of the automatic
addition of recipients to the whitelist, and usually incoming messages will not be sent from local
email addresses. Spammers often pretend to send messages from the recipient's domain to attempt
to get past spam filters which do whitelist local sender email addresses. If you need VPOP3 to check
the whitelist for incoming messages from email addresses on your local domain, go to Utilities ->
Spam Filter Settings, and set the 'CheckLocalWhitelist' setting to '1'
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There are messages on my ISP and VPOP3 sees them, but doesn't
download them

This normally happens because you have told VPOP3 to 'Leave Messages On Server' (on the External
Mail -> In Mail tab). If you do this, VPOP3 will leave messages on the ISP's mail server for several
days, and remember that it has already downloaded them. Then, the next time it connects it will see
that there are some messages waiting, but it may find that it has already downloaded them, so it
won't download them again. 


See also: Making VPOP3 re-download POP3 messages from the ISP for details on re-downloading old
messages.

Further Information


When VPOP3 connects to an ISP POP3 server it asks the ISP's POP3 server for a list of 'Unique IDs' for
the messages. The POP3 standard says that the POP3 server must give each message a unique ID
which is different from all other messages and which has to stay the same between download
sessions.


VPOP3 compares the list of Unique IDs that are on the ISP's POP3 server now, with a list of Unique
IDs for messages which it has previously downloaded, and VPOP3 will only download those
messages whose Unique IDs it has not previously downloaded.


Unfortunately, some ISPs use POP3 server software which has bugs in the Unique ID allocation
routines, so that several messages may be given the same 'Unique ID'. This is a breach of the POP3
standard, and will cause any software which can leave messages on the ISP's server (such as
VPOP3) to believe that it has already downloaded messages which it hasn't.


If you turn on Log POP3 Client Connections on the Logging -> Diagnostics page in the VPOP3
settings, and make VPOP3 connect to the ISP, it will write the conversation between VPOP3 and the
ISP's POP3 server into a file POP3CLT.LOG in the VPOP3 folder on the hard disk. If you view this file
either through the VPOP3 settings or in a text editor like Notepad, you will see VPOP3 send a
command called UIDL ('Unique ID List'), and the ISP will return with a list of numbers followed by the
Unique IDs for those messages. If you see duplicate Unique IDs in that list, then you should report it
to your ISP as a bug with their server, and send them the log file to look at. A decent ISP will be able
to see the problem and investigate.


In this case, the only course of action in VPOP3 is to stop it checking the Unique IDs, and just
download all messages from the ISP and delete them immediately. To do this, go to the appropriate
External Mail -> In Mail setting, and turn off Leave Messages on Server and turn off Use Downlod
Rules. This makes VPOP3 fall back to assuming the ISP's Unique ID functionality does not exist.


 


Also, note that VPOP3 remembers Unique IDs which it has seen but which have been deleted from
the ISP in the last few days. This is because, a few ISPs have been known to make messages
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'reappear' after they have previously 'disappeared', so this facility in VPOP3 stops those messages
being treated as new, and being redownloaded. However, some other ISPs will re-use Unique IDs
shortly after the previously using message was deleted. So, VPOP3 may delete the message with
unique ID '12345', but then, the ISP gives that unique ID to the next message that comes in. In this
case VPOP3 will treat the new messages as old, even though it isn't. To resolve this, go to the
Utilities -> Misc Settings -> Basic Tweaks settings page and change the Hold Obsolete UIDLs for
setting to '0' days. This makes VPOP3 forget Unique IDs once it has deleted them or has seen that
something else has deleted them. 


There is still the slight chance that re-used unique IDs may cause problems - for instance if VPOP3
downloads a message, then another program deletes that message, and the ISP gives the same
unique ID to a new message before VPOP3 reconnects. VPOP3 won't know that the message with
that unique ID has changed, so it will treat it as old. In this case, the only solutions are to ask the ISP
to change their POP3 server configuration so it won't re-use unique IDs, or at least waits a
reasonable time (at least several days) before doing so, or make sure that no other software access
the ISP's POP3 mailbox other than VPOP3.


Also, making this setting change may cause duplicate messages to be downloaded if, for instance,
the ISP doesn't actually delete a message after VPOP3 has asked it to.


 


Keywords: old messages uidl

Timeout errors when using 1&1 as ISP

There is a known issue with 1&1's mail servers when downloading certain mail (usually spam).
Unfortunately, at the time of writing, 1&1 have not acknowledged this as they do not seem to know
about the POP3 standard documents, so are not fixing it.


The problem is that the POP3 mail standard requires that all line endings must be a CR-LF (Carriage
Return/Line Feed) pair of characters. Individual CR or LF characters do not indicate the end of a line.
This is strictly mandated by the POP3 standard (RFC 1939, section 3, para 4)


Unfortunately, when VPOP3 asks 1&1's mail servers for the message header, the response comes
back until the first LF character, whether or not there was a CR character before it. This means that
as VPOP3 is following the standard correctly, it does not think it has received the full response, so
VPOP3 continues waiting for the rest of the response. However 1&1's mail servers are not following
the standard, so they think they have sent the full response, so will not send any more. So, VPOP3
waits until the timeout error occurs.


This is really a bug which needs to be fixed in 1&1's mail servers as it is a clear violation of the POP3
standard.


There is a workaround in VPOP3, which will make VPOP3 equally in breach of the standards. It should
be noted that using this workaround will force VPOP3 to behave in a buggy manner, so it is not
recommended, but until 1&1 fix their mail servers it may be the only solution (other than to switch
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to an ISP without buggy servers, or to find someone at 1&1 who knows of the existence of standards
and knows how to read them).


To implement the workaround in VPOP3:



    stop VPOP3 

    Run Regedit 

    Find HKEY_LOCAL_MACHINE\Software\PaulSmith\VPOP3\Secret 

    Set "AllowAnyLineEndings" to "1" 

    restart VPOP3 




 keywords: 10060 one and one

Timeout problems downloading/uploading messages with attachments

There are various possible reasons for this, mostly to do with problems with Windows TCP/IP or dial-
up adapter or with third party software. You may not have problems with other software, but that
doesn't mean it's a problem with VPOP3. 



    Check if you have any email anti-virus software such as MailScan, Norton Antivirus or McAfee
VirusScan installed. These programs will process all email TCP/IP connections and scan the
messages at that point. Often there are problems with these programs which can cause sending or
receiving of messages to lock up. 

    Check for 'Internet Security' or Firewall software. Some of these will act in a similar way to the
anti-virus software above and can cause problems with certain types of attachments. 

    Check with your ISP to see if they've had similar problems reported before. We've had reports of
this problem where the ISP has been able to fix it 'over the phone' by telling you to change some
specific settings. 

    Check for driver/firmware updates for your network card. If possible try changing the network card
in the VPOP3 server for one of a different model/make. The rest of the network may work OK, but we
see many cases where changing the network card will fix the problem even if it seems to be working
OK for other applications.

    On the Utilities -> Misc Settings -> Network Tweaks page in VPOP3 (or the Diagnostics ->
TCP/IP Tuning window in VPOP3 1.4.0 and 1.5.0), try changing the following settings one at a time:

    

        Disable TCP/IP Nagle Algorithm 

        Set the 'TCP/IP' block sizes to 512 bytes 

        Set the 'Winsock Buffer' sizes to 512 bytes 

    

    




The following methods used to be important for Windows 95/98/ME and NT, but are less so with
Windows 2000/XP/2003



    Download MTUSpeed from http://www.mjs.u-net.com/home.htm or DrTCP from
http://www.dslreports.com/drtcp. This allows you to change some TCP/IP configuration settings. You
can try the 'Optimum settings' option, or set the MTU to '576'. 

    Go to the Utilities -> Misc Settings page in VPOP3 and turn on 'POP3 the SMTP Connection' (or
Diagnostics -> Tuning window and turn on 'Sequential POP3 -> SMTP Connection' in VPOP3 1.5.0
and earlier) . 
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Too Many Hops or Mail Loop errors

If you get a Too Many Hops or Mail Loop error from VPOP3 or another mail server it means that a
configuration mistake somewhere has made it so that a message is passing backwards and forwards
between one or more mail servers.


Normally the error report will contain the full headers of the message which has failed. In the failed
message's headers there will be many lines beginning with the word Received:. 


As an email messages passes through a mail server, that mail server adds a Received:  header line
to the TOP of the message giving some trace information, such as where the message was received,
where it was received from, and the time when it was received.


You can use these Received: header lines to work out where the configuration loop was occurring, as
there will be more than one Received: line added by all the mail servers which the message looped
through. By reading the Received header lines from the bottom up, you will be able to see where the
message passed through a mail server twice - that is probably the place where the loop started. The
configuration error will probably be in the mail server which passed it to that mail server


As a example, if the Received headers look like:




Received from E by C; Mon, 22 Aug 2005 03:47:57 +0100


Received from D by E; Mon, 22 Aug 2005 03:47:55 +0100


Received from C by D; Mon, 22 Aug 2005 03:46:23 +0100


Received from E by C; Mon, 22 Aug 2005 03:45:14 +0100


Received from D by E; Mon, 22 Aug 2005 03:45:13 +0100


Received from C by D; Mon, 22 Aug 2005 03:41:32 +0100


Received from B by C; Mon, 22 Aug 2005 03:40:30 +0100


Received from A by B; Mon, 22 Aug 2005 03:46:27 +0100



You can tell that the configuration error was probably in 'E' - because that is the first (remember,
read from the bottom up) mail server which passed the message back to a mail server which the
message had previously passed through ('C' in this example)

Note, read the Received: header lines from the bottom up, do NOT use the timestamps. It is possible
that the clocks on some of the mail servers are set incorrectly (as appears to be the case with the 'B'
mail server in the example above)
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Translating VPOP3 to other languages

VPOP3 1.4.6 and later have a built in mechanism to try to make it easier to translate VPOP3 to other
languages than English, as long as the language uses the standard 'US' character set (simple
accented characters are allowed as well). This means that it should be possible to translate it to 
most Western languages.

At the moment there are no translations available, but if you want to do them yourself you will
need the VPOP3 Translation Kit.

Note that this is <B>ONLY</B> intended for technical users as it involves editing text files and can
cause VPOP3 to crash or malfunction if the translations are carried out incorrectly.

Troubleshooting VPOP3Decode

This article assumes you are familiar with the setup and terminology involved with virus 
scanning products and VPOP3.  Please work through the following steps in sequence to resolve
problems with virus scanning 
using VPOP3Decode.

1) Are you using either the Enterprise version of VPOP3 or have the VPOP3 Plug-ins pack 
installed?  If not, you will need to 
download and install one or other of these products.

2) Go to the Misc tab in VPOP3 settings and select 
Define VPOP3 Extensions. Make sure you have the following line in the External 
Router and/or Out Mail Processor boxes respectively:

vpop3decode.exe -s -in -t:infected -d:vscan -v

vpop3decode.exe -s -out -t:infected -d:vscan -v

where 'infected' is a valid mailbox to which you want the infected mails to be redirected.

3) Make sure you have created a virusscan.cmd file for your chosen scanner as detailed in the 
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knowledgebase.

4) Obtain a copy of 
EICAR.COM.  Place a copy of this in the vscan directory (it will be deleted so make sure you 
have a copy elsewhere also).  Start a DOS prompt.  Go to the VPOP3 installation directory.  
Type virusscan.cmd.  Your scanner should run, detect and delete the EICAR test 
virus.  If not contact support including details of which 
scanner (and version) you are using and a copy of the virusscan.cmd file.

5) Once step 4 is successful, download test_infected.dat and 
test_clean.dat from our website.  
Place these in the VPOP3 installation directory and copy test_infected.dat to routing.dat.  
Start a DOS prompt.  Go to the VPOP3 installation directory.  Then run vpop3decode -s 
 from a DOS prompt.  This should report the discovery of the EICAR test virus.  If not 
contact support including details of which 
scanner (and version) you are using and a copy of the virusscan.cmd file.

6) Once step 5 is successful, copy test_infected.dat to routing.dat as per step 5 and then run 
vpop3decode again from the DOS prompt using the same command 
as you defined in the External Router section in step 2 above.  The command should indicate that a 
virus has been detected and a mail sent to 'infected'.

7) Then send yourself a mail with EICAR.COM attached and check the mail is again diverted to the 
infected folder.

8) Finally, try this with the OutMail processor if scanning out bound mail is required.

Uninstalling/Reinstalling avast! for VPOP3

If you want to uninstall avast! for VPOP3 - for example to perform a clean install, 
you need to perform the following steps.

Stop VPOP3
Delete the _avast subdirectory of the VPOP3 directory
Run Regedit, find HKEY_LOCAL_MACHINE\SOFTWARE\ALWIL Software\Avast
Delete the 'VPOP3' key under the above registry key in RegEdit
Reinstall avast! for VPOP3 (download from here) if desired.
Restart VPOP3
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Upgrading from VPOP3 Standard to VPOP3 Enterprise

To upgrade from VPOP3 Standard to VPOP3 Enterprise, simply install VPOP3 Enterprise over the top
of your VPOP3 Standard installation


Do NOT uninstall VPOP3 Standard first


All your settings, users, messages etc will be retained in the upgrade


Once you have installed VPOP3 Enterprise you will need to go to the Info page in the settings to
enter the VPOP3 Enterprise licence key (if you are not using the standard 25 user evaluation licence)

User ... couldn't be deleted - in use

If you get an error "User xxxxx couldn't be deleted - in use" when trying to delete a VPOP3 user, this
means that that some software is currently logged into that user's account.


You can check whether a user's account is in use on the Utilities -> Server Status -> Active Sessions
page in the VPOP3 settings.


Once all users are logged out of that user's account, then the account can be deleted.


A common cause of this problem is that someone is logged into that account using the VPOP3 Status
Monitor utility.


 


Keywords: removing remove deleting delete user postmaster administrator

Using download rules with the VPOP3 Spam Filter

You cannot use VPOP3's download rules to check the results of the VPOP3 spam filter.


This is because download rules are processed before VPOP3 downloads the message itself. At the
time of processing download rules, VPOP3 only has the message headers.


The VPOP3 spam filter only works after the entire message has been downloaded, so the spam filter
works after the download rule processing has finished.
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The main reason people want to use download rules with the VPOP3 spam filter is to redirect
detected spam to another mailbox. You can do this in the spam filter itself - go to Utilities -> Spam
Filter Settings -> General. There is a Redirect setting in there, enter the new mailbox name in that
setting.


Sometimes people want to discard all the mail which is detected as spam. This can be done by
setting the Redirect option to No-one. However, this is not recommended as the VPOP3 spam filter
can occasionally incorrectly detect legitimate mail as being spam, and if you have told VPOP3 to
discard any detected spam, then those messages will be lost permanently.


Note that in VPOP3 2.3.5 and later, VPOP3 has a spam Quarantine facility, where detected spam is
put to avoid cluttering up a user's mailbox, but is still available in case of false positives.

Using InnoculateIT Version 6 with the VPOP3 Plugin Pack for scanning
emails

To make VPOP3Decode call InnoculateIT Version 6 to scan message attachments for viruses, your 
<B>VIRUSSCAN.CMD</B> file should be:

inocmd32 -ENG Ino -ACT delete -MOD Secure -MCA ra -SCA mf c:\progra~1\vpop3\vscan

This should all be on a single line, and you may need to change the pathnames specified in this file
to match your setup

This information has not been tested by Paul Smith Computer Services. It was kindly submitted
by Rod Webster.

Using Lua when sending a message to a group of users through the
WebAdmin pages

VPOP3 2.3.9 beta and later have a facility to send a message to a group of users through the
WebAdmin settings pages (Users -> Utilities -> Send Message to a group of users)


On of the options of this facility lets you specify a Lua script in the message to send. This script lets
you customise the message for each user.


See the VPOP3 Lua page for details on the VPOP3 Lua implementation, including links to the
documentation.


When a Lua script in the administrator message is run, it has certain global variables set:
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    Username - contains the username of the user currently being processed

    MessageCount - contains the number of messages in the user's inbox

    MailboxSize - contains the size of the user's whole mailbox (in bytes)

    MailboxQuota - contains the user's mailbox quota setting (in bytes - 0 means no limit)

    LDAP - this is a table containing the LDAP attributes for this user - the attribute names are in
upper case - eg LDAP.CN is the user's 'display name'




(The variable names are case sensitive)


Anything that the script 'prints' gets sent to the user


An example Lua script used in the message sending facility might be



{lua}


if MailboxQuota ~= 0 then


print ("You are currently using " .. MailboxSize .. " bytes of your allowed " .. MailboxQuota .. " bytes
in your mailbox")


end


{/lua}




If the Lua script sets the global variable 'DontSend' (case sensitive) to '1' then VPOP3 won't send the
message to this particular user.


 


 

Using McAfee VirusScan Version 8 with VPOP3

Starting with McAfee VirusScan V8, Network Associates have discontinued support for the
SCAN32.EXE command-line virus scanner, which means that the previously documented methods for
using VPOP3 with McAfee VirusScan will no longer work.


However, VirusScan V8 now supports a transparent POP3/SMTP email virus scanner which can be
used with VPOP3.


To configure this, go into the McAfee SecurityCenter (Start -> Programs -> McAfee -> McAfee
SecurityCenter) and click on the VirusScan tab.
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Then, click on the Configure VirusScan Options button





On the ActiveShield tab, make sure that the Scan e-mail and attachments option is checked. Then
press Advanced.





Go to the E-mail Scan tab, and check that the Automatically clean infected attachments option is
selected. (If you select the Prompt me when an attachment needs to be cleaned option, then the
VPOP3 process may be frozen by VirusScan).


Press OK, then OK again and then close down the McAfee SecurityCenter.


Note that if you use this method, then the extra options that are included with the integrated virus
scanner options (currently Sophos and avast! for VPOP3), such as informing the email sender,
reporting problems to the administrator, etc, will not be available.


 


(Note if you are going to use this method, you should check the Licence conditions of your McAfee
software to see if this type of usage is allowed under your licence conditions, and whether you may
need to purchase extra licences from Network Associates)

Using Multiple Domains with VPOP3

You can use VPOP3 to handle the email for multiple email domains. There are several ways of doing
this, depending on your actual requirements.
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The two main situations are described below:



    One organisation with multiple domains, all of which are 'aliases' of each other 

    More than one organisation using the same VPOP3 server, or one organisation hosting email for
other organisations 



One organisation with multiple domains, all of which are 'aliases' of each other


This is the situation if, for instance, your organisation has the email domains company.com and
company.co.uk, and all email addresses at company.com have an equivalent address at
company.co.uk, and the emails are answered by the same person, regardless of which domain the
original email was sent to.


In this case, you simply add both domains to the Local Domains box on the Local Mail page in the
VPOP3 settings. (Separate multiple domains by using the semicolon symbol ";").


If you receive the incoming mail for both domains from the same ISP POP3 mailbox, you should also
put both domains in the Accepted Domains box on the In Mail settings page - again, separate
multiple domains using the semicolon symbol.


If there are a few email addresses which should be handled differently for the different domains, use
Mappings to fine tune these. For instance, if sales@company.com should be handled by Joe, and
sales@company.co.uk should be handled by Kate, simply add two Mappings: sales@company.com -
> Joe, and sales@company.co.uk -> Kate.

More than one organisation using the same VPOP3 server, or one organisation hosting email for
other organisations


This is the situation if all your email needs to be routed by looking at the full email address, rather
than just the username part (the part before the @ symbol).


In this case you create Mappings to tell VPOP3 where to route the messages. 


For this article we will assume that you have the requirement to route mail into different mailboxes
for the following email addresses:



     anyone@customer.com (a catch-all account)

    fred@company1.com

    joe@company2.com

    sales@company1.com

    sales@company2.com




We need to create 5 user accounts in VPOP3 for the mail to be routed into. You should create a
consistent naming convention to make it easier to manage this in the future because you are not
allowed to have two accounts with the same name (in this example, you cannot have two accounts
called sales)
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We will create the 5 user accounts called:



    customer.com

    fred.company1

    joe.company2

    sales.company1

    sales.company2




Then, we need to create Mappings to tell VPOP3 how to route the messages - the mappings we need
are



    *@customer.com -> customer.com

    fred@company1.com -> fred.company1

    joe@company2.com -> joe.company2

    sales@company1.com -> sales.company1

    sales@company2.com -> sales.company2




This will handle the email routing we require. 


There are two further settings you may wish to use. On the Local Mail  page in the VPOP3 settings,
there is an option Disable default user -> user mappings for local/incoming SMTP mail. There is a
similar setting on the In Mail -> Configure Routing Options window - Disable default user -> user
mappings


By default, VPOP3 will look at any email address it sees, and if the domain it matches a Local
Domain or Accepted Domain setting, it will look for a VPOP3 account which matches the username
part of the email. So, in the above example, by default VPOP3 would route mail for
fred.company1@company2.com to fred.company1 if the Accepted Domains contains
company2.com. 


The Disable default user-> user mappings options tell VPOP3 not to do this, and to require explicit
mappings for all email routing.


 

Using Norton Anti Virus 2001 with the VPOP3 Plugin Pack to scan emails
for viruses

This article provides information required to enable automatic scanning of incoming e-mail 
attachments for viruses using Norton Anti Virus 2001.  Additionally, the 
process employs additional software which is only included in the 
VPOP3 Plugins Pack or 
VPOP3 Enterprise.  
This configuration is not available under VPOP3 Standard without the VPOP3 
Plugins Pack.  An alternative process that uses the email virus scanning component of Norton
Antivirus is described in 
this article. The 

138 of 223Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



process described results in a fully transparent automated check of all 
incoming e-mail attachments routed through VPOP3.
Overview

All incoming e-mail attachments are extracted by VPOP3 and checked by calling the Norton on
demand 
virus scanner, NAVW32.  Infected attachments are diverted by VPOP3 to an administrator 
specified mailbox for monitoring purposes.

Implementing this process requires setting up VPOP3 to use Norton as an 'external router' and 
making sure the Norton background checker (Auto Protect) does not intervene in the e-mail 
scanning process.  The process, and associated options, are discussed in detail below.

For the purposes of this discussion it is assumed that a valid set up of the intended e-mail 
client software, VPOP3 and Norton Anti Virus is already in place and has been tested.  This is 
recommended so as to avoid confusion if problems occur when adding the additional 
functionality of automated e-mail scanning.

Configuring Norton Anti Virus

In order for this process to run unattended on a mail server it is necessary for Norton to be 
set to scan mail in an automated and silent configuration.

Open the Norton configuration window by right clicking on the Auto Protect icon 
or selecting 'Options' from the main program.  
Click the 'Email' tab and ensure that e-mail protection is not enabled for 
either incoming or outgoing mail 
as this will interfere with VPOP3.  Click the 'Exclusions' tab.  
Check that 'C:\VPOP3\VSCAN\*.*' is NOT in the list and close the properties dialog down.
Setting Up the External Router

Create an empty text file in 'C:\VPOP3\' called 'virusscan.cmd'
 and add the following line of text to it.

Win 9X: command.com /c "c:\program files\norton antivirus\navw32.exe" c:\vpop3\vscan\*.* 
/m- /b- /s- /Noresults

Win NT/2000: cmd.exe /c "c:\program files\norton antivirus\navwnt.exe" c:\vpop3\vscan\*.* 
/m- /b- /s- /Noresults

Configuring VPOP3

If required a new mailbox can be set up to receive infection warning e-mails or they can just be 
routed to an existing mailbox (typically the postmaster).

Edit the 'Misc' tab in VPOP3 and select the 'Define VPOP3 Extensions'
 button.  Insert the following text in the 'External Router' field:
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'"c:\vpop3\vpop3decode.exe" -s -in -t:infected -d:vscan -v'

substituting the mailbox defined above for 'infected'

This completes the configuration changes.  A re-boot is not required to bring the new 
settings into effect.

<B>NB: The VPOP3 installation directory may be a different directory to 
<I>c:\vpop3</I>. Earlier versions of VPOP3 used <I>c:\program files\vpop3</I> and you may also
have
decided to install into a different directory during installation of VPOP3.</B>

Using Norton Antivirus 2000's email scanning with VPOP3?

Norton Antivirus 2000 contains an email attachment virus scanner which works quite well. You can
use this
with the VPOP3 server to scan emails but it isn't as easy as it could be because of limitations in 
Norton Antivirus.

Norton Antivirus 2000's email scanning works by acting as a POP3 proxy server, so that the email
client
software gets the mail from Norton Antivirus, which gets the main from the ISP's POP3 server.

You can use this facility with VPOP3 in two ways:

	Have the users' email client software collect the mail from VPOP3 through Norton Antivirus, so the
mail
	gets downloaded into VPOP3 without being checked, and is checked when the user retrieves it from
VPOP3. This 
	is easy to set up, but requires a copy of Norton Antivirus 2000 on each users' PC. To set it up this
way just 
	install Norton Antivirus 2000 as normal on the client PCs. No extra work is needed.
	Make VPOP3 download the mail via Norton Antivirus. This only requires a single copy of Norton
Antivirus for the
	mail server, but isn't as easy to set up. The problem is that the Norton Antivirus email scanner will
conflict
	with the VPOP3 mail server as they both use TCP/IP port 110. The two ways around this are:
	
		Install Norton Antivirus 2000 on a different PC from the VPOP3 computer, then in VPOP3's "In Mail"
tab,
		put the POP3 Server Address as the IP address of the computer running Norton Antivirus. In the
POP3 User ID box in
		VPOP3 put <B>userid/mail.isp.com</B> where 'userid' is your account name on the ISP, and
'mail.isp.com' is 
		the ISP's POP3 server address.
	Install Norton Antivirus 2000 on the same computer as VPOP3. In VPOP3's "In Mail" tab,
		put the POP3 Server Address as 127.0.0.1. In the POP3 User ID box in VPOP3 put
		<B>userid/mail.isp.com</B> where 'userid' is your account name on the ISP, and 'mail.isp.com' is 
		the ISP's POP3 server address. Then, on the VPOP3 "Local Servers" tab, change the 
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		'POP3 Server' <B>port</B> to '1110' instead of '110'. You will then need to go around all the
users' email
		client programs and change the POP3 server's port number to '1110' instead of '110' (see the
documentation
		for the email client you use to see how to do this).
	
	If you have VPOP3 collecting mail through Norton Antivirus's checker, you should ensure that you
have told
	Norton Antivirus <B>not</B> to ask the user what to do with an infected attachment. It should be
set up either
	to 'clean or quarantine' the file, or 'clean or delete' the file without prompting the user for what to
do.

Using SpamPal and MailScan on the same installation

To install SpamPal and MailScan for VPOP3 on the same computer, you need to change the MailScan
scanning port.


The instructions below give more details:



    Install SpamPal on the VPOP33 server

    Follow instructions on SpamPal web site to setup with VPOP3
http://www.spampal.org/usermanual/servers/vpop3/vpop3.html

    In mailscan administrator (v4.2a), click on "Local Domain" and change the "POP3 to listen on port"
to the same as you set up in VPOP3 following the instructions in step (2) (eg 9110)

    Reboot the server & test (note that simply restarting VPOP3 is not sufficient)




(Thanks to Kevan Gibbings for this information)

Using the VPOP3 Web Mail Service

VPOP3 contains a built in Web Mail server for reading and sending email using a web browser.


To use this facility in VPOP3, tell your web browser to access

http://:5108

    

e.g. 

    http://192.168.1.1:5108

        

You will need to log on using a valid VPOP3 username and password. 
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If you want to access the VPOP3 Web Mail server from outside your local LAN (you will need a
permanent Internet connection to do this), you will need to make two changes:

        

            Change the VPOP3 Web Mail server Access Restrictions - see the Defining Access Restrictions
in VPOP3 article - to allow access from outside your LAN.

            Change your firewall/router configuration to allow incoming connections on port 5108 to go
to the VPOP3 server on your LAN.

        

        

 

         

Using VPOP3 on 64 bit Windows

VPOP3 is a 32 bit Windows application, but it will work correctly on 64 bit versions of Windows with
no problems.


The only thing you need to be aware of is that if you need to manually access the section of the
registry with VPOP3's settings in, instead of HKEY_LOCAL_MACHINE\Software\PaulSmith\VPOP3
where the settings are usually stored, in a 64 bit version of Windows, the settings are stored in
HKEY_LOCAL_MACHINE\Software\WOW6432Node\PaulSmith\VPOP3

Using VPOP3 on Novell networks

VPOP3 can be used on the same network as a Novell server, but you MUST install TCP/IP networking
on the VPOP3 computer and all the other computers which you wish to have access to email.

On Windows 95/98/NT/2000 computers you can have both TCP/IP networking and IPX/SPX
networking running at the same time, and they will not conflict with each other.

You cannot run VPOP3 without having TCP/IP networking installed, and VPOP3 will not run on the
Novell server itself, it must run on a Windows 95/98/NT/2000 computer.

Using VPOP3 Plug-in Pack with Norton/Symantec Antivirus Corporate

The VPOP3 Plug-in pack allows virus scanning with most common virus scanners. However it
requires that the virus scanner has a command line scanner. (allowing it to be run from
the Windows Run Menu option). 


Norton Antivirus Corporate does not have a command line facility, so the following procedure
will allow the plug-in pack to work with Norton Antivirus Corporate.
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1. Install the Plug-in pack as usual. After installation check the External Router command and
OutMail preprocessor commands 


The External Router command will look something like this...


c:\\vpop3decode.exe -in -s -d:vscan -t:infected


The OutMail Preprocessor command will look something like this...


c:\\vpop3decode.exe -out -s -d:vscan -t:infected


(VSCAN is a subdirectory that should be created in the VPOP3 directory)


2. In the VPOP3 directory, make sure there is no file named virusscan.cmd. (usually this file is used
by vpop3decode.exe to call the virus scanner, but for Norton AV Corporate we don\'t need this file)


3. In Norton AV Corporate make sure that \"Real Time Protection\" is enabled. Configure NAVC to
qurantine or delete infected files. Do not choose the option \"Prompt me\". Make sure that ALL file
types are scanned.


How this works


For all incoming and outgoing messages, vpop3decode will unpack the message into the VSCAN
directory in VPOP3. This will prompt the Real Time protection in NAV Corporate, to scan the file as it
is written to the disk. The scanner will then delete/quarantine infected messages, and in turn
vpop3decode will recognise that the message was infected, and thus redirect the message to the
infected mailbox in VPOP3.


 


Notes: NAV corporate also contains a DOS command line scanner named vpscan.exe. This should
also work in theory, but we have been unable to get this working here.


 

Using VPOP3 to connect to GMAIL

GMail (mail.google.com) requires SSL connections to their POP3 & SMTP mail servers. 


If you are using VPOP3 2.6.0 or later, you simply set up the In Mail/Out Mail settings in VPOP3 to
connect to the GMail mail servers on the appropriate ports, and set the 'Session Encryption' to 'SSL'
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Earlier versions of VPOP3 do not support SSL connections to remote mail servers because ISP's
rarely require SSL connections, so VPOP3, on its own, could not connect to GMail's POP3 & SMTP
mail servers.


However, using the free STUNNEL program, you can make VPOP3 connect to GMail's servers
successfully.


To do this, go to STUNNEL's website at www.stunnel.org and download the latest Windows installer
(currently V4.14 from http://www.stunnel.org/download/stunnel/win32/stunnel-4.14-installer.exe )


Run this on your VPOP3 computer to install STUNNEL there (you can install STUNNEL on a different
computer, but you will have to alter the rest of the configuration below accordingly)


Then, put the following into the STUNNEL.CONF file (replace the rest of the STUNNEL.CONF file if you
do not need it). You will find the STUNNEL.CONF file in the directory where you installed STUNNEL
(usually c:\program files\stunnel)


 




 


client = yes


debug = debug 


[pop3s]


accept = 127.0.0.1:2110


connect = pop.gmail.com:995


[smtps]


accept = 127.0.0.1:2025


connect = smtp.gmail.com:465
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Now, in the VPOP3 In Mail settings, choose POP3 Incoming and for the server address put 127.0.0.1
and for the port number specify '2110'. In the VPOP3 Out Mail settings, choose Send via SMTP Relay,
and for the server address put 127.0.0.1:2025.


Run STUNNEL.EXE, and VPOP3 should now be able to connect to GMail's servers correctly.

Make STUNNEL run at startup


So that VPOP3 will be able to use STUNNEL all the time, you need to make sure that STUNNEL runs
when Windows starts up.


In Windows 9x, put a shortcut to STUNNEL.EXE in the 'Startup' group


In Windows NT/2000/XP/2003 etc, go to Start -> Run in Windows, and run C:\Program
Files\Stunnel\Stunnel.exe -install . This will install an STUNNEL service which will start automatically
when Windows starts.


 

Using VPOP3 with a Permanent Internet Connection

Setting up VPOP3 to use a permanent Internet connection is very simple to do from the VPOP3 side.

All you need to do is go to the <I>Connection</I> tab and choose 'Use LAN for Connection'. Then
enter the ISP's SMTP relay (smarthost) server on the <I>Out Mail</I>tab and the ISP's POP3 server
on the <I>In Mail</I> tab.

You do <B>not</B> need to tell VPOP3 the IP address of the router or anything like that. This
should all be set up in the Windows TCP/IP settings, exactly the same as for other computers on the
network (ie you should set the DNS settings and the Default Gateway settings appropriately)

If you will receive incoming mail using SMTP then also see Accepting Incoming SMTP through a
router.

Using VPOP3 with Blackberry devices

145 of 223Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



VPOP3 has no way of pushing mail to a Blackberry device itself. This is because that functionality is
patented by RIM, you need to use RIM's Blackberry Enterprise Server to be able to push mail to a
Blackberry. Unfortunately, RIM do not produce an Enterprise Server suitable for use with a standards
compliant POP3/SMTP server such as VPOP3.


So, there are two other possibilities:



    Most mobile phone companies who provide Blackberry devices will also give you a free email
address which they will push to the Blackberry for you. You can tell VPOP3 to forward a copy of all
your mail to this email address by editing the relevant user in the VPOP3 settings, and adding this
address to the Assistant box in the user's settings

    Some Blackberry devices come with a POP3/IMAP4 email client as part of the software package.
This can be used to collect mail from VPOP3 over the Internet. See this article for details of
configuring VPOP3 to make it mail to be collected over the Internet.




Keywords: push email Blackberries

Using VPOP3 with Exchange Server 2000

The instructions below are for Exchange Server 2000. For Exchange Server 5.5 see here and for
Exchange Server 2003 see here.


You can link VPOP3 to Exchange Server, so that Exchange Server sends outgoing mail through
VPOP3 and VPOP3 sends any incoming mail directly to Exchange Server. 


You should first of all set up VPOP3 to send and receive Internet email as described in the online
help. 

VPOP3 and Exchange Server on the same PC

Changing the Exchange Server SMTP port

As both VPOP3 and Exchange Server are on the same computer, you will need to change the TCP/IP
port assignments for the SMTP service in Exchange Server. You should NOT change the SMTP service
port in VPOP3 as you cannot change the port which Exchange Server will forward to, but you can
change the port which VPOP3 will forward to.



    On the Exchange Server computer, go to the Exchange System Manager. Under the Server
section select the Exchange Server then Protocols then SMTP then Default Virtual SMTP
Server. Right click and choose Properties. On the General tab select the ip address e.g
192.168.1.1 from the drop down box then click on the Advanced button and change the port from
25 to 5025. It seems not to properly if you leave it as \"all unassigned\" 

    On the Exchange Server computer, go to the Exchange System Manager. Under the Server
section select the Exchange Server then Protocols then POP3 then Default Virtual POP3 Server.
Right click and choose Properties. On the General tab select the ip address e.g 192.168.1.1 from
the drop down box then click on the Advanced button and change the port from 110 to 5110. It
seems not to properly if you leave it as \"all unassigned\" 

    Do NOT change the port setting under Delivery | Outbound Connections from 25 or the mail
system will loop 

    Under the Server section go to Recipient Policies then Default Policy, right-click and select
Properties. Add in the email domains that will be forwarded from VPOP3,eg. @xyz.com 

    Navigate down the Exchange tree to Connectors. Right-click and choose Add a Connector.On
the General tab select Forward All Mail Through This Connector to the Following Smart
Host andenter the IP address of the computer with VPOP3 on it, eg [192.168.1.1] (the square
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brackets are required). In the Local Bridgehead Server just select the ExchangeServer. On the
Address Space tab add in an SMTP address space of *. 



To set up forwarding of incoming mail from VPOP3 to Exchange Server

VPOP3 1.5.x and earlier

If you have a catch-all email account at your ISP:


Go to the VPOP3 Local Mail tab and press the Edit LAN Forwarding button.In this window put a line
like

     *@mydomain.com    192.168.1.1:5025


where mydomain.com is your registered domain, or the subdomain given to you by your ISP, and
192.168.1.1 is the IP address of the Exchange Server computer. 


Also, in the In Mail tab, press Routing, and set the routing method to According to Recipient

If you have individual email accounts at your ISP:


Also, in the In Mail tab in the VPOP3 settings for each In Mail setting, press Routing, and set the
routing method to set the Routing method to Forward to another LAN Mail Server, and in the box put
something like fred@domain.com@192.168.1.1:5025

VPOP3 2.0.0 and later

If you have a catch-all email account at your ISP:


Go to the Local Mail -> LAN Forwarding -> Configuration page in the VPOP3 settings. In this LAN
Forwarding configuration box put a line like 

     *@mydomain.com    192.168.1.1:5025


where mydomain.com is your registered domain, or the subdomain given to you by your ISP, and
192.168.1.1 is the IP address of the Exchange Server computer. 


Also, in the External Mail -> In Mail page in the VPOP3 settings, make sure that the Extended Email
Routing options main radio button is set to Route According to Detected Recipient.

If you have individual email accounts at your ISP:


Also, in the External Mail -> In Mail page in the VPOP3 settings for each In Mail setting, set the
Extended Email Routing options main radio button to Forward all messages to another LAN mail
server using SMTP


Then, in the configuration boxes put the email address on the Exchange Server, and the IP
address:port of the Exchange Server SMTP service.

To set up forwarding of outgoing mail from Exchange Server to VPOP3


On the Exchange Server settings, choose the Connectors item, then the appropriate connector, right
clickit and choose Properties. Then on the General tab, choose the Forward all mailthrough this
connector to the following smart hosts option and type in the hostname of the VPOP3computer,
or the IP address surrounded by square brackets. 

Avoiding other port conflicts
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Because both VPOP3 and Exchange Server are mail servers, they may both try to use the same
TCP/IP ports which will lead to conflicts if they are both running on the same computer. This happens
with 389 (LDAP). To stop these conflicts, either disable these protocols in the Exchange Server
settings, or change the ports assigned to these services in the VPOP3 Local Servers tab. 


That\'s it... 


These instructions were adapter from instructions sent to us by Philip Elphick of ADP Micro 

VPOP3 and Exchange Server on different PCs

To set up forwarding of incoming mail from VPOP3 to Exchange Server


Follow steps (4) and (5) above (but skip steps (1) to (3)). 

VPOP3 1.5.x and earlier


Go to the VPOP3 Local Mail tab and press the Edit LAN Forwarding button.In this window put a line
like

     *@mydomain.com    192.168.1.1


where mydomain.com is your registered domain, or the subdomain given to you by your ISP, and
192.168.1.1 is the IP address of the Exchange Server computer. 

VPOP3 2.0.0 and later


Go to the VPOP3 Local Mail page, then the LAN Forwarding sub-page, in the bug box put a line like

     *@mydomain.com    192.168.1.1


where mydomain.com is your registered domain, or the subdomain given to you by your ISP, and
192.168.1.1 is the IP address of the Exchange Server computer. 

To set up forwarding of outgoing mail from Exchange Server to VPOP3


On the Exchange Server settings, choose the Connectors item, then the appropriate connector, right
clickit and choose Properties. Then on the General tab, choose the Forward all mail through this
connector to the following smart hosts option and type in the hostname of the VPOP3computer,
or the IP address surrounded by square brackets. 


That's it... 

Using VPOP3 with Exchange Server 2007

The instructions below are for Exchange Server 2007. For Exchange Server 2000 see here, and for
Exchange Server 2003 see here.

You can link VPOP3 to Exchange Server, so that Exchange Server sends outgoing mail through
VPOP3 and VPOP3 sends any incoming mail directly to Exchange Server.


You should first of all set up VPOP3 to send and receive Internet email as described in the online
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help.


Note that these instructions are specifically for linking VPOP3 to Exchange, they do not mention the
general Exchange configuration that you will need to do. For that, see your Exchange
documentation, or talk to your Exchange installer.




VPOP3 and Exchange Server on the same PC

Changing the Exchange Server SMTP Port


As both VPOP3 and Exchange Server are on the same computer, you will need to change the TCP/IP
port assignments for the SMTP service in Exchange Server. 



    On the Exchange Server computer go to Start -> Programs -> Microsoft Exchange Server 2007 ->
Exchange Management Console

    On the left of the Management Console, choose Server Configuration, then Hub Transport. Now in
the Receive Connectors section, right-click the Default- connector, and choose Properties.

    Go to the Network tab. In the top half of this page, called Local IP Addresses select each address
in turn, and press Edit... Change the Port to a different number larger than 1024, for instance 5025,
and press OK.


    




Now follow the instructions for VPOP3 and Exchange Server on different PCs below

VPOP3 and Exchange Server on different PCs

Setting up Exchange to accept mail for the appropriate domain



    On the Exchange Server computer go to Start -> Programs -> Microsoft Exchange Server 2007 ->
Exchange Management Console

    On the left of the Management Console, choose Organization Configuration, then Hub Transport.
On the right-hand side select the Accepted Domains tab, and make sure that your email domain is
listed in there in the Accepted Domain column

    On the E-Mail Address Policies tab, right-click the Default Policy item, and choose Edit...

    Press Next until you are on the E-Mail Addresses section. Make sure there is an entry there under
SMTP called @.



Usually the above settings are set during installation of Exchange Server, but it will cause problems
if they are not there, so it is worth checking.

Setting up Exchange to forward outgoing mail back to VPOP3



    In the Exchange Management Console, choose Organization Configuration, then Hub Transport.
On the right-hand side select the Send Connectors tab. 

    If there is already an 'All Outgoing Mail' connector defined, go to the next section

    Press New Send Connector on the far right. 

    In the Name  box enter something like Mail to VPOP3

    In the Select the intended use box, make sure that Custom is selected. Press Next

    On the Address Space page, press Add. In the Address box type * (asterisk) and press OK. Press
Next

    On the Network Settings page, select Route mail through the following smart hosts:

    Press Add. Enter the name or IP address of the VPOP3 computer. Press OK. Press Next

    On the Configure smart host authentication settings page, choose either None or Basic
Authentication, as required by your VPOP3 configuration, and enter the appropriate details. Press
Next

    Press Next
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    Press New, Finish

    Go to the Setting up VPOP3 to forwarding incoming mail to VPOP3 section below



If there was already an 'All Outgoing Mail' connector defined in the Send Connectors section.



    Right-click the All Outgoing Mail connector, and choose Properties

    Go to the Network tab

    Select Route mail through the following smart hosts:

    Press Add. Enter the name or IP address of the VPOP3 computer. Press OK. 

    If your VPOP3 server requires authentication, press the Change button to set this

    Close the All Outgoing Mail Properties window



Setting up VPOP3 to forward incoming mail to VPOP3

VPOP3 1.5.x and earlier

If you have a catch-all email account at your ISP:


Go to the VPOP3 Local Mail tab and press the Edit LAN Forwarding button.In this window put a line
like


     *@mydomain.com    192.168.1.1:5025


where mydomain.com is your registered domain, or the subdomain given to you by your ISP, and
192.168.1.1 is the IP address of the Exchange Server computer. 


Also, in the In Mail tab, press Routing, and set the routing method to According to Recipient

If you have individual email accounts at your ISP:


In the In Mail tab in the VPOP3 settings for each In Mail setting, press Routing, and set the routing
method to set the Routing method to Forward to another LAN Mail Server, and in the box put
something like fred@domain.com@192.168.1.1:5025

VPOP3 2.0.0 and later

If you have a catch-all email account at your ISP:


Go to the Local Mail -> LAN Forwarding -> Configuration page in the VPOP3 settings. In this LAN
Forwarding configuration box put lines like:




user1@mydomain.com   192.168.1.1:5025


user2@mydomain.com   192.168.1.1:5025



You can tell VPOP3 to forward unspecified addresses to user1@mydomain.com by using:




~@mydomain.com     192.168.1.1:5025     user1@mydomain.com



If you want to forward ALL email addresses, use something like:



*@mydomain.com    192.168.1.1:5025
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where mydomain.com is your registered domain, or the subdomain given to you by your ISP, and
192.168.1.1 is the IP address of the Exchange Server computer. 


Note that using the wildcard will forward all addresses, so should only be used if you have a VPOP3
licence which supports unlimited LAN forwarding (eg a VPOP3 Standard licence for 25 users or more,
or a VPOP3 Enterprise licence).


Also, in the External Mail -> In Mail page in the VPOP3 settings, make sure that the Extended Email
Routing options main radio button is set to Route According to Detected Recipient.

If you have individual email accounts at your ISP:


In the External Mail -> In Mail page in the VPOP3 settings for each In Mail setting, set the Extended
Email Routing options main radio button to Forward all messages to another LAN mail server using
SMTP. Then, in the configuration boxes, put the email address on the Exchange Server, and the IP
address:port of the Exchange Server SMTP service.

Avoiding other port conflicts


Because both VPOP3 and Exchange Server are mail servers, they may both try to use the same
TCP/IP ports which will lead to conflicts if they are both running on the same computer. This happens
with 389 (LDAP). To stop these conflicts, either disable these protocols in the Exchange Server
settings, or change the ports assigned to these services in the VPOP3 Services page.


That's it...


See also: Using VPOP3's Spam Filter with LAN Forwarding


How to 'share' domains between Exchange and VPOP3


 


 

Using VPOP3 with Exchange Server 5.5

The instructions below are for Exchange Server 5.x. For Exchange Server 2000 see here and for
Exchange Server 2003 see here.


You can link VPOP3 to Exchange Server, so that Exchange Server sends outgoing mail through
VPOP3 and VPOP3 sends any incoming mail directly to Exchange Server. 


You should first of all set up VPOP3 to send and receive Internet email as described in the online
help. 

VPOP3 and Exchange Server on the same PC

Changing the Exchange Server SMTP port
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As both VPOP3 and Exchange Server are on the same computer, you will need to change the TCP/IP
port assignments for the SMTP service in Exchange Server. You should NOT change the SMTP service
port in VPOP3 as you cannot change the port which Exchange Server will forward to, but you can
change the port which VPOP3 will forward to.


On the Exchange Server computer, edit the file \System32\drivers\etc\services using Notepad. 


Change the line which says: 

    smtp               25/tcp    mail

so that it says:

    smtp               5025/tcp  mail

Then restart Windows NT.

To set up forwarding of incoming mail from VPOP3 to Exchange Server

If you have a catch-all email account at your ISP:

Go to the Local Mail -> LAN Forwarding -> Configuration page in the VPOP3 settings. In this LAN
Forwarding configuration box put a line like

     *@mydomain.com    192.168.1.1:5025


where mydomain.com is your registered domain, or the subdomain given to you by your ISP, and
192.168.1.1 is the IP address of the Exchange Server computer. 


Also, in the External Mail -> In Mail page in the VPOP3 settings, make sure that the Extended Email
Routing options main radio button is set to Route According to Detected Recipient.

If you have individual email accounts at your ISP:


Also, in the External Mail -> In Mail page in the VPOP3 settings for each In Mail setting, set the
Extended Email Routing options main radio button to Forward all messages to another LAN mail
server using SMTP


Then, in the configuration boxes put the email address on the Exchange Server, and the IP
address:port of the Exchange Server SMTP service.

To set up forwarding of outgoing mail from Exchange Server to VPOP3

On the Exchange Server 'Internet Mail Connector' Connections tab, in the 'Message Delivery' section,
choose Forward all messages to host: and enter the IP address of the VPOP3 computer.

Avoiding other port conflicts

Because both VPOP3 and Exchange Server are mail servers, they may both try to use the same
TCP/IP ports which will lead to conflicts if they are both running on the same computer. This happens
with port 110 (POP3) and 389 (LDAP). To stop these conflicts, either disable these protocols in the
Exchange Server settings, or change the ports assigned to these services in the VPOP3 Local Servers
tab.


That's it... 

VPOP3 and Exchange Server on different PCs

To set up forwarding of incoming mail from VPOP3 to Exchange Server

Go to the VPOP3 Local Mail tab and press the Edit LAN Forwarding button. In this window put a
line like

     *@mydomain.com    192.168.1.1

where mydomain.com is your registered domain, or the subdomain given to you by your ISP, and
192.168.1.1 is the IP address of the Exchange Server computer.

To set up forwarding of outgoing mail from Exchange Server to VPOP3

On the Exchange Server 'Internet Mail Connector' Connections tab, in the 'Message Delivery' section,
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choose Forward all messages to host: and enter the IP address of the VPOP3 computer.


That's it... 

Using VPOP3 with Lotus Notes Domino Server

You can use VPOP3 with Lotus Notes Domino server with VPOP3 downloading mail from an external
POP3 mailbox and forwarding it on to the Domino server using SMTP.


We do not have experience of Lotus Domino server ourselves, so we cannot describe the
configuration steps required in Domino server in detail, but this article will describe the configuration
steps required in VPOP3, and explain the configuration which may be needed in the Domino server.


The settings below assume that the Domino server will be on a different computer from VPOP3. This
is because if you run both Domino server and VPOP3 on the same computer you will encounter
conflicts between the two SMTP servers, and, since we have no experience of Domino server, we are
unsure whether it is possible to reassign service ports in Domino server - so, unless you know how to
do this yourself, it is best to run VPOP3 and Domino Server on different computers.

VPOP3 settings


You should configure VPOP3 to send and receive mail from the ISP as normal, setting up the External
Mail -> In Mail, Out Mail, Connection and Schedule pages. You do not need to configure VPOP3 users
corresponding to the Lotus Domino servers.


Then, go to the Local Mail -> LAN Forwarding -> Configuration section of the VPOP3 settings. In the
LAN Forwarding configuration section, add something like the following




*@yourdomain.com   192.168.0.2:25




Where yourdomain.com is your email domain, 192.168.0.2 is the IP address of your Domino Server,
and 25 is the TCP/IP port which the Domino Server SMTP service is running on (25 is the default).


Note that the above settings assume you have a 25 user VPOP3 Standard licence or larger (or any
VPOP3 Enterprise licence), so that unlimited LAN Forwarding is supported. If you only have a 5 or 10
user VPOP3 Standard licence, then you will be limited to forwarding email to 5 or 10 email addresses
on Domino Server. To prevent invalid addresses using up your forwarding allowance, the LAN
Forwarding configuration should be something like:




fred@yourdomain.com   192.168.0.2:25


joe@yourdomain.com 192.168.0.2:25


kate@yourdomain.com 192.168.0.2:25
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ie - list the explicit email addresses


If you want aliases, then put something like:




joseph@yourdomain.com 192.168.0.2:25 joe@yourdomain.com




ie - the alias should be the first thing on the line, then IP address:port of the Domino server, then the
email address which VPOP3 should forward the message to on the Domino Server


If you want to catch all unrecognised email addresses, you can put something like:




~@yourdomain.com 192.168.0.2:25 fred@yourdomain.com




The ~@ means 'unrecognised addresses at'

Lotus Domino Settings


In Lotus Domino you should configure it as if it has an incoming SMTP feed (this will be coming from
the VPOP3 computer), and you should configure it to send all outgoing mail to the 'smarthost' or
'relay server' at the VPOP3 computer's IP address.


You could let the Domino Server send outgoing mail itself, but then you will lose the ability to use
VPOP3 for monitoring, archiving, filtering, virus scanning etc the outgoing messages.


 

Using VPOP3 with Norton Internet Security

Configuring VPOP3 to work with Norton Internet Security


This article is based on Norton Internet Security 2004, though information here may also apply to
earlier versions of NIS.


Firstly, after installing Norton Internet Security, you should not need to make any changes to VPOP3.
NIS works in the background and monitors internet activity. So when configured correctly, VPOP3
should not be affected.
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To configure NIS, you should take the following steps...
 - Open the NIS Settings Screen
 - Select \"Norton Internet Security\"
 - Select \"Status & Settings\"
 - Select \"Personal Firewall\"
 - Choose the \"Configure\" option


On the next screen...
 - Choose the \"Networking\" page tab
 - Use the options to add an address range for your local network
   (this helps Norton decide whether a connecting computer is local or remote)


 - Choose the \"Programs\" page tab
 - Select the option \"Program scan\" so that Norton can find all the Internet program on your PC
   (this may take 30 minutes or more, and may not find VPOP3!)


 - If the program scan does not find VPOP3, you can add this manually
 - Choose the option \"permit\" so that VPOP3 can connect to the Internet


Notes
1. Installing NIS may well slow down your PC operation quite significantly. (and add 2 minutes to the
start-up time). You can improve the performance a little by disabling some of the options in NIS, for
example...
 - Privacy Control
 - Ad Blocking
 - Norton Anti-Spam
 - Productivity Control


2. NIS may also install Norton Anti-virus. In NAV you are recommended to disable scanning of
Outgoing messages. This is because if Norton fails to scan an outgoing message (for any reason) the
virus scanner will simply report an on-screen message. VPOP3 won\'t know about this, so the
outgoing message will be lost. (We have several better options for virus scanning in VPOP3)


3. If you are getting Connection error in VPOp3 (typically 10060 errors), you can first identify if NIS is
causing these by disabling NIS from the icon in the Windows system tray.  If that fixes the problem
you can then look at the \"programs\" option in NIS to see whether VPOP3 has been blocked by NIS.
If so, you can reset this to permit Internet access by VPOP3.


 


(Note that this article does not imply a recommendation or otherwise of the Norton Internet Security
software)

Using VPOP3 with WATCHGUARD FIREBOX II

(This information has been supplied by a VPOP3 user, and has not been verified by 
Paul Smith Computer Services)
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On the WATCHGUARD FIREBOX II you should use the
"Filtered SMTP" as opposed to "SMTP Proxy"

WATCHGUARD FIREBOX II is a hardware firewall system produced by 
Watchguard. Paul Smith Computer Services 
have no experience of this system so offer no recommendation or otherwise about it.

Using VPOP3 with Windows XP SP2

VPOP3 works correctly with Windows XP SP2 (Service Pack 2), however you will probably need to
modify the configuration of the Windows Firewall (if you are using it) to allow access to VPOP3
through it


There are several ways to do this:

Using our 'EnableSP2Firewall' utility


Download and run the utility from http://www.pscs.co.uk/downloads/vpop3/EnableSP2Firewall.exe.
This will check for SP2 being installed and add VPOP3 and the VPOP3 Status Monitor to the allowed
applications in the firewall

Manually adding the VPOP3 application



    Go to Control Panel -> Windows Firewall. 

    Click on the Exceptions tab 

    Click on Add Program... 

    Either find VPOP3 in the list, or click on 'Browse...' at the bottom of the page, and find the
VPOP3.EXE program 

    Press OK 



Manually adding the ports that VPOP3 uses



    Go to Control Panel -> Windows Firewall. 

    Click on the Exceptions tab 

    Click on Add Port... 

    Enter 'POP3' in the Name box 

    Enter '110' in the Port Number box 

    Select TCP 

    Press OK 

    Click on Add Port... 

    Enter 'SMTP' in the Name box 

    Enter '25' in the Port Number box 

    Select TCP 

    Press OK 

    Click on Add Port... 

    Enter 'VPOP3 WebMail' in the Name box 

    Enter '5108' in the Port Number box 

    Select TCP 

    Press OK 
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You may want to add other ports as well, depending on which VPOP3 services you want to allow.

Using VPOP3 with WinProxy

These instructions tell you how to use VPOP3 with the WinProxy proxy server from
www.winproxy.com in a typical setup.

WinProxy Configuration



    For WinProxy Version 2.x - Go to WinProxy and choose File -> Advanced Properties. 

    For WinProxy Version 3.x, 4.x and 5.x - Go to WinProxy and choose File -> Settings. 

    Go to the Protocols tab and press the Mail button 

    In the Mail Host IP (SMTP) box type the name of your ISP's SMTP mail server. 

    In Mail Proxy Port type 1025 

    In POP3 Server IP - put in the name of your ISP's POP3 server (this will be overridden by VPOP3
in any case, so it doesn't really matter) 

    In POP3 Proxy Port type 1110 

    Turn on Allow users to specify alternate mail servers with user name delimiter 

    In Mail Server Delimiter type # 



<img height="361" alt="" src="/Image/winproxy.gif" width="387"/>

VPOP3 Configuration



    On the External Mail -> Connection page choose Use LAN for Connection 

    On the External Mail -> Out Mail page choose Via SMTP Relay and in the SMTP Relay Servers
box type the IP address of your WinProxy computer, followed by :1025, eg: 192.168.1.1:1025 

    On the External Mail -> In Mail page:

    

        In the POP3 Server Address box type the IP address of your WinProxy computer. 

        In the Port box, type 1110. 

        In the User ID box, type #, eg: mycompany#mail.myisp.com 

        In the Password box, type your ISP password 

    

    




NB - some people have reported problems with some versions of WinProxy if the POP3 Server IP is
set and you specify the mail server in the VPOP3 User Id settings as well. In this case, try either
clearing the POP3 Server IP setting in WinProxy (or set it to 0.0.0.0) or set that to your ISP's POP3
server and don't specify the # and ISP POP3 server in the VPOP3 User Id setting.

Using VPOP3 with Zonelabs ZoneAlarm firewall

To use VPOP3 on a computer running ZoneAlarm (a personal firewall from 
ZoneLabs), set the following 
permissions for VPOP3 in ZoneAlarm.

On the ZoneAlarm <B>Programs</B> tab, select the <B>VPOP3</B> program.

 Tick <B>Allow Connect</B> in the <B>Local</B> and <B>Internet</B> sections.
 Tick <B>Allow Server</B> in the <B>Local</B> section.
 Tick <B>Allow Server</B> in the <B>Internet</B> section, if you want to allow remote access
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to VPOP3
 Tick the <B>Pass Lock</B> option (failure to tick this option seems to cause occasional 10047
errors when VPOP3 starts up).

Using VPOP3's SPAM Filter with LAN forwarding

When using the VPOP3 Spam filter with LAN forwarding you need to be aware a bit of how it works.
The spam filter will only quarantine messages which are going to a VPOP3 user. This is because that
user needs to be able to log into VPOP3 to be able to view their quarantined messages.


There are 4 main ways of setting it up:



    Have any quarantining/redirection of spam performed by the onward SMTP mail server 

    Have VPOP3 redirect spam to a specified user on the onward SMTP mail server 

    Have VPOP3 redirect spam to a specified VPOP3 user 

    Have VPOP3 put spam in quarantines for each user 



1. Have any quarantining/redirection of spam performed by the onward SMTP mail server


To do this, just set up VPOP3's LAN forwarding as normal. In the onward SMTP mail server set up
rules to filter messages either on the 'VPOP3-SPAM:' prefix added to the message subject line or the
"X-VPOP3-SpamResult: YES" header line added by the spam filter to any detected spam messages.

2. Have VPOP3 redirect spam to a specified user on the onward SMTP mail server


To do this, go to Utilities -> Spam Filter Settings -> General in the VPOP3 settings, and specify
something like 'spambox@mydomain.com' in the Redirect setting. As long as the LAN forwarding
rules would forward that email address to the onward mail server (eg because of a
*@mydomain.com LAN forwarding rule), that's where all the spam will go. 


Then, make sure that the specified account exists in the onward mail server.

3. Have VPOP3 redirect spam to a specified VPOP3 user


This is similar to the above setting.


To do this, go to Utilities -> Spam Filter Settings -> General in the VPOP3 settings, and specify
something like 'spambox@mydomain.com' in the Redirect setting. 


Now, make sure that the VPOP3 LAN filter rules do NOT LAN forward that email address. This can be
done either by specifying explicit LAN forwarding rules for each user you do want to forward, or by
using the ~@mydomain.com style LAN forwarding rule to mean 'unrecognised addresses at
mydomain.com'


Then, make sure that the specified account exists in the VPOP3 server.

4. Have VPOP3 put spam in quarantines for each user
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To do this, you need to create a user account in VPOP3 for each user on the onward mail server. This
means that you have to have a VPOP3 licence sufficient for all your users, rather than needing a
maximum of a 25 user licence. You also need to create Mappings in VPOP3 instead of creating the
aliases on the onward mail server.


In each user, in the 'Forward To' section enter something like
SMTP:user@mydomain.com@192.168.1.1, tick the Use Forwarding box, and tick the Don't use
forwardings or assistants if mail would be quarantined box.


This tells VPOP3 to forward messages for this user on to user@mydomain.com on the mail server
192.168.1.1 using LAN forwarding. However, if the message is spam, it won't forward it, but will put
it into the VPOP3 quarantine for that user instead.


Finally, remove any LAN Forwarding rules from Local Mail -> LAN Forwarding Configuration or they
will override the users and associated mappings.


Users can access their quarantines by logging into the VPOP3 WebMail server (on
http://server.ip.address:5108 ) or by following the links in the quarantine daily report email.


 


 Keywords: Exchange

Virus Scanning e-mail with McAfee Anti Virus

This article provides information required to enable automatic scanning of incoming e-mail
attachments for viruses using McAfee Anti Virus. The process employs additional software which is
only included in the VPOP3 Plugins Pack or VPOP3 Enterprise. This configuration is not available
under VPOP3 Standard without the VPOP3 Plugins Pack. An alternative process is described in this
article. The process described results in a fully transparent automated check of all incoming e-mail
attachments routed through VPOP3. Any attachment(s) found to be infected may be dealt with in a
number of ways as discussed below. It is recommended that the attachment(s) should be either
quarantined or deleted.

Overview


All incoming e-mail attachments are extracted by VPOP3 and checked by calling the McAfee virus
scanner. Infected attachments are processed by McAfee according to the administrator\'s
requirements and a warning copy is forwarded to an administrator specified mailbox for monitoring
purposes.


Implementing this process requires setting up VPOP3 to use McAfee as an \'external router\' and
making sure the default McAfee background checker, VShield, does not intervene in the e-mail
scanning process. The process, and associated options, are discussed in detail below.


For the purposes of this discussion it is assumed that a valid set up of the intended e-mail client
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software, VPOP3 and McAfee Anti Virus is already in place and has been tested. This is
recommended so as to avoid confusion if problems occur when adding the additional functionality of
automated e-mail scanning.

Configuring McAfee Virus Scan


In order for this process to run unattended on a mail server it is necessary for McAfee to be set to
scan mail in an automated and silent configuration. If McAfee VShield is running (icon present in task
tray) open the properties tab (specifically for 'System Scan' in some setups) by right clicking on the
VShield icon. Click the 'Properties' button (if present) and select the 'Exclusions' tab. Add
'C:\VPOP3\VSCAN' to the list and close the VShield properties dialog down.

Setting Up the External Router


Create an empty text file in 'C:VPOP3' called 'virusscan.cmd' and add the following line of text to it
(including the quotes).


For Windows 9x with V4.0.3a add: "C:\Program Files\McAfee\McAfee VirusScan\scan.exe"
"c:\vpop3\vscan*.*" /all /analyze /del /nobeep /nomem /nodda /sub /unzip


For Windows 9x with V3.1.4 and V2.5.3a add: command.com /c "C:\Program
Files\McAfee\VirusScan\scan.exe" "c:\vpop3\vscan*.*" /all /del /nobeep /nomem /nodda /sub 


For Windows NT/2000 with V4.0.3a add: "C:\Program Files\Network
Associates\VirusScan\NTscan32.exe" /all /nosplash /nomsg /delete /nobeep /uinone /noboot /sub
"c:\vpop3\vscan*.*"


For Windows NT/2000 with V2.5.3a add: cmd.exe /c "C:\Program
Files\McAfee\VirusScan\NTscan32.exe" /nosplash /autoscan /alwaysexit /all /uinone /comp /sub
/delete /nomem /noboot /nobeep c:\vpop3\vscan\*.*


Additionally you may want to remove alerting from the scanner\'s Alert Manager. This can be done
by selecting 'Alerts' from the VirusScan tray icon popup menu and setting accordingly.

Configuring VPOP3


If required a new mailbox can be set up to receive infection warning e-mails or they can just be
routed to an existing mailbox (typically the postmaster).

To scan incoming POP3 mail


For VPOP3 2.0.0 and later, go to the Utilities -> VPOP3 Extensions page, and insert the following text
in the External Router field.


For VPOP3 1.5.0 and earlier go to the 'Misc' tab in VPOP3 and select the 'Define VPOP3 Extensions'
button. Insert the following text in the 'External Router' field:


'c:\vpop3\vpop3decode.exe -s -in -t:infected -d:vscan -v'


substituting the mailbox defined above for 'infected'
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To scan incoming SMTP and outgoing mail


For VPOP3 2.0.0 and later, go to the Utilities -> VPOP3 Extensions page, and insert the following text
in the OutMail Preprocessor field.


For VPOP3 1.5.0 and earlier go to the 'Misc' tab in VPOP3 and select the 'Define VPOP3 Extensions'
button. Insert the following text in the 'OutMail Preprocessor' field:


'c:\vpop3\vpop3decode.exe -s -out -t:infected -d:vscan -v'


Also, tick the box which says 'Use OutMail Preprocessor for incoming/internal mail'


substituting the mailbox defined above for 'infected'


This completes the configuration changes. A re-boot is not required to bring the new settings into
effect.

Virus Scanning e-mail with Norton Anti Virus 2000

This article provides information required to enable automatic scanning of incoming e-mail 
attachments for viruses using Norton Anti Virus 2000 (otherwise known as V6).  Additionally, the 
process employs additional software which is only included in the 
VPOP3 Plugins Pack or 
VPOP3 Enterprise.  
This configuration is not available under VPOP3 Standard without the VPOP3 
Plugins Pack.  An alternative process is described in 
this article.  The 
process described results in a fully transparent automated check of all 
incoming e-mail attachments routed through VPOP3.
Overview

All incoming e-mail attachments are extracted by VPOP3 and checked by calling the Norton
command 
line virus scanner, NAVC.  Infected attachments are diverted by VPOP3 to an administrator 
specified mailbox for monitoring purposes.

Implementing this process requires setting up VPOP3 to use Norton as an 'external router' and 
making sure the Norton background checker (Auto Protect) does not intervene in the e-mail 
scanning process.  The process, and associated options, are discussed in detail below.

For the purposes of this discussion it is assumed that a valid set up of the intended e-mail 
client software, VPOP3 and Norton Anti Virus is already in place and has been tested.  This is 
recommended so as to avoid confusion if problems occur when adding the additional 
functionality of automated e-mail scanning.

Configuring Norton Anti Virus
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In order for this process to run unattended on a mail server it is necessary for Norton to be 
set to scan mail in an automated and silent configuration.  Copy the 'D:NAVC' 
directory and its contents to the 'C:VPOP3' folder from the Norton Anti Virus 
distribution CD.  Alternatively, if you are using Norton Internet Security 2000 which does not 
contain NAVC you can download it from Symantec. 
Open the Norton configuration window by right clicking on the Auto Protect icon 
or selecting 'Options' from the main program.  
Click the 'Email Protection' tab and ensure that e-mail protection is not enabled 
as this will interfere with VPOP3.  Click the 'Exclusions' tab.  
Add 'C:VPOP3VSCAN' to the list and close the properties dialog 
down.
Setting Up the External Router

Create an empty text file in 'C:VPOP3' called 'virusscan.cmd'
 and add the following line of text to it.

Win 9X: command.com /c c:vpop3navcnavc.exe c:vpop3vscan*.* /delete /m- /b- /s- 
/doallfiles /zips /nobeep

Win NT/2000: cmd.exe /c c:vpop3navcnavc.exe c:vpop3vscan*.*  /delete /m- /b- /s- 
/doallfiles /zips /nobeep

Configuring VPOP3

If required a new mailbox can be set up to receive infection warning e-mails or they can just be 
routed to an existing mailbox (typically the postmaster).

Edit the 'Misc' tab in VPOP3 and select the 'Define VPOP3 Extensions'
 button.  Insert the following text in the 'External Router' field:

'c:vpop3vpop3decode.exe -s -in -t:infected -d:vscan -v'

substituting the mailbox defined above for 'infected'

This completes the configuration changes.  A re-boot is not required to bring the new 
settings into effect.

Virus Scanning e-mail with Norton Anti Virus 2001

This article provides information required to enable automatic scanning of incoming e-mail 
attachments for viruses using Symantec's Norton Anti Virus 2001.  Note that this process 
will not work with versions of Norton prior to 2001 as the port number cannot be edited.  
The process described results in a fully transparent automated check of all incoming e-mail 
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attachments routed through VPOP3.  Any attachment(s) found to be infected may be dealt with in a 
number of ways as discussed below.  It is recommended that the attachment(s) should be either 
quarantined or deleted.
Overview

All incoming e-mail traffic is firstly routed through Norton Anti Virus' e-mail protection which 
acts as a proxy POP3 server in this configuration.  Infected attachments are processed by NAV at 
this stage and a replacement text warning attachment is added to any infected mail.  Traffic is 
then passed through VPOP3 itself in the normal way to the final e-mail client.

Implementing this process requires setting up VPOP3 to point to Norton Anti Virus as well as 
setting up Norton to act as a proxy and to perform the necessary virus scanning.  The process, and 
associated options, are discussed in detail below.

For the purposes of this discussion it is assumed that a valid set up of the intended e-mail 
client software, VPOP3 and Norton Anti Virus is already in place and has been tested.  This is 
recommended so as to avoid confusion if problems occur when adding the additional 
functionality of automated e-mail scanning.

Configuring Norton Anti Virus 2001

In order for this process to run unattended on a mail server it is necessary for Norton Anti 
Virus to be set to scan mail in an automated and silent configuration.  Open Norton Anti Virus 
and select 'Options' (or right click the Auto-Protect icon in the system tray and 
select 'Configure Norton Anti Virus').
Setting Action on Virus Detection

Select the 'Email Protection' page.  To ensure scanning is transparent make 
sure that the 'Action' combo box does not have 'Ask me 
what to do' selected.  It is recommended that either 'Quarantine the attachment'
 or 'Delete the attachment' are used but the other two options will also 
work.
Linking VPOP3 Client to Norton

VPOP3 is the client from the point of view of Norton Anti Virus and Norton must be manually 
configured to pass traffic on to VPOP3.  This is done by placing a check mark in the 
'Enable Manual Configuration' check box on the 'Advanced' page under 
'Email Protection'.
Changing the Port Number for Norton

To avoid port number conflicts you should edit the registry entry for Norton.  Start 
'regedit' from the 'Start|Run' menu and navigate to 
'HKEY_LOCAL_MACHINE\SOFTWARE\Symantec\Norton AntiVirus\eMail Protection' and modify the 
'Default Port' to 'Hex 456' (Decimal 1110).  Make sure you are 
changing '\eMail Protection\DefaultPort' rather than '\eMail Protection\
Port\Default'.  Close regedit.

Configuring VPOP3

Edit the 'In Mail' tab in VPOP3 and set the POP3 server address to 

163 of 223Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



'pop3.norton.antivirus', set the username to 'userid/mail.ispname.com' 
substituting the original userid and pop3 server name and set the port number to 
'1110' to match the registry setting made in the Norton configuration above.

This completes the configuration changes.  Be sure to re-boot the machine to bring the new 
settings into effect.

Virus Scanning e-mail with Norton Anti Virus 2002

This article provides information required to enable automatic scanning of incoming e-mail
attachments for viruses using Norton Anti Virus 2002. Additionally, the process employs additional
software which is only included in the VPOP3 Plugins Pack or VPOP3 Enterprise. This configuration is
not available under VPOP3 Standard without the VPOP3 Plugins Pack. An alternative process that
was described in this article no longer works and should be avoided when using NAV2002 (symantec
have removed their POPROXY software). The process described results in a fully transparent
automated check of all incoming e-mail attachments routed through VPOP3.

Overview


All incoming e-mail attachments are extracted by VPOP3 and checked by calling the Norton on
demand virus scanner, NAVW32. Infected attachments are diverted by VPOP3 to an administrator
specified mailbox for monitoring purposes.


Implementing this process requires setting up VPOP3 to use Norton as an \'external router\' and
making sure the Norton background checker (Auto Protect) does not intervene in the e-mail
scanning process. The process, and associated options, are discussed in detail below.


For the purposes of this discussion it is assumed that a valid set up of the intended e-mail client
software, VPOP3 and Norton Anti Virus is already in place and has been tested. This is recommended
so as to avoid confusion if problems occur when adding the additional functionality of automated e-
mail scanning.

Configuring Norton Anti Virus


In order for this process to run unattended on a mail server it is necessary for Norton to be set to
scan mail in an automated and silent configuration.


Open the Norton configuration window by right clicking on the Auto Protect icon or selecting
'Options' from the main program. Click the 'Email' tab and ensure that e-mail protection is not
enabled for either incoming or outgoing mail as this will interfere with VPOP3. Click the 'Exclusions'
tab. Add 'C:\VPOP3\VSCAN*.*' to the list and close the properties dialog down.

Setting Up the External Router


Create an empty text file in 'C:VPOP3' called 'virusscan.cmd' and add the following line of text to it.


Win 9X: command.com /c "c:\program files\norton antivirus\navw32.exe" vscan*.* /m- /b- /s-
/Noresults
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Win NT/2000: cmd.exe /c "c:\program files\norton antivirus\navwnt.exe\" vscan*.* /m- /b- /s-
/Noresults


Note that Norton Antivirus 2002 seems to show a 'scan window' each time it scans an email, even
with the '/Noresults' setting above (this didn't happen with Norton Antivirus 2000/2001).
Unfortunately this makes it inconvenient if the VPOP3 computer is being used as a user's
workstation as well. 

Configuring VPOP3


If required a new mailbox can be set up to receive infection warning e-mails or they can just be
routed to an existing mailbox (typically the postmaster).


Edit the 'Misc' tab in VPOP3 and select the 'Define VPOP3 Extensions' button. Insert the following
text in the 'External Router' field:


'"c:\vpop3\vpop3decode.exe" -s -in -t:infected -d:vscan -v'


substituting the mailbox defined above for 'infected'


This completes the configuration changes. A re-boot is not required to bring the new settings into
effect.


NB: The VPOP3 installation directory may be a different directory to c:\vpop3. Earlier
versions of VPOP3 used c:\program files\vpop3 and you may also have decided to install
into a different directory during installation of VPOP3.

Virus Scanning e-mail with Panda Anti Virus V6.0 On Windows 9x

This article provides information required to enable automatic scanning of incoming e-mail 
attachments for viruses using Panda Anti Virus under Windows 95/98.  
Note that this process will disable the resident Panda Anti Virus software and your 
particular configuration may therefore be open to attack from non-email infections.  Ensure this 
process does not put your system at risk before implementing it.  
The process employs additional 
software which is only included in the 
VPOP3 Plugins Pack or VPOP3 
Enterprise.  This configuration is not available under VPOP3 Standard without the VPOP3 
Plugins Pack.  An alternative process is described in 
this article.  
The process described results in a fully transparent automated check of all 
incoming e-mail attachments routed through VPOP3.  Any attachment(s) found to be infected may
be 
dealt with in a number of ways as discussed below.  It is recommended that the attachment(s)
should 
be either quarantined or deleted.
Overview
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All incoming e-mail attachments are extracted by VPOP3 and checked by calling the Panda virus 
scanner.  Infected attachments are processed by Panda according to the administrator's 
requirements and a warning copy is forwarded to an administrator specified mailbox for monitoring 
purposes.

Implementing this process requires setting up VPOP3 to use Panda as an 'external router' and 
making sure the default Panda background checker (Sentinel or Internet) does not intervene in the 
e-mail scanning process.  The process, and associated options, are discussed in detail below.

For the purposes of this discussion it is assumed that a valid set up of the intended e-mail 
client software, VPOP3 and Panda Anti Virus is already in place and has been tested.  This is 
recommended so as to avoid confusion if problems occur when adding the additional 
functionality of automated e-mail scanning.

Configuring Panda Anti Virus

In order for this process to run unattended on a mail server it is necessary for Panda to be 
set to scan mail in an automated and silent configuration.  If Panda is running resident (icon 
present in task tray) then unload both Sentinel and Internet to stop Panda intervening by selecting 
the 'Unload' option from the right click menu.
Setting Up the External Router

Create an empty text file in 'C:\VPOP3\' called 'virusscan.cmd'
 and add the following line of text to it (including the quotes).

command.com /c "C:\Program Files\Panda Software\Panda Antivirus 6.0\pavcl.exe" 
c:\vpop3\vscan /nom /nob /clv /nsb /cmp /nos /aex /aut
Configuring VPOP3

If required a new mailbox can be set up to receive infection warning e-mails or they can just be 
routed to an existing mailbox (typically the postmaster).

Edit the 'Misc' tab in VPOP3 and select the 'Define VPOP3 Extensions'
 button.  Insert the following text in the 'External Router' field:

'c:\vpop3\vpop3decode.exe -s -in -t:infected -d:vscan -v'

substituting the mailbox defined above for 'infected'

This completes the configuration changes.  A re-boot is not required to bring the new 
settings into effect.

Virus Scanning Email Attachments using VPOP3

A commonly requested facility is the ability to scan incoming and/or outgoing attachments for
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viruses.


Most standard virus scanners are not able to detect viruses in attachments which pass through
VPOP3. This is because they are encoded using either BASE64 or UUENCODING which most virus
scanners do not understand. 


Because of this, VPOP3 has been created with \'hooks\' to allow the integration of virus scanners into
their operation. The most common methods are: 



    From VPOP3 2.0.0, VPOP3 has integrated support for avast! for VPOP3. This works with POP3 and
SMTP incoming and outgoing mail. 

    From VPOP3 1.4.1 onwards, VPOP3 has integrated support to work with Sophos Antivirus. This
works on POP3 & SMTP incoming and outgoing mail. 

    The VPOP3 Plugins Pack contains a utility called VPOP3DECODE which can extract attachments
from both incoming and outbound messages and pass them to most virus scanners for scanning,
and then it will redirect infected messages to an administrator. This works on POP3 & SMTP incoming
and outgoing mail. 

    A third party company called "Microworld Systems" have a product called MailScan for VPOP3
which can scan incoming and outbound attachments using its own virus scanner software.
(Microworld Systems are not related in any way to Paul Smith Computer Services). This works on
POP3 & SMTP incoming and outgoing mail. 




Note that we strongly recommend that you have a virus scanning package on each computer on
your network as the first line of defense against viruses, and just use any VPOP3 based virus
scanning as a secondary defense. Scanning emails for viruses will not protect against viruses
downloaded from websites, or brought in on floppy disks or CD-ROMs.

Virus Scanning with Norton Antivirus 2003 or 2004 and VPOP3

Norton Antivirus 2003 and 2004 &trade; have a transparent email scanning system which can scan
both incoming and outgoing emails for viruses without needing any configuration changes in the
emailclient.


As far as Norton Antivirus 2003 and 2004 are concerned, VPOP3 is just like any other emailclient, so
it will scan emails collected or sent by VPOP3 \'out of the box\'. 


The only thing to be aware of is that the default settings of Norton Antivirus 2003 and 2004will show
a message box on screen when a virus is detected, this box has to be cleared manuallybefore the
email message will actually be sent or received. This problem can be eliminated by telling
NortonAntivirus to \'Repair automatically then silently delete/quarantine if unsuccessful\', as shownin
the screenshot below. 


Note that this facility of Norton Antivirus will scan both outgoing SMTP and incoming POP3 email, it
will NOT scan incoming SMTP email, or email sent from one local user to another. Norton Antivirus
will scan the emails as they are sent by VPOP3 to your ISP\'s SMTP server, or as they are receivedby
VPOP3 from your ISP\'s POP3 server. It does NOT scan emails as they pass between your email
clientand VPOP3. 

Example Screenshots from Norton Antivirus 2003 (2004 is identical)
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NB: No settings changes are required in VPOP3 itself

VPOP3 - POP3 Client Connection Problem

These errors occur during the period when VPOP3 is trying to establish a connection to your ISP's
POP3 mail server to receive incoming mail. They can mean that you have entered the POP3 Server
address incorrectly, or that there is a problem with the Dial-up Networking or RAS connection
settings, or that your ISP's mail server is not working properly.


If the message text is: 

Pop3 Client not started - Couldn't connect to server XXXX (YY)

    Then this means that VPOP3 was having a problem connecting to the In Mail entry called
\'XXXX\'.

    

Following this text there should be a further description of the specific error which occurred. See
here for a description of those errors. 

VPOP3 - POP3 Client Problem

These errors occur whilst VPOP3 is communicating with your ISP's POP3 mail server to retrieve your
mail.


If the message text is: 

Error with Pop3 Client (XXXX (YY))


    


    The server connection was closed unexpectedly 

    Then this means that the the connection between VPOP3 and your ISP's POP3 mail server was
closed when VPOP3 did not expect it to be. This can be caused by the dial-up connection failing or a
bug in the ISP's mail server which drops the connection in abnormal circumstances.

    

Following this text there should be a further description of the specific error which occurred. See
here for a description of those errors. 
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If the message text is 

    The VPOP3 POP3 Client (XXXX (YY)) has encountered an error whilst retrieving messages from
your ISP POP3 server


        The received error was: "ZZZZZ"


        The last command sent by VPOP3 was: "WWWWWWWW" 

        This means that your ISP's POP3 mail server returned an unexpected error response when
VPOP3 sent a command. 95% of the time these errors are caused by problems with, or bugs in, your
ISP's mail server, so we recommend that you contact your ISP if the situation is not mentioned
below.

        

            If the last command sent by VPOP3 was "*ENV xxx", then this is probably because you have
told VPOP3 to use Demon POP3 extensions, but your ISP does not support them (most don't), so
go to the In Mail page in VPOP3, press the Routing button and disable the Use Demon POP3
Extensions option. 

            If the last command sent by VPOP3 was "USER", then this can mean that you have
mistakenly created a second In Mail configuration in VPOP3. Go to the In Mail page, then, using the
Svr: drop-down list, choose the second or later entry and find the one which does not have a User
Id: entry, then press the Remove button to remove that entry. 

            If the received error is something like "-ERR Invalid Login" then check the username and/or
password on the VPOP3 'In Mail' tab. Check this with your ISP. In all cases, this error is coming from
your ISP, so the details you have entered, don't match what your ISP have told you to enter. 

        

VPOP3 - SMTP Client Connection Problem

These errors occur during the period when VPOP3 is trying to establish a connection to your ISP\'s
SMTP mail server to send outgoing mail. They can mean that you have entered the SMTP Server
address incorrectly, or that there is a problem with the Dial-up Networking or RAS connection
settings, or that your ISP\'s mail server is not working properly.


If the message text is: 

SMTP Client not started - Couldn't connect to server XXXX (YY)

    Then this means that VPOP3 was having a problem connecting to the Mail Server entry called
'XXXX'.

    

Following this text there should be a further description of the specific error which occurred. See
here for a description of those errors. 

VPOP3 - SMTP Client Problem

These errors occur whilst VPOP3 is communicating with your ISP\'s SMTP mail server to send your
mail.


If the message text is: 

Error with SMTP Client (XXXX (YY))
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    The server connection was closed unexpectedly 

    Then this means that the the connection between VPOP3 and your ISP's SMTP mail server was
closed when VPOP3 did not expect it to be. This can be caused by the dial-up connection failing or a
bug in the ISP's mail server which drops the connection in abnormal circumstances.

    

Following this text there should be a further description of the specific error which occurred. See
here for a description of those errors. 

    

If the message text is 

    The VPOP3 SMTP Client (XXXX (YY)) has encountered an error whilst retrieving messages from
your ISP POP3 server


        The received error was: "ZZZZZ"


        The last command sent by VPOP3 was: "WWWWWWWW" 

        This means that your ISP's POP3 mail server returned an unexpected error response when
VPOP3 sent a command. 95% of the time these errors are caused by problems with, or bugs in, your
ISP's mail server, so we recommend that you contact your ISP if the situation is not mentioned
below.

        

            If the received error is something like "550 We do not relay" or "530 Relaying Prohibited" this
means that the ISP has some anti-relay protection in place and they do not think you are allowed to
send mail through their SMTP server. In this case, the first thing you should do should be to contact
the ISP to see if they can tell you why their server thinks that you shouldn\'t be allowed to send mail
through their server. If you are allowed to send mail through their server, they should be able to
help you change your setup to make this possible. 

        

        Note - unfortunately the error code number (eg 503, 525 etc) does not define what error has
occurred, it just indicates the type of error (eg a 5xx error means a 'permanent' error). Most mail
servers will give some human readable text after the error number, this gives more information
about the error.

VPOP3 allows any passwords to be used in WebMail/POP3 etc when
running as an NT Service

Some people have reported that VPOP3 will allow any password to be specified in the
WebMail/POP3/etc logins when VPOP3 is running as an NT Service. This may also lead to
the VPOP3 passwords being 'corrupted'.

In some cases VPOP3 will seem to allow any passwords if VPOP3 is running as an NT Service and the
<B>Allow NT Passwords</B> option is enabled on the <I>Users</I> -> <I>Advanced</I> window.
If this
option is checked, VPOP3 passes the login details to Windows to ask if that user can login. 
Windows NT will allow any username which is not defined in the NT user database to log in with any
password if the NT "Guest" account is enabled and does not have a password specified. In
some cases it has been seen that an apparent bug in NT will allow Guest access even if the 
"Guest" account is disabled.

If the <B>Cache NT Passwords</B> option is also enabled in VPOP3, then VPOP3 will overwrite the
existing VPOP3 password with the password which NT accepted - this can lead to the password being
set incorrectly since NT is allowing any passwords..

Solution
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You should ensure that the NT "Guest" account is both <B>Disabled</B> AND has a non-empty
password defined for it. This seems to stop the problem occurring.

VPOP3 1.5.1 and later will automatically check if an invalid username/password combination is
allowed by Windows and will disable the <B>Allow NT Passwords</B> option if it decides that it is 
unsafe (and will send a warning to the administrator to tell them about it).

Further Information
This does not appear to be a problem in Windows 2000 which is more careful about the 
"Guest" account.

The problem with NT allowing the Guest account even when it is disabled only seems to happen
when the Windows API <B>LogonUser</B> is called with the
<B>LOGON32_LOGON_NETWORK</B> logon type. The
<B>LOGON32_LOGON_INTERACTIVE</B> type (which is used by normal user logons) is not affected

This problem only occurs if a VPOP3 username does not match the NT username. If the VPOP3 
and NT usernames match, then VPOP3/NT will correctly only allow the correct password for the 
appropriate NT username.

VPOP3 and McAfee VirusScan 9

McAfee VirusScan 9 has a feature called \'WormStopper\'. McAfee recommend that this option is
enabled, and it may be enabled by default.


In normal operation this feature is a good idea as it checks outgoing emails for suspicious behaviour,
such as more than 5 messages being sent within 30 seconds. On a normal user\'s PC this should
rarely, if ever, happen.


However, if McAfee VirusScan 9 is installed on a computer containing a mail server program such as
VPOP3, it is entirely feasible that VPOP3 might send many more than 5 legitimate emails out within
30 seconds. Also, WormStopper can check for messages being sent to a large number of recipients
at once - this might be triggered by features such as VPOP3\'s distribution/mailing list server.


To access the WormStopper settings:



right-click the McAfee \'shield\' icon in the task tray, point to VirusScan then Options.

Click Advanced, then click the WormStopper tab.


To prevent any problems when using McAfee VirusScan 9 on a computer with VPOP3 we
recommend one or more of the following actions:



Disable the WormStopper feature on the VPOP3 computer (we do not recommend that it is disabled
on other computers which McAfee VirusScan 9 may be installed on, as it is, in general, a good idea)

Disable the Alert me when X e-mails are sent within Y seconds option as that is the option most
likely to be triggered inadvertently by VPOP3. Alternatively, modify the \'X\' setting upwards based
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on your expectations. For instance set it to check for 20 emails being sent if you would usually only
have 10 or so messages in the VPOP3 Out Queue at once.

Disable the Alert me when an e-mail is sent to Z or more recipients option, if you use distribution or
mailing lists within VPOP3. Again, as an alternative, you may want to leave it enabled, but adjust the
\'Z\' setting appropriately.


It is unclear what the Enable Pattern Matching option in WormStopper does, so it may be possible to
leave that option enabled.


If you decide to leave any of the WormStopper options enabled, note that when WormStopper does
detect suspicious activity it will alert you (via the display on the VPOP3 computer). So, you should
periodically check the display there because if an alert is displayed it may prevent VPOP3 from
sending any outgoing email.


Keywords: McAfee VirusScan WormStopper Outgoing Email

VPOP3 and Windows Terminal Server

VPOP3 will run on a Windows Terminal Server with no problems and will allow other computers and
remote Terminal Server sessions to access the mail facilities. 


VPOP3 2.x works fully with Windows Terminal Server, however you can not remotely configure
VPOP3 1.x using a remote Terminal Server session. 


You can configure VPOP3 1.x from the Terminal Server computer itself, or by using the Web
Administration facility, or by using a program like pcAnywhere, VNC or LapLink. 

More Information

This limitation with VPOP3 1.x is because Terminal Server isolates the remote sessions fully, so if
you try to access the VPOP3 1.x settings from a remote session, the Control Panel applet, or
command line utility will ask Windows 'Is VPOP3 running?', and (because the remote session is
isolated from the native Terminal Server session) Windows will say "No it's not". A new copy of
VPOP3 will then be launched, rather than trying to talk to the already running copy of VPOP3. This
may then cause problems when 'binding' sockets, and any setting changes you make will not pass
through to the running copy of VPOP3.


This problem is resolved in VPOP3 V2, so, if you need to be able to administer VPOP3 remotely
without using a program like pcAnywhere, VNC etc, then you may need to upgrade (the upgrade to
VPOP3 V2 is not be a free upgrade for all users). 


 


Windows Terminal Server technology is also used with the Windows XP Remote Desktop and Fast
User Switching features.
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VPOP3 can't connect using dial-up networking on a network with
Microsoft Proxy Server

If you have VPOP3 running on a computer which has the 'Microsoft Proxy Server Client' software
installed, it will not be able to connect to the Internet using a dial-up connection.

This is a known problem with the Proxy Server Client, and Microsoft recommend that you disable
the Proxy Server Client whilst you need to use the dial-up connection.

For more Information see the Microsoft Knowledge Base and search for article 
Q196267

VPOP3 cause Windows to reboot

If a Windows NT/2000/XP computer reboots when VPOP3 tries to send/receive data over the 
network it is probably because the computer is having a blue-screen crash ('BSOD') and the
Windows settings are set to automatically reboot in this situation.

For causes of a blue-screen crash, see 
article 175.

VPOP3 Crashes when going to the Connection tab on NT/2000

If VPOP3 crashes when you view the Connection tab in the VPOP3 settings, or after running for a 
few minutes then the problem could be that VPOP3 is trying to use the Windows NT/2000 
'Remote Access' facilities, but they have either been uninstalled or disabled.
RAS Uninstalled

If you install RAS in NT/2000 and then uninstall it later, the uninstall procedure does not 
remove all the RAS files from the Windows System directory. Specifically, it leaves the file
<B>RASAPI32.DLL</B> in the <B>\WinNT\System32</B> directory. Microsoft recommend that you
check 
for this file to see if RAS is installed 
(see here)
- this is what VPOP3 does, but if RAS has been installed and then uninstalled, it will crash VPOP3.

You can resolve this issue by manually deleting the <B>\WinNT\System32\RASAPI32.DLL</B> file.
RAS Disabled

If you have installed RAS in Windows NT/2000 and then disabled the service, VPOP3 will still
try to use it, but the RAS libraries will then crash.
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You can resolve this issue by restarting the RAS service - Go to the <B>Services</B> applet 
(in the <B>Control Panel</B> in Windows NT or <B>Administrative Tools</B> in Windows 2000),
and 
check that the <B>Remote Access Connection Manager</B> service is running.

Further Information
Both these issues should have been fixed in VPOP3 1.4.6 beta and later which now checks for the 
existence of the <B>Remove Access Connection Manager</B> service and checks that it is not
disabled
before using the Windows NT/2000 RAS facilities.

VPOP3 crashes with a Stack Overflow

If VPOP3 crashes with a stack overflow, then it usually means that somehow it has got stuck in a
loop whilst sending a message.

For instance, if the 'Main Administrator' is set to a non-existant user, when an error message is
generated by VPOP3, 
it will try to send the message to the Main Administrator, which doesn't exist. This will then cause
another
error to be sent to the Main Administrator, which will also fail, and so on.

This problem should not occur in any versions of VPOP3 from VPOP3 1.3.0c or later, but it could
happen in certain situations in VPOP3 1.3.0 - 1.3.0b.

You should check that you are using either VPOP3 1.3.0c or the current beta version of VPOP3. Then, 
check that the 'Main Administrator' (set on the <B>Admin</B> tab) is set to a valid VPOP3 user
name.

If you have checked these settings, then you may have managed to create a configuration loop
which is 
not checked for (the vast majority of possible loops are detected, but it is possible that some
possibilities have
slipped through the tests). In this case, on the VPOP3 'Diagnostics' tab, set the 'Log Level' to 'Full
Logging', and when you get the Stack Overflow crash again, send the VPOP3.LOG file to
support@pscs.co.uk.

If you get a stack overflow as soon as VPOP3 starts up, then it probably means that there is some
task queued to be done which is causing the problem. 
To remove any queued tasks:

Delete the 'SUMMARY.LOG' file from the VPOP3 directory
Temporarily move any files out of the VPOP3\Housekeeper directory
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Then try restarting VPOP3.

VPOP3 doesn't make sounds on Windows NT/2000

When VPOP3 is running as a Windows NT/2000 service it runs in a user account called
<B>LocalSystem</B>
which means that any sounds associated with the currently logged in user will not apply to VPOP3.

You need to set sounds for the <B>LocalSystem</B> user to cause VPOP3 to make sounds when it
is
running as an NT service.

Unfortunately, in current versions of Windows there is no easy way to set sounds for this user.
We have found that the following procedure works, but it involves editing the Windows registry 
manually, so take care, and be sure to back up the system before making changes as mistakes may
lead
to problems when booting the computer.
Procedure

Set the sounds up as you want them in your current user setup
Using RegEdit, export the registry branch at
<B>HKEY_CURRENT_USER\AppEvents\Schemes\Apps\VPOP3</B>
to a file.
Edit the resulting .REG file (eg using Notepad) to replace <B>HKEY_CURRENT_USER</B> with 
<B>HKEY_USERS\.DEFAULT</B>
Using RegEdit, reimport the .REG file

VPOP3 Enterprise and SSL connections

VPOP3 Enterprise 2.2.0 and later support SSL/TLS connections from email clients & web browsers.


It supports HTTPS connections for the WebMail/Admin service, and the 'STARTTLS' command for the
POP3/SMTP & IMAP4 services. Note that the 'STARTTLS' command operates on the standard ports
(110, 25 and 143) and allows the email client to negotiate an SSL connection after connecting.
VPOP3 doesn't currently support the SSL versions of POP3/SMTP/IMAP4 on alternative ports.


To use SSL connections you need to create an SSL certificate for VPOP3 to use.


The download 'VPOP3GENCERT.ZIP' contains a utility to create a certificate in a suitable form. 


If you want to get a certificate from an alternative location, you need them in 'PEM' form - store the
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public key as 'vpop3sslc.pem' and the private key as 'vpop3sslk.pem' in the VPOP3 directory.

VPOP3 Error Messages

This list does not contain an exhaustive list of error messages which VPOP3 generates as there are
too many to list and most of them should never be encountered. If you come across an error
message which is not listed here, then contact support@pscs.co.uk This list contains only those error
messages which are emailed to the Main Administrator in VPOP3, it does not describe messages
logged in VPOP3.LOG or ERRORS.LOG.

Message Subject



    VPOP3 - POP3 Client connection problem 

    VPOP3 - POP3 Client Problem 

    VPOP3 - SMTP Client connection problem 

    VPOP3 - SMTP Client Problem 




See also VPOP3 Socket Errors 

VPOP3 Exception in Epanoopy

If you have installed VPOP3 2.1.0 or later and have the Epanoopy spam filter software installed, you
may get an email with a subject "VPOP3 Exception Occurred"


If this email contains a line like:


Exception occurred at 0419223c:Access violation (in MsgProcessor  Plugin:Epanoopy spam filter
2.3.0 build 246)


then this means that the problem occurred in the Epanoopy software. This is due to a bug in the
Epanoopy software version 2.3.0 build 246 which cannot handle VPOP3 calling it in a multithreaded
fashion.


To make VPOP3 call Epanoopy just once at a time, go to Utilities -> Misc Settings in the VPOP3
settings and turn on the option Do Not Multithread VPOP3 Plugins. This should stop the problem
happening, but at the expense of longer message processing times in some situations.


You should also contact Epanoopy Technical Support at support@epanoopy.com for information on
any later releases which have this problem fixed.

VPOP3 Fax Server stops sending/receiving faxes

If the VPOP3 Fax Server stops sending/receiving faxes after working OK previously, then some things
to check are:
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    If VPOP3 is running as a service in the 'Local System' account, go to Control Panel -> System ->
Advanced -> Environment Variables. Check the 'System Variables' for the TMP and TEMP variables.
Go to step 3

    If VPOP3 is running as an application, or as a service in a different account, log in to Windows as
the account being used by VPOP3, go to Control Panel -> System -> Advanced -> Environment
Variables. Check the 'User variables' for the TMP and TEMP variables. Go to step 3

    Check that the directories pointed to by the TMP and TEMP variables is accessible by the account
which VPOP3 is running under. VPOP3 needs to be able to both read and write files in those
directories

    Check that the directories pointed to by the TMP and TEMP variables are not full of junk. Delete
old files from there if necessary.


VPOP3 gives an error containing -ERR - Authorization failed

VPOP3 returns an error saying something like:

VPOP3 has encountered an error whilst retrieving messages from your ISP
POP3 server ()
The error received from the ISP was: "-ERR - Authorization failed"
The last command sent by VPOP3 was: "PASS ****"

This problem is usually an ISP problem which VPOP3 is just forwarding on to you.
Check with your ISP for more information.

This error means that VPOP3 tried to log onto your ISP using the username/password set on the
<I>In Mail</I>
tab, and the ISP reported that the logon attempt failed. This means that the username and/or
password
you have entered does not match that which the ISP has assigned to you, so you should check the
settings with your ISP.

The actual wording of 'Authorization failed' may be different depending on what POP3 mail
server software your ISP is using, other possible error texts are:

  -ERR - Bad Login
  -ERR - User Unknown
  -ERR - Unknown User
  -ERR - Invalid Password
  -ERR - Unknown Hostname

(This is <B>not</B> an exclusive list)

VPOP3 gives an error containing -ERR - No such message

VPOP3 returns an error saying something like:

VPOP3 has encountered an error whilst retrieving messages from your ISP
POP3 server ()
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The error received from the ISP was: "-ERR - No such message"
The last command sent by VPOP3 was: "RETR x"

This problem is usually an ISP problem which VPOP3 is just forwarding on to you.
Check with your ISP for more information.

This error should not happen. What it means is that the ISP has told VPOP3 that there are a number
of 
messages waiting for collection, then when VPOP3 asks for one of the messages, the ISP now tells 
VPOP3 that that message doesn't exist.

The only ways that we know of where this can happen are:

  The ISP's mailbox storage for your account is corrupted (contact the ISP to repair it)
  The ISP incorrectly allows two or more login sessions to your account, so one session deletes
a message before the other session downloads the message (contact your ISP to get them to make
them
fix their mail server)
  The ISP allows both POP3 and SMTP delivery of mail at the same time (eg Demon Internet). So the
message gets delivered using SMTP before the POP3 collector part of VPOP3 can download the
message. (You
need to make sure that only one mail collection method is used, either set up VPOP3 not to use POP3
to download the message, or contact the ISP to ask them to turn off SMTP delivery of your mail)

VPOP3 gives an error containing -ERR - Unable to copy mail spool file

VPOP3 returns an error saying something like:

VPOP3 has encountered an error whilst retrieving messages from your ISP
POP3 server ()
The error received from the ISP was: "-ERR - Unable to copy mail spool file"
The last command sent by VPOP3 was: "PASS ****"

This problem is usually an ISP problem which VPOP3 is just forwarding on to you.
Check with your ISP for more information.

This error means that VPOP3 has logged on to your ISP, but a problem on the <B>ISP</B>'s mail
server means that it can't access your mailbox contents. This could be because the ISP's mail storage
has been corrupted in someway and needs repairing, or the ISP's mail server disk is full, or
something
similar.

<B>You should contact the ISP and tell them of the error message</B>. Only your ISP will be able
to fix this problem!
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VPOP3 gives an error containing -ERR POP3 Lock Busy - Is another session
active

VPOP3 returns an error saying something like:

VPOP3 has encountered an error whilst retrieving messages from your ISP
POP3 server ()
The error received from the ISP was: "-ERR POP3 Lock Busy - Is another session active?"
The last command sent by VPOP3 was: "PASS ****"

This problem is usually an ISP problem which VPOP3 is just forwarding on to you.
Check with your ISP for more information.

This error means that VPOP3 has tried to log on to your ISP, but your ISP thinks that
another user or program is currently accessing your POP3 mail account. The POP3 protocol
only allows one session to access a POP3 mailbox at once, so your ISP will reject any
more login attempts until the first session has finished.

There are several reasons this can happen:

 There really are two or more programs/users trying to access the same POP3 account at the
same time.
 There's a problem on the ISP which means that it thinks your mailbox is in use when it
isn't really (contact your ISP for help)
 If you have an disconnection error (eg 10054, 10060) whilst downloading messages, 
the ISP POP3 mail server may take a few minutes (sometimes up to 30 minutes) to realise that you
have been disconnected, so for that time it will be unable to allow further access to your POP3 
account.

VPOP3 gives an error containing -ERR Unable to process From lines
(envelopes)

VPOP3 returns an error saying something like:

VPOP3 has encountered an error whilst retrieving messages from your ISP
POP3 server ()
The error received from the ISP was: "-ERR Unable to process From lines (envelopes)"
The last command sent by VPOP3 was: "PASS ****"

This problem is usually an ISP problem which VPOP3 is just forwarding on to you.
Check with your ISP for more information.

This error means that VPOP3 has logged on to your ISP, but a problem on the <B>ISP</B>'s mail
server means that it can't access your mailbox contents. This usually happens if your
ISP POP3 mailbox index has become corrupted in someway and needs repairing.
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<B>You should contact the ISP and tell them of the error message</B>. Only your ISP will be able
to fix this problem!

VPOP3 is connecting through a proxy server/router and reports errors
'11002' when trying to connect

If VPOP3 is connecting through a router or proxy server, VPOP3 may experience a DNS timeout
because the router/proxy takes too long to connect to the Internet.


You can increase the DNS timeout in VPOP3 by going to the Utilities -> Misc Settings -> Network
Tweaks page in the settings. Then increase the Async DNS Timeout to 30 seconds or so. 


(In VPOP3 1.5.0 and earlier this option is on Diagnostics -> TCP/IP Tuning)


 


Keywords: 11002

VPOP3 is running as an NT service and reports errors '11002' when trying
to connect

If VPOP3 is running as an NT service, sometimes it will report an error 11002 when connecting to a
dial up
ISP's mail server.

This can happen because Windows NT gives services a different set of settings from normal
applications, and
sometimes the ISP's dynamically assigned name server addresses aren't applied to the NT service
program settings.

To stop this problem, go to the NT Control Panel - Network - TCP/IP - DNS Settings, and program the
ISP's
DNS servers into the global NT settings. You will need to reboot the computer after making these
changes.

If your ISP does not tell you their DNS server addresses, you can find them out by using the
<B>IPCONFIG</B>
program from the NT command line.

VPOP3 keeps re-sending large outgoing messages

When VPOP3 sends a message to another SMTP server, it has to wait for an acknowledgement back
from that server before it knows whether the message has been accepted or not. If VPOP3 doesn't
get an acknowledgement, it has to assume that the message hasn't been sent, so it will try to send
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the message again at a later stage.


Most ISPs will acknowledge receipt of a message within a minute or less. This causes no problems
for VPOP3, which will (by default) wait up to 5 minutes for an acknowledgement..


However, some 'security' software will intercept messages as they are being sent by VPOP3, for
instance, to scan them for viruses. In this case, VPOP3 thinks it is sending the message to the ISP,
but it is really being captured by the virus scanner. When VPOP3 has finished sending the message,
the virus scanner will then scan the email for viruses, and then re-send the message on to the ISP. It
won't send an acknowledgement to VPOP3 itself, as it cannot tell whether the ISP will accept the
message or not. Then, once the ISP has finally accepted the message, and acknowledged it, the ISP
will send an acknowledgement to the virus scanner, which will then copy the acknowledgement back
to VPOP3. 


For small messages this method of scanning emails works fine, as the time when the message is
being scanned and then re-sent to the ISP is quite short. However, if the message is large, it may
take several minutes for the message to be re-sent to the ISP. During this time, VPOP3 is waiting
patiently for an acknowledgement to come in.


A well written virus scanner will periodically send back responses to VPOP3 saying 'here's a
response, but more will be coming along later'. If this happens, VPOP3 will not time out, as it will
keep receiving data telling it that the message is still being processed, and it will wait until it
receives the final response from the ISP. However, some virus scanners don't do this (this might be
because other SMTP client software cannot handle multiple responses at this phase of message
sending, or it may be an oversight), so, if the message takes more than 5 minutes for the virus
scanner to send to the ISP, VPOP3 may time out and drop the connection. In that case it will not
receive an acknowledgement, so it doesn't know that the message has been sent correctly, and it
will re-send the message later.


You can increase the timeout in VPOP3 - go to Utilities -> Misc Settings -> Network Tweaks and
increase the Client setting in the Socket Timeouts section. The default is 300 seconds (5 minutes),
so you can try increasing this to 600 seconds or more. Note that as you increase it, VPOP3 will
respond more slowly to real problems which need a timeout to recover from, so it should not be
increased too much.


The virus scanning or other security software you use may also have a setting such as 'Timeout
prevention' or similar, which you can turn on to stop VPOP3 timing out.


 

VPOP3 LDAP server crashes when used by Outlook XP

This problem will only affect VPOP3 beta versions 1.4.4 and later.

When you do an LDAP (or 'Directory Service') search in Outlook XP, VPOP3 will crash. This 
problem does not occur with earlier versions of Outlook or Outlook Express.

The problem will be fixed in VPOP3 1.4.7 beta, but there is a work around for earlier versions 
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of VPOP3.

 Close VPOP3
 In the VPOP3 directory is a file called 'LDAPDEF.DAT' take a copy of this file as a backup
 Using Notepad, open the file
 after the line <B>cn display-name -1</B> add a line
<B>cn displayName -1</B> (with the 'cn' at the very start of the line)
 restart VPOP3

VPOP3 on NT crashes when you go to the Connection tab

This normally means that VPOP3 believes that RAS is installed on the PC, but it is not running
properly. This can happen if you
have stopped the RAS service. It can also happen if you have had RAS installed in the past, but have
since removed it. NT does not
delete all the appropriate files, so VPOP3 thinks that RAS is installed.

	Go to the NT Control Panel, and open the Services applet. Check that the <B>RAS Connection
Manager</B> is started, if it is
	installed
	If you believe RAS is not installed, check in the WINNT\System32 directory to see if there is a file
called RASAPI32.DLL. 
	If there is, rename it to RASAPI32.OLD
	If you have applied any of the NT service packs, reapply them. You must always reapply the service
packs after installing
	the NT RAS software, so reapplying them ensures that this has happened.
	

VPOP3 on Windows 2000

VPOP3 works on Windows 2000 Professional, Windows 2000 Server and Windows 2000 Advanced
Server.


On Windows 2000 Server and Advanced Server there may be conflicts with some Windows services,
but these problems can easily be resolved, see here for more details. 

VPOP3 problems receiving messages from external mailing lists or BCC
messages

In many cases, when VPOP3 receives messages from a mailing list hosted elsewhere it will be unable
to work out who to route the message to if it is downloading mail from a POP3 mailbox. You will
receive a message saying:

Delivery Failure Report.

There was incoming mail with no recipients.

This is either because you do not have the 'Accepted Domain' field set

correctly on the 'In Mail' page or because this is an incoming message

from a mailing list. If this is the case, create a VPOP3
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Mapping from the 'TO:' field of the Mailing List and the intended

recipient(s)




This is because, when VPOP3 downloads mail from a POP3 mailbox it has to parse the message
header to work out who the message was intended for because the original SMTP envelope has been
discarded by the ISP. 


In many cases, mailing lists are run using 'BCC' to specify the recipients. This means that the
recipients' email addresses are not listed in the message header, so it is impossible for VPOP3 to
automatically work out who the message is for, eg: 

Received: from above.proper.com (above.proper.com [208.184.76.39])

by jupiter.nildram.co.uk (8.10.0-mysql/8.10.0) with ESMTP id fB5HLwp08980;

Wed, 5 Dec 2001 17:21:58 GMT

Received: from localhost (localhost [[UNIX: localhost]])

by above.proper.com (8.11.6/8.11.3) id fB5H9Tg16652

for ietf-822-bks; Wed, 5 Dec 2001 09:09:29 -0800 (PST)

Received: from episteme-software.com (champdsl-25-66.mcleodusa.net [216.43.25.66])

by above.proper.com (8.11.6/8.11.3) with ESMTP id fB5H9R216647

for ; Wed, 5 Dec 2001 09:09:27 -0800 (PST)

Received: from [10.0.1.3] (10.0.1.3) by episteme-software.com with ESMTP

(Eudora Internet Mail Server 3.1b1); Wed, 5 Dec 2001 11:09:21 -0600

Mime-Version: 1.0

Date: Wed, 5 Dec 2001 11:09:17 -0600

To: ietf-822@imc.org

From:

Sender: owner-ietf-822@mail.imc.org

Subject: Re: UTF-7 vs. UTF-8 for fallback charset?



Workarounds/Solutions



    If possible, consider changing to an SMTP mail feed where the SMTP envelope will be retained by
your ISP 

    Check the message header to see if the intended recipient's email address is listed there
somewhere. It may be in the Received: header lines, or a custom header line such as X-Envelope-
To:, Delivered-To: etc. In this case, see this article. Some ISPs offer these facilities, others don't -
consider suggesting it to your ISP, or changing ISP. 

    Use one or more Mappings to manually tell VPOP3 who the message is for. In the example above
you could create a Mapping of 'ietf-822@imc.org' -> '' 



More Details

This problem is not VPOP3 specific - it is related to the use of a POP3 mailbox for multiple recipients.
The POP3 standard was designed so that a single person's email would go into a single POP3
mailbox, so there was no need to retain the original recipient's email address as it could be implied
from the fact that a certain message was in a certain mailbox.


Unfortunately, nowadays, many ISPs give you a single POP3 mailbox to be shared by many people,
or domain hosting companies will forward mail on to a single user's POP3 account. 


Software such as VPOP3 lets you use these shared POP3 mailboxes for many people EXCEPT in the
case when the messages have been sent using BCC, in which case the underlying technology is not
the most suitable, and problems such as undeliverable messages can occur.
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VPOP3 Protection against Melissa virus

<B><I>First of all, VPOP3 itself will not be affected by the Melissa Virus, this protection is only
necessary to protect the Microsoft email clients which are open to attacks such as this</I></B>

To tell VPOP3 to protect against the Melissa Virus, there are two things you can do:

1) Install a Virus Scanner
VPOP3 can run a Virus Scanner on downloaded messages using the External Routing facility -
this is described in the VPOP3 help file under 'Virus Scanning', or try the VPOP3 Plugins Pack.

<B>Make sure that you have the latest updates for your virus scanner, and that it can detect
the Melissa Virus</B>

2) Use Download Rules

Messages which contain the Melissa virus all have the subject line "Important Message From -".

VPOP3 can filter these messages out using Download Rules.

	Create/Edit a file called DLRULES.DAT in the VPOP3 directory using a text editor
	Add the following lines to it:
		

		
		>infected

VPOP3 Protection against the 'LOVEBUG' Virus

<B><I>First of all, VPOP3 itself will not be affected by the I LOVE YOU Virus, this protection is only
necessary to protect the Microsoft email clients which are open to attacks such as this</I></B>

To tell VPOP3 to protect against the LOVEBUG Virus, there are two things you can do:

1) Install a Virus Scanner
VPOP3 can run a Virus Scanner on downloaded messages using the External Routing facility -
this is described in the VPOP3 help file under 'Virus Scanning', or try the VPOP3 Plugins Pack.

<B>Make sure that you have the latest updates for your virus scanner, and that it can detect
the LOVEBUG Virus</B>

2) Use Download Rules

Messages which contain the LOVEBUG virus and variants all have the subject line "ILOVEYOU", "fwd:
Joke", "Susitikim shi vakara kavos puodukui....", "How to protect yourself from the ILOVEYOU bug!",
"Mothers Day Order Confirmation" or "IMPORTANT: Official virus and bug fix".

VPOP3 can filter these messages out using Download Rules.

	Create/Edit a file called DLRULES.DAT in the VPOP3 directory using a text editor
	Add the following lines to it:
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		+>infected

VPOP3 Queue Browser doesn't work properly

Occasionally the remembered queue viewer column settings can get corrupted, so VPOP3 appears to 
show nothing in the queue browser window.

The solution is to delete the remembered column widths, so VPOP3 will use the defaults again. To do 
this:

Close VPOP3
Run <B>RegEdit</B>, and find <B>HKEY_LOCAL_MACHINE\SOFTWARE\PaulSmith\VPOP3</B> in
the left hand
pane
In the right-hand pane, delete the value <B>QueueBrowser</B>
Restart VPOP3

VPOP3 will now use default settings until you resize the columns manually.

VPOP3 reports a disk space error when trying to send mail

The first thing you should do is check that there is enough free disk space on the disk where VPOP3
is installed. VPOP3 requires a certain amount of free space before it will allow new messages to be
sent, so the disk might not be totally full, but VPOP3 will still report that there is insufficient disk
space when you try to send a new message. This buffer zone is designed to help prevent the disk
totally filling up, which can cause lots of bigger problems!


If there is plenty of free disk space on the disk where VPOP3 is installed and VPOP3 is still reporting
an insufficient disk space error, then:



    If you are using VPOP3 1.4.0 or earlier, then it might be due to a bug in the Windows API
'CheckDiskSpace' function which does not behave as documented with large disks on Windows NT4
SP4 and later. VPOP3 1.4.0d and later use an alternative disk space checking API function which
does work correctly with large disks, so we recommend that you upgrade to VPOP3 1.5.0m - see
below 

    Check that the error is actually being reported by VPOP3, and not by your ISP. As a general rule, if
the error appears as a popup window or in a progress window in your email client, then the error is
being reported by VPOP3. If it appears in the VPOP3 status window, or in an email returned to the
message sender, then the out of disk space error is being reported by your ISP. If the error is being
reported by your ISP, then you need to contact them. The exact error text that VPOP3 2.2.0 and later
use for reporting this error is 452 4.3.1 Insufficient Disk space to send mail. Earlier versions reported
it as 452 Insufficient Disk space to send mail. 

    If the error is being reported by VPOP3, and you are certain there is enough free disk space on the
disk where VPOP3 is installed, and you are using VPOP3 1.5.0 or later, then you should check the
disk space buffer zones as described below, and if that does not explain the problem, contact
support@pscs.co.uk, with the details of the exact error message you receive, the amount of free
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disk space on the VPOP3 installation disk, the version of Windows, and the version of VPOP3. 



How to turn off VPOP3's disk space checking


You can turn off the disk space checks in VPOP3, but this is not recommended - if the disk fills up
and disk space checking is turned off, you may lose messages and/or VPOP3 settings!


To turn off the disk space checks in VPOP3 2.2.0, go to the Utilities -> Misc Settings page in the
VPOP3 settings, turn off the checkbox 'Enable disk space checking'. In earlier versions of VPOP3 you
will have to edit the registry manually as below:



    Close VPOP3 

    Run Regedit, and find HKEY_LOCAL_MACHINE\SOFTWARE\PaulSmith\VPOP3\Secret 

    Create or edit a DWORD value called CheckDiskSpace and set it to 0 (zero) 

    Restart VPOP3 



How to check the disk space buffer zones in VPOP3


 In VPOP3 2.2.0, go to the Utilties -> Misc Settings page in the VPOP3 settings. There is a section
called Disk Space Checking. This has the 4 different disk space checking settings, along with an
explanation of what they mean.


In VPOP3 2.1.0 and earlier, you need to check the registry manually:



    Close VPOP3 

    Run RegEdit and find HKEY_LOCAL_MACHINE\Software\PaulSmith\VPOP3\Secret 

    The SMTPDiskSpaceSpare setting is the number of MB (megabytes) which must be available on
the disk before VPOP3 will accept any new SMTP messages 

    The SMTPDiskSpaceSpare2 setting is the number of MB (megabytes) which must be available on
the disk after a message has been received using SMTP, before VPOP3 will continue to process the
message 

    The POP3DiskSpaceSpare setting is the number of MB (megabytes) which must be available on
the disk before VPOP3 will start a POP3 download session 

    The POP3DiskSpaceSpare2 setting is the number of MB (megabytes) over the size of a particular
message before VPOP3 will download that message using the POP3 protocol. 



Upgrade to VPOP3 1.5.0m


If you are using VPOP3 1.4.0 or earlier and you are encountering this problem, ideally you should
upgrade to VPOP3 1.5.0m or later here (Download VPOP3) 



    If you are using VPOP3 1.3.0c and you do not want to upgrade, a workaround is to do the
following

    

        Close VPOP3 

        Run Regedit, and find HKEY_LOCAL_MACHINE\SOFTWARE\PaulSmith\VPOP3\Secret 

        Create or edit a DWORD value called CheckDiskSpace and set it to 0 (zero) 

        Restart VPOP3 

    

    Note: This will not work with versions of VPOP3 earlier than 1.3.0c! 
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This is normally only required on NT4 (apparently with SP4 or later) and larger than 2GB disks. It
seems to be due to an error in the Windows NT function calls which return disk space with large
disks. VPOP3 1.3.3 and later use a different function which can handle large disks better. 

 

VPOP3 reports errors such as "POP3 Client not started - Error 11001"

Most of the time, errors such as this aren't caused by VPOP3 itself, but by errors in configuration,
either of VPOP3 or of your Dial-Up Networking
(RAS) connection . There are a few things you can do to try and find out what is going wrong.

	Do a visual check of the VPOP3 settings. On the <B>Mail Server</B> property page, ensure that
the <B>Address</B> fields refer
	to your ISP's mail server. Ask your ISP if you're not sure. Normally this will just be something like
<I>mail.isp.com</I>.
	Connect to your ISP manually using Dial-Up Networking (i.e. <B>not</B> using VPOP3 to do the
dialling).
	Tell VPOP3 to manually connect to your ISP (it is easier if you've set VPOP3 up to allow menu
dialling - see the <B>Misc</B> property page).
		
			If it connects properly now, then it's a problem with the entries on the VPOP3
<B>Connection</B> property page.
			If VPOP3 doesn't connect properly, then it's probably a problem with your DUN configuration.
		
	To check your DUN configuration.
		
			Open up a MS-DOS prompt.
			Type <I>ping www.pscs.co.uk</I>. You should see a display like this:

				
					Pinging www.pscs.co.uk [195.112.5.192] with 32 bytes of data:

					

					Reply from 195.112.5.192: bytes=32 time=561ms TTL=55

					Reply from 195.112.5.192: bytes=32 time=382ms TTL=55

					Reply from 195.112.5.192: bytes=32 time=327ms TTL=55

					Reply from 195.112.5.192: bytes=32 time=391ms TTL=55

				
			If that works, then type <I>ping >your ISP's mail server

VPOP3 scheduled connections don't work, but manual ones do

When you manually tell VPOP3 to connect to the Internet it works OK, but the scheduled connections
don't work.
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This problem can happen if you have a program or device on your network which is resetting the
Windows time every minute, on the minute. When the Windows time is changed (other than by time
elapsing) - for instance if a daylight savings time change occurs, or a program, user or external time
source changes the time, a message is sent to all applications telling them about this time change.
VPOP3 uses this indication to recalculate the next schedule time.


Assuming that VPOP3 is set to connect every 10 minutes, if the time changes at 10:00:00, then
VPOP3 will recalculate the next schedule time at 10:10, then, at 10:10, the time will be changed
again, so VPOP3 will recalcuate the next schedule time at 10:20, and so on. These time changes
usually occur before VPOP3 gets chance to check whether it should connect or not (which it does
every 10 seconds), so, it means that VPOP3 never gets chance to connect because of the schedule.


To verify whether this is happening, go to Logging -> Diagnostics in the VPOP3 settings, set Log
Level to Full Logging, wait a few minutes, then look in the VPOP3.LOG file. If the time is reset, you
will see lines in the log file like:

7/10/2005 13:09:00.000 - Next Schedule Time - 07, Oct 2005 - 13:10 (Type 5)


7/10/2005 13:10:00.000 - Next Schedule Time - 07, Oct 2005 - 13:20 (Type 5)


7/10/2005 13:11:00.000 - Next Schedule Time - 07, Oct 2005 - 13:20 (Type 5)


7/10/2005 13:12:00.000 - Next Schedule Time - 07, Oct 2005 - 13:20 (Type 5)


and so, with the 'Next Schedule Time' being logged every minute, on the minute. This happens
because VPOP3 recalculates the next schedule time when the clock is changed, so you see this entry
every time the clock is changed, ie every minute if some software/device is resetting the clock like
this.


In VPOP3 2.2.0 and later, VPOP3 behaves differently, so this will not be a problem, since it checks to
see if a connection is needed immediately after a clock change. In earlier versions of VPOP3, you
need to find what software/device is resetting the Windows clock, and either disable it, or make it
update the clock less frequently, or at a random time interval rather than every minute, on the
minute. Often routers will broadcast an NTP or SNTP message on the network to reset computer
clocks, so check your router settings if you do not have software specifically to update the clock.


The software built into Windows 2000/XP/2003 to update the clock will not cause this problem since
it updates the clock at random intervals, as necessary (based on the detected clock inaccuracy),
rather than regularly, every minute.

VPOP3 Server Blue Screens

If you get a blue screen (BSOD - "Blue Screen Of Death") whilst running VPOP3, it is most likely
<B>not</B> due to a bug in VPOP3. 
This is especially the case in Windows NT, 2000 or XP, but is also true in Windows 95, 98 and ME.

Blue screen errors are only caused by errors in <I>kernel mode</I> software. VPOP3 only contains
<I>application mode</I> software. This means that if there is a programming error in VPOP3 it will
cause Windows to generate an <B>Application Error</B> and VPOP3 will be closed down without
affecting
other programs on the computer.
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Kernel mode software includes things such as device drivers (eg VxDs in Windows 95/98/ME or SYS
files in Windows NT/2000/XP), and certain Windows systems components.

Application programs such as VPOP3 are prevented by causing BSODs by the way the Windows
architecture
is designed, and then by the CPU itself.

There are many articles on the Internet about BSODs and what can cause them - 
this one from
the Windows 2000 Magazine is a good example, and describes <I>kernel mode</I> and
<I>application
mode</I> as well as the meaning of the information on the Blue Screen itself.

In our example, most BSODs in association with VPOP3 are caused by either a fault with the 
network card, or a bug in the network card driver. This especially happens with low cost network
cards - network cards produced by Intel or 3COM tend not to have problems. However we have also
had problems reported which have turned out to be a problem with the display driver, CD writing
software (especially the 'packet mode' writers), RAID drivers etc. 

So, if you encounter a BSOD, 
ensure you have the latest drivers for your hardware, also check for firmware upgrades for any
flash upgradeable hardware, and, if possible, try changing your network card to one from
a different manufacturer.

VPOP3 Service starts, then stops immediately

If the VPOP3 service starts, then stops immediately, there are several common reasons for this:



    a related service (for instance the Remote Access Connection Manager or Sophos SAVI) is not
working properly

    some other software is conflicting with VPOP3

    a disk problem is preventing VPOP3 from writing to the log file

    a queued background task is causing VPOP3 to crash for some reason




Try starting VPOP3 as an application instead of as a service. To do this go to Start -> Programs ->
VPOP3 -> Start VPOP3 as an Application. VPOP3 and Windows will then be able to report any errors
which may be useful for diagnosing the problem. For instance, if a service crashes, Windows won't
display anything to the user, but if an application crashes, it will. Also, if VPOP3 encounters a conflict
with other software it may not be able to report this if it is running as a service, but it can if it is
running as an application


Also, try deleting the VPOP3.LOG file from the VPOP3 folder before starting VPOP3 and see if that
helps.
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It can also be useful to move any files out of the VPOP3\Housekeeper folder on the hard disk to a
temporary folder before starting VPOP3. This removes any background tasks from the VPOP3
queues


If VPOP3 still stops immediately after starting, see if anything has been written to the VPOP3.LOG
file. If something has been written there, this can be very useful to the PSCS help desk for
diagnosing the problem.


If the problem is solved by moving files from the VPOP3\Housekeeper folder, then try moving them
back into the Housekeeper folder one at a time to see if you can find the one which causes the crash
to occur. Then, send that, along with the VPOP3.LOG file to support@pscs.co.uk for further
assistance.

VPOP3 Service won't start

If the VPOP3 Service won't start, you should first of all check if VPOP3 will start as an application
instead of as a service. To do this, go to Start -> Programs -> VPOP3 -> Start VPOP3 as an
application.


If this works correctly, then try removing and reinstalling the service applet. Go to Start -> Programs
-> VPOP3 -> Service -> Remove VPOP3 Service, then Start -> Programs -> VPOP3 -> Service ->
Install VPOP3 Service and see if that helps


If VPOP3 won't start as an application either, see if it reports any errors during startup. If it does, try
searching for those in this knowledgebase.


Try upgrading to the latest 1.x or 2.x version depending on your licence to see if that fixes the
problem.


If you are still stuck, contact support@pscs.co.uk giving as much detail as you can, such as the
VPOP3 version number, Windows version number, any error messages which appear on screen or in
the VPOP3.LOG file in the VPOP3 folder, and any things you have tried to remedy the situation.


 See Also: 



    VPOP3 Service starts, then stops immediately

    Windows NT Service Database locked


VPOP3 Socket Errors

This list does not contain an exhaustive list of socket errors which VPOP3 can report as there are too
many to list and most of them should never be encountered. If you come across an error message
which is not listed here, then contact support@pscs.co.uk
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Also see Microsoft's list of error codes here. 

Message Number/Summary



    10047 - Addresses in the specified family cannot be used with this socket 

    10048 - Specified Address Already in Use 

    10049 - The specified address is not available from the local computer. 

    10051 - Network is unreachable

    10053 - The TCP/IP Connection was aborted by Windows. This was possibly due to a data
transmission timeout or protocol error. 

    10054 - The virtual circuit was reset by the remote end 

    10060 - Operation Timed Out 

    10061 - The attempt to connect was forcefully rejected 

    10503 - No More Data 

    11001 - Host not found (Authoritative answer) 

    11002 - Host not found (Non-authoritative answer) 

    11004 - Valid DNS Name - No data record of requested type 


VPOP3 Standard 1.5.0 incorrectly shutsdown and reports a licence key as
'pirated'

This happens if you have not entered the licence key in the correct form, including
the hyphens.

The licence key should be entered as:

<B>XXXX-XXXX-XXXX-XXXX-XXXX</B>

so the entire licence key length should be exactly 24 characters.

A small bug in VPOP3 1.5.0 will initially accept it without the hyphens, but 
then reject it later. This will be fixed in 1.5.0a and 1.5.1 beta.

VPOP3 Status Monitor reports error "-ERR Invalid Login"

The red icon <img height="32" alt="" src="http://kbase.pscs.co.uk/Image/vpop3icon.jpg"
width="32"/> which is shown in the Windows task notification area (near the clock) is displayed by
the VPOP3 Status Monitor program, not by VPOP3. When you tell the VPOP3 Status Monitor
program to "Connect to VPOP3 Server" it has to log into VPOP3 to gain access - this prevents
unauthorised users from accessing VPOP3, because the status monitor program is capable of being
run across a network.


If the status monitor reports -ERR Invalid Login then it means that the login details which the status
monitor program knows are not the same as the details configured in VPOP3 itself. The status
monitor logs in using an appropriate user's login details (usually the "postmaster" user, but any user
could potentially log in if given appropriate permissions in VPOP3), so, if you change the
postmaster's password, or delete the postmaster user and create another administrator, you need to
change the log in details in the VPOP3 status monitor as well.
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You do this by right-clicking on the status monitor icon in the task bar, then choose 'Configure Status
Monitor...', in the configuration dialog which appears, check the details in the Username and
Password boxes match the login details for an appropriate user account in VPOP3.


Note that VPOP3 will still be running when you get this error, the only problem is that the status
monitor cannot log into it. You can still log into the VPOP3 settings in this case, by going to Start ->
Programs -> VPOP3 -> Configure VPOP3 in the Windows menus


VPOP3 will usually lock out an account after more than 3 attempts to log into that account using an
incorrect password. This may mean that even if you have changed the settings to the correct login
details the account may be locked out so you still won't be able to access the account. See
"Accounts are locked out" for details on what to do in this situation.

VPOP3 summary report contains a totally wrong 'Online Time'

The daily summary log may report values like:

Number of Connections         4
Total Online Time      592621:31:00

This has been found to be due to other software changing the system time whilst VPOP3 is online.
This other 
software may set the time from an Internet time server.

VPOP3 Taskbar Icon changes colour

Some people have reported that the VPOP3 postbox taskbar icon, which is normally red, changes
colour to green, yellow, or blue.

This has been found to be due to problems with video card drivers, so you should ensure that you
have the latest version of the video drivers for your graphics card.

The icon colour is <B>not</B> changed deliberately by VPOP3, so the change of colour should not
affect the behaviour of VPOP3 in any way.

VPOP3 Tries to LAN Forward a message incorrectly

A bug in VPOP3 1.3.0 means that if you receive an incoming message addressed to something like:

<B>To: </B>
VPOP3 will treat this as a request to use LAN forwarding to send the message to a user called 
<B>user</B> on a computer called <B>domain.com</B>.
Solution

This has been fixed in 1.3.0c and later

192 of 223Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



If you do not want to upgrade to 1.3.0c or later, you can stop the immediate problem by deleting any
files called <B>HQ*.DAT</B> or <B>FQ*.DAT</B> in the <B>VPOP3\Housekeeper</B> directory
(preferably 
after reading them first to see if they contain anything important). Note that this won't prevent
the problem happening again in the future.
More Information

The SMTP: prefix is actually illegal according to the Internet mail standards, but some email 
clients (notably early Microsoft ones) add it anyway.

VPOP3 uses the SMTP: prefix internally to indicate that a recipient is reached using 
LAN Forwarding, and in VPOP3 1.3.0b and earlier the prefix in the message header is 
"leaking" into VPOP3.

Because VPOP3 will try to send the message using LAN Forwarding, it may trigger a router or 
proxy server to dial up periodically (eg every 10 minutes) if this problem happens.

VPOP3 Web Administration on Windows 2003

Windows 2003 comes, by default, with an extension to Internet Explorer called Internet Explorer
Enhanced Security Configuration (see here for details on how to manage it). This severely
restricts the functionality of Internet Explorer 2003 for Internet sites.


 As the above documentation says, with the Enhanced Security Configuration, "Applications that
rely on Internet Web sites and Web-based applications that run over a local intranet might not
function properly" - VPOP3 falls into this category


The Internet Explorer Enhanced Security Configuration disables many features of Internet Explorer,
such as Javascript, which are widely used on web pages. This will cause VPOP3 to report that
Javascript is not enabled - even though the scripting option may be enabled in the normal Internet
Explorer settings.


There are several options to solve this problem



    Use a different web browser, eg Opera or Mozilla Firefox 

    Use a web browser from a different computer 

    Add the VPOP3 WebMail/WebAdmin pages to the 'Local Intranet' or 'Trusted' zone in Internet
Explorer (see below) 

    Uninstall the Internet Explorer Enhanced Security Configuration (see below) 




The last two options above are described in more details below.

Add VPOP3 to the Local Intranet or Trusted zone


In Internet Explorer, go to Tools -> Internet Options -> Security. Click on Local Intranet (or
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Trusted sites), then press the Sites... button


If you get another dialog with checkboxes on it, press Advanced..., otherwise you\'ll already be at
the right screen.


In the Add this Web site to the zone box, put the IP address of the VPOP3 server, and press Add.
Make sure that the Require server verification option is NOT ticked

Uninstall Internet Explorer Enhanced Security Configuration


Go to Control Panel -> Add/Remove Programs, then Windows Components. Find Internet
Explorer Enhanced Security Configuration and remove it.


 


Keywords: 2003 Web Administration Web Mail Javascript

VPOP3's Spam Filtering capability

VPOP3 2.2.0 and later have a built-in spam filter capability. For earlier versions of VPOP3 you should
look at using a spam filter service such as Red Condor, or a spam filter program such as Epanoopy
or SpamPal, both of which work well with VPOP3.

Using VPOP3's built-in spam filter (VPOP3 2.2.0 or later)


In the VPOP3 settings, go to Utilities -> Spam Filter Settings -> General in the VPOP3 settings, and
turn on Enable Spam/Content filter on SMTP messages and Enable Spam/Content filter on POP3
messages


This will enable the spam filter with the default settings.


Now, whenever you send an outgoing message, VPOP3 will add the recipients to the spam filter
White List so that replies from those people will automatically be accepted, it will also add the
contents of the outgoing messages to the good side of the statistical analysis database, so that
VPOP3 will learn what the content of 'good' messages looks like.


Whenever VPOP3 receives an incoming message, it does various checks on the message, such as
DNS realtime blacklist lookups, statistical analysis, white/blacklist checking of the sender and
various heuristic and pattern matching tests. The results of all these tests are combined to
determine whether the message is likely to be spam or not. If it detects the message as spam, it will
automatically add it to the bad side of the statistical analysis database, and if it detects it as not
being spam, it will automatically add it to the good side of the database to adjust how future
messages are processed.


The statistical analysis database means that as VPOP3 learns about what are good and bad
messages that you send and receive, it will get better at detecting future spam.
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When VPOP3 detects a message as spam, it puts a VPOP3-SPAM: prefix into the message subject,
and adds a custom header saying:




X-VPOP3-SpamResult: YES



If desired, either the subject prefix or custom header prefix can be used by the filtering or 'rules'
capability in most email clients to filter detected spam into a special folder which can be quickly
checked for false positives before discarding the messages.

Alternatively, on the Utilities -> Spam Filter Settings -> General page in the VPOP3 settings, near the
bottom is an option Redirect, if you put a user name in there, VPOP3 will redirect detected spam into
that user's mailbox instead of into the intended recipient(s)'.

If VPOP3 incorrectly detects messages as spam, or not, there are four things you can do:



    

    Forwarding (or "redirecting" if your email client supports it) the message to
spam@yourdomain.com or notspam@yourdomain.com will make VPOP3 modify its 'opinion' of that
email message, so it will affect how that message will be treated in the future

    

    

    Modifying the VPOP3 WhiteList or BlackList (Utilities -> Spam Filter Settings -> White List/Black
List) lets you add sender email addresses which will be always allowed or always blocked

    

    

    You can modify the 'Rule Weights' on the Utilities -> Spam Filter Settings -> General settings
page. The bigger the 'weight', the more importance VPOP3 gives to that particular spam filter rule.
You can disable the rule by setting the weight to '0'.

    

    

    Modifying the spam filter scripts lets you fine tune how VPOP3 detects what is spam and what
isn't. This is an advanced facility as the spam filter scripts are like a simple programming language.
The Spam filter language documentation can be downloaded from here.

    




 

VPOP3's use of the Windows Recycle Bin

VPOP3 1.5.0 and later puts certain files into the recycle bin, instead of deleting them outright. It
does this because you may want to access the files after they have been 'deleted'.


The Windows recycle bin should automatically control the size of the recycle bin, with the maximum
size being defined in the recycle bin properties. 


Windows 2000 stores recycled files in a 'different' recycle bin for each user. If VPOP3 is running as
an NT service, then any files which it sends to the recycle bin will be stored in the 'Local System'
user's recycle bin, thus may not be accessible to a user logged in as a different account. This is for
security purposes, so you can't undelete or view files that someone else deleted. Windows will still
manage the recycle bin size and delete files that make the recycle bin go over the allotted size. 
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If Windows is not maintaining the size of the recycle bin, then it may be that the bin has become
damaged in some way. There are articles on Microsoft's knowledgebase talking about this
problem,eg: 



    Files Are Not Deleted From Recycler Folder 

    How the Recycle Bin Stores Files 

    There are more - search on Microsoft's KnowledgeBase 




You can stop VPOP3 putting files into the recycle bin if you wish, but if there's a problem with the
recycle bin on the computer, that should really be fixed instead/as well. 


To stop VPOP3 putting files into the recycle bin: 

In VPOP3 2.2.0


Go to the Utilities -> Misc Settings page in the VPOP3 settings, and turn on the option Don't put
deleted files into the Windows Recycle Bin.

In earlier versions of VPOP3



    close VPOP3 

    Run REGEDIT, find HKEY_LOCAL_MACHINE\SOFTWARE\PaulSmith\VPOP3\Secret 

    Change the 'DontUseRecycleBin' value to '1' 

    restart VPOP3 


VPOP3MIGRATE.EXE seems to contain the W95/Netbus-170 virus

If you are running Thunderbyte Antivirus when installing VPOP3 1.3.0, it may report that the
VPOP3MIGRATE.EXE file contains 
the <I>W95/Netbus-170</I> virus.

This is a false alarm, and has been confirmed to be so by Thunderbyte. 

We have changed the current versions of VPOP3MIGRATE so they do not contain the
signature of the Netbus virus.

VPOP3MIGRATE.EXE is only used during installation when upgrading from VPOP3 1.2.x to VPOP3
1.3.x, and can safely be deleted 
after upgrading VPOP3 without causing any problems.

Web Based Administration

VPOP3 contains a built in facility for administering it remotely via a web browser.


To use this facility in VPOP3 2 and later, tell your web browser to access
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http://:5108

    e.g.

    http://192.168.1.1:5108

         

            

You will need to log on using an administrator's username and password. Once you are logged on,
click on the 'Administer' button on the WebMail menu.

            

You can also access this by going to Start -> Programs -> VPOP3 -> Configure VPOP3 in Windows on
the PC where VPOP3 is installed, or right-clicking on the VPOP3 status monitor icon in the task tray,
and choose 'VPOP3 Settings'.

            VPOP3 1.5.0 and earlier

            

In VPOP3 1.5.0 and earlier, you access the web administration facility through

            

            

http://:5107

            

            e.g.

            

            

http://192.168.1.1.5107

            

            

Note that the web based administration facility in VPOP3 1.5.0 and earlier does not contain all the
settings that the standard settings pages do, but it contains the most frequently accessed settings.

What is "Postfix"

Postfix is an open source SMTP server program for Unix & Linux, which is used by many ISPs. It's an
alternative to the more widely known SendMail program.


If you get any errors in VPOP3 relating to Postfix, these are probably errors which your ISP's postfix
SMTP server is reporting to VPOP3 when VPOP3 is trying to send a message to it. You should contact
your ISP for help with these questions, or search on Google for details about the error you are
getting, as the error is being generated by the Postfix server, not by VPOP3; VPOP3 is simply
reporting the error to you.
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What is 'pop3.norton.antivirus'?

If you see 'pop3.norton.antivirus' as the mail server name, either in the VPOP3 <B>In Mail</B>
tab, or in your email client server settings, then this means that you have Norton Antivirus' email
scanning installed.

Norton Antivirus installs its email scanning by having its own 'POP3 proxy' which mail is 
downloaded through. So, the email client (or VPOP3) downloads the mail from the POP3 proxy 
(which is on your computer, but has the name 'pop3.norton.antivirus') and the POP3 proxy
downloads 
the mail from either your ISP or VPOP3 (depending on how it is configured).

When you collect mail from 'pop3.norton.antivirus', the POP3 user name (or account name) 
to use is entered as 'username/server address', eg 'fred/pop3.isp.com' or 'fred/192.168.1.1'. The
password
is the same as originally specified. 'pop3.norton.antivirus' takes the username and splits it at the
'/' character, using the second part as the mail server that IT needs to connect to, and the
first part as the user name to use.

What is 4DOS/4NT

4DOS and 4NT are two COMMAND.COM/CMD.EXE replacement programs which work on Windows
95,98,NT,2000. The advantage of these programs is that they have a much more powerful batch
processing language for .BAT files. This means that it can be possible to create extensions for VPOP3
using these batch languages, instead of needing to write a C/C++ or PERL program to do the task.

You can get 4DOS & 4NT from JP Software

What is a reverse DNS lookup

A reverse DNS lookup is when you look at a computer's IP address and try to find the DNS name
associated with that IP address. For instance, a reverse DNS lookup lets you tell that the IP address
131.107.0.15 is actually mail.microsoft.com (see www.dnsstuff.com for a Reverse DNS lookup tool).


Some mail servers, most notably AOL's, will refuse to accept incoming SMTP mail directly from any
computer which does not have a reverse DNS entry. This can cause messages to be blocked when
sending to AOL or other mail servers which implement this requirement.


VPOP3 itself does not use reverse DNS lookups to validate incoming SMTP mail. Experience has
shown that doing so can block large amounts of legitimate email, which is why it is not widely used
as a spam blocking mechanism.

How to configure a reverse DNS lookup entry


As reverse DNS entries need to be configured in DNS servers, VPOP3 cannot possibly do this for
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you.


You will usually only be able to set up reverse DNS if you have a fixed IP address from your ISP.


To configure a reverse DNS lookup entry, you need to add PTR DNS records into the in-addr.arpa
DNS zone. As that zone is not managed by you directly, the first step is to contact your ISP who will
either be able to do everything necessary (usually the case), or will be able to start things off, and
then tell you how to complete the task (usually the case if you have 256 or more IP addresses
allocated by your ISP). Note that some ISPs may refuse to set up reverse DNS entries for certain
types of Internet accounts, and some ISPs may charge for doing so.


 


See also: How Reverse DNS Works from www.dnsstuff.com

What is CUCIPOP

CUCIPOP is the name of a POP3 mail server used by many ISPs. It's written by
Cubic Circle and runs on Unix/Linux platforms.

What is greylisting

Greylisting is an anti-spam technology included in VPOP3 2.4.2 and later. It is available as standard
in VPOP3 Enterprise, or as part of the Spam Filter subscription. VPOP3 Standard without the Spam
Filter subscription does not include the Greylisting capability.


Greylisting is only of use if you have a incoming SMTP directly to VPOP3. It will not help if you collect
mail from an ISP's POP3 mail server, or if your incoming mail goes through an ISP's SMTP server on
the way to your VPOP3 server. In technical terms this means that the DNS MX records for your
domain must be pointing at your VPOP3 mail server.


If you have Greylisting enabled then VPOP3 will initially reject any message with a response telling
the sending mail server to try again later. For legitimate senders, their mail server will almost
certainly try again a few minutes later (without the sending person knowing about it), and VPOP3 will
then accept the message. Most spammers will not try again later, so the message will never arrive.


Greylisting will mean that messages will initially be delayed, but VPOP3 will remember if it has
allowed mail through from a certain sender to a certain recipient, and if they then send messages
again, that message will be accepted without any delay.

What is IMAP4

IMAP4 (Internet Mail Access Protocol V4) is a new mail retrieval protocol which can be used as an
alternative to the
POP3 (Post Office Protocol V3).

199 of 223Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



The main difference between IMAP4 and POP3 is that with POP3 the messages are only stored
<I>temporarily</I> on the
mail server until they are downloaded to the email client where the messages are stored,
manipulated, searched etc.
With IMAP4 the messages are stored permanently on the server, and they are manipulated,
searched etc on the mail server.

This difference means that, whichever computer a user uses to access his or her mail, the mail is
always
accessible when using IMAP4. With POP3, the user would have to copy the email client mailboxes
onto the new PC to
have access to their old mail. This makes it easier to have 'hot desking' (people just picking a free
desk when they
arrive at work) with an IMAP4 server like VPOP3 Enterprise.

IMAP4 also makes it possible to have shared message folders because multiple people can access
the same IMAP4
account at the same time and read messages at the same time as other people.

VPOP3 Enterprise uses the IMAP4 'ACL' (Access Control List) system to allow users to restrict which
people can access
which IMAP4 mailboxes and folders. Not many email clients support ACL yet
(Mulberry is one which does), so VPOP3 Enterprise's WebMail system allows
users to set the access restrictions on IMAP4 folders.

What is Logdb.db and why is it so big?

LOGDB.DB (either in the VPOP3 directory or in the VPOP3\_database directory) is a database file
used by VPOP3 to store historical logging information. This is things such as who sent messages to
whom, when, what the subject was, what attachments were included etc.


It is used for some of the Logging -> Reports reports in VPOP3, and has the data for those, and
possible future reports we may add.


You can tell VPOP3 whether to keep data in this database file or not, and, if so, how long to keep it
for, on the Logging  -> Admin Logs page in the VPOP3 settings in the Historical Logging section.


Note that if you reduce the number of days the data is kept there, VPOP3 will delete the older data
from the database, but it will not shrink the size of the database file. Instead the freed space will be
re-used by other data records.


If you want, you can clean out the file totally by



    Stopping VPOP3

    Delete the LOGDB.DB file (and LOGDB.DB-JOURNAL file if it exists)
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    Restart VPOP3




 

What is SAVI?

SAVI stands for <B>S</B>ophos <B>A</B>nti<B>v</B>irus <B>I</B>nterface. It is a
programming
interface which VPOP3 1.4.1 and later uses to call Sophos Antivirus to 
scan messages for viruses.

If you see an entry in the VPOP3 logs saying that VPOP3 was unable to load SAVI, it 
usually simply means that you do not have SAVI installed, so VPOP3 will not activate the integrated
virus scanning facilities.

To use VPOP3 with SAVI you need to buy Sophos Antivirus and have VPOP3 1.4.1 or later running on
a Windows NT or 2000
Windows NT or Windows 2000 computer with Sophos Antivirus installed.

What is SMTP?

SMTP stands for <B>S</B>imple <B>M</B>ail <B>T</B>ransfer <B>P</B>rotocol, and is the
method that is used to send all email around the Internet.

An SMTP server is a program which accepts incoming connections (usually on TCP/IP port 25) and
receives incoming mail. An SMTP Client is a program which sends mail to an SMTP server.

VPOP3 acts as both an SMTP server (to accept locally sent mail and incoming SMTP mail) and an
SMTP client (to send outgoing SMTP mail).

The SMTP standard is defined in RFC 822

What is the 'Validation Key' on the Register VPOP3 Window?

When you register VPOP3 you are sent some details by email which you should enter into the VPOP3 
<B>Registration</B> window (accessed from the <B>Info</B> tab)

With <B>Standard VPOP3</B> there are 4 boxes on this window: <I>Name</I>, <I>Number of
Users</I>, 
<I>Expiry Date</I> and <I>Licence Key</I>. All these must be entered exactly as you are told in
the email.

201 of 223Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



With <B>VPOP3 Enterprise</B> there is an extra box called <I>Validation</I>. This must also be
entered
exactly as sent in the email.

So, if you find that you are being asked for a <I>Validation</I> value and you do not have one, this
means that you have bought a licence for Standard VPOP3 but are trying to enter it into the VPOP3
Enterprise software - you should download a copy of Standard VPOP3 from 
our downloads page and install that over
your current VPOP3 Enterprise to downgrade to Standard VPOP3 without losing any settings (except 
those specific to VPOP3 Enterprise), and then re-enter the licence details.

What is the *ENV command?

The *ENV command is an extension to the POP3 protocol which has been implemented by Demon
Internet. It allows programs which know about it to access the "SMTP Envelope" of a message.
(VPOP3 knows how to use the *ENV command)

The SMTP Envelope contains who the message is from and a list of people that the message is for -
this may or may not be the same as the message header information (for instance if a message is
BCC'd to you, your address will not be in the message header, but it will be in the SMTP Envelope)

By being able to access the SMTP Envelope information, VPOP3 can route the downloaded messages
accurately even if they are BCC'd or come from mailing lists.

<B>Note:</B> as far as we know the *ENV command is only implemented by Demon Internet.
Other ISPs' mail servers will report an error if you try to use it on their servers.

To make VPOP3 use the *ENV command go to the <B>In Mail</B> tab, press the <B>Routing</B>
button and enable <B>Use Demon POP3 Extensions</B>

What is the APOP login method for POP3?

APOP is a more secure of logging into a POP3 account than the one usually used (plain text). With
APOP the password is not sent over the network, instead the password it's encrypted before sending.

VPOP3 supports APOP authentication both for collecting mail from an ISP and for email clients
collecting mail from VPOP3. However, note that not many ISPs support APOP, and neither do most
email clients..
Making VPOP3 use APOP authentication when collecting mail from the ISP
On the <B>In Mail</B> tab, choose "APOP" from the <B>Auth</B> drop-down listbox (just above
the <B>Routing</B> button)
Making VPOP3 accept APOP authentication from email clients
By default VPOP3 will accept either plain text or APOP logins. To make VPOP3 only accept APOP
logins, you should go to the <B>Local Servers</B> tab, and press the <B>Configure</B> button
on the "POP3 Server" line. Then check the <B>Require APOP Authentication</B> option.
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What is the difference between running VPOP3 as a service or as an
application?

The main difference between running VPOP3 as a service compared to running it as an application is
that Windows services start up when the computer boots up, and can run even when no one is
logged in. This means that, normally, a program such as a mail server should run as a service.


However, there are several drawbacks to running programs as services:



    Services cannot access mapped drives. Usually this isn't a problem with VPOP3, as we do not
recommend that any files are stored on network drives anyway, but if you do need to do this, then
you can't use mapped drives if VPOP3 is running as a service. You can use UNC path names from a
service, as long as the service is running as a user account which has permission to access that
UNC path.

    Services tend to run as the 'Local System' account, instead of as a particular user's account, and if
they do run as a particular user's account, that user may have different permissions (and,
sometimes, different Windows settings) from the currently logged in user. This can confuse users
who expect VPOP3 to have the same permissions and settings as the currently logged in user.

    Services have limited access to display things on screen. If VPOP3 detects it is running as a
service and it needs to display a message, it uses the 'Net Send' functionality to display messages
on screen. However, many PCs have this facility disabled by default nowadays, which can mean that
sometimes, critical startup problems might not be obvious.

    Some Internet security software will not display popup messages if they block a service's access
to the Internet, or network access to a service, but they will show popup messages if they block an
application. 

    Some 'transparent proxy' software works fine with applications, but not with services. In this case,
if you want to run VPOP3 as a service you may not be able to use the transparent proxy part of the
proxy software, but use an explicit proxy facility instead.




Our general recommendation is to run VPOP3 as a service normally, but if you have any problems,
try running it as an application to see if that works, or if any error messages are displayed when
running as an application that are not displayed when running as a service.


If VPOP3 runs correctly as an application, but not as a service, this is usually due to either some third
party software not behaving correctly with services, or due to the access rights for the service
account being more restrictive than the access rights for the currently logged in user.


 

What is the NAGLE algorithm

The Nagle Algorithm is a procedure used by TCP/IP protocol stacks to reduce network congestion by
grouping together small data packets into larger ones. It is described in full in RFC 896 (this is a very
technical document!).


The Nagle algorithm can slow down 'conversational' protocols such as POP3 and SMTP because it
makes the TCP/IP protocol stack wait for a short time before sending a packet of data. On the other
hand it will speed up one way transmission of data if the sending program is written in such a way as
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to send small blocks of data (eg sending one byte at a time). VPOP3 is written to group up data send
packets internally in any case, so the Nagle algorithm is usually redundant which is why the default
VPOP3 setting is to disable this feature. 


If you have problems with TCP/IP data transmissions through VPOP3 it is usually worthwhile
changing this option to see if it makes any difference. Usually the difference is small, but in some
cases one option will work dramatically better than the other.

What is the syntax of the VPOP3 Download Rules

VPOP3's download rules use a slightly idiosyncratic syntax which is quite simple to most people after
a short bit of learning.


The first line of the rule defines (a) whether all the conditions must match for the rule to be
triggered, and (b) what happens if the rule is triggered. Subsequent lines for each rule define the
conditions that must be matched.


The VPOP3 help file contains the full documentation for Download Rules.


 

What is the VPOP3 Password Server

The VPOP3 Password server lets a user/program change their password by Telnetting to Port 106 on
the VPOP3 computer.

As far as we know the only email client which supports changing a password using this mechanism
is Eudora (go to <B>Special</B> -> <B>Change Password</B>), but it can be used for changing a 
password manually, or there is a utility available on 
www.merula.net which will let you
change your password using this mechanism.
Using the Password Server manually

  Run <B>Telnet  106</B>
  Type <B>user </B>
  Type <B>pass </B>
  Type <B>newpass </B>
  Type <B>quit</B>

Note that unless you set <B>local echo</B> on in your Telnet client, then you won't be able to see
what you type, and the new password is not confirmed so make sure you type it correctly if you
are connecting manually (it is probably safer to turn on <B>local echo</B>).
Alternatives to the Password Server
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The easiest way for a user to change their password is to use the <B>Web Mail</B> facility in
VPOP3.

Open up your web browser, and point it at <B>http://:5108</B>. You can then
log in, go to the <B>Change Password</B> option and change your password.

Notes

  After changing your password in VPOP3 you must remember to change the password in
your email client software as well.
  If you change your password in VPOP3 and you are also a VPOP3 administrator, your administrator
password will be changed as well as your email password!

What Sophos package do we need to buy so that VPOP3 can use it for
scanning emails for viruses?

VPOP3 requires the Sophos SAV Interface component - this is part of the Sophos antivirus suite
which allows other programs to talk to the antivirus engine to scan particular files on demand, and
receive the results.


Sophos used to bundle SAV Interface with their 'Enterprise' licences, so you could buy a SAV
Enterprise licence, and get the SAV Interface licence free. Since the beginning of 2006 that is no
longer the case, so you need to purchase a suitable SAV Interface licence whether you buy a SAV
Enterprise licence or Sophos Small Business Edition licence.


You can also purchase SAV Interface licences on their own, so VPOP3 can use that for scanning
incoming and outgoing emails, and you can use a different virus scanner for other things.


VPOP3 cannot work directly with the "Sophos Small Business Suite" and "Sophos PureMessage Small
Business Edition" products. These require you to have the Microsoft IIS SMTP server running, and
have your incoming SMTP feed going that that. The IIS SMTP server then forwards
processed incoming mail onto VPOP3. Preferably the IIS SMTP server should run on a separate
computer from VPOP3. Also, note that these two products will only scan incoming SMTP mail. If you
have incoming POP3 mail, then you need to use VPOP3 with the SAV Interface, as that will scan both
incoming POP3 and SMTP mail.


Note that we if you are going to use one of the 'email server' versions of Sophos Small Business
Edition, then we cannot support the IIS part of this - you should contact Sophos for installation
instructions for that.


Using SAV Interface with VPOP3 directly will continue to be supported by us as normal.


Alternatively, look at one of the other Antivirus packages that works with VPOP3 - see here
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What to do if you have lost your VPOP3 Licence Key

If you have lost your VPOP3 licence key, we will be able to find it for you, but we do have to make a
nominal charge of £5.00 (+ VAT if applicable) to search for it as it is a time consuming task.


If you need us to do this search, then email sales@pscs.co.uk. 


If you have an annual telephone or priority email support contract, then this includes the fee for
finding lost licence keys.

Finding the licence key yourself



    If you still have VPOP3 installed, then you can get the licence details by going to the Info page,
and pressing the Check/Change Licence Details (or Register on older versions of VPOP3) button.
(This may not be possible if you bought the VPOP3 licence through a reseller - in that case you
should contact the reseller directly!) 

    If you purchased the VPOP3 licence directly from us, you will have received the licence details by
email, usually with a subject VPOP3 Purchase or PSCS Purchase Results or something similar,
so you may still have this email in your email client software. 

    If you purchased your VPOP3 licence directly from us, you can log into our website at
http://www.pscs.co.uk/myaccount/login.php then go to My Account and Old Licence Details. If you
have lost or forgotten your login details, you can go to the Forgotten Details page to have them re-
sent to you. 




If you cannot find the licence details using the above methods yourself, then you will need to ask us
to do the search for the licence details. This will require you to send us the payment as described at
the start of this article.


You can request this online, by going here. In the 'Licence Owner Name' box, put as much
information as you can to help us to find the licence.


We always strongly recommend that you keep a copy of all your software licence keys in a safe
place, as some companies won't be able to find your licence keys at all for you if you lose them, so
you will have to repurchase the software in that case.

What to do if you need more than 1 Assistant/Forwarding address

 In VPOP3, each mailbox can only set 1 forwarding address, or 1 assistant address. So if you need to
send a copy of your mail to more than 1 address, do as follows... 


Suppose you want a copy of all mail to bill@yourdomain.com to go to the following addresses



    michelle@yourdomain.com,

    bill@yahoo.com

    bill@yourdomain.com
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    Firstly remove any assistant or forwarding address that you had previously set.

    On the "Lists" page in VPOP3 make a list named "BillsMail"

    Add the people other than the originally intended recipient to the list (ie
michelle@yourdomain.com, & bill@yahoo.com )

    Now add two mappings in VPOP3 as follows :


    


    Bill@yourdomain.com   ->  BillsMail


    Bill@yourdomain.com   ->  Bill




 What happens now is that mail for bill@mydomain.com is delivered to the mailbox "Bill", and to
the list "BillsMail". From the list, a copy of the mail is then delivered to each member of the list.


Following this method you can now forward mail to any number of assistants or forwarding
addresses.

When installing the VPOP3 Enterprise Evaluation it says that the install
program has expired

When you install the VPOP3 Enterprise Evaluation software it may say that the installation program
expired in December 2000.

In fact, it expires in December 2002 (in the VPOP3 Enterprise 1.5.0b evaluation) - this is a 
typograpical error in the installer.

The reason it is saying that it has expired may be because, for some reason, the install program
cannot write the evaluation licence keys to the Windows registry. (This will only happen on Windows
NT, 2000 or XP)

To solve the problem:

go to the <B>Start</B> -> <B>Run</B> menu in Windows, run <B>REGEDT32</B>.
Find the <B>HKEY_LOCAL_MACHINE on local machine</B> window
Find <B>SOFTWARE\PaulSmith</B> in the left part of that window, and select it
Click on <B>Security</B> -> <B>Permissions</B> in the REGEDT32 menu
Check that <B>Administrators</B> have full control of this part of the registry - if not,
enable Full Control

When running VPOP3 you lose local network connectivity

This problem happens if you are running ONLY TCP/IP networking on your local network 

(not NetBEUI as well) and do not have a local WINS or DNS server installed.
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The symptoms are that after a while of using VPOP3, the other computers on the network will

not be able to see the VPOP3 computer using \'Network Neighborhood\' and the VPOP3 computer
will

not see the other computers on the network using \'Network Neighborhood\'. The computers will

still be able to PING each other, and will still see each other when using normal TCP/IP 

connections (eg when using POP3/SMTP to talk to VPOP3)




This problem is related to Microsoft Networking computer name resolution when using Netbios 

over TCP/IP - if you do not have a WINS or DNS server installed on your network, and are using 

only TCP/IP networking, the computers have to do TCP/IP broadcasts to find each other. Any
computer

which does TCP/IP connections over a <I>second</I> \"network\" connection (eg a dial-up 

connection) may have problems with this form of name resolution.




The workaround is to create an <B>LMHOSTS</B> file on the VPOP3 computer so that it will 

know where the other computers on the network are without having to do broadcasts. A basic
LMHOSTS

file has a very simple format. To create one, run Notepad and type something like:





   192.168.0.1 server

   192.168.0.2 computer2

   193.168.0.3 computer3

   etc....





Then save this file as <B>LMHOSTS</B> in the <B>Windows\\System</B> directory (on Windows
95/98/ME) or in the 

<B>WINNT\\System32\\Drivers\\etc</B> directory (on Windows NT/2000). (When saving the file
from Notepad,

 check that it does not add a <B>.TXT</B> extension to the name, as Windows will not read a file
called

<B>LMHOSTS.TXT</B>, it must be called <B>LMHOSTS</B> with no file extension.




When sending a message through Web Mail you get - VPOP3 Message
Error

When sending a message through VPOP3 you get a response

VPOP3 Message Error
<B>Your message could not be sent. This is probably because you forgot to enter something in one
of the text boxes.</B>

First of all, obviously, check that you did enter something in the <B>To</B>, <B>Subject</B> and
<B>Text</B>
boxes.
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If it isn't that, then it must be a problem with VPOP3 sending the message. VPOP3 Web Mail sends
the message through VPOP3's SMTP server, so a common problem is if you have set up restrictions
on access
to the VPOP3 SMTP Server.

On the <B>Local Servers</B> tab in VPOP3, press the <B>Configure</B> button on the <B>SMTP
Server</B> line. 
Then check:

 If you have any access restrictions defined, make sure that access from '127.0.0.1' is allowed. This
is the 'loopback' address which VPOP3 uses to send WebMail messages through itself
 If you have SMTP Authentication enabled, then you may need to set a <I>NOAUTH</I> access
restriction rule,
eg if you set an access restriction rule of 127.0.0.1 255.255.255.255 NOAUTH, then VPOP3
will allow unauthenticated sending from the local machine, and hence, from Web Mail. (This problem
will be fixed in 1.4.2 beta)

When sending a message to an external address you get a bounce
message about a mail quota being exceeded

If you send a message to an external email address and get an error message back
saying something along the lines of "This user has exceeded his mail quota", this
simply means that the person you are trying to send the message to has got too many messages
in their mailbox at their ISP, so their ISP is not accepting any more messages.

There is nothing you can do about this apart from contact the message recipient using
some other means and telling them about the problem and asking them to reduce the number
of messages in their ISP POP3 mailbox.

If this is happening when people send a message to you, then it could be because you
have VPOP3 set up to <B>Leave messages on server</B> for several days (on the <B>In Mail</B>
tab). In this case, either reduce the number of days that messages are left there 
(recommended), turn the option off totally, or contact your ISP and ask them to increase the
quota.

 The quota is NOT being implemented by VPOP3, because VPOP3 does not currently have any
mailbox quota functionality (as of VPOP3 1.5.0).

When starting VPOP3, we get an error "RASMAN.DLL" failed to load

This can happen if you have uninstalled RAS. The official way to detect whether RAS is
installed or not is to
check for a certain file. VPOP3 does what Microsoft recommend, but unfortunately that file doesn't
get deleted when RAS is uninstalled, so
VPOP3 thinks that RAS is still installed.
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If you delete the WINNT\SYSTEM32\RASAPI32.DLL file manually, VPOP3 will realise that RAS has been
uninstalled
and it will not try to initialise RASMAN.DLL.

When Using VPOP3 on the same machine as WinGate you get errors like
"POP3 Server not started - Couldn't Bind Socket 10048"

This is caused because both VPOP3 and WinGate are trying to provide a service on TCP/IP ports 25
and 110 (Port 25 is the SMTP port and Port 110 is the POP3 port). 


There are two possible solutions: 

If you want VPOP3 to connect to the Internet directly - not via WinGate


This is the easiest solution: 



    In the WinGate configuration remove the proxies for ports 110 and 25. Merely disabling the
proxies might not work, they should be removed totally. 




You will then need to shutdown and restart both WinGate and VPOP3. 

You want VPOP3 to connect to the Internet via WinGate


This solution needs a bit more thought. You need to reassign port numbers to services. 


Probably the easiest way is to modify the WinGate proxies for ports 110 and 25 so that they work on
ports 1110 and 1025 respectively instead. Then in VPOP3, on the Mail Server property page,
change the Port for the POP3 Server to 1110, and the Port for the SMTP Server to 1025. 


Keywords: WinGate 10048 Proxy

When VPOP3 dials out, when running as an NT service, a 'manual dial or
operator assisted dial' box appears

This happens because you have set the NT phonebook settings to require an operator assisted 
dial.
If VPOP3 is running as a normal application, the setting can easily be changed by going to
Start -> Programs -> Accessories -> Dial-Up Networking. Then in the <B>More</B> drop-down
menu
check that the <B>Operator assisted or manual dialing</B> option is turned off

If VPOP3 is running as an NT service, it is more difficult to do this, as the <B>Operator assisted</B>
setting is stored on a per-user basis, and NT services use different user settings from the currently
logged in user. To change the setting that applies to a service:
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 Go to Start -> Run, and run <B>Regedit</B>
 In the left hand pane, find <B>HKEY_USERS\Software\Microsoft\RAS Phonebook</B>, in the right
hand pane find the value <B>OperatorDial</B>
 Double-click on the value <B>OperatorDial</B>, and change the value to '0' (zero)
 Close RegEdit
 Stop and restart VPOP3
 It should work correctly now

Where can I get UNMIME and UUD from

The VPOP3 help file and website refer to two programs UNMIME and UUD which are used for
extracting
UUEncoded and MIME encoded attachments from email messages. This is often used for virus
scanning
messages when using VPOP3.

These files are part of a package called <B>ESS-Code for DOS</B> by Electric Storm Software.
There
doesn't seem to be a website for Electric Storm Software so we have made the software
downloadable
from our website at http://www.pscs.co.uk/downloads/vpop3_3rdparty.html.

Please note that this software is © Electric Storm Software.

Which port do I need to open on my firewall to allow an incoming SMTP
mail feed

You need to open up port 25 on your firewall/router to allow incoming SMTP mail to arrive at VPOP3.
The firewall/router also needs to be configured to route the incoming port 25 connections through to
the VPOP3 computer


 


See also:



    SMTP Relay protection in VPOP3 

    Allowing Remote Users to relay mail through VPOP3 

    Accepting incoming SMTP through a router


Which TCP/IP Ports does VPOP3 use

A TCP/IP port is like the room number in a building. It lets a client program contact a specific server
on a computer, so if a computer has both a web server and a mail server, an email client can say it
wants to talk to the mail server and not the web server.
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The ports which VPOP3 uses (by default) are: 



    25 - SMTP (outgoing mail or incoming SMTP mail) 

    79 - Finger (user information) 

    106 - Password change server 

    110 - POP3 (incoming mail) 

    143 - IMAP4 (incoming mail) - on VPOP3 Enterprise only 

    389 - LDAP (global address book) 

    5106 - Telnet Administration server (Version 1.5.0 and earlier) 

    5107 - Web Administration server (Version 1.5.0 and earlier) 

    5108 - Web Mail server (and Web Administration in 2.0.0 and later) 

    5109 - Remote Status Server (in V2.0.0 and later) 



You can change these port assignments (and disable most of the servers) on the Services page in
the VPOP3 settings (the Local Servers tab in VPOP3 1.5.0 and earlier)

Which versions of Windows will VPOP3 run on?

VPOP3 and VPOP3 Enterprise will run on any 32 bit Intel version of Windows.

This means it will run on the following platforms:

 Windows 95
 Windows 98
 Windows NT Workstation
 Windows NT Server
 Windows 2000 Professional
 Windows 2000 Server
 Windows 2000 Advanced Server
 Windows ME (Millennium Edition)

VPOP3 does not run on:

 Linux (except in a Windows emulator such as VMWare)
 16 bit versions of Windows (Windows 3.1, 3.11 etc)
 Windows CE
 a Novell server (VPOP3 will run on Novell networks, but only on a 32 bit Windows computer
on the network, it won't run on the server itself)
 Apple Mac
 Commodore 64
 etc

You can access the VPOP3 mail and web mail facilities from any computer which has TCP/IP
networking
capabilities and the appropriate client software, so if you have VPOP3 running on a 32 bit Windows
computer, any other computers on your network running other operating systems, eg 
(Unix, Mac, Windows CE etc) can access mail on the VPOP3 computer.

Why isn't VPOP3 trying to send messages from the VPOP3 OutQueue?
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If there are messages in the VPOP3 outqueue, but VPOP3 does not seem to be trying to send them,
there are usually a couple of possible reasons if your VPOP3 is set to send Via SMTP Relay



    On the appropriate External Mail -> OutMail settings page, check that there is at least one mail
server address in the SMTP Relay Servers setting box. If this box is blank, VPOP3 will not try to send
outgoing mail.

    Also on the External Mail -> OutMail settings page, check that the Domain Filtering box is blank,
unless you know there should be something in there. If there is an inappropriate setting in there, it
may cause VPOP3 to think that no mail should be sent using this OutMail method.




Note that this article does not apply if VPOP3 is trying to send mail, but is receiving errors of some
sort.


 

Will the Plug-in pack work with my virus scanner?

Will my virus scanner work with the VPOP3 Plug-in pack?


The VPOP3 Plug-ins pack is designed to allow VPOP3 to work with most common virus scanners. The
conditions for a virus scanner to be able to work with the virus scanner are...


1. Virus scanner must be able to start and stop automatically


2. Virus scanner must be able to quarantine or delete infected messages automatically


3. Virus scanner must be able to be run from the Command prompt (Windows "Run" menu option)


("automatically" means that there should be no popup windows or manual input required by the
user.)


At PSCS we don't have the resource to check every virus scanner and version to see whether it will
work with the plug-ins pack or not. However we do have Knowledgebase articles on the following
virus scanners, and getting them to work with the VPOP3 Plug-ins pack.


Note that if you want an easy, supported method of virus scanning emails, we recommend our
integrated virus scanner options, such as Sophos SAVI or avast! for VPOP3.



    Norton AV 2000                   http://kbase.pscs.co.uk/index.php?article=126

    Norton AV 2001                   http://kbase.pscs.co.uk/index.php?article=204

    Norton AV 2002                   http://kbase.pscs.co.uk/index.php?article=172

    Norton AV 2003/2004          http://kbase.pscs.co.uk/index.php?article=202

    McAfee Antivirus                   http://kbase.pscs.co.uk/index.php?article=125

    Panda Antivirus v6               http://kbase.pscs.co.uk/index.php?article=127
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    Norton Anti-virus Corporate http://kbase.pscs.co.uk/index.php?article=221

    InnoculateIT                        http://kbase.pscs.co.uk/index.php?article=186




If you are using a virus scanner with the plug-in pack not listed above, you are welcome to send us
the infromation on how to configure that scanner, so that we can publish it here for the benefit of
other users.

Will VPOP3 allow the use of non-PC clients?

VPOP3 itself must run on a 32 bit Windows platform (Windows 95, 98, ME, NT, 2000), but other 
computers on the network can use VPOP3 for email as long as a suitable POP3/SMTP (or IMAP4 if you
use
VPOP3 Enterprise) email client is available.

This means that other computers on the network can be Windows 3.x, Apple Macs, Linux computers, 
Unix computers etc, and can send and receive email through VPOP3 as long as they support 
TCP/IP networking, have a POP3/SMTP email client, and are configured correctly.

Unfortunately, because of the wide range of different configurations we are unable to help with
the configuration of these computers. 

In general, you should just configure the email client as if VPOP3 was your own 
local "Internet Provider" which supports POP3 and SMTP email.

Windows NT reports an 'Out Of Buffers' error after a while

This is a bug in Windows NT 4.x associated with the new dial-up scripting tool. The fix is available in
Service Pack 4 (SP4), so
you should install that.

You can also work around the bug by using the old SWITCH.INF login script method rather than the
new .SCP login scripts. See
the NT resource kit for documentation on how to use SWITCH.INF scripts

Windows NT Service Database locked

When trying to add the VPOP3 service, or query it using the Windows Services applet, you might get
an error like "The Service Database is currently locked".


This might also prevent the VPOP3 service from starting.
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This problem can happen if one or more Windows services are not able to start up. This might be
totally unrelated to VPOP3, but the fact that the services are not starting will prevent the VPOP3
service from running correctly as well.


This article on the Microsoft knowledgebase gives more information, and diagnosis instructions for
this problem.

Windows passwords aren't working even though the option to use them is
enabled in VPOP3

If 'Allow NT Passwords' is checked in the Users -> Security page in the VPOP3 settings, then VPOP3
will try to log on to Windows using the supplied username/password.





If this doesn't work, there are a few possible reasons:







    Passwords are being sent to VPOP3 using an encrypted method. Windows requires passwords to
be sent to it using plain text, so if a password is received by VPOP3 using a "one-way hash"
encryption method, VPOP3 can't determine the plain text password for sending to Windows.

    

        If you are trying to use VPOP3's WebMail, go to Services -> WebMail, and check that "Encrypt
login passwords when transmitting over the network" is turned off.

        If you are trying to use an email client program, check its login settings to check it is using plain
text, rather than CRAM-MD5

    

    The Windows username may be different from the VPOP3 username. In this case, go to the users'
"Advanced" settings, and set the "Windows NT Username" setting appropriately for that user



If you have had to turn off password encryption and are worried about passwords being seen as they
are transmitted over the network, you should consider using VPOP3 Enterprise and using the
SSL/TLS options in that which will encrypt the whole session, including the passwords whilst they are
transmitted over the network, but send the password in plain text within that encrypted session, so
VPOP3 can use the plain text password to send to Windows.

You get an error message "You are currently using more than your
allowed number of LAN Forwarding users"

If you get an email error message saying:

You are currently using more than your allowed 
number of LAN Forwarding users (max 5). 
A message to "joe@company.com" did NOT get forwarded.
Please increase your licence (see the help file for details)

This means that you have a VPOP3 licence smaller than 25 users, and VPOP3 has been used
to forward too many email addresses on to the remote mail server. For instance, if you have a
5 user licence for VPOP3, VPOP3 can forward to 5 different email addresses on the remote mail
server. If you have a 10 user licence, it can forward to 10 different email addresses. Once
you have a 25 or larger licence, then it can forward to as many different email addresses as you
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want.

If you THINK you have few enough users on the other mail server, then the chances are that
VPOP3 is being confused by mis-spelt or incorrect email addresses.

VPOP3 cannot know automatically which email addresses are valid on the other email server and
which aren't, so it has to assume that they're all valid unless it's told otherwise.

Often this problem is caused by having a LAN forwarding rule such as:

*@company.com  192.168.1.1

This type of rule can be problemmatic with a VPOP3 licence smaller than 25 users. Instead you
should set up explicit rules, eg
fred@company.com 192.168.1.1
joe@company.com 192.168.1.1
sue@company.com 192.168.1.1
~@company.com 192.168.1.1 fred@company.com

This tells VPOP3 that only 'fred', 'joe' and 'sue' users exist, and any unrecognised mail should
be forwarded to 'fred@company.com' (and thus will only be counted by VPOP3 as that one email
address)

VSOCKS Light

Can VSOCKS Light be used on Windows 2000 Server

VSOCKS Light cannot be used on a Windows 2000 Server, if the Windows 2000 Server is 
acting as an Active Directory Server (the normal situation). This is because Active 
Directory needs either the Windows DNS Server or another DNS server which supports
Dynamic DNS (DDNS). 

VSOCKS Light needs its own DNS server to be used, and does not support Dynamic DNS,
so you get a conflict where both pieces of software need their own DNS server, and you
can only have one DNS server on a PC.

So, VSOCKS Light can't be used on Windows 2000 Server with Active Directory running.
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You can put VSOCKS Light on another computer, or use a proxy server like 
WinProxy instead on the
Windows 2000 Server.

Does VSOCKS Light support UDP, RealAudio, ICQ etc

VSOCKS Light can be used to proxy any TCP/IP protocol (if the client does not support SOCKS directly 
you may need a WINSOCK interceptor such as SOCKSCap 
or the Hummingbird SOCKS Client)

VSOCKS Light does <B>Not</B> support UDP or ICMP or any protocol based around those 
(eg RealAudio, ICQ etc). If you want to use those features through a proxy server then we
recommend
that you purchase a more powerful proxy server such as Winproxy.

Does VSOCKS support ADSL or DSL connections

VSOCKS Light supports ADSL and DSL connections.

ADSL and DSL connections are usually made through either a "network"
 card plugged into the PC, or an external box which is plugged into a network hub (or connected to
a standalone PC using a "swapover" cable).

To use these ADSL/DSL connections from VSOCKS Light, simply tell VSOCKS to 'Connect Using LAN'
and set up the Windows networking settings to use the ADSL/DSL connection as
instructed by your service provider.

Testing the DNS configuration in VSOCKS Light

A common problem when using VSOCKS Light is that the 'External DNS Server' configuration option 
in VSOCKS is entered correctly, so that it is not pointing at a valid DNS server.
Testing the External DNS Server Setting
Method 1

To see if this may be the problem, go to a client computer which is set up to connect through
VSOCKS Light,
open up a DOS prompt and run <B>PING WWW.PSCS.CO.UK</B>. 

If VSOCKS doesn't dial out then the problem may be that the <B>CLIENT</B> computer DNS 
configuration isn't pointing at VSOCKS Light.

If VSOCKS does dial out, but you get a <I>Bad IP Address</I> or <I>Unknown Host</I> error, then
the problem is probably that the External DNS Server setting is wrong.

Method 2
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If you want to double-check this, and you are running VSOCKS on Windows NT or Windows 2000, 
dial into the Internet, and from the DOS prompt type <B>NSLOOKUP</B>. Then at the '>' prompt 
type <B>SERVER </B> (eg <B>SERVER 123.123.123.123</B>). 
Then type <B>www.pscs.co.uk</B> (or any other Internet host name you want to look up which you
know is correct). If this doesn't work, then the DNS server address you specified isn't a proper
DNS server

Determining the External DNS Server Address

First, you should contact the ISP if you can, as they <I>should</I> know the answer. However,
unfortunately, some ISP technical support staff aren't as well trained as they could be, so they
may not give you the correct answer.

If VSOCKS is running on Windows 95/98, connect to the Internet then go to <B>Start</B> ->
<B>Run</B> and run 
<B>WINIPCFG</B>. There should be a drop-down listbox, choose 'PPP Adapter' in that box, and
press the 
<B>More Info</B> button. You will then see a <B>DNS Servers</B> box, this contains the DNS
server(s) that
Windows has been told by the ISP.

If VSOCKS is running on Windows NT/2000, connect to the Internet, then go to a DOS prompt and
run 
<B>IPCONFIG /ALL | MORE</B>. In the output, in the <B>PPP Adapter</B> section, you should see
a line saying 
<B>DNS Servers</B> - that contains the DNS servers set by the ISP, as below.

PPP adapter ISPName:
    Connection-specific DNS Suffix  . :

        Description . . . . . . . . . . . : WAN (PPP/SLIP) Interface

        Physical Address. . . . . . . . . : 00-53-45-00-00-00

        DHCP Enabled. . . . . . . . . . . : No

        IP Address. . . . . . . . . . . . : 195.195.15.37

        Subnet Mask . . . . . . . . . . . : 255.255.255.255

        Default Gateway . . . . . . . . . : 195.195.15.37

        DNS Servers . . . . . . . . . . . : 195.195.14.72

        NetBIOS over Tcpip. . . . . . . . : Disabled

In this case, the DNS server you should set in VSOCKS is <B>195.195.14.72</B>
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vDHCP

Making vDHCP Bind to all available IP addresses

To make vDHCP bind to all available IP addresses you need to manually edit the <B>VDHCP.INI</B>
file
which is located in the same directory as the <B>VDHCP.EXE</B> program.

 Close vDHCP if it is currently running (make sure you shut down the whole program, 
not just the settings window)
 Open the <B>VDHCP.INI</B> file using a text editor such as NOTEPAD
 In the section beginning with the line <B>[Server]</B> add a line

       <B>BindToAll=1</B>

       If a line beginning with <B>BindToAll=</B> already exists, change the value of this setting
  to <B>1</B> to make vDHCP bind to all IP addresses
 Save the <B>VDHCP.INI</B> file to disk
 Restart vDHCP

If you want to stop vDHCP binding to all IP addresses, then change the <B>BindToAll</B> value to 
<B>0</B> (zero)

Note that this setting will make vDHCP bind to all IP addresses and network cards including ones
which are not present when vDHCP is first started (such as a dial-up adapter IP address). This means
that there does exist a security risk since the vDHCP program could be visible to people on the 
Internet who know how to access it, and this may give them access to information such as your local
IP address ranges, DNS server addresses etc. Usually this information is of limited use, or can be
discovered in other ways, but you should be aware of this consequence of using the
<B>BindToAll</B>
setting in vDHCP

Specifying DHCP options for vDHCP to give to clients

In vDHCP 0.9 and later advanced users can make vDHCP supply DHCP options to DHCP clients that
ask for them. This has to be done by editing the VDHCP.INI file manually. Most users will not need
to do this as the most common options can be set through the vDHCP settings pages (eg DNS
servers, Default Gateway etc), however the instructions below will help you to set this facility if
required.


First of all you should work out which options are required and what data types you need to specify.
RFC 2132 specifies what the various DHCP options are. 



    Close vDHCP if it is currently running (make sure you shut down the whole program, not just the
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settings window) 

    Open the VDHCP.INI file using a text editor such as NOTEPAD 

    If a line saying [Options] does not exist, add a line like this at the end of the file 

    Add (or set) a line saying MaxOption=xxxx below the [Options] line. This specifies the
maximum Option number that vDHCP should check for. This defaults to 100 which is sufficient for
the current DHCP standards. 

    Add the various options below the [Options] line 

    Save the VDHCP.INI file to disk 

    Restart vDHCP 



Each option that you wish to set is represented by a line in the [Options] section of the VDHCP.INI
file and is formatted as below. 


Option= 


(N is an decimal value)


The various data types are: 



    B - Data consists of one or more BYTE values separated by commas or spaces 

    W - Data consists of one or more WORD (2 byte) values separated by commas or spaces 

    D - Data consists of one or more DWORD (4 byte) values separated by commas or spaces 

    I - Data consists of one or more IP addresses separated by commas or spaces 

    S - Data consists of a text string 



All W, D and I values are stored in network byte order as required by the DHCP options standards.

Example

This will probably be best illustrated by an example. In this example we will assume you want to set
the following options:



    Time Offset (option 2, DWORD) set to 28800 

    Domain Name (option 15, TEXT) set to "mydomain.com" 

    Interface MTU (option 26, WORD) set to 1500 

    TCP Default TTL (option 37, BYTE) set to 100 

    NTP servers (option 42, IP addresses) at 192.168.0.1 and 192.168.0.2 



These options would be specified in the VDHCP.INI file as below:

  [OPTIONS]

MaxOptions=100

Option2=D28800

Option15=Smydomain.com

Option26=W1500

Option37=B100

Option42=I192.168.0.1,192.168.0.2




Note 



    Setting options does NOT force a client computer to use them. Client computers will only use
options that they ask vDHCP for and then decide to act upon. 

    vDHCP does NOT do any form of checking of options set in this way, so you should make sure that
you use the correct data types for the options you are wishing to set. Use of incorrect types may
lead to unpredictable behaviour in the DHCP client computers. 
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Stopping vDHCP warning that a static IP address is needed

When vDHCP starts up it will check to see if a static IP address is assigned to the local computer.
This is usually necessary for the operation of vDHCP. However, in some cases vDHCP will not be
able to detect a static IP address due to unusual network configuration, or the vDHCP computer may
be assigned an IP address by another DHCP server on the network.

If vDHCP cannot find a static IP address it will display a message box at startup warning you
of the problem.

It is possible to change a setting in the <B>VDHCP.INI</B> file to stop vDHCP showing this
warning message box.

 Close vDHCP if it is currently running (make sure you shut down the whole program, 
not just the settings window)
 Open the <B>VDHCP.INI</B> file using a text editor such as NOTEPAD
 In the section beginning with the line <B>[Server]</B> add a line

       <B>DontWarnAddress=1</B>

       If a line beginning with <B>DontWarnAddress=</B> already exists, change the value of this
setting
  to <B>1</B> to stop vDHCP showing the warning
 Save the <B>VDHCP.INI</B> file to disk
 Restart vDHCP

If you want to make vDHCP show the warning again if it detects a problem, then change the 
<B>DontWarnAddress</B> value to <B>0</B> (zero)

Note that you should not really change this setting unless you are aware of any potential side
effects. In particular if you are disabling this warning because the vDHCP computer is being 
assigned an IP address by another DHCP server you should consider what will happen if the other
DHCP server is not working, so the vDHCP computer cannot obtain an IP address from it. Also, you
should consider whether it is really a good idea to have multiple DHCP servers on the same TCP/IP
subnet!

vDHCP Broadcasts DHCPOFFER and DHCPACK responses even when
BROADCAST bit is turned off

The DHCP standard (RFC 2131) says that a DHCP server
SHOULD send DHCPOFFER and DHCPACK responses to the DHCP client using an IP <B>unicast</B>
datagram targetted to the MAC address of the client even if the client does not have
an IP address assigned, UNLESS the "BROADCAST" bit 
is set in the DHCP request header, in which case the response should be sent using an
IP <B>broadcast</B> datagram.

vDHCP actually uses IP <B>broadcast</B> datagrams in all cases (unless the DHCP client 
has already been allocated an IP address and tells vDHCP about it in the 'ciaddr' request
header field), and ignores the "BROADCAST" bit in the DHCP request header.
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The reason behind this is that the recommended unicast method requires the use of "RAW
sockets" which are not supported in Windows 95, and which have usage limitations in
Windows NT and 2000, so the use of unicast datagrams would cause problems for some people.

Section 4.1 of the DHCP standard allows for the type of behaviour that vDHCP exhibits-
<I>If unicasting is not possible, the message
   MAY be sent as an IP broadcast using an IP broadcast address
   (preferably 0xffffffff) as the IP destination address and the link-
   layer broadcast address as the link-layer destination address.</I>
so, vDHCP's behaviour is not against the standard, it is just not <B>recommended</B> 
behaviour, and we believe there is sufficient reason to have this behaviour given the targetted
users of vDHCP, and the minimal (if any) problems that it will cause.

General

Recommended IP address ranges for local networks

When you are configuring a local network for use with TCP/IP networking, you need to assign a
unique IP address to each computer. These addresses usually need to be within a single
networkaddress range (eg 192.168.0.1 - 192.168.0.254)


You should not pick the address range totally at random as you need to be certain that the
addresses you pick are not already in use on the Internet anywhere. 


Fortunately, three sets of IP addresses have been reserved for use on private networks (that are not
directly connected to the Internet), so these addresses can be used on any network which is only
connected to the Internet using dial-up networking, a proxy server, or a NAT router. 


The address ranges which you can use are: 






    

        

            10.0.0.0 - 10.255.255.255

            (10.0.0.0 MASK 255.0.0.0)

        

        

            192.168.0.0 - 192.168.255.255

            (192.168.0.0 MASK 255.255.0.0)

        

        

            172.16.0.0 - 172.31.255.255

            (172.16.0.0 MASK 255.240.0.0)
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Any other addresses should not be used except on the instruction of your ISP.


(See RFC 1918 for more information on these, if the information in this article isn\'t sufficient)

What is RAS?

RAS stands for \'Remote Access Services\'. It\'s another name for \'Dial Up Networking\' (DUN).


Tell VPOP3 or VSOCKS Light to \'Use RAS\' if it has to use a dial-up connection to the 

Internet (using a modem or ISDN Terminal Adapter (TA)). Tell it to \'Use LAN\' if it connects

to the Internet through a router (ADSL, Leased Line, Kilostream etc) or using a proxy

server which itself uses a modem or ISDN TA.
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